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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Foreword 1
1.1 About this manual 

Purpose of the manual 
This documentation provides a complete overview of configuration and operation of RFID 
systems using SIMATIC RF-MANAGER 2008. The manual supports you with creating new 
projects and explains the engineering procedures and implementation of new projects. 
The manual is aimed at users and project engineers who are employed in the areas of 
configuring, commissioning and servicing of RFID systems using SIMATIC RF-MANAGER 
2008. 

Contents 
This documentation will familiarize you with the components of the SIMATIC RF-MANAGER 
2008 software: 
● SIMATIC RF-MANAGER Engineering System (ES): Engineering software for creating 

and processing RFID projects 
● SIMATIC RF-MANAGER Runtime (RT): Runtime software for executing RFID projects 

Basic knowledge required 
General experience in the field of automation technology and RFID technology is essential 
for understanding this manual. Knowledge of the EPCglobal Application Level Events (ALE) 
Specification is also required.  
It is assumed that the reader is competent in the use of personal computers with the 
Windows XP Professional operating system.  

Conventions 
In this manual, the product SIMATIC RF-MANAGER 2008 is also referred to as RF-
MANAGER. 

Scope of validity 
The manual is applicable to SIMATIC RF-MANAGER 2008 and describes the delivery status 
of June 2010. 
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History 
 
Edition Remarks 
02/2007 First edition 
04/2008 Edited for RF-MANAGER 2008 
06/2010 Revision for RF670R 

1.2 Further information 
You can obtain further information about the SIMATIC RFID system, for example, from the 
following documentation: 
●Configuring and Operating Manual SIMATIC RF-MANAGER Basic 
This manual contains all the information you need for installing and using the SIMATIC RF-
MANAGER Basic software for parameterizing the RF670R reader. 
●SIMATIC RF670R Function Manual 
This manual is intended for advanced users and describes the XML-based programming 
interface of the SIMATIC RF670R reader as well as the system alarms. 
● SIMATIC RF-MANAGER Information System 
● SIMATIC RF-MANAGER Getting Started 
● SIMATIC RF-MANAGER Function Manual 
● SIMATIC RF-MANAGER Basic Information System 
● Configuring and Operating Manual SIMATIC RF-MANAGER Basic 
● SIMATIC RF670R Function Manual 
● SIMATIC RF600 System Manual 
● SIMATIC RF660R Configuration Software Programming and Operating Manual 
● SIMATIC RF660R XML Interface Function Manual 
● SIMATIC RF610M Operating Instructions 
● SIMATIC RF610M Function Manual 
● SIMATIC RF300 System Manual 
● SIMATIC RF310M Operating Instructions 
● SIMATIC RF310M Function Manual 
The documentation can be downloaded from the Siemens Service & Support pages 
(http://support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&subtype=133300&extranet=standard&startNode=40000
24&nodeid0=21355358&objaction=csopen). 

http://support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW%2f&func=cslib.csinfo&siteid=csius&subtype=133300&extranet=standard&startNode=4000024&nodeid0=21355358&objaction=csopen�
http://support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW%2f&func=cslib.csinfo&siteid=csius&subtype=133300&extranet=standard&startNode=4000024&nodeid0=21355358&objaction=csopen�
http://support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW%2f&func=cslib.csinfo&siteid=csius&subtype=133300&extranet=standard&startNode=4000024&nodeid0=21355358&objaction=csopen�
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Additional information regarding RFID and the EPCglobal Application Level Events (ALE) 
Specification can be downloaded fromEPCglobal site  (http://www.epcglobalinc.org/home) at 
www.epcglobalinc.org. 

 

 Note 
Detailed information is available in the Information System 
This manual provides a comprehensive overview of RF-MANAGER. You will find detailed 
information about the individual topics in the Information System. 

 

 
 

http://www.epcglobalinc.org/home�
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Introduction 2
2.1 Field of application 

Application areas 
The RF-MANAGER is used for configuring, commissioning and operating RFID systems. It 
allows you to collect RFID data, to process it and to filter it. This data can be exchanged with 
an S7 PLC by means of variables or transferred to a higher-level management system.  
The RF-MANAGER supports you with quick and easy creation of RFID solutions as well as 
the administration of RFID systems and their hardware components. The application also 
offers extensive help with the preprocessing of RFID data. 
The RF-MANAGER supports the readers of the SIMATIC RF600 systems and RF300 
systems.  

2.2 RF-MANAGER components 
The RF-MANAGER comprises the following components: 
● RF-MANAGER Engineering System (ES) 
● RF-MANAGER Runtime (RT) 

RF-MANAGER Engineering System (ES)  
The RF-MANAGER Engineering System is the software for handling all your essential 
configuring tasks. You can use ES to create RFID projects on your PC and to parameterize 
their components. 

RF-MANAGER Runtime (RT)  
RF-MANAGER Runtime is the software that is used to operate RFID systems. In Runtime, 
you can execute the RFID projects during process operation that you created and 
parameterized in the Engineering System. The RT software can run either on the same PC 
as the ES, or on another Windows XP-PC of your choice. The SIMATIC Microbox PC 427B 
is also an option for runtime. The runtime system can exchange data with an S7 PLC by 
means of variables.  
In accordance with the product version or licensing of RF-MANAGER that you have 
selected, you can use the runtime system to address up to 50 RFID readers. Later license 
extensions for the Runtime software can also be obtained.  
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2.3 Product versions 
RF-MANAGER is available in the following versions:  

Full versions: 
 
Product version Description Order number 
SIMATIC RF-MANAGER 2008 ES +RT  
for 1 reader 

Product CD with license for the ES  
and the RT (1 reader) 

6GT2080-3CA00-8AA5 

SIMATIC RF-MANAGER 2008 ES +RT  
for 5 reader 

Product CD with license for the ES  
and the RT (5 readers) 

6GT2080-3CC00-8AA5 

SIMATIC RF-MANAGER 2008 ES +RT  
for 20 reader 

Product CD with license for the ES  
and the RT (20 readers) 

6GT2080-3CE00-8AA5 

SIMATIC RF-MANAGER 2008 ES +RT  
for 50 reader 

Product CD with license for the ES  
and the RT (50 readers) 

6GT2080-3CG00-8AA5 

Upgrade: 
 
Product version Description Order number 
SIMATIC RF-MANAGER 2007 → 2008  
ES +RT for 1 reader 

Product CD with upgrade license  
for the ES and the RT (1 reader) 

6GT2080-3CA00-8AE5 

SIMATIC RF-MANAGER 2007 → 2008  
ES +RT for 5 reader 

Product CD with upgrade license  
for the ES and the RT (5 reader) 

6GT2080-3CC00-8AE5 

SIMATIC RF-MANAGER 2007 → 2008  
ES +RT for 20 reader 

Product CD with upgrade license  
for the ES and the RT (20 reader) 

6GT2080-3CE00-8AE5 

SIMATIC RF-MANAGER 2007 → 2008  
ES +RT for 50 reader 

Product CD with upgrade license  
for the ES and the RT (50 reader) 

6GT2080-3CG00-8AE5 

 
 

 Note 
Language version 
All the above-mentioned product CDs contain the following language versions: 
German/English 

 

 Note 
Licensing 
To use the RF-MANAGER, you will need one license for each component (ES or RT) and 
PC. 
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2.4 System requirements 

System requirements 
 
 RF-MANAGER Engineering System RF-MANAGER Runtime 
Supported devices  Standard PC  Standard PC / SIMATIC Microbox PC 420 / 

SIMATIC Microbox PC 427B 
Operating system Windows XP Professional SP3 or higher 

 
Windows XP Professional SP3 or higher 
(standard PC) 
Windows XP Embedded SP3 or higher  
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 

CPU Pentium IV or later  
with 1.6 GHz processor 
 

Pentium III or later  
with 933 MHz processor 
(standard PC) 
Pentium III with at least 933 MHz processor  
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 

Graphic Resolution of at least 1024x768 / 1280x1024 
recommended 
at least 256 colors 

Resolution of at least 640x480  
 
at least 256 colors 

RAM At least 1.0 GB / 2.0 GB recommended At least 512 MB / 1024 MB recommended 
At least 1.5 GB At least 256 MB  

excluding archives 
(standard PC) 
CompactFlash card with at least 512 MB 
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 

Free memory space / 
hard disk 

In addition to the space needed by RF-MANAGER, Windows also requires space on the hard 
disk, e.g. for the swap file. For additional information, refer to your Windows documentation. 

Additional hardware CD-ROM drive (for installing the software) 
USB port for installing the licenses 

Reader for document 
display 

Adobe Acrobat Reader 5.02 

Internet browser Microsoft Internet Explorer V6.0 SP1 / SP2 
Multiple screens The operating system function used to visualize the screen content on several monitors (Control 

Panel > Display > Settings) is not released with RF-MANAGER. 
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2.5 Installation 

Installation  
The software RF-MANAGER Engineering System is located on the CD "SIMATIC RF-
MANAGER 2007". A license (license key) is required to run the software. 

 

NOTICE  
If you start the RF-MANAGER without a valid license, the system alerts you that you are 
working in non-licensed mode. You have the option, once only, of activating a trial license. 
The trial license expires after 14 days.  
If the trial license expires, one of the following applies: 
 A main license has never been installed on the computer 

– the RF-MANAGER can no longer be started. 
 A main license was installed on the computer at one time 

– the RF-MANAGER can be started, but the system outputs a message at regular 
intervals to notify the user of unlicensed mode. 

 

1. If the autorun function is enabled for your CD-ROM drive, setup is run automatically when 
the CD is inserted. Otherwise, start the program "setup.exe" from the CD. 

2. Select the user interface language of the Setup program under "Language." 
3. Display the product information and accept the licensing conditions in the subsequent 

window. 
4. Select the drives for the installation data. If you select the option "Transfer license key 

automatically", you must also specify the source and destination of the license key. If you 
do not select this option, messages will appear frequently during operation that must be 
confirmed. 

5. Select the components to be installed. 
6. Follow the instructions on the screen. 

 

 
 

Note 
If, when installing the software, you do not have a license, you can install this later using 
the Automation License Manager.  
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2.6 Installation Service Pack 

Requirement 
SIMATIC RF-MANAGER 2008 must be installed. 

Procedure 
1. Start the file "SIMATIC_RF-MANAGER_2008_SP3.exe" by double-clicking the file name. 
2. Follow the on-screen instructions. 

Result 
RF-MANAGER 2008 Service Pack is now installed on your computer. 
In the installation folder, usually "C:\Program Files\ Siemens\SIMATIC RF-MANAGER\RF-
MANAGER 2008 Support", five additional folders have been created by launching the 
Service Pack: 
● ALEDatabridgeClient 

ALEDataBridgeClient is already fully installed following installation of the Service Pack, 
and it can be started via "SIMATIC > RF-
MANAGER 2008 Runtime > AleDataBridgeClient". This demo application is based on the 
ALE+ Client API Library and uses the ALE interface to make files available in .csv (text), 
.sql (database), and .xml (structured text) formats.  
The documentation for the ALEDataBridgeClient can be found in the folder, along with 
the source files. 

● ALE+Client Demo 
The ALE+Client Demo is already fully installed following installation of the Service Pack, 
and it can be started via "SIMATIC > RF-MANAGER 2008 Runtime > ALE+Client Demo". 
This demo application is based on the ALE+ Client API Library and uses the ALE 
interface to provide an overview of the functional scope of the interface. All supported 
commands can be run, and reports for files and messages can be displayed. 
Along with the source files, the folder contains comprehensive documentation on the use 
of the ALE+ interface and the ALE+Client Demo. 

● RF610M 
The "RF610M" folder contains components to be installed on the respective devices if 
RF610M units are used with RF-MANAGER, as well as the installation documentation. 

● RF310M 
The "RF310M" folder contains components to be installed on the respective devices if 
RF310M units are used with RF-MANAGER, as well as the installation documentation.  
Prerequisites: RF310M from the 2nd generation (G2) of the PSION basic device with the 
MLFB 6GT2803-0AB00 

● Project samples 
The "Project samples" folder contains numerous example configurations for the new 
devices. The mode of operation of the readers and their integration into the RF-
MANAGER can be followed in the projects. 
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2.7 RFID systems 

2.7.1 General layout 

Overview 
The general automation and IT structure of a company is shown in the following figure. This 
comprises several different levels that are described in detail below.  

Control layer

ONS or EDI

(Object Name Service,
Electronic Data Interchange)

Covered area

Global integration

Business planning

Production control

via ALE interface

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

* Readers are connected via one COM port each on PC ** Readers are connected individually via TCP/IP

WLAN

RF660RRF620R RF630R RF610M/ 
RF310M

RF310R/ 
RF340R/ 
RF350R

RF380R

ERP
(Enterprise Resource 
Planning)

ERP
(Enterprise Resource 
Planning)

PROFIBUSSIMATIC S7

COM1 - COMx * TCP/IP **

SIMATIC 
RF-MANAGER

MES
(Manufacturing
Execution System)

Ethernet

Industrial Ethernet

SCM 
(Supply Chain 
Management)

RF670R

 
● Acquisition level 

This level contains the RFID readers that read the appropriate tag data and transfer them 
to the next highest level. 

● Control level 
At the control level , the RFID data are collected, preprocessed and presented to the 
production control and business administration control levels for further processing. 

● Production control 
The Manufacturing Execution System (MES) closes the gap between the data that arise 
in the automation environment (control level) and the logistical and commercial processes 
of the company (business administration control). MES solutions are used, for example, 
for defining and performing production processes. 
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● Business administration control 
This level covers planning and control of the equipment used. For this purpose, 
Enterprise Resource Planning (ERP) systems and Supply Chain Management (SCM) 
systems are used with modules for cost accounting, financial bookkeeping and personnel 
management. 

● Global integration 
Product information can be exchanged here at an inter-company level. This can be 
performed over the Internet with the help of special services. 
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Tasks of RF-MANAGER  
At both the planning level (ERP) and production level (MES), systems are used that 
generate a large volume of information that is relevant to production or that has commercial 
relevance. To increase productivity and efficiency, the individual levels must communicate 
with each other to use all the information that is available optimally. The RF-MANAGER 
makes an important contribution to this and is located at the PLC/PC level. It manages the 
connected RFID readers, collects the supplied data and reduces them to the accuracy and 
quantity required by the MES/ERP level. The most important areas are device management, 
data management and business integration. RF-MANAGER also acts as the interface 
between RFID data and the MES/ERP level. 
● Device management 

Device management involves management of the connected RFID readers. This 
comprises configuration of the readers during the engineering phase as well as 
monitoring the readers during normal operation. With the help of a project wizard and 
special editors, projects can be created in the shortest possible time that are ready to run. 
Up to 50 readers can be operated in parallel. Fine tuning of the readers is possible using 
the user interface of the runtime system - which, for example, also supplies statistical 
information on the read quality of individual antennas - and a high-performance indication 
system. The time spent on commissioning and servicing can be significantly shortened 
especially in the case of large-scale applications. 

● Data management 
Data management is the processing of RFID data at a hardware-based level. This 
contains the reading and writing of RFID data and its filtering on the one hand and 
conditioning of the data contents for the MES/ERP level and the PLC on the other hand. 
Read and write functions can be triggered either directly by RF-MANAGER or by the 
higher-level MES/ERP systems or PLCs. The RFID data are filtered at different levels. 
Starting from basic reduction of the read quantity of data, through bit pattern masking of 
the RFID data as far as filtering according to EPCglobal schemes. This ensures that only 
the information that is actually required is passed on. Digital inputs/outputs of the readers 
can also be activated or evaluated. Furthermore, RFID data can be evaluated by means 
of simple scripting or in the PLC. 

● Business integration 
All aspects concerning connection of the RF-MANAGER to the MES/ERP level are 
combined under the heading of business integration. The emphasis here is on presenting 
the RFID data in reports. The contents of reports and connection to the MES/ERP level 
can be configured in RF-MANAGER. At runtime, these reports can be requested from the 
higher level. Actions for the connected readers can also be triggered directly from the 
MES/ERP system. This includes, for example, the reading, writing and locking of tags. 
RF-MANAGER provides the messages of the MES/ERP level. Data is exchanged 
between the MES/ERP level and RF-MANAGER or the PLC by means of the reading and 
writing of variables. 
For maximum flexibility, RF-MANAGER provides ALE+ (Application Level Events), a 
software interface designed by EPCglobal. For a detailed description of this interface, 
refer to the ALE+ Function Manual.  
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2.7.2 Overview of the RF-MANAGER architecture 
Before you configure your RFID system with RF-MANAGER, you should be familiar with the 
individual components of the system. These components are described below, on the basis 
of typical scenarios, and their interdependencies are presented.  

1) Monitoring incoming goods  
The scenario comprises an RFID system with a reader. Its four antennas monitor the 
incoming goods portal of a production hall through which pallets are delivered - each pallet is 
marked with a tag. The tags contain user data that provide information about the sender and 
receiver of the goods. These data are read out and routed on. 

 
The reader is connected to an RF-MANAGER workstation that is connected to an enterprise 
system through an ALE interface. The enterprise system receives the data from the tags in 
the form of reports. For this example, you must configure the components described below in 
RF-MANAGER.  
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Diagram in RF-MANAGER 

 

RFID device  
The RFID device is a function block in RF-MANAGER and represents a reader. The 
following components are active in this function block:  
Antennas 
The four antennas read the data of the tags that are applied to the pallets for incoming goods 
and transfer the data to the data source.  
Data source 
Data sources are the basic components for reading RFID data. They encapsulate the 
antennas assigned to them and the data that is received by them through to the subsequent 
function units. In this example, one data source is sufficient for the four antennas assigned to 
it, because only the incoming goods portal is monitored. 
It is a general rule that one RFID device can also contain several data sources. Various 
different data sources can be defined so that mutually independent tasks can be performed 
with the same reader.  
One data source contains the following blocks: 
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● Read trigger 
Read triggers are activation mechanisms. They cause the data source to read the data 
from the tags that are located in the field of the four incoming goods antennas. A 
continuous trigger can, for example, be configured that will cause the antennas to read 
constantly. 

● Tag selector 
Tag selectors are mechanisms used to route data on and to filter data. They determine 
which tag data areas should be read or routed on. They also define which tags should be 
supplied or filtered out on the basis of the contents of these data areas. In this case, a tag 
selector orientates itself on the tag ID or the freely parameterizable user data of the tag.  
In this scenario, the tag selector is use to read the recipient of the goods from the user 
data field and to route this information on together with the pallet ID. The enterprise 
system checks, on the basis of the transferred data, whether the correct pallets have 
been delivered. If this is the case, the enterprise system triggers a green signal light in 
the production hall by activating an output of the reader. The stock inventory is also 
updated. If this is a fixed filter criterion, the evaluation and control of the output can occur 
directly in the RF670R.  

● Filtering 
Filtering is a technique that is used to optimize the read quality. The RF-MANAGER 
marks the read event with a status description for the tag (e.g.: detected for the first time 
by the inbound logistics antennas, reliably detected, lost) and adds these states to the 
read results. Time intervals are defined using this technique - for example, how long a tag 
detected for the first time has to be "seen" for it to be regarded as reliably detected. This 
allows tags to be excluded that have been unintentionally detected briefly in the boundary 
areas of the reader. 
 

Notification channel  
One or more data sources are assigned to one notification channel as data suppliers. A 
notification channel is used in this example to which the data source for the antennas of the 
incoming goods portal has been assigned. The notification channel routes on the data from 
this data source. 
A notification channel contains the following blocks: 
● Notification channel trigger 

Notification channel triggers are activation mechanisms. They cause the notification 
channel to transfer the data from the data source assigned to it. A continuous trigger can, 
for example, be configured that will cause data to be transferred constantly. 

● Data selector 
Data selectors are mechanisms that process tag information and filter it. In this scenario, 
for example, filtering can be performed using smoothing criteria that are defined in the 
data source. Information is only transferred from tags that are in the reliably detected 
state. It can be assumed that these have been detected without errors. 
In general, the data selectors can supply additional information (reader fields). This 
includes, for example, the time of the read. 
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Workplace  
Workplaces are used as an abstraction of the hardware. The relevant data sources and 
notification channels are grouped here into workplaces using the RF-MANAGER. Practically, 
workplaces are combinations of readers. 
In this example, the workplaces refers to the notification channel that is fed from the four 
incoming goods channels. This means that: This workplace represents the incoming goods 
area. It then receives the prefiltered or transferred tag data in accordance with the 
notification channel trigger.  

ALE interface  
The data of a workplace can be requested in the form of reports by the enterprise system 
over the ALE interface (Application Level Events). The is performed using the following read 
procedure:  
● Asynchronous read procedure 

An asynchronous read procedure is when an ALE client of the enterprise system logs 
onto the report of the ALE interface and receives the data automatically. This continues 
until the client logs off again.  

● Synchronous read procedure 
A synchronous read procedure is when an ALE client of the enterprise system logs onto 
the report of the ALE interface and receives the required data automatically.  
 

The data of an ALE report, however, are dependent on the activity of the following blocks:  
● ALE selector 

ALE selectors are filter mechanisms that further reduce the accumulated data in 
accordance with the configuration settings. ALE selectors can only filter out EPC tags - to 
perform, for example, filtering according to article classes.  
Filtering of the freely parameterizable user data is not possible with ALE selectors - this 
must be performed via the data source or the notification channel. 

● ALE groups 
ALE groups determine how the data records that have passed through the filter should be 
grouped for the report to the ALE client. In this scenario, for example, the data records 
can be grouped according to serial numbers. 

When data are provided over the ALE interface, it is generally the case that ALE clients only 
have a logical view of the workplaces, precise knowledge of the hardware of the RFID 
system is no longer necessary. 
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2) Monitoring inbound logistics and outbound logistics  
The scenario comprises an RFID system with two readers. Reader 1 with its four antennas 
monitors the incoming goods portal of a production hall through which pallets are delivered - 
each pallet is marked with a tag. The tags contain user data that provide information about 
the sender and receiver of the goods. These data are read out and routed on - in the same 
manner as in the first scenario. The goods supplied on pallets undergo further processing in 
the production hall and subsequently exit the hall through the outgoing goods portal. 
Reader 2 is controlled through light barriers and monitors the two outgoing goods portals that 
are assigned to different recipients with two antennas in each case. Pallets are dispatched 
through the outgoing goods portals - each pallet is marked with a tag. These tags also 
contain user data that provide information about the sender and receiver of the goods. The 
data read by the readers are checked to ensure that the pallets are waiting at the correct 
outgoing goods portal. Depending on the read results of the reader, the outgoing portal 
opens, or it remains closed. 
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The two readers are connected to an RF-MANAGER workstation that is connected to an 
enterprise system through an ALE interface. The enterprise system receives the data from 
the filtered and sorted tags in the form of reports. For this example, you must configure the 
components described below in RF-MANAGER.  

Diagram in RF-MANAGER 
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RFID device  
In this scenario, there are two RFID devices. RFID device 1 is designed as for the RFID 
device of the first scenario - it represents Reader 1 that monitors the incoming goods portal. 
RFID device 2 represents Reader 2 that monitors both outgoing goods portals. 
Antennas  
RFID device 1 contains four antennas for the pallets that pass through the incoming goods 
portal. RFID device 2 contains two antennas each for the pallets that pass through the two 
outgoing goods portals.  
Data source 
For RFID device 1, one data source is sufficient, because only the incoming goods portal is 
monitored. 
In RFID device 2, two data sources are created each with two assigned antennas - one for 
each outgoing goods portal. The two data sources enable two mutually independent tasks 
(separate read procedures for each outbound logistics gate) to be implemented. 
The data sources contain the following blocks:  
● Read trigger 

In this scenario, a continuous trigger is configured in data source 1. A trigger is 
configured in data sources 2 and 3 that activates the antenna for reading when the 
respective light barrier is interrupted. 

● Tag selector 
In this scenario, the following actions can be performed, for example:  
The tag selector in data source 1 is used to read the recipient of the goods and to pass 
this information on. In the same manner as scenario 1, it orientates itself on the user 
data. 
The tag selectors in data sources 2 and 3 also orientate themselves on the user data and 
the included goods recipient, but they use this information for filtering. This means that: 
When a suitable tag is delivered, the enterprise system automatically opens the outgoing 
goods gate by activating one output of the reader. If the gate is operated by a PLC, the 
appropriate variable must be set by the enterprise system. If this is a fixed filter criterion, 
the evaluation and control of the output can occur directly in the RF670R.  

 
Notification channel  
In this scenario, there are two notification channels: Notification channel 1 refers to data 
source 1 and is a component of RFID device 1.  
Notification channel 2 as a component of RFID device 2 and passes on the data from data 
source 2 or 3. 
The notification channels contain the following blocks: 
● Notification channel trigger 

In this scenario, the following triggering mechanisms can be configured, for example: The 
trigger in notification channel 1 operates continuously. The trigger in notification channel 
2 also operates continuously so that the enterprise system can open the outgoing goods 
door as soon as possible on delivery of a suitable tag.  

● Data selector 
In this scenario, the following filtering procedures can be performed, for example:  
The data selector in notification channel 1 operates in the same manner as in the first 
scenario.  
The data selector in notification channel 2 supplies additional data from the reader fields 
along with the data of the read procedure. This is particularly useful when the loading 
times for pallets has to be monitored. 
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Workplace  
There are two workplaces in this example: 
As in the first scenario, workplace 1 represents inbound logistics through the gate. 
Data source 2 and data source 3 are combined with notification channel 2 to form workplace 
2. This means that: Workplace 2 represents inbound logistics through both gates. 

ALE interface  
There is an ALE interface in this example that scans the data from workplace 1 (inbound 
logistics) as well as the data from workplace 2 (outbound logistics). 
The blocks of the ALE interface operate in the same manner as in the first scenario. 
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3) Monitoring incoming goods, distribution of goods and outgoing goods  
The scenario comprises an RFID system with three readers. Reader 1 with its four antennas 
monitors the incoming goods portal of a production hall through which pallets are delivered - 
each pallet is marked with a tag. The tags contain user data that provide information about 
the sender and receiver of the goods. These data are read out and routed on - in the same 
manner as in the first scenario. The goods supplied on pallets undergo further processing in 
the production hall and subsequently exit the hall through the outgoing goods portal. 
Reader 3 is controlled by a light barrier and monitors a conveyor belt using four antennas; 
the conveyor transports the goods towards two output gates that are assigned to two 
different recipients and each item is equipped with a tag. These tags also contain user data 
that provide information about the sender and receiver of the goods. There is a separating 
filter downstream of the conveyor that determines the output gate to which the goods should 
be directed. The separating filter is set in accordance with the results from the reader and 
the goods are distributed.  
Downstream of the separating filter, the goods are loaded onto pallets - each pallet is 
marked with a tag. These tags also contain user data that provide information about the 
sender and receiver of the goods. The data read by Reader 2 are checked to ensure that the 
correct pallets are waiting at the outbound logistics gate specific to the recipient. Light 
barriers are installed to control the reader. Depending on the read results of the reader, the 
outgoing portal opens, or it remains closed. 
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The three readers are connected to an RF-MANAGER workstation that is connected to an 
enterprise system through an ALE interface. The enterprise system receives the data from 
the filtered and sorted tags in the form of reports. For this example, you must configure the 
components described below in RF-MANAGER. A PLC also receives the data from Reader 
3 via the RF-MANAGER.  
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Diagram in RF-MANAGER 

RFID device  
In this scenario, there are three RFID devices. RFID device 1 represents Reader 1 that 
monitors the incoming goods portal. RFID device 2 represents Reader 2 that monitors both 
outgoing goods portals. RFID device 3 represents Reader 3 that monitors the goods 
distribution conveyor. 
Antennas  
RFID device 1 contains four antennas for the pallets that pass through the incoming goods 
portal. RFID device 2 contains two antennas each for the pallets that pass through the two 
outgoing goods portals.  
RFID device 3 contains four antennas for the items that pass over the goods distribution 
conveyor.  
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Data source 
For RFID device 1, one data source is sufficient, because only the incoming goods portal is 
monitored. 
In RFID device 2, two data sources are created each with two assigned antennas - one for 
each outgoing goods portal.  
A data source for the goods distribution conveyor is created in RFID device 3.  
The data sources contain the following blocks:  
● Read trigger 

In this scenario, a continuous trigger is required for data source 1 that activates the 
antennas for continuous reading. 
In each of data sources 2, 3, and 4, one trigger is configured that activates the antenna 
for a read when the respective light barrier is interrupted.  

● Tag selector 
In this scenario, the following actions can be performed, for example:  
The tag selector in data source 1 is used to read the recipient of the goods and to pass 
this information on. In the same manner as scenario 1, it orientates itself on the user 
data. 
The tag selector in data sources 4 also orientates itself on the user data and passes on 
the included goods recipient. This means that: The enterprise system or the PLC program 
must check on the basis of the information the output gate for which the goods are 
destined. The separating filter is set by the enterprise system or PLC in accordance with 
the result of the check and the goods are directed to the correct output gate. 
The tag selectors in data source 2 and data source 3 use the goods recipients included in 
the user data for filtering. It is determined whether the goods that have been directed to 
the correct output gate were also loaded onto the correct pallets. It this is the case, and 
therefore a suitable tag is delivered, the enterprise system or the PLC automatically 
opens the outgoing goods gate.  
 

Notification channel  
In this scenario, there are three notification channels: Notification channel 1 is assigned to 
data source 1 and is a component of RFID device 1.  
Notification channel 2 is a component of RFID device 2 and is assigned to data sources 2 or 
3. 
Notification channel 3 is assigned to data source 4 and is a component of  
RFID device 3. 
The notification channels comprise the following blocks: 
● Notification channel trigger 

In this scenario, the following triggering mechanisms can be configured, for example: The 
trigger in notification channel 1 operates continuously. The triggers in notification 
channels 2 and 3 also act continuously to allow the enterprise system to make the 
decision for the separating filter as soon as possible or to open the goods gate as quickly 
as possible.  

● Data selector 
In this scenario, the following filtering procedures can be performed, for example:  
The data selector in notification channel 1 operates in the same manner as in the first 
scenario.  
The data selector in notification channel 2 also supplies additional data from the reader 
fields along with the data of the read procedure. This is particularly important when the 
loading times for the pallets are to be monitored. 
The data selectors in notification channel 3 also supplies additional data from the reader 
fields, for example, the name of the reader. 
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Workplaces  
There are two workplaces in this scenario: 
Data source 1 and notification channel 1 are combined to form workplace 1. This means 
that: Workplace 1 represents inbound logistics through the gate.  
Notification channel 2 with data sources 2 and 3 and notification channel 3 with data source 
4 are grouped to form workplace 2. This means that: Workplace 2 represents goods 
distribution over the conveyor belt and outbound logistics through both gates.  

ALE interface  
This example contains an ALE interface that scans the data from workplace 1 (inbound 
logistics) and workplace 2 (goods distribution and outbound logistics). 
The blocks of the ALE interface operate in the same manner as in the first scenario. 
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4) Writing tag IDs at the outgoing goods portal using system functions  
The scenario is based on scenario 3 and comprises an RFID system with three readers. It is 
expanded by the following functions: Certain tags on pallets destined for the outgoing goods 
portal should be written with new IDs before dispatch. This is performed by reader 2 that 
uses two antennas to monitor each outgoing goods portal.  

Implementation with RF-MANAGER 
A display containing two input/output fields is created in the Engineering System. One of 
these will display the current tag ID and the other will display the new tag ID. The 
components shown below are also required. 
 
Button 1 
A button must be created. This button is then linked to the "ReadFirstTagId" system function. 
When the button is clicked during runtime, the function will be executed. 

 
System function "ReadFirstTagId"  
This function uses Reader 2 to read all the current tags detected in the workplace for 
outgoing goods (Workplace 2) and returns the first tag ID. All tags identified for Workplace 2 
are also written to a cache.  
Variable 1 
A string variable must be defined. This variable is linked to the function "ReadFirstTagId" and 
stores the returned tag ID. The result is visualized in the first input/output field. 
 
Button 2 
A button must be created. This button is then linked to the "ReadNextTagId" system function. 
When the button is clicked during runtime, the function will be executed. The 
"ReadNextTagId" system function can be executed at runtime as many times as necessary 
until the required tag ID to be overwritten appears. 
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System function "ReadNextTagId"  
This function reads the next tag ID from the cache of the workplace for outgoing goods.  
Variable 1 
Variable 1 is linked to the system function "ReadNextTagId". This means that: When 
"ReadNextTagId" is executed, the previous value of the variable that was generated by the 
function "ReadFirstTagId" will be overwritten with the current value of the next tag ID. The 
result is visualized in the first input/output field.  
 
Button 3 
A button must be created. This button is then linked to the "WriteTagId" system function. 
When the button is clicked during runtime, the function will be executed. This means that: 
The read tag ID (Variable 1) is replaced by the new tag ID (Variable 2). A synchronous write 
procedure is used. 
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System function "WriteTagId"  
This function uses Reader 2 to write a new tag ID in the workplace for outgoing goods.  
Variable 1 
Variable 1 is linked to the system function "WriteTagId" and contains the tag ID to be 
overwritten. Its value is generated by the function "ReadNextTagId". 
Variable 2 
A string variable must be defined. This variable is linked to the system function "WriteTagId" 
and contains the new tag ID. This is entered manually in the second input/output field. 

 

 Note 
Further possible implementations 
The scenario described above can also be implemented automatically with scripts. Another 
possible implementation involves control from an enterprise system over the ALE interface.  
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2.7.3 Overview of the RFID functions 
An overview of the main RFID functions is given below. These can be implemented either by 
using the RF-MANAGER system functions or the ALE interface functions.  
 
Overview of the RFID functionality 
Reading tags 
Writing tags  
Locking tags 
Erasing tag 
Translating EPC 
Set output 
Read input/output 
Switching RFID device online/offline 
Switching workplace online/offline 
Initiating trigger 
Starting/stopping data link 
Read/write variables 
Registering/deregistering an ALE connection for alarm transfer  

 
 

 Note 
ALE interface functions 
The ALE interface functions that can be used in combination with the RF-MANAGER are 
based on an extension of the ALE standard defined by EPCglobal.  
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Read tag  
 
RF-MANAGER system 
function 

Description ALE interface  
function 

Description 

- - Subscribe (…) Registration with an ALE connection 
for automatic (asynchronous) data 
transfer. 
The client application automatically 
receives tag data from the RF-
MANAGER over the ALE 
connection. 
The data are supplied in the form of 
a report. User data are also included 
in this report. 

- - Unsubscribe (…) Deregistering an ALE connection. 
No more reports will be 
automatically transferred to the 
client application. 

- - Poll (…) The client application receives tag 
data once (synchronously) from the 
RF-MANAGER over the ALE 
connection. 
The data are supplied in the form of 
a report. 
The report contains data from all the 
workplaces assigned to the ALE 
connection. 

ReadFirstTagId (…) Reads tags from a specific 
workplace. 
Transfers the first read value to 
an internal string variable. 

ReadNextTagId (…) Transfers the next read value to 
another internal string variable. 

ReadIDs (…) The client application receives tag 
data once (synchronously) from the 
RF-MANAGER over the ALE 
connection. 
The data are supplied in the form of 
a string array. 
The report contains the data of one 
workplace. 

ReadTagField (…) reads the user data from a tag 
with the transferred tag ID. 
The data area is defined in 
accordance with the 
configuration of the tag selectors 
/ tag fields. 
The first data source of the 
workplace that sees the 
addressed tag reads the data. 

Read (…) Reads several items of user data 
from a tag with the transferred tag 
ID. 
The data areas are defined in 
accordance with the configuration of 
the tag selectors / tag fields. 
The first data source of the 
workplace that sees the addressed 
tag reads the data. 
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RF-MANAGER system 
function 

Description ALE interface  
function 

Description 

- - Trigger (…) Start/stop reports. 
ReadTagMemory (…) Reads the user data from a tag 

with the transferred tag ID. 
The data areas are defined by 
specifying the direct address. 
The first data source of the 
workplace that sees the 
addressed tag reads the data. 

ReadTagMemory 
(…) 

Reads several items of user data 
from a tag with the transferred tag 
ID. 
The data areas are defined by 
specifying the direct address 
The first data source of the 
workplace that sees the addressed 
tag reads the data. 

Writing tags  
 
RF-MANAGER system 
function 

Description ALE interface 
function 

Description 

WriteTagId (…) Writes tags for a specific 
workplace. 
The value to be written and the 
current value are stored in a 
string variable. 

WriteID (…) A single tag is written with a new 
EPC ID. 
The tag to be written is identified on 
the basis of its current ID. 
The command refers to the reader 
of a workplace. 

WriteTagField (…) Writes any user data to tags.  
The data areas are defined in 
accordance with the 
configuration of tag selectors / 
tag fields.  
If a tag ID is not transferred, all 
the tags in the field will be 
written. The command refers to 
the reader of a workplace. 

Write (…) Writes user data to tags. 
The data areas are defined in 
accordance with the configuration of 
tag selectors / tag fields. 
The command refers to the reader 
of a workplace. 
When IDs are specified, only certain 
tags will be written - when no ID is 
specified, all the tags in the field will 
be written. 

WriteTagMemory (…) Writes any user data to tags.  
The data areas are defined by 
specifying the direct address. 
If a tag ID is not transferred, all 
the tags in the field will be 
written. The command refers to 
the reader of a workplace. 

WriteTagMemory 
(…) 

Writes user data to tags. 
The data areas are defined by 
specifying the direct address. 
The command refers to the reader 
of a workplace. 
When IDs are specified, only certain 
tags will be written - when no ID is 
specified, all the tags in the field will 
be written. 
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Locking tags  
 
RF-MANAGER system 
function 

Description ALE interface function Description 

LockEpcGen2Tag (…) Locks EPC Class1 Gen2 
tags over a specific 
workplace. 
The ID for the tag to be 
locked is saved in a string 
variable. 

LockTag (…) Locks tags for a specific 
workplace. 
When IDs are specified, 
only certain tags will be 
locked - when no ID is 
specified, all the tags in 
the field will be locked. 

LockIsoTag (…) Locks ISO 1800-6B tags 
for a specific workplace. 
The ID for the tag to be 
locked is saved in a string 
variable. 

LockTag (…) Locks tags for a specific 
workplace. 
When IDs are specified, 
only certain tags will be 
locked - when no ID is 
specified, all the tags in 
the field will be locked. 

Erasing tag  
 
RF-MANAGER system 
function 

Description ALE interface function Description 

KillTag (…) Erases tag data for a 
specific workplace. 
The ID for the tag to be 
erased is saved in a string 
variable. 

KillTag (…) Erases tag data for a 
specific workplace. 
When IDs are specified, 
only the data of certain 
tags will be erased - when 
no ID is specified, the data 
of all the tags in the field 
will be erased. 

Translating EPC 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

TranslateEpc (…) Translates an EPC from 
one format to another. 

TranslateEPC (…) Translates an EPC from 
one format to another. 
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Set output 1 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

SetReaderIO (...) Sets the specified output of 
an RFID device to the 
specified value. 

SetIOPort (…) Sets the output of an RFID 
device. 

1 Reader outputs can also be set with system functions that use variables. The output of the 
reader must be set in the variable as the address for this purpose. 

 

 Note 
For secure assignment of a value to the specified variable, use the system function 
"SetValueBuffered". The variable will then retain the value even after a connection has been 
interrupted. 

 

Read input/output 2 
 
RF-MANAGER system function Description ALE interface function Description 
GetReaderIO (...) Reads the value from 

the specified 
input/output of an 
RFID device. 

GetIOPort (…) Supplies the status of the 
input/output of an RFID 
device. 

SetIOPort (…) Direct in the RF670R 
reader 

- Sets the specified output 
in the reader to the 
specified value. 

SetIOPortOnAlarm (…) Direct in the RF670R 
reader 

- Sets the specified output 
of a reader to the specified 
value when a specified 
alarm is generated. 

SetIOPortOnCondition (…) Direct in the RF670R 
reader 

- Sets the specified output 
in the reader to the 
specified value when the 
specified condition is 
fulfilled.  

2 Reader inputs/outputs can also be read with system functions that use variables. The 
input/output of the reader must be set in the variable as the address for this purpose. 

Switching RFID device online/offline 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

SetRfidDeviceStatus (...) Switch RFID device online 
or offline for partial start-
up. 

- - 
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Switching workplace online/offline  
 
RF-MANAGER system 
function 

Description ALE interface function Description 

SetRfidWorkplace 
Status (…) 

Switch workplace online or 
offline for partial start-up. 

- - 

Initiating trigger 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

ActivateTrigger (...) Activates a trigger that has 
been configured for the 
specified RFID device.  

ActivateTrigger (…) Activates a trigger that has 
been configured for the 
specified RFID device.  

Starting/stopping data link 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

SetRfidDataLink 
Status (…) 

Starts/stops an RFID data 
link. 

- - 

Read/write variables 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

ReadVariable (…) Reads the value of an RF-
MANAGER Runtime 
variable. The name of the 
variable is transferred as 
an argument. The value of 
the variable is transferred 
as a character string. 

Use the system functions from 
the groups: 
 Calculation 
 Bit processing 

- 

WriteVariable (…) Writes a value in an RF-
MANAGER Runtime 
variable. The name and 
the new value of the 
variable are transferred as 
a character string. 
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Registering/deregistering an ALE connection for alarm transfer  
 
RF-MANAGER system 
function 

Description ALE interface function Description 

AlarmSubscribe (…) Registers the client 
application with the alarm 
logging of RF-MANAGER 
Runtime. After registering, 
alarms are transferred to 
the "notificationURI". 
When registering, one of 
the configured languages 
can be selected. The 
alarm texts will then be 
supplied in this language. 

These functions are mirrored in 
alarm logging. 

- 

AlarmUnsubscribe (…) Deregisters the 
"notificationURI" from the 
alarm logging of RF-
MANAGER Runtime. 
Following deregistration, 
no more alarms are 
supplied to the transferred 
address. 

NXP functions 
 
RF-MANAGER system 
function 

Description ALE interface function Description 

SetReadProtect - SetReadProtect (…) Protects a specific tag 
from being read. If the 
read protection is set, the 
protected tag does not 
return a tag ID in the event 
of an inventory.  

ResetReadProtect - ResetReadProtect (...) Resets the write protection 
of a tag. If the read 
protection of a previously 
read-protected tag is reset 
again, the tag can be 
addressed again via its tag 
ID when there is an 
inventory. 

 
 

 Note 
For a complete list of the RF-MANAGER system functions, see the Help system. 

 
 



Introduction  
2.7 RFID systems 

 SIMATIC RF-MANAGER 2008 
44 Operating Manual, 06/2010, A5E01070042-03 



 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 45 

RF-MANAGER Engineering System 3
3.1 Overview 

3.1.1 Basic Principles 
RF-MANAGER is the software for future oriented RFID concepts using easy and efficient 
engineering.  
To start RF-MANAGER, either click the desktop icon on the programming device or select it 
from the Windows Start menu.  

 
In RF-MANAGER, you can only ever have one project open. Start RF-MANAGER more than 
once to work on several projects simultaneously. 
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3.1.2 Program desktop 

3.1.2.1 Desktop elements 

Introduction 
The working environment of RF-MANAGER comprises several elements. Some of the 
elements are linked to specific editors which means they are not visible unless the 
corresponding editor is active. 

 

 Note 
Setting small fonts 
Set the configuration computer operating system to "Small Fonts" while working with RF-
MANAGER. Otherwise the runtime system will not display correctly.  

 

Elements of RF-MANAGER 
You can access all the functions provided by RF-MANAGER by means of its menus and 
toolbars. When the mouse pointer is moved over a function, a ToolTip appears. 
The RF-MANAGER comprises the following elements: 
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Elements of RF-MANAGER 
 

 
 
 

1 Menus and toolbars The menus and toolbars provide access to all functions you need to configure your runtime 
system. When the corresponding editor is activated, menu commands and toolbars specific 
to that editor appear. When the mouse pointer is moved over a command, the 
corresponding ToolTip appears. 

2 Project view All component parts and editors available in a project appear in a tree structure in the 
Project View. Folders are provided as sub-elements of each editor in which you can save 
objects in a structured way. With some editors, especially with the editor RFID Device, you 
have direct access to the configured objects. In the project window you have access to the 
device settings of the runtime system and the language settings. 

3 Workplace Project objects are edited in the workplace. All RF-MANAGER elements are arranged on 
the borders of the workplace. With the exception of the workplace, you can organize, 
configure and, for example, move or hide any of the elements to suit your individual 
requirements. 

4 Toolbox The Toolbox contains a selection of objects that you can add to your screens, e. g. image 
objects or operator control elements. 

5 Property view The property dialog box is used to edit object properties, e. g. the color of screen objects. 
The property view is only available in specific editors. 

6 Output window The output window displays system alarms generated, for example, in a project test run. 
7 Object view The "Objects View" shows all elements of the area selected from the "Project View". 
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 Note 
With the exception of the workplace, you can show or hide all windows in the "View" menu.  

 

See also 
Editor Properties (Page 68) 
Displaying Help (Page 73) 

3.1.2.2 Menus and toolbars 

Introduction 
The menus and toolbars provide access to all functions you need to configure your Runtime 
system. When the corresponding editor is activated, menu commands and toolbars specific 
to that editor appear.  
When the mouse pointer is moved over a command, the corresponding ToolTip appears. 

 

Positioning the Toolbars 
Menus and toolbars are, as a standard, positioned at the top edge of the screen when 
creating a new project. The position of menus and toolbars is determined by the user who is 
logged on in Windows. If the toolbars are moved using the mouse, they revert back to their 
last ‘Exit’ position when RF-MANAGER is restarted.  
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Menus 
The following menus are available in RF-MANAGER:  
 
Menu Short description 
"Project" Contains commands for project management. 
"Edit" Contains commands for clipboard and search functions. 
"View" Contains commands for opening / closing elements, and for zoom / layer 

settings. To reopen a closed element, select the "View" menu. 
"Insert" Contains commands for pasting new objects 
"Format" Contains commands for organizing and formatting screen objects. 
"Options" Contains commands for changing the user interface language and configuring 

the basic settings in RF-MANAGER, for example.  
"Script" Contains commands for the synchronization and syntax check of scripts. 
"Window" Contains commands for managing multiple windows in the workplace, e.g. for 

changing to other windows. 
"Help" Contains commands for calling help functions. 

The availability of the menus and the scope of their commands depend on the respective 
editor which is used. 

Toolbars 
The toolbars provide quick access to important, frequently used functions. The following 
toolbar configuration options are available:  
● Adding and removing buttons 
● Changing the position 
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3.1.2.3 Project view 

Introduction 
The project view is the central control point for project editing. All component parts and 
editors available in a project appear in a tree structure in the Project View. Each editor is 
assigned a symbol which you can use to identify the corresponding objects. In the project 
window you have access to the device settings of the runtime system and the language 
settings.  
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Description 
The Project View displays the project structure hierarchically:  
● project 
● Runtime systems 
● Folder 
● Objects 
The project view is used to create and open objects for editing. You can organize your 
project objects in folders to create a structure. Handling the Project View is similar to 
handling Windows Explorer. Shortcut menus, which consist of the most important 
commands, are available for all objects. 
Objects from graphic editors are displayed in the Project View and Objects View. Objects 
from "tabular editors" are shown only in the Objects View. 

See also 
Editor Properties (Page 68) 
Object view (Page 56) 
Working with the mouse (Page 63) 
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3.1.2.4 Workplace 

Introduction 
The workplace is used to edit project data either in table format (e.g. a data selector) or in 
graphic format (e.g. a diagram).  

 
Figure 3-1 Workplace: Project data in tabular form 

 
Figure 3-2 Workplace: Project data in graphical form 
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Description 
Each editor is opened in a separate tab on the workplace. In the case of graphic editors, 
each object is displayed on a separate tab. Only one tab is active when several editors are 
open simultaneously. To move to another editor, click the corresponding tab. You can open 
up to 20 editors in parallel.  

See also 
Switching between editors (Page 72) 

3.1.2.5 Toolbox 

Introduction 
The Toolbox contains a selection of objects that you can add to your screens, e. g. image 
objects or operator control elements. 
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Description 
The "Toolbox" contains various types of objects which are frequently required for use in 
screens.  
The Toolbox View can be faded in and out using the "Toolbox" command in the "View" 
menu. The Toolbox view can be moved to any position on the screen. The "Toolbox" 
contains various object groups, depending on the currently active editor. 

 

 Note 
Further information 
Further information about using the toolbox can be found in the description of the individual 
editors. 

 

3.1.2.6 Properties view 

Introduction 
The properties dialog box is used to edit the properties of an object selected from the 
workplace. The content of the properties dialog box is based on the selected object.  

 

Description 
The properties dialog box shows the properties of the selected object organized in 
categories. The changed values take effect directly after exiting from the input field.  
If you enter an invalid value, this is highlighted in color and you can correct this input error. 
QuickInfo provides you with information on the valid value range, for example 
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3.1.2.7 Output View 

Introduction 
The output window displays system alarms generated, for example, in a project test run.  

 

Description 
The output window normally displays system alarms in the order they occur. The categories 
define the corresponding RF-MANAGER module which has generated a system alarm. 
System messages of the "Generator" category are generated, for example, during the 
consistency check.  
To sort system alarms, click the header of the corresponding column. The pop-up menu can 
be used to jump to an error location or a variable, and copy or delete system alarms.  
The output window shows all system alarms of the last action. A new action overwrites all 
previous system alarms. You can still retrieve old system alarms from a separate log file. 
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3.1.2.8 Object view 

Introduction 
If folders or editors are selected in the Project View, their content is displayed in the Objects 
View. 
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Description 
Double-click an object in the Objects View to open the corresponding editor. Drag-and-drop 
functions are available for all objects displayed in the object window.  
The following drag-and-drop actions, for example, are supported:  
● Moving a variable to a screen in the workplace: Creates an I/O field which is linked to the 

variable. 
● Moving a variable to an existing I/O field: Creates a logical link between the variable and 

the I/O field. 
● Moving a screen to a screen in the workplace: Generates a button with screen change 

function which is linked to the screen. 
Long object names are abbreviated in the "Objects View". After moving the mouse pointer to 
the object, the full name appears as a ToolTip. 
When a large number of objects are available, quickly locate the object you require by 
entering just the first letter of the object. 

See also 
Working with the mouse (Page 63) 
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3.1.2.9 Placing editor-specific operating elements 

Introduction 
Editor-specific operating elements are only visible in the active workplace of the 
corresponding editor.  

 
Editor-specific operating elements include: 
● Toolbars 
● Toolbox 
● Menu commands 

Placement 
The default position of editor-specific toolbars is on the right-hand side or below the existing 
toolbars.  
Default position of editor-specific toolbox views is the screen margin on the right-hand side. 
Editor-specific commands are added to the corresponding menus.  
The positions of editor-specific operating elements are restored the next time you start RF-
MANAGER if you have rearranged these in a previous session to suit your individual 
requirements. 
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3.1.2.10 Working with windows and toolbars 

Introduction 
RF-MANAGER allows you to customize the layout of frames and toolbars. You can hide 
certain frames which are not used frequently in order to enlarge the workplace.  
The "View" menu can be used to restore the default layout of frames and toolbars.  

Operating Elements Available 
The table below shows you the operating elements of the frames and toolbars and what they 
are used for.  
 
Control Purpose Where used 

 Closes a frame or toolbar Frames and toolbars (movable) 

 
Moves and docks frames and 
toolbars using drag-and-drop  

Frames and toolbars (movable) 

 
Moves a toolbar by means of 
drag-and-drop 

Toolbar (docked) 

 Adds or deletes toolbar icons Toolbar (docked) 

 
Activates the auto-hide mode for 
a window 

Frame (docked) 

 
Disables auto-hide mode for a 
frame 

Frame (docked) 



RF-MANAGER Engineering System  
3.1 Overview 

 SIMATIC RF-MANAGER 2008 
60 Operating Manual, 06/2010, A5E01070042-03 

Docking frames or toolbars 
"Docking" refers to the integration of a window into the RF-MANAGER workbench. You can 
automatically hide docked frames in order to increase your workspace.  
A freely moveable window can be docked on a window at the following positions: 
● Upper edge 
● Right edge 
● Bottom edge 
● Left edge 
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You can dock a toolbar onto any existing toolbar.  

 

Combined frames 
You can combine a frame with another frame. Each frame is represented in the combined 
frame by a separate tab. To change to a different frame, click the corresponding tab.  
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Hiding windows automatically 
You can automatically hide the windows you do not require frequently. This will increase 
your workspace. To restore the window to the screen, click its title bar.  
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3.1.2.11 Working with the mouse 

Introduction 
In RF-MANAGER, you will work mainly with the mouse. Important operating functions in this 
context are the drag-and-drop function and the call of commands from the shortcut menu.  

Drag and drop 
Drag-and-drop makes configuration much easier. For example, when you drag-and-drop a 
variable from the Object View to a screen, the system automatically generates an I/O field 
which is logically linked to the tag. To configure a screen change, drag-and-drop the required 
screen onto the screen shown in the workplace. This generates a button configured to 
contain a corresponding screen change function.  
The drag-and-drop function is available for all objects in the project view and "Object view." 
The mouse pointer shows you whether drag-and-drop is supported at the destination or not: 
 

 

Drag and drop is possible 

 
Drag and drop is not possible 
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Context Menu 
In RF-MANAGER, you can right-click any object to open a shortcut menu. The shortcut 
menu contains the commands you can execute in the relevant situation.  

 

Overview: Mouse functions 
 
Function Effect 
Left-click Activates any object or executes an action such as a menu 

command or drag-and-drop. 
Right-click Opens a shortcut menu. 
Double-click (left mouse button) Starts an editor in the Project View or Objects View or opens a 

folder. 
<Left mouse button+drag-and-
drop> 

Generates a copy of the object in the project view. 

<CTRL+left mouse button> Selects a number of individual objects from the "Objects View" 
one after the other. 

<SHIFT+left mouse button> Selects all objects within the rectangle lasso you have drawn 
with the mouse in the "Objects View." 
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See also 
Properties view (Page 54) 
Object view (Page 56) 

3.1.2.12 Keyboard control 

Introduction 
RF-MANAGER provides a number of hotkeys which you can use to execute frequently 
required menu commands. The menu shows whether a hotkey is available for the relevant 
command or not.  
WinCC also integrates all the standard hotkeys provided by Windows.  

Important hotkeys 
The table shows you the most important hotkeys for use in RF-MANAGER.  
 
Hotkeys Effect 
<Ctrl+Tab>/<Ctrl+Shift+Tab> Activates the next/previous tab in the workplace. 
<Ctrl+F4> Closes the active view in the workplace. 
<Ctrl+C> Copies a selected object to the clipboard. 
<Ctrl+X> Cuts an object and copies it to the clipboard. 
<Ctrl+V> Inserts the object stored in the clipboard. 
<Ctrl+F> Opens the "Find and Replace" dialog. 
<Ctrl+A> Selects all objects in the active area. 
<ESC> Cancels an action. 
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3.2 Working with the engineering system 

3.2.1 Configuration Support 

Introduction 
RF-MANAGER provides support for the configuration tasks in the form of solution-oriented 
concepts. This concerns, for example, processing of bulk data.  

Engineering support 
Efficient configuration saves time and costs. RF-MANAGER supports you as follows:  
● Central modification of referenced objects 

Modifications made at a central station are applied to the entire project. If you create a 
tag selector for example, and assign it to the data sources of different RFID devices, the 
change in paramaterization of the tag selector takes effect in all the affected data 
sources. 

● Use 
The reuse of configuration objects simplifies configuration and reduces overall costs.  

● Bulk data processing 
Create an action, for example, with several tags having the same values or 
chronologically ascending addresses.  

User customization of the programming user interface 
The RF-MANAGER user interface can be user customized by moving or hiding windows and 
toolbars. 
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3.2.2 Working with projects 

Introduction 
In RF-MANAGER, you configure user interfaces for managing the devices of RFID systems 
and their components and for data processing.  
Special editors are available for the different configuration tasks. All configuration information 
is saved in a project.  

Creating or Loading a Project 
After starting RF-MANAGER, a wizard guides the user through all the steps which are 
necessary to create a new project. The user is prompted, for example, to enter a name for 
the project and select a runtime system.  
If RF-MANAGER is already open, select the "New" command to create a new project. In 
some circumstances, a wizard will appear to guide you through the process.  
To load an existing project, select the "Open" command from the "Project" menu.  
 

3.2.3 Processing more than one project 

Principle 
In RF-MANAGER, you can only ever have one project open for processing. If projects should 
be copied globally, for example, restart RF-MANAGER and then open the required project.  
Several runtime systems can be set up parallel in each project.  
Each opened RF-MANAGER is shown in the Windows task bar: 
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3.2.4 Editor Properties 

Introduction 
RF-MANAGER provides a special editor for each configuring task. RF-MANAGER 
differentiates between two different types of editors: graphical editors and tabular editors. 
You can open up to 20 editors in parallel.  

Graphical Editors 
Graphical editors, such as the "RFID Devices" editor, display the elements belonging to both 
the Project View and Object View. You open each object in the workplace with graphical 
editors.  

Tabular editors 
Tabular editors, such as the "ALE links" editor, only display the associated objects in the 
Object View. When a tabular editor is opened to edit the objects, all associated objects are 
displayed in a table in the workplace.  

Editor properties 
The following properties apply to all editors and their objects:  
● Changing contents 

Changes take effect directly after exiting an input field and affect projects globally. All the 
objects affected by a modification are automatically updated.  
If a variable parameter is changed at the place of use in the "Screens" editor, for 
example, the change has a direct effect in the "Variables" editor. 

● Accepting changes to the project data 
The modified project data are transferred to the project database as soon as the project is 
saved.  

● Undo or redo working steps 
Every editor has an internal list in which user actions are saved. In this way, all actions 
can be reverted (undone) or restored. The relevant commands are in the "Edit" menu. 
The list is deleted when the editor is closed or the project is saved. Switching to another 
editor does not affect the actions stored in the list.  

See also 
Placing editor-specific operating elements (Page 58) 
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3.2.5 Open Editor 

Introduction 
The way in which an editor is started depends on whether it is a graphical editor (e.g. 
"Screen" editor) or tabular editor (e.g. "Variable" editor). You can open up to 20 editors in 
parallel.  

Opening a Graphical Editor 
A graphical editor is started by either creating a new object or opening an existing object. 
To create a new object, proceed as follows:  
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1. Click the right mouse button on the graphical editor in the Project View in which a new 
object is to be added. 

2. Select "Add screen" in the shortcut menu, for example: 

 
The object, e.g. a screen, is created in the Project View and displayed in the workplace. 

3. To open an existing object, double-click on the object in the Project View or Object View. 
The object, e.g. a screen, is displayed in the workplace. 
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Opening a tabular editor 
A tabular editor is opened by double-clicking on the tabular editor in the Project View. The 
editor appears in the workplace. 

 
A tabular editor can also be activated using the associated shortcut menu. To open an 
existing element in the tabular editor, select the tabular editor in the Project View. Then 
double-click on the required object in the table.  

Alternative procedure 
To open an editor via the menu, select the "New object in project" command from the "Insert" 
menu.  
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3.2.6 Switching between editors 

Introduction 
Although several editors or their objects can be opened simultaneously in RF-MANAGER, 
only the workplace of one editor can be active in the workplace.  
If several editors are open, they are represented by separate tab controls in the workplace. 

Tabs 
To select a different editor, click the relevant tab in the workplace. In tabular editors, a tab 
shows the name of the editor for easy identification. In the case of graphical editors, the 
name of the current element is indicated, e.g. "Screen1".  

 
The tooltip indicates which runtime system is being configured in the editor.  

Navigation arrows 
If the workplace runs out of space to show all tabs, the navigation arrows become active in 
the workplace.  
To access tabs which are no longer visible in the workplace, click the corresponding 
navigation arrow.  

 

Closing the editor 
To close an editor, click the  symbol in the workplace.  
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3.2.7 Displaying Help 

Shortcut help 
A tooltip will appear after moving the mouse pointer over any object, icon, or dialog element.  

 
A question mark next to the tooltip indicates that a shortcut help is available for this user 
interface element. To call up an additional explanation to the short description, click on the 
question mark, press <F1> if the tooltip is activated, or move the mouse cursor to the tooltip. 

 
The explanation includes references which refer users to a detailed description in the Online 
Help.  

Online help 
In the "Help" command menu you can access the online help. When you use the "Help > 
Contents" menu command, the RF-MANAGER Information System opens with an opened 
table of contents. Use the table of contents to navigate to the desired topic. 
Alternatively select the "Help > Index" menu command. The RF-MANAGER Information 
System opens with an opened index. Use the index to search for the desired topic. 
In order to use the full text search across the entire RF-MANAGER Information System 
select the "Help > Search" menu command. The RF-MANAGER Information System opens 
with an opened search register. Enter the desired search term.  
The RF-MANAGER Information System can also be opened via the Start menu in Windows. 
Select the menu command "Start > SIMATIC > RF-MANAGER > RF-MANAGER Help 
System" in the task bar. 
The Online Help system is opened in a separate window.  
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3.2.8 Customized setup of the working environment 

Introduction 
RF-MANAGER allows you to customize the position and reaction of windows and toolbars. 
This allows you to configure the work environment to meet your special requirements.  

Working Environment User-Dependency 
The appearance of RF-MANAGER is linked to the user logged on in Microsoft Windows. On 
saving the project, the positions and behavior of windows and toolbars are automatically 
saved with it.  
When the project is opened again, the project status loaded is identical to that when saved. 
In this way, the working environment is opened as it was when last closed. This is also the 
case when a project edited by a different project planner is opened.  

Resetting the work environment 
The positions of views and toolbars can be reset to their original state. To do this, select 
"Reset layout" in the "View" menu. 

3.3 Working with projects 
You can configure a maximum of eight runtime systems in an RF-MANAGER project 
A project in RF-MANAGER contains all your configuration data for one or more runtime 
systems. Configuration data includes: 
● Desktop elements for visualizing RFID data or PLC data 
● RFID alarms for indicating the operating status of readers 
● System alarms for indicating the operating status of the runtime system 
All data related to a project is stored in the database integrated in RF-MANAGER. 

Opening multiple sessions of an RF-MANAGER project 
An RF-MANAGER project should not be opened in multiple sessions. This applies in 
particular to the opening of projects on network drives.  
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3.3.1 Components of a project 
An RF-MANAGER project consists of all the data that is provided by the data and device 
management of your system. A business interface to the MES/ERP level is also possible. 
The configuration data is compiled in RF-MANAGER according to topic categories. Each 
category is processed in an individual editor.  
If you want to archive the project, it is sufficient to back up the [project name].rfid, [project 
name]_log.ldf and [project name].rfidsim files. Before you continue with delta compilation, 
you must also back up the [project name].data and [project name]_RT_log.data files. All 
other files can be created as required. 

3.3.2 Types of projects 

Principle 
Different types of projects can be created using the RF-MANAGER. The project type 
depends on your plant planning, the size of the plant or machine and the required 
representation of the plant or machine. 
The following project types can be configured in RF-MANAGER: 
● Single-user project 

Project which is used for a single runtime system.  
● Multi-user project 

Project in which several runtime systems are configured.  

Single-user project 
In most cases, only one HMI device is configured. During the configuration phase, a project 
always displays precisely the function range which is supported by the currently selected 
runtime system.  

Multi-user project 
If several runtime systems are used to operate a system, RF-MANAGER can be used to 
create a project in which several runtime systems are configured. This type of project is 
used, for example, when the machine or system controlled is operated from several different 
points. Common objects can then be used in the project. This method means that a project 
need not be created for each separate runtime system, but rather all runtime systems are 
managed in the same project.  
An RF-MANAGER project consists of all the configuration data which supports operation and 
monitoring of your system. Each configured runtime system only displays the functions which 
the specific unit supports. Functions which are not supported are hidden but remain a 
component part of the project data. 
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3.3.3 Multilingual configuration 

Multilingual configuration 
You can configure your projects in multiple languages using RF-MANAGER. RF-MANAGER 
supports the multilingual configuration of practically all objects with texts displayed in the 
runtime system.  
RF-MANAGER can be used for configuration in all languages installed in the operating 
system.  
In addition to direct text input in the editors, RF-MANAGER provides easy-to-use export and 
import features for translating projects. This is of particular advantage when configuring large 
projects with a large share of text. 
Use the following editors to translate texts in RF-MANAGER: 
 
Toolbar Short description 
Project languages Managing languages for the project texts  
Languages and fonts Defining the languages and fonts used in the runtime system  
Project texts Managing language-dependent project texts 
Graphic browser Managing local graphics 
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Multilingual RF-MANAGER user interface 
The language of the user interface in RF-MANAGER can be selected, for example, to suit 
regional requirements of several engineers of different nationality working with the RF-
MANAGER. Languages are selected under: 
"Options > Settings > Workbench > User interface language".  

 

Switching the Online Help language 
If the Online Help system crashes when the language is switched, check the version of the 
"hhctrl.ocx" file in the "system32" subdirectory of the installation directory of the operating 
system. If the file version is older than V5.2.3735.0, download a newer version from 
http://msdn.microsoft.com/library/default.asp?url=/library/enus/htmlhelp/html 
/hwMicrosoftHTMLHelpDownloads.asp 
.  
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3.3.4 Editing projects 

Objects and editors  
The following objects can be created and edited in RF-MANAGER.  
● RFID objects 

You create and process RFID objects in the associated editors. These include, for 
example, RFID devices, workplaces, ALE connections, RFID data links and the filter 
mechanisms that operate within the RF-MANAGER.  

● Screens 
Screens are created and edited in the "Screens" editor. 

● Graphics list 
In a graphic list, the values of a variable are assigned to various graphics. The graphics 
lists are created in the editor "Graphics lists".  

● Text List  
In a text list, the values of a variable are assigned to various texts. The text lists are 
created in the "Text List" editor and displayed with the "Symbolic I/O Field" object.  

● Language-dependent texts and graphics 
Using RF-MANAGER, projects can be created in different languages:  
– The "Project languages" editor is used to manage the languages in which the projects 

should run.  
– The "Project texts" editor is used to manage and translate language-dependent texts 

centrally.  
– The "Graphic browser" editor is used to manage language-dependent graphics.  

● Variables 
Variables are created and edited in the "Variables" editor.  

● Cycles  
It is possible to configure events in RF-MANAGER which reoccur at regular intervals. The 
time intervals are defined in the "Cycles" editor. 

● Alarms 
You create and edit alarms in the "Alarm management" editor. 

● Logs  
The "Alarm log" editor is used to log alarms in order to record operating statuses and 
faults which occur in a system.  

● PLC connections 
In the "PLC connections" editor, you can configure PLCs. 

● Reports  
The "Reports" editor is used to create reports with which the user prints alarms and 
process values, for example, in runtime. 
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● Runtime user administration 
In the "Runtime user administration" editor, you can create users and user groups and 
assign user privileges for operation of the runtime system. 

● Scheduler 
In the "Scheduler" editor, you can manage job-related tasks. It is possible to execute a 
job once or several times. 

● Device settings 
In the "Device settings" editor, you can create device settings such as the welcome 
screen or language setting. 

● Scripts 
RF-MANAGER allows you to expand your project with scripts that you have written. 
These scripts are managed in the "Scripts" editor. 

Tabular editors and image editors 
Graphical editors, such as the "Screens" editor, display the elements belonging to both the 
Project View and Object View. You open each object in the workplace with graphical editors.  
Tabular editors, such as the "Variables" editor, only display the associated objects in the 
Object View. When a tabular editor is opened to edit the objects, all associated objects are 
displayed in a table in the workplace.  
 

See also 
Creating a project (Page 88) 
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3.3.4.1 Displaying projects 

Principle 
All component parts and editors available in a project appear in a tree structure in the Project 
View. 

Displaying a project in the Project View 
All editors available are displayed under the project node in the Project View. The objects in 
a project can be edited using the various editors.  
Folders are provided as sub-elements of each editor in which you can save objects in a 
structured way. In addition, direct access to the configured objects is available for RFID 
devices and screens. 

 
Select the project objects which are to be edited in the Project View. To do this, double-click 
on the relevant object. The corresponding editor will open. 
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Displaying objects in the Objects View 
The Objects View displays the content and associated information of the respective folders 
and editors selected in the Project View. The Objects View is displayed below the Project 
View by default.  
The Objects View is comprised of three columns: 
● "Object type" 
● "Name" 

Name of the object 
● "Info" 

Brief information, e.g. a comment entered by the project engineer 

 
Objects are displayed in the Objects View by the following icons: 
 
Icon Short description Icon Short description 

 RFID devices 
 

Alarm logs 

 Workplaces  Scripts 

 
Variables 

 
Text lists 

 Cycles  Graphics lists 
 ALE connections  Groups 
 ALE selectors  Users 
 ALE groups  Runtime security settings 
 Tag selectors  Device settings 
 Display selectors  Languages and fonts 
 Data selectors 

 
Scheduler 

 Screens  Network settings 
 RFID base alarm  Reporting 
 RFID edge alarm  Project languages 
 RFID status alarm  Graphic browser 
 Alarm settings  Project texts 

 
Alarm classes  Reports 

 System alarms  RFID data link 
 RFID device alarms  PLC connections 
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Working with the Objects View 
Double-click an object in the Objects View to open the corresponding editor.  
In addition, drag-and-drop actions can be performed on all objects displayed in the Objects 
View. The following drag-and-drop actions, for example, are supported: 
● Moving a variable to a process screen in the workplace: Creates an I/O field which is 

linked to the variables. 
● Moving a process screen to another process screen in the workplace: Creates a "Change 

screen" button to the relevant process screen. 

See also 
Working in the Project View (Page 83) 
Working in the Objects View (Page 85) 
Creating a project (Page 88) 
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3.3.4.2 Working in the Project View 

Principle 
The representation of the project in the Project View can be used to edit projects.  
The following actions can be executed in the Project View: 
● Double-click 
● Select a command in the shortcut menu 
● Drag and drop actions 

Double-click 
A folder is opened by double-clicking on the folder in the Project View. 
You can open an editor by double-clicking the editor, for example, "Workplaces" or "ALE 
connections". 

Shortcut menus  
After positioning the pointer on an object or folder and clicking the right mouse button, the 
respective shortcut menu appears. The following actions are available in the shortcut menu: 
 
Action Description 
"Open editor" Opens the editor 
"Add folder" Creates a new subfolder. The creation of subfolders enables the 

user to sort the objects according to topics. 
"Add object" Inserts a new object. 

 
 

"Delete" Deletes the object or folder selected. 
"Rename" Enables the object or folder selected to be renamed. 
"Undo" Reverts the last process. 
"Cut" Copies the object or folder in the clipboard and deletes it. 
"Copy" Copies the object or folder in the clipboard. 
"Flat copy" "Flat copy" will copy those objects with a parent-child relationship 

completely. See . 
 

"Paste" Inserts the object stored in the clipboard. 
"Replace" Replaces an object with the one in the clipboard.  
"Print selection" Prints the object or folder selected. 
"Cross-references" Shows all places of use for the selected object or folder. 
"Properties" Shows the properties of the object or folder selected. 
"Export/import texts" Texts can be imported or exported in accordance with the object 

type.  
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Drag and drop actions  
Drag-and-drop can be used for the following actions: 
● Inserting objects in an editor 

Drag an image from the Project View and drop it in another screen. The screen is then 
assigned a button which, when clicked, switches the screen content back to the first 
screen.  

● Moving or copying objects in subfolders 
If the Project View simultaneously contains objects and subfolders, an object can be 
moved to a subfolder by means of drag-and-drop or copied. 

See also 
Displaying projects (Page 80) 
Working in the Objects View (Page 85) 
Creating a project (Page 88) 
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3.3.4.3 Working in the Objects View 

Principle 
The Object View provides an overview of the objects.  
The following actions can be executed in the Object View: 
● Double-click 
● Select a command in the shortcut menu 
● Drag and drop 

Double-click 
A folder is opened by double-clicking on the folder in the Object View. 
After double-clicking on an object (e.g. a screen) in the Object View, the editor opens. 

Shortcut menus  
The following actions are available in the shortcut menu: 
 
Action Description 
"Open editor" Opens the editor 
"Add folder" Creates a new subfolder. The creation of subfolders enables the user to 

sort the objects according to topics. 
"Delete" Deletes the object or folder selected. 
"Rename" Enables the object or folder selected to be renamed. 
"Undo" Reverts the last process. 
"Cut" Copies the object or folder in the clipboard and deletes it. 
"Copy" Copies the object or folder in the clipboard. 
"Flat copy" "Flat copy" will copy those objects with a parent-child relationship 

completely. See "Flat copy". 
"Paste" Inserts the object stored in the clipboard. 
"Replace" Replaces an object with the one in the clipboard.  
"Print selection" Prints the object or folder selected. 
"Cross-references" Shows all places of use for the selected the object or folder. 
"Properties" Shows the properties of the object or folder selected. 
"Export/import texts" Texts can be imported or exported in accordance with the object type.  

Inserting objects in an editor with drag and drop  
Using drag-and-drop, an object can be dragged from the Object View into any editor when 
the editor permits editing of the object. An example of its application is the linking of 
variables to a screen. If a variable is dragged from the Object View into a screen, an I/O field 
is automatically created.  
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See also 
Displaying projects (Page 80) 
Working in the Project View (Page 83) 
Creating a project (Page 88) 

3.3.5 Working with the cross-reference 

Principle 
The "Cross reference" editor enables all usage points for specific objects, e.g. variables or 
screens, to be located and to skip to those points directly. 
To display the cross reference list, highlight the relevant object and click "Cross reference" 
with the right mouse button. 

Cross-reference user interface 

 
Open the object by double-clicking the icon . 

Possible operations in the cross-reference via the shortcut menu 
Use the "Go to usage" command to skip directly to the location of usage in the project. 
Alternatively, double-click the point of usage icon.  
It is possible to change the view in the "Cross reference" editor. The following commands are 
available to change the view: 
● Collapse all 

The "Collapse all" command is used to hide the list of places of use for all objects. 
● Expand all 

The "Expand all" command is used to recall the list of places of use. 
The "Print" command is used to print the cross-reference list.  
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3.3.6 Internal project find and replace feature 

Principle 
With the RF-MANAGER, you can find and replace character strings and objects:  
● You can find and replace character strings in the workplace: Use the "Find in 

workplace..." dialog and "Replace in workplace..." dialog in this case. 
● You can search for objects in the complete project or in parts of the project. Use the "Find 

in project" dialog in this case. 

3.3.7 Basic principles of documentation 

Principle 
Use the project documentation to recall an overview of the configuration data.  
The project documentation can be provided as follows: 
● Displayed on screen 
● Output as file, e.g. HTML 
● Output via a printer 
If only certain parts of the project data need to be used in the project documentation, select 
the corresponding objects. 
For further information, see the chapter "Project documentation". 



RF-MANAGER Engineering System  
3.3 Working with projects 

 SIMATIC RF-MANAGER 2008 
88 Operating Manual, 06/2010, A5E01070042-03 

3.3.8 Creating a project 
There are two basic methods for creating a project: 
● Using the Project Wizard 
● Using the option "Create empty project". 

When should I use the project wizard? 
You should use the project wizard if you are a first-time user. The Project Wizard supports 
rapid familiarization and presents standard scenarios that can be used to create a basic 
project. This basic project will have to be reparameterized later.  
To start the Project Wizard, either select the option "Create new project with project wizard" 
in the engineering system or select the menu option "Project > New project with project 
wizard".  
You will find further details in the "Getting Started" document for RF-MANAGER which 
describes the use of an RFID sample project that is included in the scope of supply. 

When should I use the option "Create empty project"? 
The option "Create empty project" is used to create a new project in RF-MANAGER without 
project components. You only have to select the HMI device that you are using for the 
runtime system in the "HMI device type" view.  
If you want to create an empty project, select the option "Create empty project" in the 
engineering system or select the menu item "Project > New". 
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3.3.8.1 Prerequisites for operating a project with a reader 
If you want to operate a project with a reader, the following requirements must be fulfilled: 
● At least one reader is connected to the PC. 
● The reader must have communications capability. 

Connecting and parameterizing readers 
Depending on the reader model, there are different connection and commissioning methods 
for the reader: 
● Stationary readers (Page 90): 

– RF670R 
– RF660R 
– RF620R/RF630R, RF310R, RF340R, RF350R, RF380R 

● Mobile readers (Page 108): 
– RF310M 
– RF610M 
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Connecting and parameterizing stationary readers 

Use of DHCP (Dynamic Host Configuration Protocol) 

Introduction 
A DHCP server ensures that IP addresses are automatically assigned to DHCP-capable 
network clients in a network segment. The DHCP server uses the MAC address of the 
network client for this purpose. The IP addresses are assigned due to permanent 
assignment of a MAC address to an IP address. The readers of the RF600 family with 
Ethernet connection are DHCP-capable. 
Mechanisms that extend beyond this, such as dynamic assignment of IP addresses or 
Domain Name Service (DNS), are not supported. 

Requirements for activating DHCP 
A DHCP server must be present in the network segment. 
An up-to-date list of permanent assignments between MAC addresses and IP addresses 
must be stored in the DHCP server. This list must be maintained by your responsible IT staff 
member. 
You will find the MAC addresses of readers: 
● on the enclosure next to the RJ45 socket 

 

NOTICE  
 

Ensure that the DHCP server is running and the reader is entered in the list. Otherwise 
RF-MANAGER Basic will be unable to establish a connection to the reader following 
activation. 
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RF670R 

Connecting stationary readers to the parameterization computer 
You have the following options for connecting a reader of the RF600 series to your 
parameterization computer via Ethernet:  
● Ethernet connection (10/100 Mbit/s) via RJ45 cable, either over an Ethernet network 

(connection via hubs or switches) or as a point-to-point link using a crosslink cable 
directly between a PC and a reader. 

 
Figure 3-3 Overview of configuration of the RF670R reader 

Connecting the stationary reader to the parameterization computer over Ethernet  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the Ethernet interface of the reader to the hub/switch to which your parameterization 

computer is also connected over an RJ45 cable. It is strongly advised that you use the accessory 
cables approved by Siemens for each reader. 
When using RJ45 cables from other manufacturers, there is a risk that the cable will be difficult to 
remove from the socket of the reader.  
For PnP connections, a crosslink cable must be used if the network card in the PC does not 
support autocrossover. 

3 Connect the reader to the power supply. 
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Providing the reader with communications capability  

 
1. Select "Project > Reader configuration > Reader communication settings". 
2. If the reader has not been pre-parameterized, use the "Start Discovery" button to activate 

the automatic reader search function in the application. 
All readers connected via Ethernet will be shown in the list. 
Note that the network card you have used to connect the reader is selected under the 
network address. 

3. Select the desired reader. 
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4. Click the button "Use Reader Address" to adopt the IP address in the "IP Settings". 
5. In the "IP Settings" menu, you can now set new Ethernet parameters for the reader. 

These include: 
– The IP address, 
– The subnet mask 
– The IP address of the gateway 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
 

Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 

 

NOTICE  
 

Avoid simultaneous Ethernet access to readers 
The applications RF-Manager Basic and RF-Manager 2008 cannot simultaneously 
access the same reader of the RF600 family via Ethernet. 
Only start applications that are currently required.  
Make sure that all RF-Manager Basic 2010 components are deactivated. 
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Providing the reader with communications capability using the RF-MANAGER Basic 
As an alternative to using the RF-MANAGER Engineering System, you can use the "RF-
MANAGER Basic 2010" software, which is included in the scope of supply of the reader, to 
provide the reader with communications capability: 
1. In the "Reader" menu, select the command "Set Reader IP Address". 
2. If the reader has not been pre-parameterized, use the Start Discovery button to activate 

the automatic reader search function in the application. 
All readers connected via Ethernet will be shown in the list. 
Note that the network card you have used to connect the reader is selected under the 
network address. 

3. Select the desired reader. 
4. Click the button "Use Reader Address" to adopt the IP address in the "IP Settings". 
5. In the "IP Settings" menu, you can now set new Ethernet parameters for the reader. 

These include: 
– The IP address, 
– The subnet mask 
– The IP address of the gateway 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
 

Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 

 

NOTICE  
 

Avoid simultaneous Ethernet access to readers 
The applications RF-Manager Basic and RF-Manager 2008 cannot simultaneously 
access the same reader of the RF600 family via Ethernet. 
Only start applications that are currently required.  
Make sure that all RF-Manager 2008 Runtime components are deactivated. 

 

 
 

Note 
For more information on DHCP 
See Chapter Enabling DHCP (Page 95) 
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Enabling DHCP 
The RF670R reader can be switched over to DHCP mode using the "Communication 
settings" menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader that should be switched over to DHCP mode to the parameterization 

computer via the Ethernet interface. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to activate it. 
The DHCP mode is activated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 
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Disabling DHCP 
The DHCP mode can be disabled for the RF670R reader via the Communication settings 
menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader for which DHCP mode should be disabled to the parameterization 

computer via the Ethernet interface. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to deactivate it. 
The DHCP mode is deactivated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 
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Restoring default settings on a DHCP reader 
 

 Note 
Please note that this functionality is currently only available for the SIMATIC RF670R reader.

 

If DHCP is activated on a reader but no DHCP server is available, no connection can be 
made to that reader because it does not have an IP address.  

Procedure 

 
To assign the reader a new unambiguous IP address, proceed as follows: 
1. Disconnect the affected reader from the network and connect it point-to-point with the 

configuration computer. 
2. Select "Project > Reader configuration > Communication settings". 
3. Click the "Reset DHCP Readers" button. 

The reader is reset to the default IP address and DHCP is deactivated.  
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4. Assign a new unique IP address to the reader. 
5. Disconnect the reader from the parameterization computer and reconnect it to the 

network. 
 

NOTICE  
 

Several readers with identical IP address 
It is recommended that the affected reader is disconnected from the network and 
connected point-to-point with the configuration computer. 
If the reader remains in the network, all DHCP readers in the network are restored to 
their default settings and thus have identical IP addresses, because the "Reset DHCP 
Readers" button works on all DHCP readers in the network simultaneously. 
You must then disconnect all DHCP readers from the network, connect each point-to-
point with the configuration computer, and successively assign each DHCP reader an 
unambiguous new IP address. 

 

Result 
The reader has an unambiguous IP address and can be addressed via the network, e.g. to 
make settings. 
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RF660R 

Connecting stationary readers to the parameterization computer 
You have two alternatives for connecting a reader of the RF660 series to your 
parameterization computer:  
● Serial connection through RS232 cable. 
● Ethernet connection (10/100 Mbit/s) via RJ45 cable, either over an Ethernet network 

(connection via hubs or switches) or as a point-to-point link using a crosslink cable 
directly between a PC and a reader. 

 
Figure 3-4 Connection options from reader to parameterization computer 

 
 

 Note 
Setting-up an Ethernet connection 
If you want to connect and parameterize a stationary reader of the RF660 family over 
Ethernet, initial contact must be made over a serial connection, i.e.: a serial connection over 
an RS232 cable must be available. 

 

Connecting the stationary reader to the parameterization computer over a serial interface  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial interface of the reader to a spare COM port of your parameterization 

computer using the RS232 cable (Order No. 6GT 2891-0GH50 or 6GT 2891-0GN10). 
3 Connect the reader to the power supply. 



RF-MANAGER Engineering System  
3.3 Working with projects 

 SIMATIC RF-MANAGER 2008 
100 Operating Manual, 06/2010, A5E01070042-03 

Connecting the stationary reader to the parameterization computer over Ethernet  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the Ethernet interface of the reader to the hub/switch to which your parameterization 

computer is also connected over an RJ45 cable. It is urgently recommended that the connecting 
cable (Order No. 6GT 2891-0HN10 or 6GT 2891-0HN20) is used when connecting via a 
hub/switch. 
When using RJ45 cables from other manufacturers, there is a risk that the cable will be difficult to 
remove from the socket of the reader.  
For point-to-point links, a crosslink cable must be used. 

3 Connect the reader to the power supply. 

Providing the stationary reader with communications capability 
There are two possibilities for providing the reader with communications capability: 
● Using the RF-MANAGER Engineering System 
● Using the configuration software included in the scope of supply of the reader. 
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Providing the reader with communications capability using the RF-MANAGER Engineering System  

 
1. Select "Project > Reader configuration > Reader communication settings". 
2. In the "Reader communication settings" menu, you can 

– specify the reader's IP address and port number under "Ethernet" if the reader has 
already been pre-parameterized. 
If the reader has not been pre-parameterized, use the "Start Discovery" button to 
activate the automatic reader search function in the application.  

– Specify the required COM interface for initial contact between the parameterization 
computer and RF660R reader under "Serial port". 

3. In the "IP Settings" menu, you can set new Ethernet parameters for the reader. These 
include: 
– The IP address, 
– The IP address of the gateway 
– The subnet mask 
– and the port number 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 
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NOTICE  
Avoid simultaneous Ethernet access to RF660R readers 
The SIMATIC RF660R Configuration Software and the RF-MANAGER cannot 
simultaneously access the same reader of the RF660 family via Ethernet. If you require 
simultaneous access, connect the reader and the SIMATIC RF660R Configuration 
Software over the serial interface. 

 

 

Establishing the communication capability of the RF660R reader using the SIMATIC RF660R 
Configuration Software  

As an alternative to using the RF-MANAGER Engineering System, you can use the SIMATIC 
RF660R Configuration Software that is included in the scope of supply of the reader to 
provide the reader with communications capability: 
● The radio profile applicable to your country has been set up. 

("Welcome" screen) 
● A permanent IP address has been assigned to the reader or DHCP has been activated. 

Note when using DHCP that a specific pre-installed infrastructure is required.  
("Ethernet and notify channel settings" menu) 

● Alarm channel configuration is set to "None". 
("Ethernet and notify channel settings" menu) 

● Read trigger mode is set to "On application request". 
Specification of a value / change in the default value for the "Minimum trigger duration" is 
not necessary.  
("Trigger settings" menu) 

● The reader is in "Stand-alone" mode. 
("Reader mode settings" menu) 

 

 
 

Note 
For more information on DHCP 
See Chapter Enabling DHCP (Page 103) 
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Enabling DHCP 
The RF660R reader can be switched over to DHCP mode using the "Communication 
settings" menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader that should be switched over to DHCP mode to the parameterization 

computer. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to activate it. 
The DHCP mode is activated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the connection between the reader and the parameterization computer again. 
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Disabling DHCP 
The DHCP mode can be disabled for the RF660R reader via the Communication settings 
menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader for which the DHCP mode is to be deactivated to the 

parameterization computer. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to deactivate it. 
The DHCP mode is deactivated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the connection between the reader and the parameterization computer again. 
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RF620R/RF630R, RF310R, RF340R, RF350R, RF380R 

Connecting the stationary reader to the parameterization computer over a serial interface 
You have two alternatives for connecting a reader to your parameterization computer:  
 
Reader Connection option 
RF620R/RF630R 
RF310R, RF340R, RF350R,  

 Serial connection via RS232/RS422 interface 
converter 

RF380R  Serial connection through RS232 cable 

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

* Readers are connected via one COM port each on PC

SIMATIC 
RF-MANAGER

COM1 - COMx *

 
Figure 3-5 Reader to parameterization computer connection options 

 

Connecting the stationary reader to the parameterization computer via RS232/RS422 interface 
converters  

 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial COM interface of the reader to an RS232/RS422 interface converter. Then 

connect the interface converter to your PC via an RS232 cable. 
A list of which interface converters have been tested by Siemens along with their pin assignment 
can be found in the RF600 System Manual, chapter "Integration into networks".  

3 Connect the reader to the power supply. 



RF-MANAGER Engineering System  
3.3 Working with projects 

 SIMATIC RF-MANAGER 2008 
106 Operating Manual, 06/2010, A5E01070042-03 

Connecting the stationary reader to the parameterization computer over a serial interface  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial interface of the reader to a spare COM port of your parameterization 

computer using the RS232 cable (Order No. 6GT 2891-0GH50 or 6GT 2891-0GN10). 
3 Connect the reader to the power supply. 
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Providing the reader with communications capability 

Providing the reader with communications capability  

 
1. Enter the ComPort and baud rate in the dialog box "RFID-

Gerät>Eigenschaften>Eigenschaften". 
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Connecting and parameterizing mobile readers (RF310M/RF610M) 

Preconditions for parameterization of the WLAN connection 
● The mobile reader must be ready for operation (the battery is charged). 
● The mobile reader must contain a WLAN card. 
● A WLAN connection must exist between the reader and the network of the PC, e.g. via an 

access point. 
● Information regarding the WLAN settings must be available. 
● The operating mode of the mobile reader must be set to "Supervisor". 

 

Overview of procedure 
1. Make settings in the Engineering System. 
2. Parameterize the WLAN card in the mobile reader. 
3. Assign the IP address if a DHCP server is not used. 
4. Start the application on the mobile reader. 
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Settings in the Engineering System 
1. Enter IP address of the reader 

Enter the assigned IP address in the device settings of the mobile reader ("RFID devices 
> RFID device_X"). 

2. Enter the network address of the PC 
Enter the network address of the PC in the network settings ("Device settings > RFID / 
network settings"). 

 

 Note 
An automatic reader search is not possible in the Engineering System 
The automatic reader search via "Project > Reader configuration > Communication settings" 
does not function in the case of mobile readers. 

 

Parameterize the WLAN card in the mobile reader 
Two examples are given below for the procedure that you can follow for configuring the 
WLAN card of a mobile reader. The examples pertain to the SIMATIC RF610M mobile 
reader, but are also applicable to the SIMATIC RF310M mobile reader. 
Consult your network administrator to ensure that the WLAN connection is set up correctly. 
You will find detailed information on configuring the WLAN in the operating instructions for 
the PSION WORKABOUT PRO.  
Please note that "WPA 2" encryption is only possible in Example 2. 

Example 1 
With this procedure, the active radio network is automatically displayed and "WPA 2" 
encryption is not possible.  
1. Set the operating mode to "Supervisor" in SIMATIC RF610M. 
2. In SIMATIC RF610M, select "Start > Programs > Summit > SCU" 
3. Under "Active Config", select "Third party". 
4. To activate these changes, set the device to "Power down" mode by pressing the <FN> 

key followed by the <ENTER> key. Then restart the device by pressing the <ENTER> 
key. 

5. Select the required active radio network in the dialog that subsequently appears. 
6. Click the "Connect" button and enter the respective encryption code under 

"Authentication" and "Network key". 
7. Click on the "OK" button. 
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Example 2 
1. In the mobile reader, select "Start > Programs > Summit > SCU" 
2. Click on the "Config" tab. 
3. Select the "New" button to create a new profile setting 
4. Enter a name for the profile setting. 
5. At least make the following settings: 

– SSID (name of the radio network), e.g. "RF610M" 
– Auth Type (security level): e.g. "Shared" 

6. Select the encryption required under "Encryption": e.g. "WPA 2". 
7. Then click the button "WEP/PSK Keys". Enter the encryption code and confirm with "OK". 
8. Click the "Commit" button to confirm the settings. 
9. In the "Main" tab, under "Active config", select the profile that should be active. 

 

 Note 
Other encryption possibilities 
You can also use other encryption methods, depending on the access point. "WEP" 
encryption is no longer regarded as secure; you should not use this. 

 

 

Enter the IP address in the mobile reader 
If a DHCP server is not present in the network, you must enter the IP address in the mobile 
reader:  
1. Double-click the WLAN icon in the taskbar for this purpose. 
2. Click the "Configure" button and select "Specify an IP address". Enter the IP address. 
You can also enter the IP address in the following manner: "Start > Settings > Control 
Panel > Network and Dial-up Connections" and select the appropriate connection. 



 RF-MANAGER Engineering System 
 3.3 Working with projects 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 111 

Notes on working with RF-MANAGER and a mobile reader 

Display in the task bar 
After establishing the connection between the mobile reader and RF-MANAGER, note the 
symbol  in the task bar.  
It provides the following information about the radio connection: 
 
Green
:  

A radio connection exists 

Red: A radio connection does not exist 

Working with RF-MANAGER and the mobile reader 
To start working with the mobile reader, activate the "RF-MANAGER" application by double-
clicking the desktop icon for the mobile reader. 

 

 Note 
Display the MAC and IP address 
Double-click the icon in the taskbar. The MAC address and IP address are displayed in the 
"Wireless Statistics" and "IP Information" tab sheets. 

 

Use of DHCP (Dynamic Host Configuration Protocol) 

Introduction 
A DHCP server ensures that IP addresses are automatically assigned to DHCP-capable 
network clients in a network segment. The DHCP server uses the MAC address of the 
network client for this purpose. The IP addresses are assigned due to permanent 
assignment of a MAC address to an IP address. The readers of the RF600 family with 
Ethernet connection are DHCP-capable. 
Mechanisms that extend beyond this, such as dynamic assignment of IP addresses or 
Domain Name Service (DNS), are not supported in RF-MANAGER. 
RF-MANAGER always uses fixed IP addresses internally. If a reader is replaced and 
receives the IP address of a reader that is already known, the new reader will be 
reparameterized when the connection is established. The new reader will then function 
without any further modification to the project configuration. 
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Requirements for activating DHCP 
A DHCP server must be present in the network segment. 
An up-to-date list of permanent assignments between MAC addresses and IP addresses 
must be stored in the DHCP server. This list must be maintained by your responsible IT staff 
member.  
You will find the MAC addresses of readers: 
● In the case of mobile readers, in the "Wireless statistics" tab 

Double-click the WLAN icon in the taskbar and access the "Wireless statistics" tab.  
 

NOTICE  
 

Ensure that the DHCP server is running and the readers are entered in the list. 
Otherwise RF-MANAGER will be unable to establish a connection to a reader following 
activation. 

 

● DHCP can be used with the mobile reader if a WLAN card is inserted and the card is 
parameterized (seeParameterize the WLAN card in the mobile reader (Page 109)). 

Enabling DHCP 
The mobile reader is switched to DHCP mode using the integral device menu. Proceed as 
follows: 
1. Double-click the WLAN icon in the taskbar. 

Select "IP Information > Configure" to access the tab sheet for enabling DHCP mode. 
2. Activate the button "Obtain an IP address via DHCP" here. 

 
Alternatively, you can call up the tab sheet for enabling DHCP mode via "Start > Settings > 
Control Panel > Network and Dial-up Connections > Selection of the appropriate 
connection > IP Information > Configure". 
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Disabling DHCP 
If you want to disable DHCP mode for a mobile reader, proceed as follows: 
1. Double-click the  icon in the taskbar. 

Select "IP Information > Configure" to access the tab sheet for disabling DHCP mode. 
2. Deactivate the button "Obtain an IP address via DHCP" here. 

 

Benefits of replacing a reader with DHCP 
DHCP mode allows a reader to be replaced without the need for modifying the configuration 
in the project. The IT staff member only has to change the NAC address in the DHCP server.  

Mobile reader: SIMATIC RF310M and SIMATIC RF610M 
Enable DHCP mode on the mobile reader as described above under Mobile reader: 
SIMATIC RF310M, SIMATIC RF610M > Enabling DHCP. 
If the new reader is detected by RF-MANAGER and its configuration is not in accordance 
with the settings in the project, the reader will be automatically reparameterized. 
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3.3.8.2 Creating a new project using the Project Wizard 

Getting Started 
1. Start the RF-MANAGER Engineering System (ES) by double-clicking the desktop icon (or 

via "Start" or by clicking the "RF-MANAGER" icon in the taskbar). 
2. In the welcome screen, select the option "Create new project with the project wizard". The 

window described in the following chapter opens. 

Operation and display options 
When creating a project using the Project Wizard, you have the following operation and 
display options:  

 
Operation and display options of the Project Wizard 

  

 
  

1  Jump to next menu page. Any parameter settings made in the current menu will 
be saved. 

2  The parameter settings made on all menu pages until now are saved and the 
project will be created. Further processing of the project is then possible. 
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Operation and display options of the Project Wizard 
3  Jump to welcome menu. All parameter settings made until now on all menu 

pages are rejected. 
4 

 
Jump to previous menu. Any parameter settings made in the current menu will 
be saved. 

5 - Navigation field. The current menu is highlighted in color.  
6 - Information field. Explains the contents of the current menu. 

Select project type 

Introduction 
Under "Project type", you can select a predefined scenario for the structure and the 
associated configuration of your RFID system.  
Click "Select project type" on the welcome screen to parameterize your settings. You have 
the following options when selecting the project type: 
● Single RFID device 
● Several RFID devices 

Single RFID device  

 
With the "Single RFID device" option, one RFID reader is connected to the RF-MANAGER. 
You can create system screens with RFID elements and an alarm system. Enterprise 
systems can access the reader data through the RF-MANAGER. 
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Several RFID devices  

 
With the "Several RFID devices" option, several RFID readers are connected to the RF-
MANAGER. You can create system screens with RFID elements and an alarm system. 
Enterprise systems can access the reader data through the RF-MANAGER. 
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Country selection for wireless profile 
Under "Country for wireless profile", select the country in which the project must operate. 
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Specifying the RFID devices and enterprise system 

Introduction 
In the "Communication" menu, you can parameterize the communication paths for your RFID 
system and set parameters for the individual readers and PLCs.  

 
The communication is parameterized in the following stages: 
● RFID device 
● RFID connection 
● RF-MANAGER 
● ALE connection 
● Enterprise system 
● PLC 
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RFID device 
The following settings are made here: 
● Device type 
● Wireless profile (for further information, see Section . 
● Tag protocol 
● Number of antennas ("Read points") 
● The IP start address of the reader 
● Port for the reader 

 

 
 

Note 
Reader IP addresses 
In the Project Wizard, you only have to specify the IP address of the first reader. The IP 
address is automatically incremented for subsequent readers. 

 

RFID connection 
The route of the connection between the reader and the runtime system is specified here. 
The "Ethernet" connection is permanently set and cannot be changed. 

RF-MANAGER runtime 
You can make the following settings here: 
● Changing the screen resolution 
● Specifying the type of runtime system: 

– RF-MANAGER runtime (standard PC) 
– Microbox 420 
– Microbox 427B 

ALE connection 
The route of the connection between the runtime system and the enterprise system is 
specified here. The "Ethernet" connection is permanently set and cannot be changed. 

Enterprise system 
No parameters can be set here. 
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Controller 
If you check "Controller", you can make the following settings: 
● Setting the interface: "MPI/DP" or "ETHERNET" 
● Selecting the controller: 

– SIMATIC S7 200 or 
– SIMATIC S7 300/400 

● Number of PLCs: You can specify the number of PLCs here that will be created by the 
Project Wizard. 

Setting basic topology parameters 
 

 Note 
The "Topology" menu can only be selected when you selected the "Several RFID devices" 
option in the start menu. 

 

You can specify the following in the "Topology" menu:  
● Total number of workplaces. 
● Number of readers that are each connected to a workplace. 

 
The workplaces are logical combinations of readers whose RFID data are collected and 
evaluated, for example, the group of readers for the incoming goods area. 
These data can be transferred to an enterprise system over an ALE connection. 
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Selecting a screen template 

Introduction 
In the "Screen template" menu, you can set the basic parameters for screen presentation. 
The template to be created here is used for all screens of the RF-MANAGER project. 

 
The screen template is parameterized in the following stages: 
● Page header 
● Alarm line / Alarm window 

Page header 
You specify here whether the screens should have a page header and the information that it 
should contain (e.g. date or company logo). 
The graphic for the company logo is selected using the  button. 

Alarm line / Alarm window 
You specify here whether the screens should have an alarm line or alarm window and where 
it should be positioned. 
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Selecting system screens 

Introduction 
In the "System screens" menu, you specify which system screens should be generated for 
your project.  

 
The system screens are parameterized in the following stages: 
● Root screen for system screens 
● System screen for 

– Language switching 
– Runtime stop 

● System screen for user administration 
● System screen for project information 
● System screen for RFID tag events 
● System screen for RFID configuration view 
● System screen for RFID statistics view 
● System screen for alarm window 
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Root screen 
Here you specify whether a root screen should be created as a central screen for all system 
screens or whether all system screens should be directly referenced in the welcome screen.  

System screen for language switching and runtime stop 
You specify here whether a system screen should be created that you can use to switch 
between the configured languages. 
You also specify whether a system screen should be created via which you can stop the 
runtime system, start or stop RFID processing or switch to transfer mode for transferring a 
project.  

System screen for user administration 
You specify here whether a system screen should be created that will display user 
administration. Tabular information about the different authorized users of a project is 
displayed in this screen and can be edited. 

System screen for project information 
You specify here whether a system screen should be created that will display the project 
information that you have entered. See Chapter . 

System screen for RFID tag events 
You specify here whether a system screen should be created that will display the RFID data 
communication. The tag events, associated readers and the over-arching workplaces are 
displayed in this screen for example.  
 . 

System screen for RFID configuration view 
You specify here whether a system screen should be created that will display the RF-
MANAGER configuration. You can make changes to the project configuration and 
reparameterize individual components at runtime using this screen. 
  

System screen for RFID statistics view 
You specify here whether a system screen should be created that will display the statistical 
values for your project, such as the number of read statuses of all scanned tags. 
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System screen for RFID alarm window 
You specify here whether a system screen should be created that will display the RFID 
alarms. The alarm event is displayed in accordance with the assigned alarm classes. 

 

 Note 
Select all system screens 
When you activate the option "All system screens", the Wizard will automatically create all 
the available system screens. 

 

Enter project information 

Introduction 
In the "Project information" menu, you can enter information that precisely defines your 
project to make identification in RF-MANAGER easier. The project information can be 
displayed as a system screen.  
See  

 
The project information is parameterized in the following stages: 
● Project name 
● Project author 
● Creation date 
● Comments 

Project name 
You can enter the name of the project here. 
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Project author 
You can enter the name of the project author here. 

Creation date 
You can enter the creation date of the project here. 

Comments 
You can enter a project comment of any length here. 

Creating and modifying a project 
After entering the project information, if you click on the "Finish" button, the project will be 
created. The project can be modified later as required. In the case of some settings, such as 
the parameterization of IP addresses, modification is mandatory.  
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3.3.9 Requirements for transfer 
A transfer operation refers to the transfer of a compiled project file to the runtime system 
where the project is to run.  

Requirement 
After you have completed a configuration process, check the consistency of the project by 
using the menu "Project > Compiler > Check Consistency". After completing the consistency 
check, the system generates two compiled project files. This project files have the same 
name assigned to it as the project, however with the extensions "*.rfidx" and "*.xml". These 
compiled project files must be transferred to the runtime system. 

 

 Note 
Engineering System and Runtime System on the same PC 
If the Engineering System and Runtime System are on the same PC, a transfer is not 
necessary. The project files can be stored locally in any directory. 

 

The runtime systems must be connected to the configuration computer to transfer the project 
files. Mobile data storage units can also be used to transfer the files. 
Compile the project again if the *.pwx is not found and you receive an error message while 
transferring the data.  

Basic procedure 
1. Enter the transfer settings for the individual runtime systems in your RF-MANAGER 

project. 
2. Enter the transfer mode on the runtime system to which the project is to be transferred in 

"RF-MANAGER 2008 Runtime Loader". The alternative options are as follows: 
– Using the "RF-MANAGER 2008 Runtime Loader" 
– By executing the system function "SetDeviceMode" with the option "Transfer" 

3. Transfer the compiled project files from the configuration computer to the runtime 
systems. The project files are transferred to all runtime systems for which the respective 
check box is selected in the transfer settings. 

Transfer mode  
The runtime system must be in "transfer mode" for the transfer operation. If a project is not 
yet available on the PC, you must enable the transfer mode in the "RF-
MANAGER 2008 Runtime Loader" manually before the first transfer operation.  
This is however not necessary if you selected the "File" option in the "Transfer settings" 
and/or your engineering system and your runtime system are located on the same PC. 
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Automatic restart of RFID processing 
When you make extensive changes to your configuration in the engineering system, stop 
RFID processing before you copy the changes. Use the system function 
"StopRfidProcessing" for this purpose or select "Stop RFID processing" in the Start Center. 
This shortens the subsequent starting phase considerably. It is generally recommended that 
RFID processing should be restarted after several project modifications. 
Before any productive data has been supplied from the plant, the following possibility for 
transferring modified configuration data is available as an alternative: Check the box 
"Automatic restarting of RFID processing when runtime starts" under "Device settings > 
RFID/network settings".  

 
When this box is disabled, only those changes implemented since the last start will be 
transferred for any RFID processing in progress. This can result in inconsistencies in the 
configuration which can cause malfunctions in RFID processing. 

Data comparison with the runtime system 
You can use the menu item "Data comparison with the runtime system" to save changes in 
the Engineering System that you made to your project at runtime in the "Configuration" 
screen object. In this procedure, the changes are saved in an "xml.sync" file and copied into 
the project in the Engineering System.  
Otherwise the changes in the runtime system will be overwritten by the transfer. 

See also 
Configuration (Page 500) 
Data comparison with the runtime system (Page 461) 
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3.3.10 Debugging projects 

3.3.10.1 Introduction 

Testing the runtime system 
You can check that the connected readers are functioning correctly using the SIMATIC 
RF660R Configuration Software.  
Requirements 
  

3.3.10.2 Debugging projects 

Introduction 
During configuration, the data entered is automatically tested for its plausibility. Example: 
When you create a new user, the system indicates that the current password of the user is 
invalid and you have to assign a new password for the user.  
The plausibility test ensures, for example, that value ranges are maintained and incorrect 
input is indicated during the configuration phase.  
There is no check for incorrect parameters in the input, for example, when a variable is not 
assigned in an I/O field. The assignment is checked with the "Check consistency" function 
and displayed as an error. Using the simulator, you can also check that the RFID system is 
functioning correctly with regard to tag processing and the configured screens /screen 
objects. 

Perform consistency check 
To locate configuration faults, start the integrity test by clicking the "Check consistency" icon 
or via "Project > Check consistency". All faulty points in the project are listed in the Output 
View. Then skip to the cause of fault. Work through the fault list from top to bottom.  
If you perform the consistency check frequently, inconsistencies may occur in the project 
built. To remedy this problem, rebuild the project using the command "Project > Generator > 
Rebuild all." 

See also 
Troubleshooting (Page 129) 
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3.3.10.3 Troubleshooting 

Introduction 
After completing the consistency test in the project, the results of the test appear in the 
Output View. There are three different result categories  
● Notes 

It is possible that logical links in the project are not correct or not available. Check the 
logical links of the project in conjunction with the alarms. The generating operation is fully 
executed. 

● Warnings 
The project contains faults which may lead to an incomplete view on the runtime system. 
The generating operation is fully executed. 

● Error 
Faults must be eliminated so that the data can be fully loaded onto the runtime system. 
The fault number helps to identify the type of fault. 

 
It is possible to call in help on the individual alarms by moving the mouse pointer to the 
relevant alarm line and pressing <F1>. 

Procedure 
1. Click the "Check consistency" icon to run the consistency test on the project. 

The configuration data are now verified. Notifications, warnings and faults are shown in 
the Output View.  

2. Double-click an entry in the Output View to access the location in the project which 
caused the fault. 

3. Clear the fault. 
 

 
 

Note 
Clear the faults in succession because follow-up faults could already have been cleared 
after clearing a fault. 

 

Debugging projects 
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See also 
Debugging projects (Page 128) 

3.3.10.4 Using the simulator 
The RF-MANAGER is supplied with a simulator which you can use to test the essential 
components of the RFID project.  
The simulator is a separate application.  
You can use the simulator to simulate operation of the readers used in your projects using 
pre-defined tag events in the runtime system. The tag events are created in a simulation 
table. Tag IDs can be defined simply and conveniently in this table. It is also possible to 
trigger several tag IDs simultaneously. 
You can also simulate reader inputs on the runtime system. The I/O events are also created 
in a simulation table. You can easily define the reader inputs and their conditions in this 
table. 
Simulated reader inputs can also be used to trigger tag events. 

Simulation of tags 
During simulation, you can use a simulation table to create any number of tag jobs with 
predefined tag events for the readers configured in the Engineering System. These jobs are 
independent of each other and can execute once, cyclically or triggered by reader inputs. 

 
The created jobs can be set to active or inactive. You can also copy the jobs and delete 
individual jobs. 
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Simulation of reader inputs 
Using the simulation table I/O jobs, you can simulate reader inputs with predefined time 
events on the runtime system.  
For detailed information please see the simulator help system. 

Handling instructions 
The following steps show the basic procedures for simulating a project.  
1. Start by creating a project as it is going to be run later with an interconnected controller. 
2. Save and compile the project. 
3. Launch the simulator directly from the running configuration software. Select "Compiler" > 

start Runtime with simulator" from the "Project" menu.  
When you simulate the project for the first time, the simulator is started with new, empty 
simulation tables; only the previously configured readers are shown. You can then create 
the required jobs for each reader and parameterize them using "Edit > Insert".  
If you have already created a simulation table for your project, it will then be opened 
automatically. The simulation table "*.rfidsim" contains all the settings that you made for 
the simulation. These settings can be changed. 

4. You can save all settings made in this table for project simulation to a file. To do so, 
select "File > Save" in the Simulator, then type in a file name ("*.rfidsim".) You can now 
always retrieve these settings in order to simulate your project again.  

5. When you click the Start button, simulation will be started in the runtime system. 
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3.3.10.5 Basic functional test of the RF670R using the SIMATIC RF-MANAGER Basic 

Requirements  
If problems occur when using the RF670R reader, you can check the general functionality as 
follows: 
● The antenna configuration must be as shown in the figure below. 
● The reader is connected to the SIMATIC RF-MANAGER Basic. 
● RF-Manager 2008 and RF-Manager 2008 Runtime must not have been started. 

Procedure 
To check whether the reader can read a tag, proceed as follows: 
1. Open the RF-MANAGER Basic. 
2. Select the IP address of the reader to be checked (see ). 
3. Hold a tag on an electromagnetically neutral base in the middle in front of the antennas. 

 

NOTICE  
 

As a base use wood or plastic, for example, but definitely do not use any metallic or 
field-influencing materials. 

 

4. In the menu "View", select the "Diagnosis View" command or click the  icon. 
The "Diagnosis View" dialog box is opened. 

5. Click "Start". 
 

 
Figure 3-6 Configuration to test the RF670R 
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Result 
If the tag in the field can be read by the reader, it will appear in the list in the "Diagnosis 
View" dialog. In addition, the orange LED of the RF670R indicates that a tag recognized by 
the reader is presently located in the field. 
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3.3.10.6 Basic functional test of the RF660R using the SIMATIC RF660R Configuration 
Software 

Requirements  
If problems occur when using the RF660R reader, you can check the general functionality as 
follows: 
● The antenna configuration must be as shown in the figure below. 
● Alternative configuration: 

The antennas are installed above one another. Mounting height of the first antenna 1 m 
above the ground, the second antenna 2 m above the ground (bottom edge of antenna in 
each case) 

● Reader must be in the "Autonomous" operating mode. 
● The reader must be connected to the RF660R Configuration Software. 

Procedure 
Hold a tag on an electromagnetically neutral base in the middle in front of the antennas. 

 

NOTICE  
As a base use wood or plastic, for example, but definitely do not use any metallic or field-
influencing materials. 

 

 
Figure 3-7 Configuration to test the RF660R 
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Result 
The "Tag Detect" LED of the RF660R starts to light up yellow. 

Event monitor 
To view the tag ID, ID type, protocol and time stamp of the transmitted tag, click the "Event 
monitor" button in the RF660R Configuration Software.  

 
Figure 3-8 Event monitor button 

The following window is displayed: 

 
Figure 3-9 Tag event monitor 
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3.4 Parameterize topology 
Under the item "Topology" of the project tree, you can set the basic parameters for your 
RFID system. You create connections between the readers and the runtime system, 
parameterize the readers, create workplaces and determine which areas of the tag memory 
can be read or written. You can also configure PLC connections. 
Overview of the RF-MANAGER architecture (Page 21)  
The parameters are set in the following stages: 
● Topology: 

– RFID device 
– Workplaces 
– PLC connections 

 

 
 

Note 
PLC connections 
Information on creating PLC connections can be found in the chapter Fundamentals > 
Working with PLC connections. 
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3.4.1 Parameterizing RFID devices 

3.4.1.1 Introduction 
In the "RFID devices" submenu, you can create new readers and parameterize readers that 
have already been created in your RFID system. The transmission paths between the 
runtime system and readers are specified here. You can also set general parameters for the 
antennas that are connected to the readers.  

 
And you can create data sources for the purpose of reading tags and notification channels 
for transferring the scanned tags. It is also necessary to specify triggers: Triggers that 
activate the data sources for reading and triggers that activate the notification channels to 
transfer the data of the data sources that are assigned to you. 
  
The RFID devices are parameterized in the following stages: 
● RFID device 
● Antennas 
● Data sources 
● Notification channels 
● Trigger 
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● Barcode units (RF610M only) 
● Inputs/outputs (only RF670R) 

Procedure 
If you want to create a new RFID device, use the right mouse button in the Project View to 
click on the folder "Topology > RFID devices". Select the option "Add RFID device". The 
editor opens for the new device. This device can also be selected in the tree structure of the 
Project View under "RFID device_(number)".  
If you want to edit an RFID device that has already been created, click "RFID 
device_(number)" with the right mouse button. Select the option "Open editor". Alternatively, 
you can double-click "RFID device_(number)" with the left mouse button.  
The menus appear in the workplace in the form of register cards. You can edit these menus 
in the properties dialog box. 
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3.4.2 Stationary readers connected via Ethernet 

3.4.2.1 RF670R 

RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 

 
Here you can enter the IP address for the reader set in the RF670R, and the radio profile 
used for the reader.  
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Properties 
● Radio settings 

 
You can set the radio profile used for the reader under "Radio settings"  
If your RFID system is using "Frequency hopping", you can specify the "Channel 
switching interval" for the reader transmission channels here in milliseconds. 
Frequency hopping is used to prevent mutual inference from the readers. If frequency 
hopping is not activated, you must permanently assign the transmission channel by 
means of an ID. If the FCC radio profile is used, however, frequency hopping cannot be 
deactivated.  
  
You can set the following parameters under "Air Protocol":  
"Retries before failure: 
Here you can set the maximum number of repetitions of a faulty air protocol command. 
The command is terminated and an error reported only when the command has failed in 
all attempts. With this setting you can reduce the likelihood of errors when accessing 
tags. However, this lower error probability leads to an increased time required for 
command execution. The maximum execution time may increase depending on the 
actual number of repetitions performed. For time-critical applications, it may therefore be 
advantageous to turn off the repeat and if needed, to respond in the application and then 
selectively make the repetition. 
  
"Write Boost" 
Here you set how many decibels the antenna performance is increased for writing of data 
or the ID to the tag. To write data or an ID, a tag that can be read needs about 3 dB more 
energy at a constant distance. This increased capacity reduces interference potential and 
increases performance. An increase can only be up to the maximum allowed power. 
  
"Sensitivity" 
Here you set the attenuation of the tag responses in the input branch of the reader. An 
increase in attenuation causes weak received tag signals to no longer be recognized by 
the reader. A decrease means that even weak received tag signals are detected. On the 
other hand, decreased attenuation brings with it the disadvantage that interference can 
negatively affect detection. The attenuation simultaneously affects all antennas. 
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● Tag protocol 

This is where you select the communication protocol to be used between the reader and 
tag.  
With EPC Class1 Gen2, you can use "Initial Q" to specify the maximum number of tags 
that can be expected to be located in the measuring field at the same time so that 
collisions can be prevented.  
The following formula applies: 2 Initial Q value = number of expected tags.  
It is important to note here that the length of a read cycle increases with the value of the 
Initial Q value. Normally this value is automatically set by the reader. If, however, you 
want to optimize performance, the rule of thumb is that the value must be set as low as 
possible and as high as necessary.  
  
Under "Tag communication scheme", you can set the data transfer rates between reader 
and tag for EPC Gen2 (see Tag modulation schemes (Page 149)).  
Under "Tag ID Length", you can select the setting "Automatic" or "Specific". "Automatic" 
means that tags of different lengths are detected. Select the setting "Specific" only when 
you are sure that there will only be tags with the same length or only specific ID lengths 
are desired. Tags with different ID lengths are ignored. 
Dense Interrogator mode (Page 149)  
See also: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Connection 

 
If "RSSI events" is activated, then for each tag a message containing the information 
"Tag ID", "RSSI value" and "active antenna" is generated for all read processes and tag 
commands that result in the acquisition of the tag ID at the air interface. This information 
can be useful during commissioning.  

 

NOTICE  
 

Very many messages 
Very many messages are generated for large tag populations, which can reduce overall 
performance and lead to overload. Disable "RSSI events" after commissioning if you 
work with large tag populations. 

 

With the "Delta threshold" parameter you can set the difference in the RSSI value per tag 
from which a new RSSI message is created. If, for example, the value is set to "10" and a 
message has been generated at an RSSI value of 50 for the tag with ID x, a new 
message is created when a value of >60 or <40 is reached. No messages are generated 
at RSSI values in between to avoid a flood of messages on small changes.  
If "Command response events" is activated, messages containing information such as 
command, ID, result of the command, RSSI value, active antenna, etc. are created for all 
tag command (e.g. WriteID, Kill, Lock, etc.) and for each tag. If the command was 
executed on several tags, separate messages are generated for each individual tag. At 
the end of a command execution, an additional message is created with a summary of 
the results (tags OK, number of tags NOK). 
During commissioning, you can enable this option in order to detect problems with 
command execution. After the commissioning you should disable the option again, 
otherwise a lot of data will be generated, causing the overall performance of the system 
to be reduced or leading to an overload.  
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● System 

 
Under "Asynchronous reader mode", you can change the operating mode of the RFID 
module. In asynchronous reader mode, the RFID module continuously reads tags that 
are present in the field. Even if always the same tag is in the field, the same tag is 
constantly read and the data source made available. If the option is not enabled, the 
RFID module will only read in response to an explicit request from the data source or in 
accordance with the configured trigger conditions. 
You use "Asynchronous reader mode" when you want tags to be detected as quickly as 
possible. In this mode, the software does not provide a trigger because the reader reads 
autonomously. You will need this function for high-speed processes in which temporary 
reading pauses are not acceptable. 

 

 
 

Note 
Preconditions/settings 
 Read settings: Set the threshold for "Observed" to 0. 
 Set all the participating components, e.g. data sources and notification channels, to 

continuous triggering. 
 

 
 

Note 
Only one data source 
Please note that you can only parameterize one data source for your reader in 
asynchronous reader mode. Scenarios with multiple data sources are not permitted! 

 

● Properties 

 
The dialog "Properties" contains expert parameters for special applications. These expert 
parameters permit the subsequent optimization for difficult applications.  
The following expert parameters can be parameterized via the "Properties" dialog: 
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Parameter Description Default setting 
RFInterfaceModulationType The RF670R readers provide two basic 

modulation types: 
 Double Sideband (DSB) 
 Phase Reversal Amplitude Shift 

Keying (PR-ASK) modulation. 
 

PR-ASK modulation is the 
default setting and should not 
be changed. 

TagCommUsePilotton To ensure that the RFID module can 
better synchronize with the transponder 
response, the tag is told to transmit a pilot 
signal (x ms long) via the air interface. If 
no fault is expected in the field, the pilot 
signal can be switched off (minimal time 
savings). But the user is advised to 
always leave the pilot signal switched on. 

ON = 255 

TagCommIntelligentWrite In comparison with the reading process, 
the writing process is a very slow process. 
The concept of intelligent writing includes 
reading of the special cells to be written in 
the tag, comparing of words (2 bytes), and 
word-by-word writing of only those words 
that deviate in content between target 
data and actual data. 
Users who would like to write the contents 
of the memory in any case, due to the 
medium-length data management period, 
will shut down this mechanism. 

ON = 255 

TagCommVerifyWrite When writing data to transponders, the 
transponder can acknowledge correct 
writing in the event of a defective memory 
cell, but during the next reading, it is 
discovered that memory cells were not 
correctly written compared to the 
acknowledgement. 
In order to be able to prevent such data 
corruption, the corresponding memory 
cells are read word-by-word by the reader 
after writing data on tags and then 
compared to the writing data by default. 
Users who do not want to use this mode 
can disable the mechanism via the expert 
parameter defined here. 

ON = 255 

TagCommForcePowerOffAfterEPCWrite In order to be able to optimize the 
inventory chronologically, you must 
ensure that a tag briefly exits the status 
after overwriting the EPC ID in order to be 
assigned a new status in a different 
inventory as soon as possible. 
This timed response can be achieved by 
switching off the power for X ms after the 
EPC ID is written. 

The setting range for the wait 
time is 0 ms to 255 ms. The 
default is a pause of 5 ms. 
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Parameter Description Default setting 
RFInterfaceTimeToPowerOff This time specifies how long the carrier 

remains switched on after a tag operation, 
taking the restrictions of the selected 
communication standard into 
consideration. 
The advantage of selecting a sufficiently 
long carrier running-on time is that after 
data accesses, the reader leaves the 
carrier of a channel switched on, thus 
saving time when the data accesses are 
used again. 

5 s 

RFInterfaceMultiplexingExposureTime1 ... 4 These settings only become effective 
when the reader is operating in 
asynchronous mode (see 
RFID device > Properties > System). 
In this mode, the RFID module 
continuously executes read cycles 
(inventories) and switches the antennas 
according to the set times. Time 1 ...4 
corresponds to Antenna 1 ... 4 

100 

GlimpsedTimeoutCount 
ObservedTresholdCount 
ObservedTimeOutCount 

Three counters are reserved in the tag list 
for each tag. They can be changed by the 
user. 
These settings only become effective 
when the reader is operating in 
asynchronous mode (see RFID 
device > Properties > System). In this 
mode, the RFID module continuously 
executes read cycles (inventories). When 
a tag is reported depends on the number 
of identifications and the resulting states. 
The tag status "Observed" is reported.  
Possible states:  
 Glimpsed 
 Observed 
 Lost 
The basic model of smoothing is 
described in the chapter "Understanding 
and optimizing the scanning of RFID 
tags". 

GlimpsedTimeOutCount = 1 
ObservedTresholdCount = 0
ObservedTimeoutCount = 5 
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Parameter Description Default setting 
TagCommTransmitSelectIfNoFilterIsOn Before each read cycle, the reader sends 

a select command at the air interface to 
switch tags into a defined idle state. This 
procedure is only required if tags changed 
their states due to previous filter functions.
If it is ensured that no filters affect tags via 
the air interface, the read performance 
can be increased by omitting the select 
command. 

ON = 255 

TagCommUseBlockWrite The EPC Gen 2 air protocol supports the 
command "BlockWrite" for simultaneously 
writing several words to the tag. If only 
tags that support this command are used, 
you can activate this write mode 
exclusively. Word-by-word writing is then 
deactivated. 

OFF = 0 
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● Data selector 

 
You can select the current data selector or define new data selectors here. Please note 
that the data selector chosen here will only be effective in the following cases: 
– During synchronous read procedures 
– Or for notification channels for which a data selector has not been explicitly selected. 
In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.  
For further information on using data selectors, see . 

● Alarm 

 
You can select alarms for reader status and available memory here or define them.  
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the RFID device.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed.  
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● Information 

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here. This information is displayed in the "Configuration" and 
"Statistics" views.      
  
  

● Events 

 
"On Alarm" 
If the reader triggers an alarm, this event is triggered. You can configure function lists for 
the event in order to execute system functions. 
You can find further information on the use of lists of functions in the chapter "System 
functions and runtime scripting". 
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Tag modulation schemes 
You set the data transfer rate between reader and tag using tag modulation schemes. This 
parameterization is only possible with the tag protocol EPC Class1 GEN2.  

EPC Class1 GEN2 tag communication schemes 
 
Index Reader - 

Tag Tari* 
Reader - Tag 
data rate 

Link 
frequency 

Tag - reader 
data rate 

Coding ETSI-
compatible 

FCC-
compatible 

0 25 μs 40 kbps 80 kHz 80 kbps FM 0 Yes Yes 
2 25 μs 40 kbps 160 kHz 160 kbps FM 0 Yes Yes 
4 25 μs 40 kbps 160 kHz 40 kbps Miller 4 Yes Yes 
5 12.5 μs 80 kbps 160 kHz 160 kbps FM 0 Yes Yes 
7 12.5 μs 80 kbps 160 kHz 40 kbps Miller 4 Yes Yes 
9 12.5 μs 80 kbps 320 kHz 160 kbps Miller 2 Yes Yes 
10 12.5 μs 80 kbps 320 kHz 80 kbps Miller 4 Yes Yes 
11 12.5 μs 80 kbps 320 kHz 40 kbps Miller 8 Yes Yes 
12 6.25 μs 160 kbps 320 kHz 320 kbps FM 0 No Yes 
13 6.25 μs 160 kbps 320 kHz 160 kbps Miller 2 No Yes 
14 6.25 μs 160 kbps 320 kHz 80 kbps Miller 4 No Yes 
15 6.25 μs 160 kbps 320 kHz 40 kbps Miller 8 No Yes 

Dense Interrogator mode 
The dense interrogator mode for Gen 2 tags (schemata with Miller coding) enables several 
RF670R readers to be operated without interference in close proximity to each other.  

Operating principle 
When using Gen 2 tags, a so-called Miller subcarrier permits readers located close to one 
another to use the same frequency. This is achieved by inserting a frequency offset for the 
signal carrier in the tag (by using a square-wave hybrid signal). 
As a result of the large difference in level between the transmitter channels and the tag 
response channels, this technology provides great advantages for frequency reuse. 
However, a prerequisite is that a certain minimum distance, and thus minimum decoupling, is 
observed between the antennas of adjacent readers.  
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Antenna alignment and distances 
The minimum distance required between antennas using the same frequency depends on 
the transmitter power set and the antenna alignment.  

 
Figure 3-10 Antenna distances 

 
Antenna configuration Antenna alignment Minimum distance required = D 
A With backs to each other 0.5 m 
B Arranged laterally 1 m 
C Antennas point toward each other 6 m 

Optimizing tag reading accuracy 
A further improvement in the tag reading accuracy in an environment with a high density of 
readers can be achieved by orienting the antennas toward the respective tag field, i.e. by 
rotating them horizontally and vertically. 
In addition, the transmitter power of the readers can be reduced down to the minimum at 
which the tags are still just detected accurately.  
This greatly reduces the probability of interference.  
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Antennas 

Antennas 
The "Antennas" menu provides the following parameter setting options: 

General 

 
In this window, you can specify the radio properties of an antenna. The "Name" of the 
antenna and the antenna port assigned to it are automatically assigned.  
The maximum "Power" is limited by the radio profile and communication scheme used. The 
settings for the "antenna gain" and "cable loss" parameters are dependent on the hardware 
used.  
Under "Enable", you can activate the antenna. 
The operating mode of the antenna with RF670R is preset to TX/RX, as the reader operates 
the antenna monostatically, i.e. transmitting and receiving take place simultaneously. 
For additional information on the transmit power of the antennas, refer to Transmit power of 
the antennas (Page 153). 

RSSI threshold value 
RSSI (received signal strength indication) data provide information about the strength of the 
reception field with which a tag is read. To reduce the effect of overshooting when making 
data accesses to transponders, setting a threshold allows received transponder signals that 
do not reach the Received Signal Strength Indicator (RSSI) threshold to be discarded by the 
reader. An analysis of RSSI data may also help, for example, to initiate a write operation only 
if there is a sufficiently strong tag in the field. This can increase the writing success rate. 
The value is a unitless amount without direct conversion to the level and a value range of 0-
255 (default 0). 
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Properties 
● Alarm 

 
You can assign the "RFID status alarms" and "RFID base alarms" to the antenna here. 
You can either select them from the drop-down list or create new ones. 
Under "Operational status alarms", you can assign several RFID status alarms to the 
selected antenna. You will then receive detailed information regarding the status of the 
antenna.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

● Information 

 
You can store a description of the antenna here. 
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Transmit power of the antennas 
The maximum transmit power of the antennas is restricted by the radio profile used. 
Parameterization of antenna gain and cable loss depends on the hardware used.  

ETSI radio profile 
With the ETSI radio profile, the minimum transmit power is 50 mW ERP, and the maximum is 
2000 mW ERP. The set power corresponds to the desired effective radiate power (ERP), 
and is calculated for the reader based on the entered parameters "Antenna gain" and "Cable 
loss". The RF660A-EU antenna has a gain of 7 dBi, and a 10 m long LMR-195 cable has a 
loss of 4 dB or an LMR-300 cable has a loss of 2 dB.  

FCC radio profile 
With the FCC radio profile, the minimum transmit power is 100 mW, and the maximum 
transmit power is 1000 mW. The set power corresponds to the desired signal level on the 
end of the antenna cable and is calculated for the reader based on the entered parameters 
"Antenna gain" and "Cable loss". The RF660A-US antenna has a gain of 6 dBi, and a 10 m 
long LMR-195 cable has a loss of 4 dB or an LMR-300 cable has a loss of 2 dB.  

Antenna configurations 
Some basic antenna configurations and possible fields of application are shown below.  
 
Antenna configuration 1 Description/application areas 

 
 

 
 
 

This arrangement of antennas is 
appropriate when the tags to be read are 
only located on one side of the items to 
be identified, e.g. when pallets are to be 
identified on which the tags to be read 
must be on a prespecified side. 

① Tag 
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Antenna configuration 2 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
The tag is located in the field of radiation 
of two antennas; for reliable tag reading, 
the height of the tag above floor level 
must therefore be known with 
reasonable accuracy. 

① Tag 

 

 
Antenna configuration 3 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
Similar to configuration 2, but with 
additional reading reliability when the tag 
is at an angle to the vertical. 

① Tag 
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Antenna configuration 4 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
The tag is located in the field of radiation 
of all four antennas, so the tag position 
can vary more than in configuration 2 for 
reliable tag identification. 

① Tag 

 

 
Antenna configuration 5 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
Similar to configuration 4, but the 
reliability of tag identification is improved 
as a result of the four antennas at 
separate locations, so the tag position is 
not critical. 

① Tag 
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Antenna configuration 6 Description/application areas 

 
 

 
 
 

This tunnel configuration is suitable for 
conveyor belt applications. The goods 
with the tags to be read are moving 
forwards on a conveyor belt but the 
alignment of the tags relative to the 
antennas is not clearly defined. One of 
the antenna is located on the floor and 
radiates vertically upwards in the 
direction of the conveyor belt. A relatively 
high reading reliability is achieved due to 
the use of four antennas. 

① Tag 
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Specified spacing of antennas 

Specified minimum spacing of antennas 
The following diagram shows the specified minimum and maximum spacings for mounting 
antennas.  
A minimum spacing of 50 cm is necessary between the antenna and liquids or metals. 
The distance between the antenna and the floor should also be at least 50 cm. 

 
Figure 3-11 Minimum distance to the environment 

 
The distance between two antennas mounted alongside each other or one above the other 
should be at least 20 cm, but a distance of more than 50 cm is better. 



RF-MANAGER Engineering System  
3.4 Parameterize topology 

 SIMATIC RF-MANAGER 2008 
158 Operating Manual, 06/2010, A5E01070042-03 

 
Figure 3-12 Antennas mounted adjacently horizontally or vertically  

 
For a portal configuration, the distance between two antennas that are connected to the 
same reader is up to 3.5 m (in Europe) or 4 m (in the USA). 

 
Figure 3-13 Portal configuration, maximum distance 

 
The specified distances are recommended minimum or maximum values for configuration. 
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Tag orientation in space 
The alignment of the tag antenna to the antenna of the reader affects the reading range. For 
maximum performance and to achieve the maximum reading range, the tag antenna should 
therefore be aligned in parallel with the reader antenna:  
 
Parallel tag alignment Large reading range 

 
 
 

Maximum probability of identification of tags. 

 

 
Vertical tag alignment Minimal reading range 

 
 
 

Minimum probability of identification of tags. 
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Data sources 
Data sources read the data from logically associated antennas. The data sources pass on 
the data that are read from the antennas assigned to them.  
The "Data sources" menu provides the following parameter setting options: 

General 

 
You can assign a name to the data source using the parameter "Name". Under "Antennas", 
you can assign the antennas that are available to the data source.  
If you selected EPC Class1 Gen2 as the communication protocol between the reader and 
the tags, you must specify the session parameters for the data source. One tag can 
communicate with up to 4 data sources simultaneously, so to distinguish between these data 
sources, a unique number S0 to S3 is assigned to each via the session parameters.  
Under "Enable", you can activate the data source.  
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Properties 
● Read settings 

 
Under "Read settings" you can choose between "Repeated reading" and "Bulk reading".  
If the option "Repeated reading" is activated, you can define the number of "Read cycles 
per trigger". The "Read timeout" specifies in milliseconds how long the defined number of 
read cycles per trigger may take. When this time limit is exceeded, the read cycles are 
stopped even if the number of cycles that you specified has not been reached.  
If the option "Bulk reading" is active, the reader continuously reads all tags in the fields in 
one read cycle. The "Read timeout" determines how long this continuous reading will last. 
Other data sources must wait during this defined read duration and are only processed 
when it ends. 
For more detailed information and general background information, please refer to: 
Help system Getting started > Understanding and optimizing the scanning of RFID tags 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The reader adds a 
status indication for the tags to the read results.  
In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
The different statuses are described below:  
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Status Meaning Description 
The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time "Glimpsed 
timeout" has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold": 
If a stable connection exists beyond the time "Observed threshold", the status 
"Observed" is assigned to the tag. 
The rule of thumb is that "Observed threshold" should be at least twice as long as 
one complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that "Observed timeout" must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Triggers  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.  

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not entered here, the tag IDs will be supplied from all tags.  
If several tag selectors with filter function are selected here, they will be combined with a 
logical and. If this is not desirable, you must create additional data sources.  
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● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
data source. You can select these from the drop-down list or create them.   You will then 
receive detailed information regarding the status of the data source.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

Events 

 
The following events to trigger system functions are available: 
● Tag Detected 

As soon as a tag is detected by the data source, triggering is initiated. The system 
functions "SetIOPort" or "SetIOPortOnCondition" can be configured at the trigger.  
By defining a tag selector for the system function "SetIOPortOnCondition", it can be 
specified for which tag data the output is to be set.  
If several tags are recognized, triggering occurs for each tag. 

● Read Requested 
The triggering occurs at the start of each read request to the RFID module. Only the 
system function "SetIOPort" can be triggered at the trigger. 

● Read Finished 
The triggering occurs at the end of a read request to the RFID module. Only the system 
function "SetIOPort" can be triggered at the trigger. 
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I/O Ports 
The digital I/O ports of the RF670R reader can be activated or deactivated individually. Via 
the digital inputs, for example, read operations can be triggered by means of light barriers. 
Pertinent visual or acoustic feedback can be output via the digital outputs. 
The "I/O Ports" menu provides the following parameter setting options: 

General 

 
You can select an output from the table in the workplace. Its parameters can then be set via 
the Property view: 
In the input field "Inactivity Level", you can define the state of the output (High or Low) after 
switching on the reader. 
A time in ms can be entered in the "Automatic Reset Time" input field. After the reset time, a 
set output returns to the status defined via "Inactivity Level". If there is a further change in 
state during the Automatic Reset Time , the Automatic Reset Time starts from the beginning. 
The "Toggle Interval" indicates a time interval in ms. As long as a set output is activated, it 
automatically switches the status of the reader output at the beginning and end of this time 
interval.  
The parameters "Automatic Reset Time" and "Toggle Interval" can be combined with each 
other, so that the output automatically changes its state and after the given Automatic Reset 
Time returns to the level set under "Inactivity Level". 
If you additionally activate the option "Send notifications", the reader will automatically 
generate an alarm after every status change. 

Events 

 
● Level High 

As soon as an input or output is switched on, the function list configured here is triggered. 
Only the function "SetIOPort" can be used in the list of functions. 

● Level Low 
As soon as an input or output is switched on, the function list configured here is triggered. 
Only the function "SetIOPort" can be used in the list of functions. 
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Notification channels 
The notification channels pass on the RFID data of the data sources assigned to it in 
accordance with the configured triggering mechanism and the data selector.  
The "Notification channels" menu provides the following parameter setting options: 

General 

 
You can assign a name to the notification channel and assign a "Data selector" and one or 
more "Data sources" to it. You can define the data selector and the data source(s) yourself 
or select them from a drop-down list.  
If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  
Under "Enable", you can activate the notification channel.  
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Properties 
● Trigger 

 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated.  
  

● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
notification channel. You can select these from the drop-down list or create them.   You 
will then receive detailed information regarding the status of the notification channel.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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Events 

 
● Data Sent 

As soon as data supplied from the data sources are forwarded to the workplace, the 
trigger is activated. Only the system function "SetIOPort" can be set as a trigger. 
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Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. Tag data are read at specific times or the stored tag data can be 
transferred dependent on triggers. Triggers can be used with data sources (read triggers) 
and notification channels (notification channel triggers).  
The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:  

 
Trigger Description Parameter settings 
Continuous The activity is activated as soon as possible and 

operates continuously. 
The maximum permissible frequency reservation 
time must be taken into account.  
For notification channel triggers, this means that 
notifications are transmitted immediately to the 
workplace when a new event occurs. 

- 

I/O edge The activity is triggered by an external binary 
signal that specifies a transition: 0 → 1 or 1 → 0 
(rising or falling). 

The transition for the trigger ("rising" or "falling") 
must be specified.  
A digital I/O of the reader must be assigned to 
the trigger.  

I/O signal level The activity will be activated by an external binary 
signal as long as the level is Low or High. 

The trigger must be set to "Low" or "High". 
 The trigger must be assigned to a digital I/O of 
the reader. 

Application request The activity is triggered on request from the 
application (e.g. over the ALE interface, or using 
the system function "ActivateTrigger"). 

- 

Timer The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 

Events 
● Trigger fired 

As soon as a trigger is fired according to its conditions, the function list configured here is 
triggered. Only the function "SetIOPort" can be used in the list of functions. 
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3.4.2.2 RF660R 

RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 

 
You can assign a "Name" to the reader and enter the parameter settings made on the 
RF660R. This contains the "IP address" and the "Port number" of the reader as well as the 
"radio profile" used for the RFID reader.  
Note that the "Listen Before Talk" (LBT) procedure with the new ETSI standard 
EN 302 208 V1.2.1 is no longer supported for RF660R readers V1.3 or higher and the new 
XML protocol version GR_XML_3.0. The "ETSI SRD" radio profile also no longer applies. 
With the new XML messaging version GR_XML_3.0, RF660R readers V1.3 can also be 
parameterized with the "CHINA" radio profile. The UHF band ranges from 920.125 MHz to 
924.875 MHz in 250 kHz channel increments. There are 16 channels up to max. 2 W (ERP) 
and 20 channels up to max. 0.1 W (ERP). 
Further detailed information on radio profiles can be found in the RF600 System Manual, 
chapter Regulations for frequency bands".  
Select the radio profile via the dropdown menu "Type". 
The "Antenna switching" option uses "Switching mode" to switch antennas over between 
transmitting (TX) and receiving (RX) in accordance with the rotation principle. You enter the 
"Switching interval" in milliseconds.  



 RF-MANAGER Engineering System 
 3.4 Parameterize topology 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 171 

In practice, the "Switching interval" causes the system to transmit on one antenna at one 
time and to receive on the other antennas. As long as one antenna is receiving further tags, 
the system continues to transmit on the same transmission antennas until all responding 
tags have been detected. Afterwards, or if a tag does not respond, the system will activate 
another antenna as the transmission antenna. After all the antennas have transmitted at 
least once or if the settling time is too long, the reader will set frequency hopping mode 
(USA) or channel selection mode (Europe). 
In general, it is recommended that the antenna switching option is activated and all 
connected antennas are set to combined transmit and receive mode (TX/RX) to increase the 
read probability of tags.  
Antenna switching (Page 184)  
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Properties 
● Radio settings 

 
If your RFID system is using "Frequency hopping", you can specify the "Channel 
switching interval" for the reader transmission channels here in milliseconds.  
Frequency hopping is used to prevent mutual inference from the readers. If frequency 
hopping is not activated, you must permanently assign the transmission channel by 
means of an ID. If the FCC radio profile is used, however, frequency hopping cannot be 
deactivated.  
Reader with firmware version up to V1.2 and XML messaging version GR_XML_V2.0: 
When the ETSI radio profile is used, frequency hopping automatically causes the Listen 
Before Talk procedure to be used. The reader checks before transmitting whether a 
channel is reserved to prevent tag collisions. The reader only transmits when a channel is 
free. The reader can transmit on this channel for up to 4 seconds and must then either 
insert a pause of at least 100 milliseconds or hop immediately to an unreserved channel 
where it can transmit for another 4 seconds.  
When frequency hopping is activated, you also have the option of "Send only on even 
channels". This option ensures that more than one RF660R reader can be operated 
simultaneously close to each other without interference and the tag read reliability can be 
increased. This will function correctly provided that the minimum spacings of antennas 
are complied with. This option is only specified for EPC Class1 Gen2 and does not 
function with other tag types.  
 

 

NOTICE  
 

Select "Dense Interrogator" modulation mode 
If you selected the option "Send only on even channels", in the "Tag protocol" menu, 
you must select the EPC Class1 Gen2 modulation mode "Dense Interrogator". 
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● Tag protocol 

 
This is where you select the communication protocol to be used between the reader and 
tag. Depending on the tags used, you can decide between ISO 18000-6 Type B, EPC 
Class1 Gen1 or EPC Class1 Gen2. More than one communication protocol can be used.  
You can also specify the "Number of read cycles". When more than one communication 
protocol is used, the cycle time can be increased to extend the time that the reader 
searches for specific tag types taking other tag types into account.  
Example: If two tag types are used, ISO and EPC Gen2, the number of read cycles for 
each of them can be set to 1; so that 50 % of the time, the reader will search for ISO tags 
and 50 % of the time it will search for EPC Gen2 tags. If the ISO read cycles were set to 
3 and the EPC Gen2 read cycles to 1, this would mean that the reader would search for 
ISO tags for three times as long as for EPC Gen2 tags.  
You must also specify the "Read mode". For ISO 18000-6 Type B, you can choose either 
SINGLE_TAG or BULK_READ.  
In SINGLE_TAG mode, the reader is optimized so that it finds a single tag in the field as 
quickly as possible. When several tags are located in a field, in some cases, after the first 
tag has been detected by the reader, the others are ignored. 
In BULK_READ mode, the reader is set so that it finds all the tags located in the field with 
the greatest possible probability. This is the default setting. 
With EPC Class1 Gen2, you can use "Initial Q" to specify the maximum number of tags 
that can be expected to be located in the field at the same time, so that collisions can be 
prevented.  
The following formula applies: 2 Initial Q value = Number of expected tags 
It is important to note here that the length of a read cycle increases with the value of the 
Initial Q value. Normally this value is automatically set by the readers. If, however, you 
want to optimize performance, the rule of thumb is that the value must be set as low as 
possible and as high as necessary.  
In "Modulation mode", for ISO and EPC Gen2, set the data transfer rates between the 
reader and tag.  

 

NOTICE  
 

Option conditional on "Dense Interrogator" for "Send only on even channels" 
If you have selected the EPC Class1 Gen2 modulation mode "Dense Interrogator", in 
the "Radio settings" menu, you must select the option "Send only on even channels". 

 

Dense interrogator mode (Page 179)  
Tag modulation schemes (Page 179)  
See also: 
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Help system Understanding and optimizing the scanning of RFID tags 
● System 

 
You specify the "Heartbeat interval" in milliseconds here. This describes the time interval 
between the transmission of the live pings that are exchanged between the RF-
MANAGER and the reader. The live pings are used to monitor communication within the 
RFID system. Short intervals place a higher load on the RFID system but result in faster 
fault detection.  
Under "Minimum trigger duration", you can specify the minimum duration of a complete 
read cycle. The default value is set to 100 milliseconds and must not be changed for 
standard scenarios.  
Under "Asynchronous reader mode", you can change the operating mode of the reader. 
In asynchronous reader mode, the reader continuously reads tags that are resent in the 
field. Even if the same tag is always present in the field, the tag is read again and again 
and transferred to RF-MANAGER via the interface. Asynchronous reader mode 
corresponds to the "Trigger mode > Continuous" setting in the 
"SIMATIC RF660R Configuration Software". When the option is not enabled, the RF660R 
reader will only read in response to an explicit request or in accordance with the 
configured trigger conditions. 
You use "Asynchronous reader mode" when you want tags to be detected as quickly as 
possible. In this mode, the software does not provide a trigger because the reader reads 
autonomously. You will need this function for high-speed processes in which temporary 
reading pauses are not acceptable. 

 

 
 

Note 
Preconditions/settings 
 Read settings: Set the threshold for "Observed" to 0. 
 Set all the participating components, such as notification channels, to continuous 

triggering. 
 

 
 

Note 
Only one data source 
Please note that you can only parameterize one data source for your reader in 
asynchronous reader mode. Scenarios with multiple data sources are not permitted! 

 
 

NOTICE 
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Network problems and performance problems 
In asynchronous reader mode, an extremely large number of tag events are transferred 
to RF-MANAGER over the network. When a number of readers are operated in 
asynchronous mode, a narrow network bandwidth can cause problems. 
Similarly, when a large number of tag events are processed in RF-MANAGER, problems 
can occur with the computing performance of your PC. 

 

NOTICE  
 

No asynchronous reader mode in ETSI-SRD mode 
In ETSI-SRD mode, the reader should not operate in asynchronous reader mode, 
because active reading is always performed.  

 

NOTICE  
 

Time delays on reparameterization 
In asynchronous reader mode, when a number of tags are located in the field, time 
delays can occur in the "Configuration" screen object during reparameterization.  

 

Under "Protocol version", the communication protocol is displayed that is used for 
communication with the reader. The protocol is dependent on the firmware of the reader 
and can only be changed during a firmware upgrade.  
When you create new projects for the RF660R reader in RF-MANAGER 2008, the new 
XML messaging version GR_XML_3.0 is automatically set. This ensures compatibility 
with the firmware version V1.3 of the reader. The profile "Dense interrogator" is activated 
as modulation scheme. 
If you open projects created with older RF-MANAGER versions, the readers in these 
projects initially keep their old XML messaging version. An automatic conversion to 
GR_XML_3.0 does not take place. 
In these projects, however, you can manually convert the XML messaging version of 
individual RF660R readers from GR_XML_2.0 to GR_XML_3.0. The result is that all 
channels except for the 4 channels permitted in the 4-channel plan are deactivated for 
this reader in this project. Therefore, only RF660R readers with firmware version V1.3 are 
permitted. 
Below you will find an overview of the compatibility of XML messaging versions and 
RF660R reader firmware versions. 

 
 XML messaging versions 
Reader firmware version GR_XML_2.0 GR_XML_3.0 

V1.1 X - 
V1.2 Restricted functionality 1) - 
V1.3 X 2) X 

1) In this case the reader firmware's properties are compatible with firmware V1.1 (e.g. no CHINA radio profile permissible) 
2) No command parameters may be used that are no longer permitted in firmware V1.3. 
 



RF-MANAGER Engineering System  
3.4 Parameterize topology 

 SIMATIC RF-MANAGER 2008 
176 Operating Manual, 06/2010, A5E01070042-03 

 

NOTICE  
Avoidance of faults 
If you use RF-MANAGER projects with the old XML messaging version GR_XML_2.0, it is 
your responsibility to configure your project in agreement with the new ETSI standard 
EN 302 208 V1.2.1. If you do not do that, this may result in problems in the plant and you 
might infringe radio regulations. Further information on this and on the possible mixed 
operation of readers according to ETSI EN 302 208 V1.1.1 und V1.2.1 can be found in the 
RF600 System Manual. 
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● Data selector 

 
You can select the current data selector or define a new data selector here. Please note 
that the data selector chosen here will only be effective in the following cases: 
– During synchronous read procedures 
– Or for notification channels for which a data selector has not been explicitly selected. 
In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.  
For further information on using data selectors, refer to the section. 

● Alarm  

 
You can select alarms for reader status and available memory here or define them.  
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the RFID device.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed.  
RFID alarms (Page 302)  
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● Information  

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here. This information is displayed in the "Configuration" and 
"Statistics" views.      
Configuration (Page 500)  
Statistics view (Page 498)  

See also 
Overview of the RF-MANAGER architecture (Page 21) 
Parameterizing data selectors (Page 275) 
Parameterizing tag selectors (Page 271) 
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Tag modulation schemes 
You set the data transfer rate between reader and tag using tag modulation schemes. This 
parameterization is only possible in the case of tag logs ISO 18000-6 Type B and EPC 
Class1 GEN2.  

ISO 18000-6 type B tag modulation schemes 
 
Tag communication 
scheme 

Reader-tag 
data rate 

Tag-reader 
data rate 

ETSI-
compatible 

FCC-
compatible 

China-
compatible 

ETSI_SRD-
compatible 

Standard (40-40) 40 kbps 40 kbps Yes Yes Yes Yes 
Low (10-40) 10 kbps 40 kbps Yes Yes Yes No 
High (40-160) 40 kbps 160 kbps Yes Yes Yes Yes 

EPC Class1 GEN2 tag communication schemes 
 
Tag 
communication 
scheme 

Reader - 
Tag 
Tari* 

Reader-tag 
data rate 

Link 
frequency 

Tag-reader 
data rate 

ETSI-
compatible 

FCC-
compatible 

China-
compatible 

ETSI_SRD-
compatible 

Standard  
(25-1.0-40) 

25 μs 26.7 kbps 40 kHz 40 kbps Yes Yes Yes Yes 

Higher rate 
(12.5-1.0-160) 

12.5 μs 53.3 kbps 160 kHz 160 kbps No Yes No No 

Higher rate 
(12.5-1.0-80) 

12.5 μs 53.3 kbps 80 kHz 80 kbps No Yes No No 

Higher rate  
(25-0.5-160) 

25 μs 32 kbps 160 kHz 160 kbps Yes Yes Yes No 

Higher rate  
(25-1.0-160) 

25 μs 26.7 kbps 160 kHz 160 kbps Yes Yes Yes No 

Higher rate 
(12.5-0.5-160) 

12.5 μs 64 kbps 160 kHz 160 kbps No Yes No No 

Higher rate 
(6.25-1.0-160) 

6.25 μs 106.7 kbps 160 kHz 160 kbps No Yes No No 

Higher rate  
(6.25-0.5-160) 

6.25 μs 128 kbps 160 kHz 160 kbps No Yes No No 

Dense  
(25-1.0-200) 

25 μs 26.7 kbps 160 kHz 40 kbps Yes Yes Yes No 

* Tari = Duration for representation of a bit with content 0. 

Dense interrogator mode 
The dense interrogator mode for Gen 2 tags enables several readers to be operated without 
interference in close proximity to each other.  
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Dense Interrogator Environment mode (DIE mode) 
In this mode, tag readability is increased through the application of interference-reducing 
measures.  
DIE mode is only defined for Gen 2 and does not function with other tag types. 

Operating principle 
When using Gen 2 tags, a so-called Miller subcarrier permits readers located close to one 
another to use the same frequency. This is achieved by inserting a frequency offset for the 
signal carrier in the tag (by using a square-wave hybrid signal). 
In accordance with EPC Global, only the even channels are used for transmitting in this 
mode (communications path Reader → Tag); the tag response is on the odd channels as a 
result of the frequency offset. As a result of the large difference in level between the 
transmitter channels and the tag response channels, this technology provides great 
advantages for frequency reuse. However, a prerequisite is that a certain minimum distance, 
and thus minimum decoupling, is observed between the antennas of adjacent readers.  

Antenna alignment and distances 
The minimum distance required between antennas using the same frequency depends on 
the transmitter power set and the antenna alignment.  

 
Figure 3-14 Antenna distances 
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Antenna configuration Antenna alignment Minimum distance required = D 
A With backs to each other 1 m 
B Arranged laterally 2 m 
C Antennas point toward each other 5 m 

Optimizing tag reading accuracy 
A further improvement in the tag reading accuracy in an environment with a high density of 
readers can be achieved by orienting the antennas toward the respective tag field, i.e. by 
rotating them horizontally and vertically. 
In addition, the transmitter power of the readers can be reduced down to the minimum at 
which the tags are still just detected accurately.  
This greatly reduces the probability of interference.  
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Antennas 
The "Antennas" menu provides the following parameter setting options: 

General 

 
In this window, you can specify the radio properties of an antenna. You must specify the 
"Antenna port" of the reader. If an RF660R is used, Ports 1 to 4 are available. The "Name" of 
the antenna is automatically assigned.  
The maximum "Power" is limited by the radio profile used. The settings for the antenna gain 
and cable loss parameters are dependent on the hardware used.  
The "Operating mode" of each antenna must also be determined in this window: "Transmit 
only (TX)" / "Receive only (RX)" or "Transmit and receive (TX/RX)". TX/RX is only available if 
the antenna switching option was activated in the "RFID devices > General" menu. "Transmit 
only (TX)" is only available when antenna switching is deactivated.  
The rules described below are applicable regardless of the number of antennas used: 
 
Rules for antenna switching 
Antenna switching On At least two antennas must be set to TX/RX and the remaining antennas 

must be set to RX. No antennas must be set to TX. 
Antenna switching Off Only one antenna can be set to TX; at least one of the other antennas must 

be set to RX. 
No antenna can be set to TX/RX. 

Under "Enable", you can activate the antenna. Alternatively, you can enable the antenna 
later using the "Configuration" screen object at runtime.  
The advantage of the enable option is that the project can be completely configured even 
when the required hardware is not yet available.  
Antenna switching (Page 184)  
Transmit power of the antennas (Page 184)  
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Properties 
● Alarms 

 
You can assign the "RFID status alarms" and "RFID base alarms" to the antenna here. 
You can either select them from the drop-down list or create new ones. 
Under "Operational status alarms", you can assign several RFID status alarms to the 
selected antenna. You will then receive detailed information regarding the status of the 
antenna.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

● Information 

 
You can store a description of the antenna here. This information is displayed in the 
"Configuration" and "Statistics View" screen objects.      
Configuration (Page 500)  
Statistics view (Page 498)  

See also 
RFID alarms (Page 302) 
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Antenna switching 
To achieve a high probability of reading tags, the "Antenna switching" function has been 
implemented in the RF660R reader.  
During a defined time period, the reader transmits on one antenna and receives on the other.  
As long as the antenna is receiving signals from further tags, the reader continues to 
transmit on the same transmitter antenna until all responding tags have been identified. 
Subsequently, or if no tags respond, the reader activates another antenna as the transmitter 
antenna. After all the antenna have transmitted at least once and no tag has responded, or 
when the settling time is excessively long, the reader activates frequency hopping (in the 
USA) or channel selection (in Europe).  

 
Cycle 1 Cycle 2 Cycle 3 

   
Antenna 1 transmits 
Antennas 2 and 3 receive 

Antenna 2 transmits 
Antennas 1 and 3 receive 

Antenna 3 transmits 
Antennas 1 and 2 receive 

Transmit power of the antennas 
The maximum transmit power of the antennas is restricted by the radio profile used. 
Parameterization of antenna gain and cable loss depends on the hardware used.  

ETSI radio profile 
With the ETSI radio profile, the minimum transmit power is 100 mW ERP, and the maximum 
is 2000 mW ERP. The set power corresponds to the desired effective radiate power (ERP), 
and is calculated for the reader based on the entered parameters "Antenna gain" and "Cable 
loss". The RF660A-EU antenna has a gain of 7 dBi, and a 10 m long LMR-195 cable has a 
loss of 4 dB. For further antennas and cables, refer to the RF600 System Manual 

ETSI_SRD radio profile (up to reader firmware V1.2) 
With the ETSI_SRD radio profile, the minimum transmit power is 100 mW ERP, and the 
maximum is 500 mW ERP. The set power corresponds to the desired ERP and is calculated 
for the reader based on the entered parameters "Antenna gain" and "Cable loss". The 
RF660A-EU antenna has a gain of 7 dBi, and a 10 m long LMR-195 cable has a loss of 4 
dB. For further antennas and cables, refer to the RF600 System Manual 
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FCC radio profile 
With the FCC radio profile, the minimum transmit power is 100 mW, and the maximum 
transmit power is 1000 mW. The set power corresponds to the desired signal level on the 
end of the antenna cable and is calculated for the reader based on the entered parameters 
"Antenna gain" and "Cable loss". The RF660A-US antenna has a gain of 6 dBi, and a 10-m 
long LMR-195 cable has a loss of 4 dB. For further antennas and cables, refer to the RF600 
System Manual 

China radio profile 
With the China radio profile, the minimum transmit power is 100 mW ERP, and the maximum 
transmit power is 2000 mW ERP. The set power corresponds to the desired effective radiate 
power (ERP), and is calculated for the reader based on the entered parameters "Antenna 
gain" and "Cable loss". The RF660A-US antenna has a gain of 6 dBi, and a 10 m long LMR-
195 cable has a loss of 4 dB. For further antennas and cables, refer to the RF600 System 
Manual 
 

Antenna configurations 
Some basic antenna configurations and possible fields of application are shown below.  
 
Antenna configuration 1 Description/application areas 

 
 

 
 
 

This arrangement of antennas is 
appropriate when the tags to be read are 
only located on one side of the items to 
be identified, e.g. when pallets are to be 
identified on which the tags to be read 
must be on a prespecified side. 

① Tag 
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Antenna configuration 2 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
The tag is located in the field of radiation 
of two antennas; for reliable tag reading, 
the height of the tag above floor level 
must therefore be known with 
reasonable accuracy. 

① Tag 

 

 
Antenna configuration 3 Description/application areas 

 

 

Preferred application: For the 
identification of goods at loading portals. 
Similar to configuration 2, but with 
additional reading reliability when the tag 
is at an angle to the vertical. 

① Tag 
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Antenna configuration 4 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
The tag is located in the field of radiation 
of all four antennas, so the tag position 
can vary more than in configuration 2 for 
reliable tag identification. 

① Tag 

 

 
Antenna configuration 5 Description/application areas 

 
 

 
 
 

Preferred application: For the 
identification of goods at loading portals. 
Similar to configuration 4, but the 
reliability of tag identification is improved 
as a result of the four antennas at 
separate locations, so the tag position is 
not critical. 

① Tag 
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Antenna configuration 6 Description/application areas 

 
 

 
 
 

This tunnel configuration is suitable for 
conveyor belt applications. The goods 
with the tags to be read are moving 
forwards on a conveyor belt but the 
alignment of the tags relative to the 
antennas is not clearly defined. One of 
the antenna is located on the floor and 
radiates vertically upwards in the 
direction of the conveyor belt. A relatively 
high reading reliability is achieved due to 
the use of four antennas. 

① Tag 
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Specified spacing of antennas 

Specified minimum spacing of antennas 
The following diagram shows the specified minimum and maximum spacings for mounting 
antennas.  
A minimum spacing of 50 cm is necessary between the antenna and liquids or metals. 
The distance between the antenna and the floor should also be at least 50 cm. 

 
Figure 3-15 Minimum distance to the environment 

 
The distance between two antennas mounted alongside each other or one above the other 
should be at least 20 cm, but a distance of more than 50 cm is better. 
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Figure 3-16 Antennas mounted adjacently horizontally or vertically  

 
For a portal configuration, the distance between two antennas that are connected to the 
same reader is up to 3.5 m (in Europe) or 4 m (in the USA). 

 
Figure 3-17 Portal configuration, maximum distance 

 
The specified distances are recommended minimum or maximum values for configuration. 
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Tag orientation in space 
The alignment of the tag antenna to the antenna of the reader affects the reading range. For 
maximum performance and to achieve the maximum reading range, the tag antenna should 
therefore be aligned in parallel with the reader antenna:  
 
Parallel tag alignment Large reading range 

 
 
 

Maximum probability of identification of tags. 

 

 
Vertical tag alignment Minimal reading range 

 
 
 

Minimum probability of identification of tags. 
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Data sources 
Data sources read the data from logically associated antennas. The data sources pass on 
the data that are read from the antennas assigned to them.  
The "Data sources" menu provides the following parameter setting options: 

General 

 
You can assign a name to the data source using the parameter "Name". Under "Antennas", 
you can assign the antennas that are available to the data source.  
If you selected EPC Class1 Gen2 as the communication protocol between the reader and 
the tags, you must specify the session parameters for the data source. One tag can 
communicate with up to 4 data sources simultaneously, so to distinguish between these data 
sources, a unique number S0 to S3 and SL is assigned to each via the session parameters.  
Under "Enable", you can activate the data source. Alternatively, you can enable the data 
source using the "Configuration" screen object at runtime.  
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Properties 
● Read settings 

 
You specify the number of "Read cycles per trigger" here. 
Under "Maximum read duty cycle", you specify a percentage that provides information on 
the length of time for which the antenna of a reader is permitted to be switched on; this 
feature serves to reduce the radio interference. 
The "Read timeout" specifies in milliseconds how long the specified number of read cycle 
per trigger is permitted to take. When this time limit is exceeded, the read cycles are 
stopped even if the number of cycles that you specified has not been reached.  
For more detailed information and general background information, please refer to: 
Help system Getting started > Understanding and optimizing the scanning of RFID tags 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
adds a status indication for the tags to the read results.  
In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
The different statuses are described below:  
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Status Meaning Description 
The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time "Glimpsed 
timeout" has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold": 
If a stable connection exists beyond the time "Observed threshold", the status 
"Observed" is assigned to the tag. 
The rule of thumb is that "Observed threshold" should be at least twice as long as 
one complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that "Observed timeout" must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Triggers  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.  

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not entered here, the tag IDs will be supplied from all tags.  
For further information on the mode of operation of tag selectors, see  
Parameterizing tag selectors (Page 271)  

● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
data source. You can select these from the drop-down list or create them.   You will then 
receive detailed information regarding the status of the data source.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
RFID alarms (Page 302)  
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Notification channels 
The notification channels pass on the RFID data of the data sources assigned to it in 
accordance with the configured triggering mechanism and the data selector to its 
workplaces.  
The "Notification channels" menu provides the following parameter setting options: 

General 

 
You can assign a name to the notification channel and assign a "Data selector" and one or 
more "Data sources" to it. You can define the data selector and the data source(s) yourself 
or select them from a drop-down list.  
If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  
Under "Enable", you can activate the notification channel. Alternatively, you can activate the 
notification channel in the "Configuration" view at runtime.  
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Properties 
● Triggers 

 

 
 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated.  
  

● Alarm 
 

 
 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
notification channel. You can select these from the drop-down list or create them.   You 
will then receive detailed information regarding the status of the notification channel.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. Tag data are read at specific times or the stored tag data can be 
transferred dependent on triggers. Triggers can be used with data sources (read triggers) 
and notification channels (notification channel triggers).  
Triggers can also be activated using the system function "ActivateTrigger" independently of 
these settings; in addition to the triggering conditions configured for the trigger. When this 
function is used, for example, for changing the value of a variable, a trigger can be activated 
by a change in value in the PLC. Depending on the configuration, this trigger causes the 
data sources to be read.  
The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:  

 
Trigger Description Parameter settings 
Continuous The activity is activated as soon as possible and 

operates continuously. 
The maximum permissible frequency reservation 
time must be taken into account.  
For notification channel triggers, this means that 
notifications are transmitted immediately to the 
workplace when a new event occurs. 

- 

I/O edge The activity is triggered by an external binary 
signal that specifies a transition: 0 → 1 or 1 → 0 
(rising or falling). 

The transition for the trigger ("rising" or "falling") 
must be specified.  
A digital I/O of the reader must be assigned to 
the trigger.  

I/O signal level The activity will be activated by an external binary 
signal as long as the level is "Low" or "High". 

The trigger must be set to "Low" or "High". 
The trigger must be assigned to a digital I/O of 
the reader. 

Application request The activity is triggered on request from the 
application (e.g. over the ALE interface, or using 
the system function "ActivateTrigger"). 

- 

Timer The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 
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3.4.3 RF620R/RF630R/RF300 systems 

3.4.3.1 RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 
Here you can select the Reader type and assign a name to the reader. 

 

Properties 

 
Under "Properties" you can enter the parameters of the readers. 
The parameters are entered in plain text form. The parameters in the Engineering System 
are not language-dependent. The parameters and their possible values are shown below. 
Please note that not all parameters are available to all readers. 
More detailed information on the significance of the parameters can be found in the 
RF620R/RF630R Parameterization Manual, the RF300 Product Information, and the 
manuals for the individual function blocks. 
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● Parameters for RF300 readers 
 

Parameter Value range Default Description 
ComPort COM1 ... COM

xx 
COM1 Serial interface to be used for 

communication with the reader. 
Baudrate Decimal value:

19200, 57600, 
115200 

115200 Baud rate to be used for communication 
with the reader. 

CommandTimeout 1 Decimal value:
20 ... 1000 

100 Time in milliseconds in which the reader 
must process commands. 

LongCommandTimeout Decimal value:
2000 ... 10000 

3000 Time in milliseconds in which the reader 
must process long commands. 

RF300Enabled Boolean value:
true or false 

true Activates the RF300 protocol on the air 
interface (transponder), 
see MOBY manuals, parameter 
"field_ON_time" 

Iso15693Enabled Boolean value:
true or false 

false Activates the ISO15693 protocol on the air 
interface (transponder), 
see MOBY manuals, parameter 
"field_ON_time 

IsoTagType Hexadecimal 
value: 
01 ... 07 

01 Type of ISO tag used 
 01 hex = Manufacturer-independent tag
 03 hex = ISO my-d(Infineon SRF 

55V10P) 
 04 hex = ISO(Fujitsu MB89R118) 
 05 hex = ISO I-Code SLI(NXP SL2 

ICS20) 
 06 hex = ISO Tag-it HFI(Texas 

Instruments) 
 07 hex = ISO (ST LRI2K), 

see MOBY manuals, parameter 
"field_ON_time" 

WithPresence 2 Boolean value:
true or false 

false Activates presence control, 
see MOBY manuals, parameter 
"MDS_control" 

RFID AntennaPower Hexadecimal 
value: 
02 ... 08 

05 Antenna performance 
 02 hex = 0.5 W 
 03 hex = 0.75 W 
 04 hex = 1.0 W 
 05 hex = 1.25 W 
 06 hex = 1.5 W 
 07 hex = 1.75 W 
 08 hex = 2.0 W 
See MOBY manuals, parameter 
"distance_limiting" 

ResetOfLed Boolean value:
true or false 

true Activates restart of the ERR-LED, 
see MOBY manuals, parameter "option_1" 

HeartBeatInterval 1000 ... 20000 2000 Time in milliseconds in which the heartbeat 
is sent to the reader. 
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Parameter Value range Default Description 
scanning_time Hexadecimal 

value 
 

00 Expert settings for air interface, 
see MOBY manuals, parameter 
"scanning_time" 

field_ON_control Hexadecimal 
value 
 

00 Expert settings for air interface, 
see MOBY manuals, parameter 
"field_ON_control" 

1) If errors in communications or in writing data to the transponder occur sporadically, it may be 
necessary to increase the value for CommandTimeout. This is necessary if several protocols 
are simultaneously activated or if larger data amounts are written to ISO transponders (typical 
value: 300). 

2) If presence is activated (WithPresence = true), only one protocol may be activated (either 
RF300enabled or Iso15693Enabled) 

● Parameters for RF620R/RF630R readers 
 

Parameter Value range Default Description 
ComPort COM1 ... COM

xx 
COM1 Serial interface to be used for 

communication with the reader. 
Baudrate Decimal value:

19200, 57600, 
115200 

115200 Baud rate to be used for communication 
with the reader. 

CommandTimeout Decimal value:
100 ... 1000 

250 Time in milliseconds in which the reader 
must process commands. 

LongCommandTimeout Decimal value:
2000 ... 10000 

3000 Time in milliseconds in which the reader 
must process long commands. 

MultiTag 
 

Boolean value:
true or false 

false Activates MultiTag mode, 
see MOBY manuals, parameter 
"MOBY_mode" 

MaxNumberofTags Decimal value:
1 ... 40 

15 Maximum number of tags in the field that 
can be processed in parallel. 
See MOBY manuals, parameter "Multitag" 

WithPresence Boolean value:
true or false 

true Activates presence control, 
see MOBY manuals, parameter 
"MDS_control" 

Antenna01Power Hexadecimal 
value: 
00 ... 0F 

00 Performance of Antenna 01 
0 ≙ 18 dBm (65 mW)  
1 ≙ 19 dBm (80 mW) 
... 
9 ≙ 27 dBm  
A(...F) ≙ 27 dBm (500 mW) 

Antenna02Power Hexadecimal 
value: 
00 ... 0F 

00 Performance of Antenna 02 
0 ≙ 18 dBm (65 mW)  
1 ≙ 19 dBm (80 mW) 
... 
9 ≙ 27 dBm  
A(...F) ≙ 27 dBm (500 mW) 
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Parameter Value range Default Description 
RadioProfile Hexadecimal 

value: 
01 ... 05 

01 Radio profile according to EPC Global 
00 hex = no standard selected 
 01 hex = autodetect: Default profile 

depending on reader type (ETSI, FCC)
For ETSI readers: ETSI new: EU, 
EFTA, and Turkey ETSI EN 302 208 
V1.2.1 (4-channel plan) 

 02 hex = ETSI new: EU, EFTA, and 
Turkey correspond to the standard 
ETSI EN 302 208 V1.2.1 (4-channel 
plan) 

 03 hex = ETSI old: EU, EFTA, and 
Turkey correspond to the standard 
ETSI EN 302 208 V1.1.2 

 04 hex = FCC (e.g. USA, Canada) 
 05 hex = China 

Channels Hexadecimal 
value: 
00 ... 0F 

00 
(all 
channels 
on) 

Defines the active channel 
 Bit 0=865.7 MHz 
 Bit 1=866.3 MHz 
 Bit 2=866.9 MHz 
 Bit 3=867.5 MHz 
See MOBY manuals, parameter 
"field_ON_time" 

ResetofLeds Boolean value:
true or false 

true Activates restart of the ERR-LED, 
see MOBY manuals, parameter "option_1" 

HeartBeatInterval 1000 ... 20000 2000 Time in milliseconds in which the heartbeat 
is sent to the reader.  

field_ON_control Hexadecimal 
value 

02 Expert settings for air interface, 
see MOBY manuals, parameter 
"field_ON_control" 

 

 

 
 

Note 
For the RF620R/RF630R readers and all RF300 readers, the antenna performance must 
be set in the properties table. The value under the antenna tab is not relevant. 
In general, in the overview of all readers many properties are shown that are only 
relevant for the RF670R/RF660R and RF610M readers. Properties that cannot be set for 
the RF620R/RF630R and all RF300 readers are ignored. 

 

See also 
RFID device (Page 170) 
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Operating modes with serial readers 
The following operating modes are supported: 
● Single tag without presence 

Continuous cyclic reading from the RF-MANAGER takes place. 
● Single tag with presence 

Cyclic reading from the RF-MANAGER only takes place after a reader presence message 
has been received. 

● MultiTag without presence (only RF620R/RF630R) 
Continuous cyclic reading from the RF-MANAGER takes place. 

● MultiTag with presence (only RF620R/RF630R) 
Cyclic reading from the RF-MANAGER only takes place after a reader presence message 
has been received. 

In all operating modes, the RF300 readers provide 8 bytes for the tag ID. The 
RF620R/RF630R readers provide 12 bytes for the tag ID to the RF-MANAGER.  

 

 Note 
The activation of the operating mode with presence (WithPresence = true) causes 
commands to be sent only to the reader if at least one tag is in the field. 
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● Data selector 

 
You can select the current data selector or define a new data selector here. Please note 
that the data selector chosen here will only be effective in the following cases: 
– During synchronous read procedures 
– Or for notification channels for which a data selector has not been explicitly selected. 
In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.  
For further information on using data selectors, refer to the section. 

● Alarm 

 
You can select alarms for reader status and available memory here or define them.  
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the RFID device.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed.  
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● Information 

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here. This information is displayed in the "Configuration" and 
"Statistics" views.      
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3.4.3.2 Antennas 
The "Antennas" menu provides the following parameter setting options: 

General 

 
There are no setting options in the "General" dialog. The "Name" of the antenna is 
automatically assigned.  
This performance of the antenna can be set under RFID device > Properties 
> Characteristics.  

Properties 
● Information 

 
You can store a description of the antenna here. This information is displayed in the 
"Configuration" and "Statistics View" screen objects.      
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3.4.3.3 Data sources 
Data sources read the data from logically associated antennas. The data sources pass on 
the data that are read from the antennas assigned to them.  
The "Data sources" menu provides the following parameter setting options: 

General 

 
You can assign a name to the data source using the parameter "Name". Under "Antennas", 
you can assign the antennas that are available to the data source.  
Under "Enable", you can activate the data source. Alternatively, you can enable the data 
source using the "Configuration" screen object at runtime.  
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Properties 
● Read settings 

 
You specify the number of "Read cycles per trigger" here. 
The "Read timeout" specifies in milliseconds how long the specified number of read cycle 
per trigger is permitted to take. When this time limit is exceeded, the read cycles are 
stopped even if the number of cycles that you specified has not been reached.  
For more detailed information and general background information, please refer to: 
Help system Getting started > Understanding and optimizing the scanning of RFID tags 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
adds a status indication for the tags to the read results.  
In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
The different statuses are described below:  
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Status Meaning Description 
The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time "Glimpsed 
timeout" has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold": 
If a stable connection exists beyond the time "Observed threshold", the status 
"Observed" is assigned to the tag. 
The rule of thumb is that "Observed threshold" should be at least twice as long as 
one complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that "Observed timeout" must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Triggers  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.  

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not entered here, the tag IDs will be supplied from all tags.  
For further information on the mode of operation of tag selectors, see  
  

● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
data source. You can select these from the drop-down list or create them.   You will then 
receive detailed information regarding the status of the data source.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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3.4.3.4 Notification channels 
The notification channels pass on the RFID data of the data sources assigned to it in 
accordance with the configured triggering mechanism and the data selector to its 
workplaces.  
The "Notification channels" menu provides the following parameter setting options: 

General 

 
You can assign a name to the notification channel and assign a "Data selector" and one or 
more "Data sources" to it. You can define the data selector and the data source(s) yourself 
or select them from a drop-down list.  
If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  
Under "Enable", you can activate the notification channel. Alternatively, you can activate the 
notification channel in the "Configuration" view at runtime.  
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Properties 
● Trigger 

 

 
 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated.  
  

● Alarm 
 

 
 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
notification channel. You can select these from the drop-down list or create them.   You 
will then receive detailed information regarding the status of the notification channel.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read the section "Working 
with alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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3.4.3.5 Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. Tag data are read at specific times or the stored tag data can be 
transferred dependent on triggers. Triggers can be used with data sources (read triggers) 
and notification channels (notification channel triggers).  
Triggers can also be activated using the system function "ActivateTrigger" independently of 
these settings; in addition to the triggering conditions configured for the trigger. When this 
function is used, for example, for changing the value of a variable, a trigger can be activated 
by a change in value in the PLC. Depending on the configuration, this trigger causes the 
data sources to be read.  
The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:  

 
Trigger Description Parameter settings 
Continuous The activity is activated as soon as possible and 

operates continuously. 
The maximum permissible frequency reservation 
time must be taken into account.  
For notification channel triggers, this means that 
notifications are transmitted immediately to the 
workplace when a new event occurs. 

- 

Application request The activity is triggered on request from the 
application (e.g. over the ALE interface, or using 
the system function "ActivateTrigger"). 

- 

Timer The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 

3.4.3.6 Presence as virtual input 
In addition the presence is made available in the form of a virtual input (as InPort00). To be 
able to evaluate the presence in the application, this input can be addressed as a variable. 
Likewise, the input can be used to set a trigger. If a trigger of type "IO edge" or "I/O level" is 
linked to this input, the activation is dependent on presence.  
Examples: With the "IO edge" type, as soon as a tag enters the field, a single read process 
is initiated. With the "IO level" type, reading takes place as long as a tag is in the field. 
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3.4.4 Mobile reader 

3.4.4.1 RF610M 

RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 

 
You can assign a "Name" to the reader here and enter the "IP address" setting made on the 
RF610M. 

 

 Note 
Restriction of the selection of the "radio profile"  
For SIMATIC RF610M, the only radio profiles that are available are "ETSI-SRD" and "FCC".

 

Application mode 
You can set the application mode to set up the SIMATIC RF610M device for "Remote" or 
"Mobile" operating mode: 
 
Application mode "Remote" Application mode "Mobile" 
 RF610M behaves like a stationary reader 
 The acquired data is only displayed and 

transferred to RF-MANAGER 
 The acquired data cannot be modified 

 The acquired data is acknowledged before 
being transferred to RF-MANAGER. Data 
that has been incorrectly scanned can be 
deleted. 

 All the tag data from the RFID chip can also 
be displayed or edited depending on the 
configuration in the engineering system. 
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Properties 
● Display settings  

You can select the following under display settings:  

 
– Edit tag: Display or edit tag data (only available in "Mobile" application mode) 
– Scan indication: Visual indication that a read procedure is active (waves propagate in 

a circular manner) 
– Scan beep: Acoustic signal indicates that a tag or barcode has been detected 
– Scan result time: Display interval for the tag data. When this time elapses, the display 

will automatically disappear. (Only available in "Remote" application mode.) 
● Tag protocol 

 
This is where you select the communication protocol to be used between the reader and 
tag. Depending on the tags used, you can decide between ISO 18000-6 Type B or EPC 
Class1 Gen2.  
You must also specify the "Read mode". For ISO 18000-6 Type B, you can choose either 
SINGLE_TAG or BULK_READ.  
In SINGLE_TAG mode, the reader is optimized so that it finds a single tag in the field as 
quickly as possible. When several tags are located in a field, in some cases, after the first 
tag has been detected by the reader, the others are ignored. 
In BULK_READ mode, the reader is set so that it finds all the tags located in the field with 
the greatest possible probability. This is the default setting. 
With EPC Class1 Gen2, you can use "Initial Q" to specify the maximum number of tags 
that can be expected to be located in the field at the same time, so that collisions can be 
prevented.  
The following formula applies: 2 Initial Q value = Number of expected tags 
It is important to note here that the length of a read cycle increases with the value of the 
Initial Q value. Normally this value is automatically set by the readers. If, however, you 
want to optimize performance, the rule of thumb is that the value must be set as low as 
possible and as high as necessary.  
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● Data selector 

 
You can select the data selector or define new data selectors here. Please note that the 
data selector chosen here will only be effective in the following cases: 
– During synchronous read procedures 
– Or for notification channels for which a data selector has not been explicitly selected. 
In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.  
In the data selector, the boxes for the "Observed" and "Lost" events must be checked:  
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● Alarm 

 
You can select alarms for reader status and available memory here or define them.  
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the RFID device.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

● Information  

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here. This information is displayed in the "Configuration" and 
"Statistics" views.      
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Antennas 

General 
Two antennas are already defined for SIMATIC RF610M: One for RFID and one for 
barcodes. You can only set parameters for "Alarms" and "Information". 

Properties 
● Alarms 

 
You can assign the "RFID status alarms" and "RFID base alarms" to the RFID antenna 
here. You can select these from the drop-down list or create them.   For barcodes, only 
"RFID status alarms" are available. 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the antenna.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

● Information 

 
You can store a description of the antenna here. This information is displayed in the 
"Configuration" and "Statistics View" screen objects.      
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Data sources 
In SIMATIC RF610M, one data source with the associated antenna is permanently assigned 
for barcode scanning and one for RFID data scanning. 

General 

 
Under "Enable", you can activate the data source. Alternatively, you can enable the data 
source using the "Configuration" screen object at runtime.  
You can disable unused data sources here, e.g. when the SIMATIC RF610M device does 
not have a barcode scanner.  
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Properties 
● Read settings(only for RFID data source) 

 
You specify the number of "Read cycles per trigger" here. 
Under "Maximum read duty cycle", you specify a percentage that provides information on 
the length of time for which the antenna of a reader is permitted to be switched on; this 
feature serves to reduce the radio interference. 
The "Read timeout" specifies in milliseconds how long the specified number of read cycle 
per trigger is permitted to take. When this time limit is exceeded, the read cycles are 
stopped even if the number of cycles that you specified has not been reached.  
For more detailed information and general background information, please refer to: 
Help system Getting started > Understanding and optimizing the scanning of RFID tags 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
adds a status indication for the tags to the read results.  
In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
The different statuses are described below:  

 
Status Meaning Description 

The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
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Status Meaning Description 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time "Glimpsed 
timeout" has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold": 
If a stable connection exists beyond the time "Observed threshold", the status 
"Observed" is assigned to the tag. 
The rule of thumb is that "Observed threshold" should be at least twice as long as 
one complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that "Observed timeout" must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 
Help system Understanding and optimizing the scanning of RFID tags 
Only a simple status model is required for "Mobile" application mode and with barcode 
scanning in general. 
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● Trigger  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.  
Triggers have been predefined for the keys on the SIMATIC RF610M. This makes it easy 
for you to specify which key should be used to read data.  

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not specified, the tag IDs of all tags are supplied or all barcode data is 
transferred. 
If more than one tag selector is selected, they will be logically anded.  
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● Alarm 

 
Under "Operational status alarm", you can assign several RFID status alarms to the data 
source. You can select these from the drop-down list or create them.   You will then 
receive detailed information regarding the status of the data source.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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Notification channels 
The notification channels pass on the data of the data sources assigned to it in accordance 
with the configured triggering mechanism and the data selector to its workplaces.  
One notification channel is permanently specified for RFID data and one for barcode data. 
The "Notification channels" menu provides the following parameter setting options: 

General 

 
You can assign a name to the notification channel and assign a "Data selector" to it. You can 
define the data selector yourself or select them from a drop-down list.  
If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  
Under "Enable", you can activate the notification channel. Alternatively, you can activate the 
notification channel in the "Configuration" view at runtime.  
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Properties 
● Trigger 

 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated.  

● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
notification channel. You can select these from the drop-down list or create them.   You 
will then receive detailed information regarding the status of the notification channel.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read the section "Working 
with alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. Tag data are read at specific times or the stored tag data can be 
transferred dependent on triggers. Triggers can be used with data sources (read triggers) 
and notification channels (notification channel triggers).  
Triggers can also be activated using the system function "ActivateTrigger" independently of 
these settings; in addition to the triggering conditions configured for the trigger. When this 
function is used, for example, for changing the value of a variable, a trigger can be activated 
by a change in value in the PLC. Depending on the configuration, this trigger causes the 
data sources to be read.  
This is, however, only appropriate for SIMATIC RF610M when it has been established that a 
connection to RF610M is active. 
The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:  

 
Trigger Description Parameter settings 
Continuous The activity is activated as soon as possible and 

operates continuously. 
The maximum permissible frequency reservation 
time must be taken into account.  
For notification channel triggers, this means that 
notifications are transmitted immediately to the 
workplace when a new event occurs. 

- 

Application request 
(Only appropriate 
when it has been 
established that a 
connection to the 
RF610M is active.) 

The activity is triggered on request from the 
application (e.g. over the ALE interface, or using 
the system function "ActivateTrigger"). 

- 

Timer 
 

The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 

Device key The activity is performed with an operator input 
on the SIMATIC RF610M. 
 

The time condition for the trigger can be 
specified as a parameter. 
 Selection of the start/stop response 
 Response to a held down key: Scanning is 

performed as long as the key is held down 
 ReadFirst ID: Scanning is performed until 

the tag/barcode is detected. 
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Barcode unit 
When you have installed a barcode scanner in SIMATIC RF610M, the following settings in 
RF-MANAGER are also relevant:  

General 

 
● Name: 

You can enter a name for the barcode unit here. 
● Aiming duration: (0...2)  

Time for aiming. The laser generates a dot as an aid to aiming. When the time has 
elapsed, the actual scan is performed. 

● Linear security level: (1...4) 
The linear security level is set to enhance the read quality for barcodes. It is only effective 
for linear codes (e.g. Code 39).  
The higher the setting (maximum 4), the more often a barcode is read before it is 
transferred as a valid scan. 

● Bi-directional redundancy: The barcode must be successfully scanned in both directions 
(forwards and backwards) before it can be decoded.  
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Properties 
● Display settings 

 
– Transmit code ID character 

You specify the ID character here that is displayed with the selected barcode: NONE, 
AIM or SYMBOL  
If NONE is selected, an ID character is not inserted. 

– Scan data transmission format 
You specify the display format for the barcode data here. Select the possible 
formatting in a drop-down list. 
If you select a format with a prefix or suffix, you can specify their values in the 
appropriate fields. 
The relationship between barcode type, ID character and barcode data formatting is 
explained below. 

● Barcode type 

 
In a selection list, you can tick the barcode types that should be recognized by the 
scanner.  

 

 
 

Note 
The greater the number of barcode types selected, the longer the scanning procedure will 
be. 
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Relationship between barcode type, ID character and barcode data formatting 
The individual barcode types are assigned to the following ID characters: 
 
Barcode type AIM ID characters SYMBOL ID characters 
Code 39 ]A0 D 
Code 128 ]C0 D 
EAN 13 ]E0 A 
EAN 8 ]E A 
UPC A ]E000 A0 
UPC E ]E000 A0 
Codebar ]F0 C 
Code 93   
Interleaved 2 of 5   
MSI Plessey   
Discrete 2 of 5   
IATA 2 of 5   

In accordance with the barcode data formatting selected, the selected ID characters are 
always inserted in front of the barcode data. 
Output examples: 
 
Scan data transmission format ID character Barcode type Output 
data (as-is) NONE Code 39 data  
data (as-is) AIM Code 39 ]A0 data 
data <S1> SYMBOL EAN 8 A data <S1> 
<P> data AIM Codebar <P> ]F0 data 
<P> data <S1><S2> SYMBOL UPC E <P> A0 data <S1><S2> 
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3.4.4.2 RF310M 

RFID device 
The "RFID device" menu provides the following parameter setting options: 

General 

 
You can assign a "Name" to the reader here and enter the "IP address" setting made on the 
RF310M. 

Further parameters  
 
Parameter Value range Default Description 
CommandTimeout 1 Decimal value: 

20 ... 1000 
100 Time in milliseconds in which the 

reader must process commands. 
LongCommandTimeout Decimal value: 

2000 ... 10000 
3000 Time in milliseconds in which the 

reader must process long commands. 
RF300Enabled Boolean value: 

true or false 
true Activates the RF300 protocol on the 

air interface (transponder), 
see MOBY manuals, parameter 
"field_ON_time" 

Iso15693Enabled Boolean value: 
true or false 

false Activates the ISO15693 protocol on 
the air interface (transponder), 
see MOBY manuals, parameter 
"field_ON_time 
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Parameter Value range Default Description 
IsoTagType Hexadecimal 

value: 
01 ... 07 

01 Type of ISO tag used 
 01 hex = Manufacturer-

independent tag 
 03 hex = ISO my-d(Infineon SRF 

55V10P) 
 04 hex = ISO(Fujitsu MB89R118) 
 05 hex = ISO I-Code SLI(NXP SL2 

ICS20) 
 06 hex = ISO Tag-it HFI(Texas 

Instruments) 
 07 hex = ISO (ST LRI2K), 

see MOBY manuals, parameter 
"field_ON_time" 

ResetOfLed Boolean value: 
true or false 

true Activates restart of the ERR-LED, 
see MOBY manuals, parameter 
"option_1" 

scanning_time Hexadecimal 
value 
 

00 Expert settings for air interface, 
see MOBY manuals, parameter 
"scanning_time" 

field_ON_control Hexadecimal 
value 
 

00 Expert settings for air interface, 
see MOBY manuals, parameter 
"field_ON_control" 

MobileOperatingModeEnabled Boolean value 
true or false 

true Application mode "Mobile": 
 The acquired data is 

acknowledged before being 
transferred to RF-MANAGER. Data 
that has been incorrectly scanned 
can be deleted. 

 All the tag data from the RFID chip 
can also be displayed or edited 
depending on the configuration in 
the engineering system 

Application mode "Remote" 
 RF310M behaves like a stationary 

reader 
 The acquired data is only 

displayed and transferred to RF-
MANAGER 

 The acquired data cannot be 
modified 

EditTagEnabled Boolean value 
true or false 

false Edit tag: Display or edit tag data (only 
available in "Mobile" application mode)

BeepEnabled Boolean value 
true or false 

true Acoustic signal indicates that a tag or 
barcode has been detected 
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Parameter Value range Default Description 
ScanResultTime Decimal value 

0 ... 20 
3 Display interval for the tag data. When 

this time elapses, the display will 
automatically disappear. (Only 
available in "Remote" application 
mode.) 

PowerOnTimeout Decimal value 
5000 ... 60000 

20000 Time in milliseconds after which the 
reader will automatically switch off if 
there is no activity in the field. 

1) If errors in communications or in writing data to the transponder occur sporadically, it may be 
necessary to increase the value for CommandTimeout. This is necessary if several protocols are 
simultaneously activated or if larger data amounts are written to ISO transponders (typical value: 
300). 

2) If presence is activated (WithPresence = true), only one protocol may be activated (either 
RF300enabled or Iso15693Enabled) 
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● Data selector 

 
You can select the data selector or define new data selectors here. Please note that the 
data selector chosen here will only be effective in the following cases: 
– During synchronous read procedures 
– Or for notification channels for which a data selector has not been explicitly selected. 
In general, data selectors are components of notification channels and are used with the 
asynchronous read procedure.  
In the data selector, the boxes for the "Observed" and "Lost" events must be checked:  
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● Alarm 

 
You can select alarms for reader status and available memory here or define them.  
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the RFID device.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed.  

● Information  

 
You can store descriptions regarding the reader, reader location, responsible contact 
person(s) and reader role here. This information is displayed in the "Configuration" and 
"Statistics" views.      
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Antennas 

General 
For SIMATIC RF310M, only one antenna is predefined for RFID. You can only set 
parameters for "Alarms" and "Information". 

Properties 
● Alarms 

 
You can assign the "RFID status alarms" and "RFID base alarms" to the RFID antenna 
here. You can select these from the drop-down list or create them.   For barcodes, only 
"RFID status alarms" are available. 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
selected RFID device. You will then receive detailed information regarding the status of 
the antenna.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section Working with 
alarms.  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

● Information 

 
You can store a description of the antenna here. This information is displayed in the 
"Configuration" and "Statistics View" screen objects.      
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Data sources 
In SIMATIC RF310M, only one data source with the associated antenna is permanently 
assigned for RFID data scanning. 

General 

 
Under "Enable", you can activate the data source. Alternatively, you can enable the data 
source using the "Configuration" screen object at runtime.  
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Properties 
● Read settings(only for RFID data source) 

 
You specify the number of "Read cycles per trigger" here. 
Under "Maximum read duty cycle", you specify a percentage that provides information on 
the length of time for which the antenna of a reader is permitted to be switched on; this 
feature serves to reduce the radio interference. 
For more detailed information and general background information, please refer to: 
Help system Getting started > Understanding and optimizing the scanning of RFID tags 

● Smoothing 

 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
adds a status indication for the tags to the read results.  
In this window, you specify the parameters for the status indication for the tags. Here you 
can specify times that have an effect on the status transitions.  
The different statuses are described below:  
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Status Meaning Description 
The tag has this status before communication is established with the reader. Unknown Unknown 
Data selector event "Purged": 
Status "Unknown" is achieved due to "Lost timeout". 
This status is assigned to the tag when it is read for the first time. Two times are 
activated: 
"Glimpsed timeout": 
If communication is established briefly and unintentionally, when the time "Glimpsed 
timeout" has elapsed, the status changes back to "Unknown". The tag is removed 
from the tag list. This is used to remove tags that have been briefly detected in the 
boundary areas of the reader. 
The rule of thumb is that "Glimpsed timeout" should be at least twice as long as a 
complete read cycle.  
"Observed threshold": 
If a stable connection exists beyond the time "Observed threshold", the status 
"Observed" is assigned to the tag. 
The rule of thumb is that "Observed threshold" should be at least twice as long as 
one complete read cycle. 

Glimpsed Briefly detected 

Data selector event "New":  
The status "Glimpsed" was achieved from status "Unknown" for the first time. 

Observed Reliably detected An interruption in the communication that is shorter than the set time "Observed 
timeout" has no effect on the current status. This time interval can be used to 
suppress temporary interference. 
The rule of thumb is that "Observed timeout" must be twice as long as one complete 
read cycle. 
When the times of the read triggers are set longer than the "Observed timeouts", 
there is a danger that tags that remain stationary in the field will be lost.  

Lost  Lost When a tag exits the field of the reader, the status "Lost" will be assigned to it after 
the time "Observed timeout" has elapsed. If communication is established again, the 
status "Glimpsed" will be assigned again immediately. The "Unknown" status is 
activated if communication is not established before the time "Lost timeout" elapses. 
The rule of thumb is that "Lost timeout" must be at least twice as long as one 
complete read cycle. 

For more detailed information and general background information, please refer to: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Trigger  

 
You specify the read triggers here. They cause the data source to read the data from the 
tags that are located in the antenna field. You can select the triggers from the drop-down 
list or define them yourself.  
Triggers have been predefined for the keys on the SIMATIC RF310M. This makes it easy 
for you to specify which key should be used to read data.  

● Tag selectors 

 
You assign tag selectors to the data source here. You can select the selectors from the 
drop-down list or define them yourself. The data to be read and filtered is specified here. 
If a selector is not specified, the tag IDs of all tags are supplied. 
If more than one tag selector is selected, they will be logically anded.  

● Alarm 

 
Under "Operational status alarm", you can assign several RFID status alarms to the data 
source. You can select these from the drop-down list or create them.   You will then 
receive detailed information regarding the status of the data source.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read section "Working with 
alarms".  
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Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 

Notification channels 
The notification channels pass on the data of the data sources assigned to it in accordance 
with the configured triggering mechanism and the data selector to its workplaces.  
One notification channel is permanently specified for RFID data. 
The "Notification channels" menu provides the following parameter setting options: 

General 

 
You can assign a name to the notification channel and assign a "Data selector" to it. You can 
define the data selector yourself or select them from a drop-down list.  
If a data selector is not defined for the notification channel, the data selector will 
automatically be used that was defined as current in the "Data selectors" submenu on the 
RFID device.  
Under "Enable", you can activate the notification channel. Alternatively, you can activate the 
notification channel in the "Configuration" view at runtime.  
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Properties 
● Trigger 

 
You can specify here whether the events received from the data sources should be 
transmitted continuously or whether they should be passed on dependent on the 
notification channel trigger. You can select these triggers from the drop-down list or 
create them.   When you define the triggers, you can also specify when they will be 
activated.  

● Alarm 

 
Under "Operational status alarm", you can assign more than one RFID status alarm to the 
notification channel. You can select these from the drop-down list or create them.   You 
will then receive detailed information regarding the status of the notification channel.  
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read the section "Working 
with alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
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Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. Tag data are read at specific times or the stored tag data can be 
transferred dependent on triggers. Triggers can be used with data sources (read triggers) 
and notification channels (notification channel triggers).  
Triggers can also be activated using the system function "ActivateTrigger" independently of 
these settings; in addition to the triggering conditions configured for the trigger. When this 
function is used, for example, for changing the value of a variable, a trigger can be activated 
by a change in value in the PLC. Depending on the configuration, this trigger causes the 
data sources to be read.  
This is, however, only appropriate for SIMATIC RF310M when it has been established that a 
connection to RF310M is active. 
The "Trigger" menu provides the following parameter setting options: 

General 

 
You can specify the trigger "Type" here and set the following parameters:  

 
Trigger Description Parameter settings 
Continuous The activity is activated as soon as possible and 

operates continuously. 
The maximum permissible frequency reservation 
time must be taken into account.  
For notification channel triggers, this means that 
notifications are transmitted immediately to the 
workplace when a new event occurs. 

- 

Application request 
(Only appropriate 
when it has been 
established that a 
connection to the 
RF310M is active.) 

The activity is triggered on request from the 
application (e.g. over the ALE interface, or using 
the system function "ActivateTrigger"). 

- 

Timer 
 

The activity is triggered in accordance with 
specified time intervals.  

The time ("Timer") between the triggers must 
be specified in milliseconds. 

Device key The activity is performed with an operator input 
on the SIMATIC RF310M. 
 

The time condition for the trigger can be 
specified as a parameter. 
 Selection of the start/stop response 
 Response to a held down key: Scanning is 

performed as long as the key is held down 
 ReadFirst ID: Scanning is performed until 

the tag/barcode is detected. 
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3.4.5 Editor "All RFID devices" 
The editor "All RFID devices" in the project tree offers you the following functions with regard 
to the properties of your RFID devices: 

 

Display parameters  
In the overview table, you can check the properties of all configured RFID devices at once. 
The tabs "RFID devices", "Antennas", "Sources", "I/O Ports", "Notification channels", 
"Trigger", "Barcode unit" are provided for this purpose.  
In the table header of the individual tab sheet, you can also hide or show additional 
properties of the components. Right-click on the header line and activate or deactivate the 
tick for the properties.  

Editing the overview table  
Using the table editor, you can change values in the table quickly and easily. Click the cell 
whose value you want to change, delete the old value and enter the changed parameter.  
You can also transfer any value to other lines of the same column easily: 
1. Move the mouse pointer to the bottom right-hand corner of a cell for this purpose. 
2. Click the right mouse button and hold the button down. 
3. Drag the mouse downwards over the cells of your column that should receive the same 

value as the original cell. 
4. Now release the mouse button. 

You have now transferred the original value to other cells. 
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Multiple selection in the overview table  
In the overview table, you can make changes to several RFID devices, antennas, data 
sources, I/O ports, notification channels, triggers or barcode units simultaneously. 
In the relevant tab sheets, you can highlight several RFID devices or components and 
change their settings in the property view: The same settings will then be assigned to the 
highlighted RFID devices. 

 
Multiple selection 
1. Select the tab sheet in which you want to make changes to the RFID device or 

components. 
2. Use the mouse to click the left-hand column for the respective RFID device or component 

to highlight the line. To add further lines, hold down the <Ctrl> button and click the lines 
that you want to add using the left mouse button. 
As an alternative, you can also highlight blocks of lines. After you have highlighted a line, 
hold the <Shift> key down and mark the required lines using the left mouse button. 

3. In the property view, you can now change the required parameters for all highlighted lines 
simultaneously. 
The selection is retained on switching to a different properties area. 
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3.4.6 Parameterizing workplaces 
You can create RF-MANAGER workplaces In the "Workplaces" submenu. These represent 
containers for logically related data sources and notification channels and they are 
represented in the abstract for the higher-level systems.. One workplace is assigned to one 
or more ALE connections for communication with the enterprise system. 

 

Procedure 
Right-click on "Topology > Workplaces" in the project view. Select the option "Add 
workplace". The editor for workplaces opens. 
Alternatively, you can double-click "Topology > Workplaces" with the left mouse button. In 
the table, you can then create a new workplace in the next empty line.  
The workplace can be edited in the property view.  

Workplaces 
The "Workplaces" menu provides the following parameter setting options: 
General 
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● Asynchronous data access 

 
You can parameterize asynchronous data access here. This is the most common read 
procedure. The asynchronously transferred data of the notification channels are transferred 
from the workplace to its ALE connection(s). You then have to specify the appropriate RFID 
devices with the associated notification channels. Select the RFID devices and notification 
channels whose read data you want to make available to the workplace and the associated 
ALE connection. You can select these from the drop-down list or create them.    
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Properties 
● Synchronous data access  

 
You can parameterize synchronous data access here. You specify the RFID devices and 
the data sources that they provide whose data is requested by the workplace when 
required. You can select the RFID devices and the associated data sources from the 
drop-down list or create them.    
You can also specify the "Poll cycle" in milliseconds here. This is in fact a trigger that 
determines how often the associated data sources are scanned. After one poll cycle has 
ended, another cycle is not triggered until all the assigned data sources have been 
scanned. Otherwise, the next poll cycle is skipped. The rule of thumb for parameterizing 
the poll cycle is that it should be longer than the sum of the read cycles for all data 
sources.  

 

 
 

Note 
Preconditions for writing via system functions and ALE functions 
Parameterization of synchronous data access is the precondition for writing via system 
functions and ALE functions, such as WriteTagId".  

 

 
 

Note 
Standard workplace 
RF-MANAGER automatically creates a standard workplace to which all data sources and 
notification channels are assigned that are not explicitly assigned to other workplaces. 
The standard workplace is always assigned to the standard ALE connection and cannot 
be deleted. 
You can however assign all data sources and notification channels of the standard 
workplace to a configured workplace. Then, their connection to the standard workplace is 
removed. 

 

 
 

Note 
Assignment of data sources and notification channels to workplaces 
One data source or notification channel can be assigned to any number of workplaces. 
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3.5 Parameterize communication 

3.5.1 Introduction 
Under the item "Communication" of the project tree, you can set the basic parameters for 
communication relationships in your RFID system. You can create RFID data links via which 
RFID data can be provided for evaluations. You can define variables for transferring data 
and cycles for recurring project procedures. 
  
The parameters are set in the following stages: 
● Communication 

– RFID data links 
– Variables 
– Cycles 

 

 
 

Note 
Variables / cycles 
For information about handling variables and cycles, refer to the chapter Working with 
variables or Working with variables > Working with cycles. 
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3.5.2 Parameterizing an RFID data link 
You set up the supply of RFID data in the submenu "RFID data links". The read RFID data is 
supplied in variables. This ensures that the data can be reliably evaluated in a PLC or with 
VB scripting in RF-MANAGER. The PLC can then trigger appropriate actions, for example, in 
production in accordance with the evaluation results. Through the use of variables, the data 
can be displayed in output fields in parallel. 

 
① Project view 
② Workplace 
③ Property view 

Procedure 
Right-click on "Communication > RFID data links" in the project view. Select the option "Add 
RFID data link". A new RFID data link appears in the workplace that you can edit in the 
property view. 
Alternatively, you can use the left mouse button to double-click on "Communication / RFID 
data links" to open the workplace for ALE connections. By double-clicking the next empty 
table line with the left mouse button, you can create a new RFID data link that you can edit in 
the property view.  
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RFID data links 
The "RFID data links" menu provides the following parameter setting options: 
General 

 
You can specify the name of the RFID data link here and determine the type of data link. 
You can specify where the RFID data originate from: From a workplace, an RFID device or a 
data source. Multiple selections are possible for every type. 
Under "Variable", you specify which RFID data is supplied in which variable: 
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Field Variable 
ID The current tag ID as a string variable 

The event type for the above tag ID  
Variable of type STRING "New" 

"Glimpsed" 
"Observed" 
"Lost" 
"Purged" 
"Unknown" 
"Read" 

Event type 

Variable of type VALUE 1 = "New" 
2 = "Glimpsed" 
3 = "Observed" 
4 = "Lost" 
5 = "Purged" 
6 = "Unknown" 
7 = "Read" 

Date/time The acquisition time of the tag as a string variable or 
alternatively the acquisition time of the tag as a date/time variable 
e.g. 10/22/2007 12:45:11:312 AM 1) or 
alternatively in UTC e.g. 2007-10-22T12:45:11.312+00:00 

Workplace The name of the workplace via which the tag was read as a string variable 
Reader The name of the reader that read the tag as a string variable 
Data source The name of the data source where the tag was read as a string variable 
Antenna As string (Antenna 01 ... Antenna 04) or  

value (1 ...4) 
RSSI value As value 0 ... 255 (is only provided by RF670R) 
1) The display is dependent on the selected runtime language and the settings in the control panel. 

Internal and external variables can be used as variables. 
If you do not select any variable in a field, this is permitted and data is not supplied in this 
case.  

 

 Note 
For performance reasons, you must only activate the fields that are actually required for 
evaluation. 

 

Data is usually supplied from a large number of tags over the RFID data link. The supply of 
data and processing of the supplied data must therefore be coordinated. Two coordination 
techniques are available: 
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● Coordination via an acknowledgement variable 
To ensure reliable synchronization between the supply and evaluation of data, you should 
use coordination by means of an acknowledgement variable. 
After selecting this method, you must assign an acknowledgement variable. The 
acknowledgement variable must be of the "BOOL" type. After it has been enabled, 
synchronization takes place between the supply of data and confirmation of evaluation 
via the acknowledgement variable. 

● Coordination via a delay time 
You should use coordination via a delay time when 
– Faster processing of the RFID data is necessary. The RFID data link does not have to 

wait for the acknowledgement variables to be reset before new data can be written to 
the output variables. The polling time for updating the acknowledgement variables is 
omitted. 

– The cycle time is known. This is required by the PLC so that written RFID data can be 
completely processed. It is only then possible to set an appropriate value for the delay 
time. This ensures that the previous data is not overwritten by new data and no 
inconsistencies in the data can arise. 

After selecting this method, you can adjust the preset time value to your requirements. 
You can also assign a variable here. Following activation, the supply of data and its 
evaluation are coordinated via the set delay time and the optionally assigned variable. 

For additional information, see Section . 
Under certain conditions for a system and procedure, a coordination procedure can be 
omitted. 
You can use the "Enable" checkbox to specify whether the RFID data link should be started 
automatically at runtime. This check box is not selected in the default state. Starting/stopping 
is possible in the runtime system by executing the system function "SetRfidDataLinkStatus".  
  

 

 Note 
A number of simultaneously active RFID data links will have an adverse effect on runtime 
system performance. Only enable those RFID data links in the runtime system that are 
actually required. 

 

 Note 
Data consistency and coordination 
During parameterization, ensure that the same variables or destination memory in the PLC 
are not used by more than one RFID data link. Otherwise data consistency and error-free 
coordination cannot be assured. 

 

Properties 
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● Tag fields 

 
You can specify further data here that should be supplied in variables. Through tag 
selectors, select the tag fields whose values you require. String variables are permitted to 
be used as variables.  
The tag selectors must be assigned to at least one data source used here.  
The data can be supplied in internal or external variables. All the selection possibilities 
and notes described under General above also apply here. The coordination procedure 
described above is also used. 

● Event filter 

 
You can define the event filter here which in the case of a match the read RFID data 
events will be supplied in the variables. It is possible, for example, to only supply RFID 
data events with the "Observed" status. All other statuses are discarded. This can be 
used to reduce the data volume for evaluation to achieve higher performance.  

 

 
 

Note 
At runtime, only those events can be written to the variables that have been actually 
generated. The settings for the associated data selectors are decisive here.  
Example: For all "Observed" events in Workplace_1, RFID data should be supplied. 
Workplace_1 has one notification channel with a data selector. The event "Observed" 
must therefore also be selected for this data selector. 

 



RF-MANAGER Engineering System  
3.5 Parameterize communication 

 SIMATIC RF-MANAGER 2008 
254 Operating Manual, 06/2010, A5E01070042-03 

● System 

 
– You specify the maximum number of entries here for the internal buffer that must be 

buffered for serial processing. This is set to 100 entries by default; the maximum 
number is 10,000. 

– You can specify the output format for date/time. 
– You can specify the output format for the tag ID. 

The available options are as follows: 
 
Format Formatting Example of output format 

with complete prefix 
(full) 

urn:epc:raw:96.x307427D58B0D47C000000190 

with abbreviated prefix 
(prefixed) 

96.x307427D58B0D47C000000190 

Raw hex 

without prefix (pure) 307427D58B0D47C000000190 
with complete prefix 
(full) 

urn:epc:raw:96.14995703977968923535281750416 

with abbreviated prefix 
(prefixed) 

96.14995703977968923535281750416 

Raw decimal 

without prefix (pure) 14995703977968923535281750416 
with complete prefix 
(full) 

urn:epc:id:sgtin:0652642.800031.400 

with abbreviated prefix 
(prefixed) 

sgtin:0652642.800031.400 

EPC format 

without prefix (pure) 0652642.800031.400 
with complete prefix 
(full) 

urn:epc:tag:sgtin-96:3.0652642.800031.400 

with abbreviated prefix 
(prefixed) 

sgtin-96:3.0652642.800031.400 

Tag format 

without prefix (pure) 3.0652642.800031.400 
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3.5.3 Functionality of RFID data links at runtime 

Introduction 
In the runtime system, the RFID data link registers with the selected workplaces, readers or 
data sources and receives the RFID data read there from this point onwards.  

Function method 
With acknowledgement variable 

 

 Note 
No exchange of data over the RFID data link 
After starting the runtime system, set the selected acknowledgement variable to "0", e.g. with 
the start value for the variable. There will otherwise be no exchange of data over the RFID 
data link. 

 

The RFID data link checks whether the supplied data matches one of the parameterized 
event types. If so, the data will be stored in the internal buffer first. 
Before the values are written to the output variables, the RFID data link checks whether the 
value of the acknowledgement variable is set to FALSE (i.e. "0"). If this is the case, the 
oldest values from the internal buffer will be written to the configured output variables. The 
acknowledgement variable is then set to TRUE (i.e. "1"). This signals that all the values have 
been written and evaluation can start:  
● The PLC reads the data from the variables and evaluates them in the user program. 
● If the data is to be evaluated using a VB script, it is recommended that the script is 

started when the acknowledgement variables are set. You can use the event trigger 
"Value change" of the acknowledgement variables for this purpose. 

After the data has been read, the PLC or script sets the acknowledgement variable to 
FALSE ("0").  
In the diagram below, this procedure is depicted graphically based on the example of the 
PLC. 
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Figure 3-18 Sequence diagram for RFID data link with acknowledgement variable 

The RFID data link then checks cyclically whether the acknowledgement variable has been 
reset. Further values that are available in the buffer will not be written to the output variables 
until it has been reset.  
If new RFID data is supplied in the meantime, this will be buffered until the buffer is full. If the 
buffer overflows, an appropriate system alarm will be output.  

 

 Note 
You can prevent a buffer overflow by increasing the maximum number of buffer entries. 
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With delay time 
The RFID data link checks whether the supplied data matches one of the parameterized 
event types. If so, the data will be stored in the internal buffer first. 
Before the values are written to the output variables, the RFID data link checks whether the 
delay time has elapsed since the last write. If this is the case, the oldest values from the 
internal buffer will be written to the configured output variables. If a variable has been 
assigned, the RFID data link will then set the variable to TRUE ("1").  
The PLC reads the data from the output variables and evaluates them in the user program. if 
a variable has also been assigned, the PLC can check whether this is set to TRUE ("1"). 
This ensures that the data has been completely written. 
After the data has been read, the PLC sets the variable to FALSE ("0").  
In the diagram below, this procedure is depicted graphically. 

 
Figure 3-19 Sequence diagram for RFID data link with delay time 

The RFID data link then checks cyclically whether the delay time has elapsed. Further 
values that are available in the buffer will not be written to the output variables until it has 
been reset.  
If new RFID data is supplied in the meantime, this will be buffered until the buffer is full. If the 
buffer overflows, an appropriate system alarm will be output.  

 

 Note 
You can prevent a buffer overflow by increasing the maximum number of buffer entries. 
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Without coordination procedure 
If you have not configured a coordination procedure, newly arriving RFID data is directly 
transferred to the output variables.  
This is only appropriate when the system procedures ensure that the next RFID data will 
only arrive after the evaluation has definitely been completed. 

3.6 Parameterizing an enterprise system 
In the "Enterprise System" branch of the project tree, you can specify the ALE connections 
between the RF-MANAGER and the enterprise system. You can also determine which 
selectors sort the occurring RFID data communication and how the data records allowed to 
pass through should be grouped for the report to the ALE client.  
Overview of the RF-MANAGER architecture (Page 21)  

 

 Note 
Basic information 
Basic information about the EPCglobal Application Level Events (ALE) Specification can be 
downloaded from the EPCglobal site atwww.epcglobalinc.org  

 

The enterprise system is parameterized in the following stages: 
● ALE connections 
● ALE selectors 
● ALE groups 

See also 
EPCglobal site (http://www.epcglobalinc.org/home) 

http://www.epcglobalinc.org/home�
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3.6.1 Parameterize ALE connections 
In the "ALE connections" submenu, you can create and parameterize the Application Level 
Events connections. This allows you to transfer RFID data from RF-MANAGER to a higher-
level enterprise system and to receive alarms in the enterprise system.  

 
The ALE connection provides a standardized format for transferring collected and filtered 
RFID data. This is performed independently of the origins and method of processing of the 
RFID data. 
The core of ALE connections is the report into which the RFID data is incorporated. Clients 
can scan the report data either synchronously (direct approach) or asynchronously 
(logon/logoff). For this reason, you also have to specify for example the read procedure and 
the report cycles in this menu.  
RFID alarm events can also be sent to the enterprise system over the ALE connection. 
Abstraction of the hardware, as implemented by the ALE connection, means that the ALE 
clients do not require detailed knowledge of the RFID system.  
You will find detailed information on the functionality and scope of the ALE interface or the 
ALE client in the ALE+Function Manual in the section "ALE+Client Example Application". 

Procedure 
Click in the project view with the right mouse button on "Enterprise system > ALE 
connections". Select the item "Add ALE connection". A new ALE connection appears in the 
workplace that you can edit in the property view. 
Alternatively, you can use the left mouse button to double-click on "Enterprise system / ALE 
connections" to open the workplace for ALE connections. By double-clicking the next empty 
table line with the left mouse button, you can create a new ALE connection that you can edit 
in the property view.  
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ALE connections 
The "ALE connections" menu provides the following parameter setting options: 
General 

 
You specify the name of the ALE connection and an address here. Under "Outgoing" you 
specify the output "Port" and the "Path" (URL) that the client of the enterprise system should 
use to connect to the RF-MANAGER. These settings are relevant for both the synchronous 
and asynchronous read procedures for RFID data and for providing the alarms of the RFID 
system.  
You can also specify the "Workplaces" that are scanned by the ALE connection.  
Under "Activate", you can activate the ALE connection. Alternatively, you can activate the 
ALE connection in the "Configuration" view at runtime.  
Parameterizing workplaces (Page 245)  

 

 Note 
Assigning addresses to more than one ALE connection 
When you create more than one ALE connection, they must differ on the basis of either the 
address or port number. 

 

 Note 
Standard ALE connection 
The application automatically creates a standard ALE connection to which all workplaces are 
assigned that are not explicitly assigned to other ALE connections. A standard ALE 
connection exists because there would otherwise be components in the system that would 
have no connection to an enterprise system and their data could therefore not be accessed. 
You can, however, assign a new ALE connection to all workplaces of the standard ALE 
connection. Then, their connection to the standard ALE connection is removed.  
The standard workplace is, however, always assigned to the standard ALE connection and 
cannot be deleted. 

 

Properties 
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● ALE selector 

 
You assign selectors to the ALE connection here. You can select these from the drop-
down list or create them.   If you do not assign a selector to the connection, all incoming 
data records will be passed on.  
Parameterizing ALE selectors (Page 265)  

● ALE group 

 
The data records passed on by the ALE selectors can be combined into groups here. You 
can use groups to arrange the data records in accordance with specific criteria and to 
increase the clarity of the information. You can select the groups from the drop-down list 
or create them.    
Parameterizing ALE groups (Page 268)  

● ALE report 

 
You can parameterize the notification procedure of the ALE connection here. These 
settings are relevant for both the synchronous and asynchronous read procedures. 
You can specify under "Type" whether all the tags already scanned by the reader 
("Current tags") should be reported or only the newly arrived tags ("Additions") or only the 
tags that are no longer detected by the reader ("Deletions").  
Under "Tag format" you specify the formats in which the tag IDs are stored in the report 
and the number of EPCs in a group ("Count").  
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The output format of the ID is specified under "Tag format". 
The available options are as follows: 

 
Format Formatting Example of output format 
EPC format With complete prefix urn:epc:id:sgtin:0652642.800031.400 
Tag format With complete prefix urn:epc:tag:sgtin-96:3.0652642.800031.400 
Raw hex With complete prefix urn:epc:raw:96.x307427D58B0D47C000000190 
Raw decimal With complete prefix urn:epc:raw:96.14995703977968923535281750416 
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● Cycles 

 
You specify the report cycles here. These settings are relevant for both the synchronous 
and asynchronous read procedures. 
You can specify the type of start cycle - "Start immediate"or enter a "Repeat period" in 
milliseconds. 
There are three ways to specify the stop cycle: Using "Report immediate", "Duration" or 
"Stable set interval".  
When "Duration" is selected, you can define a period during which the report is open and 
therefore data can flow into it. It must be taken into account that the interval defined here 
must be at least as long as the longest "Read timeout" parameterized under "Data 
sources".  
When "Stable set interval" is selected, you can define an interval that on elapsing will 
cause the report to close if no new events have occurred.  
If you specified a "Repeat period" for the start cycle, this period must be longer than a 
period selected under "Stable set interval" or "Duration". 
Finally, under "Report cycle options", you can specify whether reports should be sent 
when there are no new events ("Send empty reports") and whether reports should only be 
sent if a new event occurs ("Report only on change").  

 

 
 

Note 
Report cycle parameterization 
The parameter settings for the report cycle affect the time interval to be parameterized 
under "Workplaces" during which the ALE connection can scan its workplaces 
("Acquisition cycle").  
Example: If you selected "Start immediate" and a time of 200 milliseconds was set under 
"Duration", a second scan will be performed with synchronous data access and an 
acquisition cycle of 100 milliseconds. 
Parameterizing workplaces (Page 245)  

 

See also: 
Help system Understanding and optimizing the scanning of RFID tags 
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● Alarm 

 
You can parameterize sections of the alarm system here. Alarms can be defined here 
under "RFID edge alarm" that provide information about the spare memory space ("Free 
memory"), and about any interruption of the ALE connection ("Connection interrupt 
alarm").  
Under "RFID status alarm", you can define alarms that output connection information 
("Operational status alarm"). You can assign more than one RFID status alarm to an ALE 
connection here. You can select all these alarms from the drop-down list or create them.   
If you select the "Enable" option, changes in operational status will be monitored. You can 
specify the change that triggers one of the RFID status alarms selected here when 
configuring the individual alarms. For further details, please read the section "Working 
with alarms".  
Under "Suppress interval", you can specify the length of time that multiple alarms or 
alarms triggered at short intervals should be suppressed. 
 
RFID alarms (Page 302)  
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3.6.2 Parameterizing ALE selectors 
In the "ALE selectors" submenu, by specifying the EPC type to be used, you can create 
selectors that limit the data flow from RF-MANAGER to an enterprise system. ALE selectors 
can only sort EPC data; filtering of the freely parameterizable user data is not possible. 

 
 

 Note 
Filtering of ISO data is not supported 
Due to the structure of ISO 18000-6B tags, filtering of ISO data through ALE selectors is not 
possible. 

 

Procedure 
Click in the project view with the right mouse button on "Enterprise system / ALE selectors". 
Select the option "Add ALE selector". A new editor for the ALE selector appears in the 
workplace. 
Alternatively, you can also use the left mouse button to double-click "Enterprise system / 
ALE selectors". You can then create a new editor for ALE selectors in the next empty line in 
the workplace. 
The ALE selector can be edited in the property view.  
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ALE selectors 
The "ALE selectors" menu provides the following parameter setting options: 
General 

 
You can assign a name to the ALE selector here and select the EPC type used. The ALE 
selector is based on the EPC structure in accordance with the type used - this results in the 
provided parameters that correspond to the individual EPC data fields.  
 
EPC type Data fields 
GID-96 General manager number, object class, serial number 
SGTIN-64 ID, company prefix, reference to the element, serial number 
SGTIN-96 ID, company prefix, reference to the element, serial number 
SSCC-64 ID, company prefix, reference series 
SSCC-96 ID, company prefix, reference series 
SGLN-64 ID, company prefix, site reference 
SGLN-96 ID, company prefix, site reference 
GRAI-64 ID, company prefix, stock type, serial number 
GRAI-96 ID, company prefix, stock type, serial number 
GIAI-64 ID, company prefix, individual stock reference 
GIAI-96 ID, company prefix, individual stock reference 
DoD-96 ID, government managed identifier, serial number 
DoD-64 ID, government managed identifier, serial number 

 
 

 Note 
Further information 
Refer to the document EPCglobal Tag Data Standards for further information about the 
structure of the individual EPC types. This can be downloaded from the EPCglobal site 
www.epcglobalinc.org . 

 

You can now filter the contents of these fields according to the following criteria: 
● "Any": The EPC data field can have any value 
● "Number": The EPC data field must have a specific value assigned to it 
● "Range" The value of the EPC data field must lie within an assigned range of values 
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If the "Inclusive" option is activated, all the tags are supplied that correspond to the 
parameterized filtering criteria. If this option is not activated ("Exclusive"), all the tags are 
supplied that do not correspond to the parameterized filtering criteria.  
Example of the structure of a GID 96 bit code 

 
● ID: identifies the subsequent EPC number identifier or length, type, structure or version of 

the EPC 
● General manager number: identifies the company/corporation 
● Object class: corresponds to the article number 
● Serial number: consecutive number of the article 
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3.6.3 Parameterizing ALE groups 
You can create EPC groups in the submenu "ALE groups" by determining the EPC type 
used. They determine how the data records that have passed through the filter should be 
grouped for the report to the ALE client. ALE groups therefore support structuring of the data 
in accordance with requirements. 
 

 
 

Procedure 
Click in the project view with the right mouse button on "Enterprise system / ALE groups". 
Select the option "Add ALE group". A new table for the ALE group appears in the workplace. 
You can edit this in the properties dialog box. 
Alternatively, you can use the left mouse button to double-click on "Enterprise system / ALE 
groups" to open a new tab for the ALE group in the workplace. You can create a new group 
here by double-clicking an empty line of the table with the left mouse button here. You can 
edit it in the properties dialog box.  
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ALE groups 
The "ALE groups" menu provides the following parameter setting options: 
General 

 
You can assign a name to the ALE group here and select the EPC type used. The ALE 
group is based on the EPC structure in accordance with the type used - this results in the 
provided parameters that correspond to the individual EPC data fields.  
 
EPC type Data fields 
GID-96 General manager number, object class, serial number 
SGTIN-64 ID, company prefix, reference to the element, serial number 
SGTIN-96 ID, company prefix, reference to the element, serial number 
SSCC-64 ID, company prefix, reference series 
SSCC-96 ID, company prefix, reference series 
SGLN-64 ID, company prefix, site reference 
SGLN-96 ID, company prefix, site reference 
GRAI-64 ID, company prefix, stock type, serial number 
GRAI-96 ID, company prefix, stock type, serial number 
GIAI-64 ID, company prefix, individual stock reference 
GIAI-96 ID, company prefix, individual stock reference 
DoD-96 ID, government managed identifier, serial number 
DoD-64 ID, government managed identifier, serial number 

 
 

 Note 
Additional information 
Refer to the document EPCglobal Tag Data Standards Version 1.1 Rev.1.27 for additional 
information about the structure of the individual EPC types. 

 

Under "Group by value", you can allow groups to be created automatically for each different 
value.  
Alternatively, you can create ALE groups under "Filter" using the above-mentioned data 
fields. Available selection criteria:  
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● "Type - Any": Regardless of its value, the EPC data field belongs to the ALE group 
● "Type - Number": The EPC data field must have a specific value in order to belong to the 

ALE group 
● "Type - Value range": The EPC data field must have an assigned value range in order to 

belong to the ALE group 
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3.7 Parameterizing selectors 
In the "Selectors" section of the project tree, you can set basic parameters for the selectors 
that you are using in your RFID system. You can define selectors for controlling tag 
acquisition by the reader, to reduce the amount of data in the screens and to reduce the 
volume of information flowing through the notification channels 
Overview of the RF-MANAGER architecture (Page 21)  
The filters are parameterized in the following stages: 
● Tag selectors 
● Display selectors 
● Data selectors 

3.7.1 Parameterizing tag selectors 
In the "Tag selectors" submenu, you can define mechanisms that use HEX character strings 
to control the detection of tags by the reader. Tag selectors are based on the EPC data and 
on the freely parameterizable user data. Tag selectors are components of data sources. 

 
In combination with tag fields, tag selectors determine which data are read. When the read 
data are filtered, tag selectors determine which tags are passed on and which are rejected. 
You can use the tag fields to filter on the basis of the values of the EPC components. For 
this purpose, you must select one of the predefined and unchangeable tag fields.  
If you want to filter on the basis of freely definable user data, new tag fields must be created 
for this purpose. 
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Procedure 
Click in the project view with the right mouse button on "Selectors > Tag selectors". Select 
the option "Add tag selector". A new table for the tag selector appears in the working area. 
You can edit this in the property view. 
Alternatively, you can use the left mouse button to double-click on "Selectors > Tag 
selectors" to open a new tab for tag selectors in the workplace. You can create a new 
selector here by double-clicking an empty line of the table with the left mouse button here. 
You can edit it in the property view.  

Tag selectors 
The "Tag selectors" menu provides the following parameter setting options: 
General 

 
You can assign a name to the selector under "General".  
If you want to filter on the basis of "EPC components", select a "Predefined tag field" 
("AccessPassword", "KillPassword" or "TagID").  
If you want to filter on the basis of freely definable user data, select the option "User-defined 
tag field". Specify a name under "Tag field name". You can assign an address to the memory 
bank under "Memory bank". The "Offset" parameter supplies the start address offset within 
the memory bank in bits. Finally, enter the length of the tag field in bits in the "Length" 
parameter.  
Regardless of the type of filtering, the following applies: You must enter a HEX character 
string under "Mask" that specifies the bit positions that are applicable to filtering with regard 
to the tag fields used. "Value" defines a HEX character string that specifies the bit values for 
the bit positions.  
Example  
 
Contents of the freely parameterizable tag 
field 

1 2 3 4 5 6 

Mask 0 F F F 0 0 

Value 0 2 3 4 0 0 
If the "Inclusive filter" option is activated, all the tags are supplied that correspond to the 
filtering criteria - which was the case in the above example. 
If the inclusive option is not activated ("Exclusive filter"), all the tags are supplied that do not 
correspond to the filtering criteria. If several tag selectors are created and they are assigned 
to a data source, a tag will only be supplied if it matches at least one inclusive filter and does 
not match any exclusive filter.  
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If you only want to read the RFID data, activate the option "No filter" - then filtering will not be 
performed. 
If, for example, from a large number of tags, only the tags of two manufacturers should be 
supplied, you will need two tag selectors. For each of these, you must specify a field under 
"Tag field name" that contains the manufacturer's name and activate the "Inclusive filter" 
option. Under "Mask / Value". one of the manufacturers must be parameterized for each tag 
selector. 
If you want to work with several tag selectors, but the parameterization does not permit it, 
you must configure several data sources with the same antennas. 

3.7.2 Parameterizing display selectors 
In the "Display selectors" submenu, you can define selectors that determine which data is 
displayed in an "RFID view" screen object at runtime. 

 
RFID view (Page 495)  

Procedure 
Right-click on "Selectors > Display selectors" in the project view. Select the option "Add 
display selector". A new table for the display selector appears in the workplace. You can edit 
this in the property view. 
Alternatively, you can use the left mouse button to double-click on "Selectors > Display 
selectors" to open a new tab for display selectors in the workplace. You can create a new 
selector here by double-clicking an empty line of the table with the left mouse button here. 
You can edit it in the property view.  
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Display selectors 
The "Display selectors" menu provides the following parameter setting options: 
General 

 
You can assign a name to the selector and set its reference point here. First select the type 
of reference point under "Type" ("Workplace", "RFID device" or "Data source"). You can 
select the reference point from the drop-down list or create them.   You can also select 
several reference points. In accordance with your selection, only the events of the selected 
reference point will be displayed in the "RFID view" screen object.  
Parameterizing workplaces (Page 245)  
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3.7.3 Parameterizing data selectors 
In the "Data selectors" submenu, you can define selectors that will further reduce the volume 
of information and determine which information should be passed on. Data selectors are 
components of notification channels and can only be used with the asynchronous read 
procedure. 

 

Procedure 
Right-click on "Selectors > Data selectors" in the project view. Select the option "Add data 
selector". A new table for the data selector appears in the working area. You can edit this in 
the property view. 
Alternatively, you can use the left mouse button to double-click on "Selectors > Data 
selectors" to open a new tab for data selectors in the workplace. You can create a new data 
selector here by double-clicking an empty line of the table with the left mouse button here. 
You can edit it in the property view.  
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Data selectors 
The "Data selectors" menu provides the following parameter setting options: 
General 

 
You can assign a name to the data selector and link it to the tags by means of "Event filters" 
with reference to the status description - in accordance with the settings made under 
"Smoothing". The set event types are transferred to the enterprise system. You can select up 
to six predefined event filters. (for an explanation, see Section ) 
You can also assign reader fields to the data selector. These determine which information 
(e.g. reader name or tag type) will be displayed on the Runtime System and or the ALE 
client.    
 
Available reader fields 
Name Meaning 
Event trigger Read trigger that led to creation of the event 
Event type Event type / Status description of the tags 
Event time (ticks) Time of event in ticks 
Event time (UTC) Time of event in UTC format 
Reader EPC EPC of the reader specified by the manufacturer 
Reader handle Number for identification of the reader  
Reader name Name of the reader 
Reader role Role of the reader 
Reader time (ticks) Time of event handover in ticks 
Reader time (UTC) Time of event handover in UTC format 
RSSI value Signal strength of the tag (is only provided by RF670R) 
Tag type Tag type used 
Tag ID ID of the tag 
Data source name Name of the data source 
Notification channel name Name of the notification channel 
Notification channel trigger Name of the notification channel trigger 
Transmitting antenna Name of the antenna that was transmitting when the tag 

was detected. 
All event fields - 
All reader fields - 
All notification fields - 
All supported fields - 
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 Note 
Reader fields without data selectors 
If a data selector is not configured, all the information supported by the reader is transferred 
as standard. This corresponds to the above-mentioned option "All supported fields". 

 

 Note 
Standard data selector 
RF-MANAGER automatically creates a standard data selector that cannot be deleted. This is 
automatically assigned to the first notification channel to be created. As soon as you have 
created a new data selector, assignment of the standard data selector can be removed. 
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3.8 Working with variables 
 
You will find information about working with variables in the following chapters.  
There are two aspects to this: 
● Internal variables 
● External variables 

Internal variables 
Internal variables do not have any connection to the reader or PLC. They are saved in the 
memory of the runtime system. Therefore, only this runtime system has read and write 
access to the internal variables. You create internal variables, for example, in order to 
execute local calculations. You can use all basic data types for internal variables. 

External variables 
External variables are used to exchange process values between the runtime system and 
reader or PLC.  
An external variable is the image  
● Of a defined memory location in the PLC or 
● Of inputs/outputs of a reader 
in the runtime system. 
The runtime system and the PLC both have read and write access to the memory location in 
the PLC. Both the runtime system and the reader can access the memory location of the 
inputs/outputs of a reader. 
Since external variables are also the image of a storage location in the PLC, the applicable 
data types depend on the PLC which is connected to the runtime system. 

Data types for PLC variables 
Basic data types are available for all configurations. 
In addition, you can also use other data types for external variables which are intended 
specifically for the PLC to which a connection exists. 
A detailed listing of the basic data types and the data types for a connection to S7 controllers 
and readers can be found under Data types if connecting to S7 and Data types if connecting 
to readers.  

 

 Note 
In addition to the external variables, area pointers can be used for communication between 
the runtime system and the PLC. You can set up and activate the area indicators in the "PLC 
connections" editor. Detailed information about the area indicators can be found under 
"Communication." 
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Updating variable values in scripts and functions 
Scripts and system functions always fetch the value of an external variable that is stored in 
the memory of the runtime system. When the runtime system starts up, the current value will 
be read from the PLC or reader and stored in the memory of the runtime system. The 
variable value will then be updated with the set cycle time. Scripts and functions first access 
variable values read from the PLC at the previous scan cycle checkpoint.  
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3.8.1 Elements and Basic Settings 

3.8.1.1 "Variables" editor 

Introduction 
In the "Variables" editor, you create and configure variables.  

Open  
To open the "Variables" editor, create a new variable or edit a variable displayed in the 
Object View.  
As an alternative, you can open the "Variables" editor by double-clicking on the entry 
"Variables" in the Project View. 

Layout 
The "Variables" editor displays all variables that are in a folder. 

 
Figure 3-20 "Variables" editor 

Workplace 
All variables are displayed in a table in the workplace. You can edit the properties of the 
variables in the table cells. You can sort the table according to the entries in a column by 
clicking on the column header.  
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You can configure the selection of columns to suit your needs. The configured column 
selection will be saved whenever the project is saved. It is linked with the user name that you 
used when logging into Microsoft Windows. 

Properties dialog box 
Here you configure variables. The properties dialog box offers the same information and 
settings as the workplace table. 
The properties dialog box has a tree structure on the left from which you can select the 
various properties categories. The fields for configuring the selected properties category are 
shown on the right in the properties window. 

See also 
Basic Settings for Variables and Arrays (Page 282) 
Properties of a Variable (Page 284) 
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3.8.1.2 Basic Settings for Variables and Arrays 

Introduction 
You can configure the properties of variables and array elements in the tabular editors and 
also in the corresponding properties dialog boxes. 
The respective properties dialog box offers the same information and settings as the 
Variables editor. 

Structure of the properties dialog box 
All properties dialog boxes have a tree structure on the left from which you can select the 
various properties categories. The fields for configuring the currently selected properties 
category are shown on the right in the properties dialog box. 

Properties dialog box for variables 

 
In the properties dialog box for variables, you can configure the following properties of the 
selected variables:  
 
Entry in the tree structure Fields 
"General" "Name" 

"Connection" 
"Data type" 
"Acquisition mode" 
"Acquisition cycle" 
"Array count" 
"Length" 

"Properties"  
"Inports" 
"Outports" 

For reader "Addressing" 
(for external variables only) 

"Area", e.g. "DB" or "DBW" For PLC 
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Entry in the tree structure Fields 
"Settings" "Hi limit - disabled" 

"Hi limit constant" 
"Upper limit - variable" 
"Lo limit - disabled" 
"Lo limit constant" 
"Lower limit - variable" 
Limit check 

"LinearScaling" 
(for external variables only) 

"PLC end value" 
"PLC start value" 
"Runtime system end value" 
"Runtime system start value" 

"Basic settings" "Start value" 
"Update code" 

"Comment" Text field for entering the comment 
"Multiplexing" Index variable with a variable list from which the relevant 

variables are selected at runtime 
"Events"  
"Value change" List of functions that will be processed if the value changes 
"Hi limit exceeded" List of functions that will be processed if the hi limit is 

exceeded 
"Lower limit violated" List of functions that will be processed if the value drops 

below the lower limit 

See also 
"Variables" editor (Page 280) 
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3.8.2 Working with variables 

3.8.2.1 Properties of a Variable 

Introduction 
In the RF-MANAGER, certain properties can be configured for every variable. 
The properties determine how you can use the variable in your configuration. 

Principle 
The following properties can be set for variables: 
● "Name" 

Every variable has a name which you can choose. Note, however, that the name may 
only occur once within the variable folder. 

● "Connection" to the PLC or to the reader and "Acquisition cycle" of the variables 
For external variables, you must specify the PLC or reader to which the runtime system is 
connected since these variables represent memory locations in the PLC or the image of 
the inputs/Outputs of the reader. The available data types for a variable and their address 
in the memory of the PLC or reader depend on the type of PLC or reader.  
Furthermore, you must specify how often the variable should be updated. 

● "Data type" and "Length" 
The data type of a variable determines  
– What type of value is saved in a variable. 
– How these values are stored internally. 
– Which value range can be accepted by the variables as a maximum. 
Two simple examples of data types are "Int" for saving integers or "String" for saving 
character strings. You can input leading zeros in values for variables of data type "Int". 
For text variables of the type "String" or "StringChar", you can also set the "Length" of the 
variable in bytes. For all other data types, the value of "Length" is fixed. 

● "Array elements" 
You can assemble variables from a number of the same type of array elements. Array 
elements are saved in consecutive memory locations.  
You can use array variables mainly for working with many items of data of an identical 
format. 

● "Comment" 
You can enter a comment for each variable to provide for a more exact documentation of 
your project. 
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● "Limits" 
You can specify a value range with an upper and lower limit range for each variable. If, 
for example, an entered value that should be stored in the variable lies outside the 
permitted limits, this value will not be loaded and an appropriate system alarm is output. If 
the value lies outside the value range, a function list for outputting alarms can be 
processed. 

● "Start value" 
You can configure a start value for every variable. The variable will be set to this value at 
runtime start. In this manner, you can ensure that the project will begin in a defined state 
every time it is started. 

All properties which were configured when the variable was created can be modified with the 
object list later where the variable is used. 
Example: Create a variable and configure its limit values. Link this variable to an I/O field. 
The limit values which were set when the variable was created can be modified with the 
object list later when the I/O field is configured.  
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3.8.2.2 Communication with the PLC with external variables 

Introduction 
External variables are used to exchange data between the runtime system and PLC.  

Principle 
An external variable is the image of a defined memory location in the PLC. The runtime 
system and the PLC both have read and write access to this memory location.  
The fact that the runtime system can access data on the PLC affects which properties are 
available when you configure the variables. The configuration possibilities supported by the 
following variable properties depend on the PLC or reader that is connected to the runtime 
system: 
● "Addressing" 
● "Data type" 
With linear scaling, you can adjust the value range of external variables to suit the 
requirements of the configuration. 

Addressing 
If you create an external variable in RF-MANAGER, you must specify the same address as it 
has in the PLC program. This enables both the runtime system and the PLC to access the 
same memory location. 

Data type 
Since external variables are the image of a defined storage location in the PLC, the available 
data types depend on the PLC which is connected to the runtime system.  
A detailed listing of the basic data types and the data types for a connection to S7 controllers 
can be found under Data types if connecting to S7.  
A change from communications driver A to communications driver B may cause discrepancy 
in the following special situations: 
● The data type is recognized, but the address range cannot be interpreted. 

In this case, the default address range of the data type is used. 
● No suitable data type is found.  

The default data type of the communications driver will be used in such a situation. 

Acquisition cycle 
The acquisition cycle determines when the runtime system will read the value of an external 
variable. Normally, the value is updated at regular intervals as long as the variable is shown 
in the screen. The interval for regular updates is set with the acquisition cycle. You can either 
choose a default acquisition cycle, or define a user-specific cycle.  
An external variable can also be updated independent of the display in the screen, for 
example, by triggering a value change for the variable functions. Please note that frequent 
read operations increase communication load. 
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Linear Scaling 
You can configure a linear scaling for numerical data types. The data in a PLC for an 
external variable can be mapped to a specific value range in the RF-MANAGER project.  
Example: The user enters length dimensions in centimeters although the controller expects 
inches. The entered values are automatically converted before they are forwarded to the 
controller. Using linear scaling, the value range [0 ... 100] on the PLC can be mapped to the 
value range [0 ... 254] in the runtime system. 
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3.8.2.3 Communication with digital inputs/outputs of readers 

Principle 
The RF670R/RF660R readers have digital inputs/outputs. The inputs can be used to trigger 
automation tasks.  
The digital inputs/outputs of a reader are external variables of the BOOL type from a logical 
point of view. With the RF-MANAGER, you can create a specific number of Boolean 
variables. For RF670R, for example, these are four input variables and four output variables. 
These variables can be used for process control and process display.  
The four inputs or outputs of the reader can be combined in one input or one output variable 
respectively of the BYTE type. 

RF620R/RF630R/RF300 
The RF620R/RF630R/RF300 readers have no real physical inputs/outputs. In the operating 
mode "With Presence = true", however, these reader offer a function that permits feedback 
via tags in the antenna field (presence). This presence is provided in the form of a virtual 
input (as InPort00). To be able to evaluate the presence in the application, this input can be 
addressed as a variable. If a trigger of type "IO edge" or "I/O level" is linked to this input, the 
activation is dependent on presence.  
Examples: With the "IO edge" type, as soon as a tag enters the field, a single read process 
is initiated. With the "IO level" type, reading takes place as long as a tag is in the field. 
Likewise, the input can be used to set a trigger. 

RF670R application example 
You are connecting a light barrier to the digital input of an RF670R. Pallets with tags interrupt 
the light barrier and therefore activate a trigger in the notification channel. The tags are read. 
This event can be displayed, for example, through one of the variables in the runtime system 
that references the digital input.  
At the same time, this event activates a digital input to place a branch point after the light 
barrier via a script or system functions and to distribute the pallets in accordance with 
requirements. Positioning the branch point can also be displayed, for example, through one 
of the variables in the runtime system that references the digital output.  
If you combine the outputs of a reader in a variable of the BYTE type, you can, for example, 
set the required outputs of the reader simultaneously. The Hex value "05" must be entered in 
the relevant byte for setting outputs 0 and 2. By using a variable of the BYTE type, you can 
obviate the need to transfer 2 variables of the BOOL type.  

 
In this way, you can achieve synchronous updating of the digital outputs or synchronized 
evaluation of the digital inputs of a reader. 
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RF620R/RF630R/RF300 application example 
You want to recognize in an output field in a screen that a tag is present in the reader's field. 
For this purpose, link the Boolean variable of the output field to the virtual "Inport00" of the 
reader under "Variable > Properties > Address". If the reader is operated in the mode "With 
Presence = true", the value is set to 1 as long as a tag is in the reader's field. 
If you want to indicate the number of present tags in the output field, the variable must be of 
the BYTE type and "Inport00-PresenceCount" must be selected as address. Via the variable 
trigger "Value change" further actions can be triggered, if required. 

Properties 
The following properties can be set for external variables: 
● "Name" 

Every variable has a name which you can choose. Note, however, that the name may 
only occur once within the variable folder. 

● "Connection" to the reader and "Poll cycle" of the variables 
For external variables, you must specify the reader with which the runtime system is 
connected. Furthermore, you must specify how often the variable should be updated. 

● "Data type" and "Length" 
The data types permitted for the external variables of a reader are BOOL and BYTE. 
The value of "Length" is predefined. 

● "Comment" 
You can enter a comment for each variable to provide for a more exact documentation of 
your project. 

● "Start value" 
You can configure a start value for every variable. The variable will be set to this value at 
runtime start. In this manner, you can ensure that the project will begin in a defined state 
every time it is started. 

All properties which were configured when the variable was created can be modified with the 
object list later where the variable is used. 

Addressing 
If you create an external variable in the RF-MANAGER, you must specify the input or output 
port that you use for reader inputs/outputs. 

Poll cycle 
The poll cycle determines when the runtime system will read the value of an external 
variable. The update is usually implemented at regular intervals and it is controlled by an poll 
cycle. You can either choose a default poll cycle, or define a user-specific cycle. Please note 
that frequent read operations increase communication load.  
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3.8.3 Updating the variable value in Runtime 

Introduction 
Variables contain values which change during runtime. Value changes are handled 
differently at internal and external variables.  

Principle 
If a start value has been configured for the variable, the variable will be set to this value 
when the runtime system starts up. The values of variables change during runtime. 
During runtime, you have the following options for changing the value of a variable: 
● By executing a system function, for example, "SetValue." 
● By operator input, for example, in an I/O field. 
● By a value assignment in a script. 
● A value change in an external variable in the PLC or reader. 

Updating the value of external variables 
Method for updating the value of an external variable: 
● Updating after an acquisition cycle 

Normally, variables are updated after an acquisition cycle as long as the variable appears 
in a screen. The acquisition cycle determines the cycle for updating the value of a 
variable on the runtime system. You can either choose a default acquisition cycle, or 
define a user-specific cycle.  

● When the setting "Cyclic continuous" is activated 
If this setting is activated, the variable will be updated in runtime, even if it is not found in 
the currently open screen. This function is set, for example, for variables which are 
configured to trigger a function list in the event of a change in their value.  
Only use the "Cyclic continuous" setting for variables that must truly be updated. 
Frequent read operations increase communication load. 

● On demand 
The variable is updated by calling the system function "UpdateVariable" or when a screen 
is constructed. 

See also 
Cycle basics (Page 291) 
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3.8.4 Cycle basics 

Introduction 
Cycles are used to control project sequences that are run at regular intervals. Common 
applications are the acquisition cycle and the update cycle. Besides the cycles predefined in 
RF-MANAGER, you can also define your own cycles.  

Principle 
In runtime, actions that are performed at regular intervals are controlled by cycles. Typical 
applications for cycles include the acquisition of external variables and the updating of 
screens. 
● Acquisition cycle 

The acquisition cycle of the variable determines when the runtime system will read the 
value of an external variable from the PLC or reader. Set the acquisition cycle to suit the 
rate of change of the values. 
If the acquisition cycle is set too low, it will strongly increase the communication load. 

The smallest value for a cycle is 100 ms. The values of all other cycles are always an integer 
multiple of the smallest value. 
If the standard cycles predefined in RF-MANAGER do not satisfy the requirements of your 
project, it is possible to define your own cycles. These custom cycles must, however, be 
based on the standard cycles.  

Application example 
Use cycles, for example, to log your system at regular intervals or to provide reminders of 
the maintenance intervals. 

See also 
Updating the variable value in Runtime (Page 290) 
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3.9 Creating screens 

3.9.1 Basic principles 

3.9.1.1 Screen Basics 

Introduction 
You can use RF-MANAGER to create screens for configuring and operating/monitoring RFID 
systems and their components. When you create your screens, the predefined object 
support you in simulating your plant, displaying production processes and defining values. 

Screen design 
You add screen elements you need for visualization of the RFID system, and configure these 
to suit the requirements of your system. 
A screen may consist of static and dynamic elements.  
● Static elements such as text or graphic objects do not change their status in runtime. 
● Dynamic elements change their status based on the production process. They visualize 

current RFID data of the runtime system in the form of alphanumeric displays. Operator 
input boxes in the runtime system also belong to the category of dynamic elements. 

Function keys and softkeys 
A function key is a physical key on the runtime system to which you can assign one or more 
functions in RF-MANAGER. These functions are triggered when the operator presses the 
relevant key on the runtime system.  
A function key can be assigned global or local functions.  
Global function keys always trigger the same action, regardless of the currently displayed 
screen. 
Function keys assigned local functions are softkeys. They trigger different actions, based on 
the currently displayed screen on the runtime system. This assignment applies only to the 
screen in which you have defined the function key.  

Navigation 
All configured screens must be integrated into the operating sequence of the RFID system, 
in order to enable runtime access to these in the runtime system. Here you can use the 
"Screens" editor to configure buttons and function keys for calling other screens. 
An RF-MANAGER project which consists of multiple screens offers the following screen 
navigation options in runtime:  
● Navigation by means of navigating buttons 
● Navigating with the help of function keys 
Buttons or function keys can be configured in the RF-MANAGER. 
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3.9.1.2 "Screens" Editor 

Introduction 
You configure your screens in the "Screens" editor. This editor is formed by the combination 
of a graphic programming software and a plant visualization tool. You can access the screen 
editor in the project view.  

Open 
Double-click "Add screen" in the "Screens" group of the project view,  
The workspace opens with a new screen. 

Layout 

 
 

① Workplace 

② Toolbox 

③ Properties dialog box 
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Workplace 
You configure screens in the workplace.  

Toolbox 
The toolbox contains a selection of simple and complex objects which you can add to your 
screens, for example, graphic objects or operating elements.  

Properties dialog box 
The content of the properties dialog box is determined by the object you have currently 
selected in the workplace.  
● The properties of a selected object can be viewed and edited in the properties dialog box. 
● If you have not selected an object on the active screen, the properties of this screen are 

shown and can be edited in the properties dialog box. 

3.9.1.3 Procedures 

Procedures 
To create screens, you need to take the following initial steps:  
● Create a draft of the project structure, i.e. define the structure and the number of screens. 

Example: Subsystems can be visualized in separate screens and merged in a master 
screen. 

● Define your screen navigation control strategies. 
● Adapt the template. 

The template which is stored in RF-MANAGER for the selected runtime system applies to 
all your project screens. In this template, you can define objects locally and assign global 
function keys. You can store the objects you want to integrate into all screens in the 
permanent view. 
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3.9.2 Working with objects 

3.9.2.1 Overview of objects 

Introduction 
Objects are graphic elements which you use to design the plant displays of your project.  
The "Toolbox" contains various types of objects which are frequently required for use in plant 
displays.  
The Toolbox view can be faded in and out using the "Toolbox" command in the "View" menu. 
The Toolbox view can be moved to any position on the screen. 

Screen objects  
 
Icon Object Notes 

 
"Line"  You can select straight, rounded or arrow-shaped line ends. 

 
"Ellipsis"  You can fill an ellipsis with a color or a pattern. 

 
"Circle"  You can fill the circle with a color or a pattern. 

 
"Rectangle"  The corners of a rectangle can be rounded. You can fill the 

rectangle with a color or a pattern.  

 
"Text box"  You can enter one or several lines of text in a "Text box" and 

define the font and the font color. You can add a background color 
or pattern to a text box. 

 
"I/O field"  An I/O field can have the following functions in the runtime system: 

 Output of the values in a variable 
 Operator input of values; these input values are saved to a 

variable. 
 Combined input and output; the operator can here edit the 

output value of the variable and thus set a new value. 
You can define limits for the variable values shown in the I/O field.  
Set "Hide input" if you want to hide operator input in runtime. 

 "Date-time box"  A "Date / time box" may have the following runtime functions: 
 Output of the date and time 
 Combined input and output; the operator can here edit the 

output values in order to reset the date and time. 
The system time or a corresponding variable may be used as 
source to define the date and time.  
The date can be output in extended format, for example, Tuesday, 
December 31, 2003, or in short format, for example, 12/31/2003. 
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Icon Object Notes 

 
"Symbolic I/O field"  A symbolic I/O field can have the following functions in the runtime 

system: 
 Output of text list entries 
 Combined input and output; the operator can here select a text 

from a text list in order to change the content of the symbolic 
I/O field. 

 "Graphic I/O field"  A graphic I/O field can have the following functions in the runtime 
system: 
 Output of graphic list entries 
 Combined input and output; the operator can here select a 

graphic from a graphic list in order to change the content of the 
graphic I/O field. 

 "Graphic view"  The "Graphic view" shows you on one screen all of the graphic 
objects created by means of an external graphic programming tool. 
Graphic objects can be shown in the following formats: "*.emf", 
"*.wmf", "*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".  
In the "Graphic view", you can also integrate graphic objects of 
other graphic programming tools as OLE (object linking and 
embedding) objects, for example. OLE objects opened and edited 
in the graphic program in which they were created directly from the 
properties dialog box of the graphic view.  

 
"Button"  The operator can use a button to control a plant. You can configure 

functions for a button. 

 
"User view"  In RF-MANAGER ES, you can use passwords to control access to 

screen objects. 
In the "User view", an administrator can manage users on the 
runtime system at runtime. In the "User view", user who do not 
have administrator privileges can change their password in 
runtime. 

 
"Alarm view"  In the alarm view, the operator can view selected alarms or alarm 

events in the alarm buffer or the alarm log in runtime.  
 RFID view  Visualization of RFID data communication 

 
 Statistics view  Visualization of RFID statistical data 
 Configuration  Visualization and changing of RFID configuration data 
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3.9.2.2 Object Groups 

Principle 
You can organize multiple object in a group. In your screen, you edit an object group in the 
same way you edit a single object. You can also edit any object of the group separately. 
In contrast to the multiple selection function which shows the selection rectangles of single 
objects, the system displays only one selection rectangle for the complete group. 
You can edit any object of the group separately. To do so, change to the single-object editing 
mode. In this mode, you can access all of the properties of a single object you have selected 
from the group. 

3.9.2.3 External graphics 

Introduction 
In RF-MANAGER you can use images created with an external graphic editor. To view the 
images, you must have stored them in the image browser of your RF-MANAGER project. 
Importing is performed through graphics objects. 
The following image types can be stored in the image browser: 
● As an image file in one of the following formats: 

*.bmp, *.dib, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg or *.jpg 
● As OLE object which is embedded in RF-MANAGER and linked to an external graphic 

editor. With an OLE link, the external graphic editor can be opened from RF-MANAGER. 
The linked object can be edited with the graphic editor. OLE will only work if the external 
graphic editor is installed on your PC and supports OLE. 

Using images from the image browser 
Screen applications for images from the image browser:  
● Graphic view 
● Image lists 

Transparent graphics 
RF-MANAGER also supports the use of images with a transparent background. When you 
insert an image with a transparent background in an RF-MANAGER graphic object, the 
transparency is replaced by the background color defined in the RF-MANAGER graphic 
object. The selected background color is permanently linked to the image. If you use the 
image in another RF-MANAGER graphic object, it is displayed with the same background 
color as the graphic object which was configured first. If you want to use the image with 
different background colors, you have to add this image to the image browser again under a 
different name. Assign the additional background color to the appropriate RF-MANAGER 
graphics object when you use the image.  
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3.9.3 Options of assigning dynamic update functions 

Introduction 
All objects for input and output demonstrate dynamic reactions in Runtime. You can also 
assign dynamic properties for objects. An example of this feature is the graphic of a tank 
filling level, which is dynamically updated based on the respective process value. Another 
example of dynamic object properties is a button which triggers a particular function.  

Dynamic objects 
You can assign dynamic properties to any graphic object. Programming options: 
● The object changes its appearance: Color or flashing properties. 
● The screen object is animated. 
● The object is shown or hidden. 
The following additional options are available for the operator control elements: 
● Operator control of an object is enabled or locked. 
● The operator control, e.g. clicking, of an object triggers an event which is configured to 

execute a function list. 

Dynamic control and object properties 
Dynamic update is an element of the object properties. Which dynamic update functions and 
events are actually available depends on the selected object. When you copy an object, its 
dynamic update functions are included. 
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3.9.4 Working with function keys 

Introduction 
A function key is a key on the runtime system which can be assigned user-defined functions. 
A function list can be configured for the "Press" and "Release" events for the key.  
A function key can be assigned global or local functions.  

Global assignment 
Global function keys always trigger the same action, regardless of the currently displayed 
screen. 
Global function keys are configured once in the template. A global assignment applies to all 
screens of the selected runtime system which are based on this template.  
Global function keys reduce programming effort considerably, because there is no need to 
assign these global keys to each individual screen. 

Local assignment 
Local function keys in displays can trigger a different action in each screen. This assignment 
applies only to the screen in which you have defined the function key. 
Using a local function key, you can override global function keys and the local function keys 
of a template.  

 

 Note 
When a screen containing local function keys is covered by an alarm screen or an alarm 
window at runtime, the function keys are still enabled in the Runtime system. 

 

Hotkey assignment 
You can assign hotkeys to command elements such as buttons 

Visualizing the assignment 

Table 3- 1 The following table shows which symbols indicate the assignment of the function keys: 

Function key Description 

 

Unassigned 

 

Used globally 
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Function key Description 

 

Used locally 

 

Used locally (local assignment overwrites global assignment) 

3.9.5 The Advantage of Layers 

Layers 
You use layers to process the objects of a screen differently. A screen consists of 32 layers. 
By assigning objects to the layers, you specify the hierarchic levels in the screen. Objects of 
the layer 0 are located at the screen background, while objects of the layer 31 are located in 
the foreground.  
The objects of an individual layer are also arranged hierarchically. When you create a 
display, the object inserted first in the layer is placed at the back. Each further object is 
placed one position towards the front. Within a layer, you can move the objects forwards and 
backwards. 

Principle of the layer technique 
One level of the 32 levels is always active. New objects you add to the screen are always 
assigned to the active layer. The number of the active layer is indicated in the "Layer" toolbar 
and in the Properties view of the screen. The active layer is highlighted in color in the 
properties view of the screen.  
When you open a screen, all 32 layers of the screen are displayed. You can hide all levels 
apart from the active level in the properties view of the screen. Then you can explicitly edit 
objects of the active layer. 

Application examples 
You can use levels, for example, in the following cases: 
● To hide the labels of objects while you are editing. 
● To hide objects, such as alarm windows, while you configure further screens. 
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3.10 Structure of an alarm system 

3.10.1 Basic principles 

Introduction 
The RF-MANAGER supports the following alarms: 
● RFID alarms  

RFID alarms provide information about the operating states of the RFID system, e.g. of a 
reader, and are activated by it. Apart from the predefined RFID alarms, it is also possible 
to configure additional RFID alarms. 

● System alarms  
System alarms are predefined to indicate certain system statuses of the runtime system. 
These are activated by the runtime system. 

Tasks of the alarm system  
● Display on the runtime system: To report events or states that occur in the RFID system. 

A state is reported as soon as it occurs. 
● Reporting: Alarm events are output to a printer. 
● Logging: Alarm results are saved for further editing and evaluation. 
● Transfer to a higher-level system Alarm events are transferred to the higher-level system. 
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3.10.1.1 RFID alarms 

Introduction 
RFID alarms provide information about the operating states of the reader and are activated 
by the reader. Events in RFID process operation can also trigger alarms. 
An RFID alarm comprises the number, alarm text and assignment to an alarm class. The 
alarm text can also contain internal system variables that indicate the cause of the alarm 
more precisely. The alarms can be archived.  

Activating RFID alarms 
The reader or the runtime system activates an alarm when an error occurs.  

Types of RFID alarms 
There are two types of RFID alarms:  

 
Name Description 
RFID base alarms  Alarms that inform the user about errors and malfunctions.  

These are activated by system events. 
They can refer to: Antennas  
Example: Antennas report errors with reading of tag data (writing failed - base alarm) 

RFID status alarms  Alarms that inform the user about a change in status. 
They can refer to: RFID devices, antennas, data sources, notification channel, ALE connection
Example: Data source has switched to "Inactive" status (SourceDown - status alarm) 

RFID edge alarms  Alarms that inform the user whether and in which direction thresholds have been overshot.  
They can refer to: RFID devices, ALE connections 
Example: The free memory on a reader has undershot a fixed limit (ReaderFreeMemory -
 edge alarm) 

RFID device alarms  Hardware-specific alarms of an RFID device that are triggered by the firmware of the reader. 
See the documentation for the reader used 

Editing RFID alarms 
Every type of RFID alarm can be edited in a dedicated editor. 

Alarm variables 
The text of any alarm can contain output fields.  

Displaying RFID alarms in the runtime system 
In the basic settings for the alarm system, you can determine which type of RFID alarms are 
displayed on the runtime system and for how long an RFID alarm is displayed. 
To display RFID alarms on the runtime system, use the "Alarm view" and "Alarm window" 
objects  
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3.10.1.2 System alarms 

Introduction 
System alarms provide information about operating states of the runtime system and are 
output by it. System alarms can range from notes to serious errors.  
A system alarm comprises the number and text of the alarm and its assignment to an alarm 
class. The alarm text can also contain internal system variables that indicate the cause of the 
alarm more precisely. Only certain properties can be configured for system alarms. The 
alarms can be archived. 
  

 

 Note 
Viewing and editing system alarms 
System alarms can only be viewed and edited in RF-MANAGER if you have selected the 
option "Display all" under "Options > Settings > Workplace > Project View".  

 

Triggering of system alarms 
The runtime system outputs an alarm when a specific system state or error occurs.  

Displaying system alarms in the runtime system 
In the basic settings for the alarm system, you can specify for how long a system alarm is 
displayed. 
To display system alarms in the runtime system, use the objects "Alarm View" and "Alarm 
Window". 
When these objects are configured in a screen or in the template, select the "System" alarm 
class in both cases. 
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3.10.1.3 Alarm classes 

Introduction 
Alarm classes mainly determine how alarms will appear when they are displayed on the 
runtime system. Alarm classes are also used to group alarms for various means of display.  
RF-MANAGER has both predefined alarm classes and the option to configure user-defined 
alarm classes.  

Available alarm class settings 
The following settings can be defined for each alarm class:  
● Acknowledge: Alarms in this class must be acknowledged. 
● Texts, colors, and flash modes to identify each alarm status when alarms are displayed 
● An alarm log for logging all events related to alarms in this class. 
● A text placed in front of the alarm number to indicate the alarm class when alarms are 

displayed in the runtime system. 
● An e-mail address to which all messages about events related to the alarms in this class 

will be sent. 

Predefined alarm classes  
 
Alarm Predefined alarm classes Description 
System alarm System Class for system alarms that notify the operator about the 

operating states of the runtime system. This alarm class cannot 
be used for user-defined alarms. 

RFID alarm Class for RFID alarms that require an immediate response from 
the user. 

RFID critical Class for RFID alarms that provide information about critical 
system states. 

RFID debug Class for RFID alarms that provide information about debug 
levels. 

RFID emergency Class for RFID alarms that provide the information that the system 
can no longer be accessed. 

RFID error Class for RFID alarms that provide information about errors. 
RFID information Class of RFID alarms that contain information about errors. 
RFID note Class for RFID alarms that provide information about normal 

system states.  

RFID alarm 

RFID warning Class of RFID alarms that contain warnings. 
 
 

 Note 
Changing properties of the alarm classes 
Only very specific properties can be changed for predefined alarm classes. The name and 
the acknowledgement response of a predefined alarm class cannot be changed.  
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3.10.1.4 Acknowledge alarms 

Introduction 
For alarms displaying critical or hazardous operating and process states, a stipulation can be 
made requiring the plant operator to acknowledge the alarm.  

Mechanisms for acknowledging alarms 
An alarm can be acknowledged by the operator in the runtime system. Acknowledgment can 
be performed by the operator in the following ways: 
● Function keys 
● Softkeys or buttons in screens 
In addition, alarms can be acknowledged through system functions in function lists or scripts. 

Alarms requiring acknowledgment 
The alarm class determines whether or not the alarm must be acknowledged. 
Alarm classes essentially define how alarms will appear when shown on the runtime system 
as well as the acknowledgement behavior. RF-MANAGER has both predefined alarm 
classes and the option to configure user-defined alarm classes. 
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3.10.2 Displaying Alarms 

3.10.2.1 Displaying alarms in the runtime system 

Options for displaying alarms in the runtime system 
RF-MANAGER offers the following possibilities for displaying alarms in the runtime system:  
● Alarm view 

The alarm view is configured for a certain screen. More than one alarm can be displayed 
simultaneously, depending on its configured size. More than one alarm view can be 
configured for different alarm classes and in different screens. The alarm view can be 
configured in such a way that it includes only one alarm line. 

● Alarm window 
The alarm window is configured in the screen's template and is thus a component of all 
screens in a project. More than one alarm can be displayed simultaneously, depending 
on its configured size. An event can trigger closing and reopening of the alarm window. 
Alarm windows are saved in their own layer for the practical reason that this allows them 
to be specifically hidden during the configuration. 

Additional signal: Alarm indicator  
The alarm indicator is a configured graphic symbol that is displayed on the screen when an 
alarm activates. The alarm indicator is configured in the screen's template and is thus a 
component of all screens in a project.  
The alarm indicator can have one of two states: 
● Flashing: At least one unacknowledged alarm is pending. 
● Static: The alarms are acknowledged but at least one of them is not yet deactivated. 
Function lists can be used to configure the responses of the runtime system. 
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3.10.2.2 Filtering the display of alarms 

Introduction 
In the enhanced alarm view and in the alarm window you have the option to filter the display 
of alarms by means of the alarm text of the alarms. A character string or the value of a filter 
variable is used as the filter criterion. In Runtime, only the alarms whose alarm text contains 
the configured character string or the character string from the filter variable are displayed. 
The filter only applies to the display in runtime. All alarms are retained in the alarm buffer.  

Filtering rules 
For filtering using a fixed filter entry, configure a character string in the properties of the 
Alarm View. All the alarms which contain the full character string in the alarm text are 
displayed in runtime.  
For filtering that can be changed, use a variable for the filter criterion. You can assign the 
variable at runtime, for example, by entering the required character string in an I/O field. The 
display of the alarms is filtered in accordance with the contents of the variable. 

Behavior of the filter 
● If the filter entry is empty, all the pending alarms are displayed. 
● The filter variable is superordinate to the permanently configurable character string. If a 

permanently assigned character string and filter variable are assigned during 
configuration, the alarms are filtered by the contents of the filter variable. If the filter 
variable is empty, filtering is implemented based on the permanently assigned character 
string. 

● The filter function is case sensitive. Wildcards and general expressions are not 
recognized. 

● The filter function is not language dependent. A configured character string remains the 
same after a language change. 

● The length of the filter entry is limited to the maximum length of the alarm text. 
Configure filtering in the properties of the alarm view or the alarm window.  
Filtering is not possible for the following alarm views: 
● Simple alarm view 
● Alarm line 
● Alarm window which is automatically displayed 
● Alarm view which is configured for displaying alarms of an alarm log 
● Alarm window which is configured for displaying alarms of an alarm log 
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3.10.2.3 Logging and reporting alarms 

Evaluation and documentation of alarms  
In addition to real time displays of alarm events in the "alarm view" and "alarm window," RF-
MANAGER offers the following options for evaluating and documenting alarms: 
● Alarm events can be printed out immediately upon occurrence. 
● Alarm events from the alarm buffer can be printed out in report form. 
● Alarm events can be logged in an alarm log. 
● Logged alarm events can be displayed on the runtime system or printed out in report 

form. 

Printing Alarms Immediately 
You can enable or disable the printing of alarms for the entire project in the basic settings for 
the alarm system. In addition, printing of each individual alarm can be enabled. 

Logging of alarms 
Alarm classes are used to configure assignment of alarms to an alarm log. An alarm log can 
be specified for each alarm class. All events related to the alarms of this alarm class are 
logged in the specified alarm log. 

Logging of alarms 
The properties of the "Print alarm" object are used to configure the assignment of alarms to a 
report. In addition to the data source (alarm buffer or alarm log), filtering is also possible on 
the basis of alarm classes. 
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3.10.2.4 System Functions for Alarm Editing 

System functions 
System functions are predefined functions you can use to implement many tasks during 
runtime even without having any programming knowledge. You can use system functions in 
a function list.  
The table shows all of the system functions available for editing alarms and manipulating 
their display. 
 
System function Effect 
EditAlarm Triggers the "Edit" event for all selected alarms. 
ClearAlarmBuffer Deletes alarms from the alarm buffer on the 

runtime system. 
AlarmViewEditAlarm Triggers the event "Edit" for all alarms selected in 

the given alarm screen. 
AlarmViewShowOperatorNotes Displays the configured operator notes of the 

alarm selected in the given alarm screen. 
SetAlarmReportMode Switches the automatic logging of alarms on the 

printer on or off. 
ShowAlarmWindow Hides or shows the alarm window on the runtime 

system. 
ShowSystemAlarm Displays the value of the supplied parameter as a 

system alarm on the runtime system. 
AcknowledgeAlarm Acknowledges all selected alarms. 
AlarmViewAcknowledgeAlarm Acknowledges the alarms selected in the given 

alarm view. 

Events for alarms and objects for alarm indication 
The following events can occur during runtime in the case of alarms and in the case of 
objects for alarm displays. A function list can be configured for each event.  
 
Object Configurable events 
Alarm view Enable 

Deactivate 
Alarm window Enable 

Deactivate 
Alarm indicator Click 

Click when flashing 
RFID alarms Activate 

Deactivate 
Acknowledge 
Edit 
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Provision of RFID alarms to the enterprise system 
The enterprise system can log on to the runtime system through a defined interface (ALE+) 
for the purpose of receiving RFID alarm events. When the alarm status changes in the 
runtime system, it is supplied to the enterprise system immediately. This takes place until the 
enterprise system logs off again. 
For detailed information about the transfer functions, refer to the ALE+ Function Manual. 
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3.10.3 Elements and Basic Settings 

3.10.3.1 Alarm Components and Properties 

Properties of alarms 
An alarm always comprises the following components:  
● Alarm text 

The alarm text contains a description of the alarm. Each character of the alarm text can 
be formatted. 
It can contain output fields for RFID parameters. The alarm buffer retains the 
instantaneous value at the time at which the alarm status changes. 

● Alarm number 
The alarm number is used to reference an alarm. The alarm number is unique within the 
following types of alarms: 
– RFID base alarms 
– RFID edge alarms 
– RFID status alarms 
– RFID device alarms 
– System alarms 

● Alarm triggers:  
– Trigger on function units of the RFID system 

● Alarm class  
The appearance of the alarm on indication in the runtime system can be controlled by its 
association with an alarm class. The alarm class also determines whether and where the 
corresponding alarm is logged and whether it requires acknowledgement. 

These components are freely selected or entered for each alarm. 

Optional alarm properties 
The behavior of an alarm can also be defined by the following properties:  
● Infotext 

Operator notes can contain additional information about an alarm. Operator notes are 
displayed in a separate window in the runtime system when the operator presses the 
<HELP> button.  

● Automatic logging 
In addition to the option of enabling and disabling automatic logging of alarms for the 
entire project, it is also possible to enable logging for each individual alarm. 
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3.10.3.2 Alarm settings 

Introduction 
In principle, the RF-MANAGER alarm system is functional using the default settings. You 
only need to change these default settings if you want to adapt the alarm system behavior to 
specific plant conditions.  

Opening the basic settings 
In the project view, double-click "Alarm settings" in the "Alarms > Settings" group. 

Layout 
 

 
 

Workplace 
You define the settings for the alarm system in the workplace.  
In the "System alarms" area you select, for example, how long the system alarms should be 
displayed on the runtime system.  
In the "RFID alarms" area, select the display interval following which RFID base alarms and 
RFID device alarms will be automatically deactivated. 
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3.10.3.3 Basic Principles of Editors 

Editors for configuring alarms 
The following editors are available in RF-MANAGER for configuring alarms:  
● "System alarms" for changing alarm texts of system alarms 
● "RFID alarms": One editor each for creating and editing RFID base alarms, RFID status 

alarms and RFID edge alarms as well as one editor for changing RFID device alarms  
● "Alarm classes" for creating and changing alarm classes  

Changing the column display 
The column display can be configured as follows: 
● You can show or hide individual columns using the context menu (right-click) for the 

column header. 
● You can change the column width by dragging the right margin of a column header. 
● By dragging a column header, you change the order of the columns. 
● You can sort the table according to the entries in a column by clicking on the column 

header. Click the same column header again to reverse the sort order. 
The corresponding column header is marked with an arrow. The arrow direction 
determines the sort order. 

Deleting and copying objects 
One or more whole objects can be deleted or copied if you select the entire table row for 
each object using the icon on the left side of the row. 

Filling in multiple table rows automatically by dragging 
In tabular editors of RF-MANAGER, you can fill in multiple table rows in one operation. 
● Creating multiple new objects (alarms, or alarm classes) with similar properties: 

– Sort the table so that the table row to be copied is at the bottom. 
– Select the first element in the row to be copied. 
– Keeping the left-hand mouse button pressed, drag the lower right-hand corner of the 

selected table element downwards into the blank part of the table. 
● Transferring a property to more than one existing object (for example, changing the 

suppression period): 
– Select the table element with the relevant property. 
– Keeping the left-hand mouse button pressed, drag the lower right-hand corner of the 

selected table element downwards across the table rows to be modified. 
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Dragging and dropping within a table 
A drag-and-drop operation can be used to copy an individual property (such as an alarm text 
or a color) from one table element to another.  

See also 
"RFID alarms" editors (Page 314) 
"System alarms" editor (Page 316) 
"Alarm classes" editor (Page 317) 

3.10.3.4 "RFID alarms" editors 

Introduction 
There a a number of editors for RFID alarms. You create the RFID alarms using the relevant 
editor: and define their properties: 
● RFID base alarms 
● RFID status alarms 
● RFID edge alarms 
● RFID device alarms 

Open 
Double-click the "Alarms" group in the project view and select one of the following RFID 
alarms:  
● "RFID base alarms" 
● "RFID status alarms" 
● "RFID edge alarms" 
● "RFID device alarms" 
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Layout 

 

Workplace 
All RFID alarms are displayed in a table in the workplace. You can edit the properties of the 
RFID alarms in the table cells. You can sort the table according to the entries in a column by 
clicking on the column header.  

Properties dialog box 
Here you configure RFID alarms. The properties dialog box offers the same information and 
settings as the workplace table.  
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3.10.3.5 "System alarms" editor 
You can view all system alarms and change the alarm texts in the "System alarms" tabular 
editor.  

Opening the "System alarms" editor 
In the Project View, double-click "System alarms" in the "Alarms" group.  

 

 Note 
Viewing and editing system alarms 
System alarms can only be viewed and edited in RF-MANAGER if you have selected the 
option "Display all" under "Options > Settings > Workplace > Project View". 

 

Layout 
 

 
 

Workplace 
All the system alarms are displayed in a table in the workplace. You can edit the alarm text 
of the alarms in the table cells. You can sort the table according to the entries in a column by 
clicking on the column header.  

Properties dialog box 
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The alarm text of the system alarms can be modified in the properties dialog box. The alarm 
number and alarm class are assigned by the system.  

See also 
Basic Principles of Editors (Page 313) 

3.10.3.6 "Alarm classes" editor 

Introduction 
You create alarm classes and specify their properties in the "Alarm classes" tabular editor.  

Opening the "Alarm Classes" editor 
In the project view, double-click "Alarm classes" in the "Alarms > Settings" group.  

Layout 
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Workplace 
All the alarm classes are displayed in a table in the workplace. You can edit the properties of 
the alarm classes in the table cells. You can sort the table according to the entries in a 
column by clicking on the column header.  

Properties dialog box  
Here you configure alarm classes. The properties dialog box offers the same information and 
settings as the workplace table.  

See also 
Basic Principles of Editors (Page 313) 

3.10.4 Working with alarms 

3.10.4.1 Acknowledge alarms 

Introduction 
For alarms displaying critical or hazardous operating and process states, a stipulation can be 
made requiring the plant operator to acknowledge the alarm.  

Mechanisms for acknowledging alarms 
An alarm can be acknowledged by the operator in the runtime system. Acknowledgment can 
be performed by the operator in the following ways: 
● Function keys 
● Softkeys or buttons in screens 
In addition, alarms can be acknowledged through system functions in function lists or scripts. 

Alarms requiring acknowledgment 
The alarm class determines whether or not the alarm must be acknowledged. 
Alarm classes essentially define how alarms will appear when shown on the runtime system 
as well as the acknowledgement behavior. RF-MANAGER has both predefined alarm 
classes and the option to configure user-defined alarm classes. 
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3.10.4.2 Reporting alarms 

Introduction 
Configure a report in RF-MANAGER with which you can output the alarms from the alarm 
buffer or an alarm log.  

Output data of an alarm report 
In order to report the alarms from the alarm buffer or an alarm log, insert the "Print alarm" 
object from the toolbox view into a report. Select the object in order to have the properties 
displayed in the properties dialog box. Configure the data selection for the report in the 
properties dialog box. 
The following data can be output in the report: 
● Current alarms from the alarm buffer 
● Alarms from an alarm log 
Specify the alarm classes which you want to output for the selected source. 
● RFID alarm classes 
● Custom alarm classes 
Specify the sequence of the alarms for the output. The following selections are possible: 
● Oldest alarm first 
● Most recent alarm first 
In order to output the alarms of a certain period, connect the "Display beginning" and 
"Display end" fields to variables. The variables can be supplied in runtime with the date and 
time for the first or the last alarm of the period. 
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3.10.5 Alarm logging 

3.10.5.1 Basic principles of alarm logging 

Introduction 
In the project, alarms indicate fault and operating states of the runtime system and the 
reader. RF-MANAGER lets you log alarms and document operational states and error states 
of the plant. 

Principle 
You can configure alarm logging. The alarms to be logged are assigned to an alarm log via 
the alarm class. Every alarm belongs to a specific alarm class. When configuring an alarm 
class, enter the alarm log to be used.  
You can save alarms from various alarm classes in a single log. 
When you create a log, you specify the log properties and select the log behavior. 
A log contains the following data:  
● Date and time of alarm 
● Alarm text 
● Alarm number 
● Alarm status 
● Alarm class 
● Alarm procedure 
● Values of the output fields contained in the alarm text 
● Device 

 

 
 

Note 
The alarm text and the device are only logged if this has been configured in the 
properties of a log. 

 

See also 
Alarm logging (Page 321) 
"Alarm logs" editor (Page 322) 
Basic settings for alarm logs (Page 323) 
Alarm logging (Page 325) 
Displaying logged alarms on screens (Page 325) 
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3.10.5.2 Alarm logging 

Introduction 
To log alarms, you group them in alarm classes. Each alarm class can be recorded in a 
separate log. You specify the log behavior when configuring the log.  

Log types 
In RF-MANAGER, you can select from the following log types:  
1. Circular log 
2. Segmented circular log 
3. Log with system alarm 
4. Log with execution of system functions 
Alarms can be logged automatically or managed by an operator. 

Storage media 
Log data can be saved either in a file or in a database. Saved data can undergo additional 
processing in other programs, e.g. for analysis purposes.  

Displaying log contents 
You can display log contents on the runtime system. To do so, you must configure an alarm 
view.  

See also 
"Alarm logs" editor (Page 322) 
Basic settings for alarm logs (Page 323) 
Alarm logging (Page 325) 
Displaying logged alarms on screens (Page 325) 
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3.10.5.3 "Alarm logs" editor 

Introduction 
In the "Alarm logs" table editor, you configure alarm logs for logging alarm classes and 
define their properties.  

Opening the "Alarm logs" editor 
Double-click on "Alarm logs" in the project window in the "Log" group to open the "Alarm log" 
editor. 

Layout 
 

 
 

Workplace 
All alarm logs are displayed in a table in the workplace. You can edit the properties of the 
alarm logs in the table cells. You can sort the table according to the entries in a column by 
clicking on the column header.  

Properties dialog box 
Here you configure alarm logs. The properties dialog box offers the same information as the 
workplace table.  
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See also 
Basic settings for alarm logs (Page 323) 
Alarm logging (Page 325) 

3.10.5.4 Basic settings for alarm logs 

Introduction 
The properties of an alarm log can be defined in the "Alarm log" editor or in the Properties 
window for logs.  

General properties 
● Name 

The name of the alarm log is freely selectable but the name must include at least one 
letter or one number. 

 

 
 

Note 
The characters which can be used in the name of the data source depend on the storage 
location. 
 If the storage location "File" is used, the following characters may not be used:  

\ / * ? : " < > | 
 If the storage location "Database" is used, the following characters may not be used: 

a-z A-Z 0-9 _ @ # $ 
However, the characters _ @ # $ may not be used as the first character of the name. 

 

● Memory location 
The alarm log may be stored in an ODBC database or in a separate "*.csv" file. Select 
"File" or "Database" as the storage location correspondingly. 
Depending on the configuration of the runtime system, you can select the local hard disk 
of the PC or, if present, a network drive as "path." 
If you have chosen an ODBC database as the storage location, you have the name 
suggested by the system (system-defined data source name) or enter one yourself (user-
defined data source name). 

● Size 
The size of the log is calculated from the number of data records and the rough size of an 
entry. The size of an entry is dependent, amongst other things, on whether the alarm text 
is to be logged with it. 
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Alarm log properties 
● Start-up behavior 

Under Enable you can specify that logging starts when runtime is started. Enable the 
checkbox "Enable logging at runtime start." 
You can also control the behavior at runtime start in other ways. Enable "Reset log" if you 
want to overwrite previously logged data with the new data or "Append data to existing 
log" if you want to append new data to an existing log. 

 

 
 

Note 
System functions can be used to control the restart of a log during runtime. 

 

● Logging method 
Here you can specify what should happen when the log is full. You can choose one of the 
following options: 
– Circular log 

When the log is full, the oldest entry will be overwritten. 
– Segmented circular log 

Multiple logs of the same size will be created and filled one after the other. When all 
logs are completely full, the oldest log is overwritten. 

– Display system message when 
When a defined status is reached a system alarm is displayed. 

– Trigger event 
The event is triggered as soon as the log is full. 

● Settings 
Define whether the alarm text should be stored each time an alarm is logged. The alarm 
texts will be logged in the current runtime language. 

● Comments 
Here you can enter descriptive text regarding the log. 

See also 
"Alarm logs" editor (Page 322) 
Alarm logging (Page 325) 
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3.10.5.5 Alarm logging 

Introduction 
In runtime, alarms can be stored in logs for later evaluation. When configuring the logging of 
alarms and alarm classes, the user defines the log in which the alarms are to be stored and 
whether just the alarm events are stored or the associated alarm texts and variable values, 
too.  

Principle 
Several steps are involved in alarm logging: 
● Creating and configuring alarm logs 

When creating an alarm log, the following must be defined: 
– General settings, e.g. name, size, storage location 
– Behavior at runtime start 
– Behavior when the log is full 

● Configuring logging of the alarms in an alarm class 
An alarm log can be specified for each alarm class in which the alarm events are stored 
during runtime.  

● Further processing logged alarms 
The logged alarms can be evaluated directly in your RF-MANAGER project, e.g. in an 
alarm view, or via another application, e.g. Excel. 

See also 
Displaying logged alarms on screens (Page 325) 

3.10.5.6 Displaying logged alarms on screens 

Introduction 
During runtime, you can display logged alarms on the screens of the runtime system. During 
this process, alarms in an alarm class are downloaded from the log database and presented 
in an alarm view.  

Principle 
You must configure an alarm view to display logged alarms on the runtime system. When 
configuring an alarm view, specify the alarm class of the alarms to be displayed. 
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3.10.5.7 Structure of a CSV file 

Introduction 
In the *.csv (Comma separated value) file format, table columns (name and value of entry) 
are separated by a semicolon. Each table row ends with a carriage return. 

Example of a CSV file 
This example shows a file with logged alarms: 
"Time_ms";"MsgProc";"StateAfter";"MsgClass";"MsgNumber";"Var1";...;" 
Var8";"TimeString";"MsgText";"PLC"37986550590,27;1;1;3;110001;"";... 
;"";"30.06.99 13:12:51";"Change to operating mode 
'online'";37986550682,87;1;1;3;140010;"";...;"";"30.06.99 
13:12:59";"Connection established: PLC_1, Station 2, Rack 0, 
Position 2"; 

Structure of a log file in CSV format 
The following values are entered in the individual columns of an RF-MANAGER log file:  
 
Parameters Description 
Time_ms Specify a time stamp as a decimal value ( see below for conversion) 
Msg_Proc Alarm procedure: 

0 = Unknown alarm procedure 
1 = System alarm 
9 = RFID base alarm 
10 = RFID edge alarm 
11 = RFID status alarm 
12 = RFID device alarm 

State after Alarm event: 
0 = Activated/Deactivated 
1 = Activated 
2 = Activated/Acknowledged/Deactivated 
3 = Activated/Acknowledged 
6 = Activated/Deactivated/Acknowledged 

Msg_Class Alarm class: 
0 = No alarm class 
3 = System 
64 to 99 = Alarm classes configured by the user 
100 = RFID emergency 
101 = RFID alarm  
102 = RFID critical  
103 = RFID fault  
104 = RFID warning 
105 = RFID note 
106 = RFID information 
107 = RFID debug 

Msg Number Alarm number 
Var1 to Var8 Alarm variable value as STRING 
Time string Time stamp as STRING, i.e., readable date format 
Msg text Alarm in a readable STRING 
PLC Alarm localization (relevant device) 
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Conversion of the decimal value in the time stamp 
If the value needs to be processed using a different program, proceed as follows: 
1. Divide Time_ms by 1,000,000. 

Example: 37986476928 : 1.000.000 = 37986,476928 
2. The whole number portion (37986) is the date calculated from 31.12.1899. 

You can now convert the time stamp value to days in Excel by assigning a corresponding 
format from the "Date" group to the cells, which contain the time stamp. 
Result: 37986 results in 31.12.2003 

3. The value after the comma (0,476928) indicates the time: 
– Multiply the value (0.476928) by 24 to obtain the hours (11.446272). 
– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632). 
– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792). 

Overall result 11:26:46,579 
This conversion is supported by Microsoft Excel, for example. 

3.10.5.8 Accessing the ODBC log database directly 

Introduction 
The storage location of a log can be a database or a file.  
The database is addressed by means of its "Data source name" (DSN). Select the database 
you would like to use RF-MANAGER in the Windows Start menu under Settings > Control 
panel > ODBC data sources. 
To store log data, specify the "Data source name" (DSN) instead of a directory name when 
making your configuration settings. With the DSN, you are referencing the database and the 
storage location. 

Application 
The entire functional scope of the database is available for additional processing and 
evaluation of log data. 

Principle 
You create the data source that connects to the database on the same computer that 
contains the runtime software. You then specify the DSN configured here when you create a 
log in the RF-MANAGER.  
Using the ODBC interface, you can access the database directly with other programs such 
as MS Access or MS SQL server. 
With the "StartProgram" system function, you can also configure a program call (for MS 
Access, for example) on the runtime system. This does not interrupt the runtime program 
sequence. 
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3.11 Working with PLC connections 

3.11.1 Fundamentals 

3.11.1.1 Basic principles of communication 

Communication partners  
The communication partner can be a SIMATIC S7 PLC. The communication partners can be 
interconnected via direct cable connection or network. The data transferred between the 
communication partners are used to represent control values and to logically combine them 
with RFID data.  

3.11.1.2 Principle of the communication 

Introduction 
RF-MANAGER controls communication between the runtime system and the reader or PLC 
by means of variables and area pointers. 

Communication using variables 
In RF-MANAGER, variables are centrally managed in the "Variables" editor. There are 
external and internal variables. External variables are used for communication, An external 
variable is the image of a defined memory location in the PLC or reader. A runtime system 
and the PLC or reader have read and write access to this memory location. Those read and 
write operations may cyclic or event-triggered.  
In your configuration, create variables that point to specific addresses in the PLC or reader. 
The runtime system reads the value from the specified address and displays it. The operator 
can also make an input on the runtime system that is then written to the address on the 
PLC/reader. 

Communication using area pointers 
Area pointers are used to exchange data of specific user data areas. Area pointers are 
parameter fields the RF-MANAGER uses in Runtime to obtain information about the location 
and size of data areas of the PLC/reader. During communication, the PLC/reader and the 
runtime system read and write information for each other in these data areas. Based on the 
evaluation of data stored in these areas, the PLC/reader and runtime system trigger defined 
actions.  
The RF-MANAGER uses the following area pointers: 
● Screen number 
● Date/time PLC 
● Coordination 
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Communication drivers 
A communication driver is a software component that establishes a connection between an 
RFID system and a runtime system and thus allows the transfer of process values to the RF-
MANAGER variables. RF-MANAGER provides a communication driver for connection to 
SIMATIC S7.  
Users can select the interface, the profile and the transmission speed for each specific 
communication partner. 
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3.11.2 Elements and Basic Settings 

3.11.2.1 The PLC Connections editor 

Introduction 
In the "PLC connections" editor, you create and configure connections.  

Open  
Select "PLC connections" from the project view, and then open the shortcut menu. Select 
"Add PLC connection" from in this shortcut menu. The new connection will be created and 
opened in the workplace. 

Layout  

 
 

① Workplace 

② Tabs 
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Workplace  
All connections are visualized in the workplace in tabular format. You select the 
communication drivers from the table cells, and edit the relevant connection properties. You 
can sort the table according to the entries in a column by clicking on the column header.  

Tabs  
Using the "Parameters" tab you can configure the settings for the communication drivers 
selected in the table. Select the settings for the runtime system, the network and for the 
controller. 
Using the "Area pointers" tab you can configure the area pointers of the connections. 

3.11.2.2 Parameters for connections 

Introduction 
Select the "Parameters" tab of the "PLC connections" editor to configure the properties of a 
connection between the runtime system and the communication partner. 

Layout  
The communication partners are visualized schematically on the "Parameters" tab. This tab 
provides the "Runtime system", "Network" and "Controller" areas where you can declare the 
parameters of the relevant interface used. 

 
The system sets default parameters. Always ensure consistency on the network whenever 
you edit parameters.  

 

 Note 
Protocol description 
For detailed information on configurable parameters, refer to the description of the supported 
protocols In the SIMATIC RF-MANAGER Information System. 
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3.11.2.3 Area pointers for connections 

Introduction 
Using the "Area pointer" tab of the "PLC connections" editor, you can configure the usage of 
the available area pointers. 

Layout  
The "Area pointer" tab contains two tables of area pointers. The "For all connections" table 
contains those area pointers which are created only once in the project and can be used for 
only one connection.  
The "For each connection" table contains the area pointers you can set separately for each 
available connection.  

 
 

 

 Note 
Protocol description 
For detailed information on the area pointers and their configuration, refer to the description 
of the supported protocols in the SIMATIC RF-MANAGER Information System. 
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3.12 Working with reports 

3.12.1 Working with the Report System 

Introduction 
Logs are used in the RF-MANAGER to document plant statuses. You can log alarms in order 
to generate shift logs.  

Overview 
You can edit the report files in the graphic editor. In this editor, you configure the layout of 
the reports and determine the output data. You can add various objects for the output of data 
to a report file.  
You can create separate report files for reporting different types of data. You can set the 
triggering of the output separately for each report file. You can choose to trigger the output of 
data at a specific time or in defined intervals, or by other events. 
The modular structure of these features allows you to explicitly configure reports for different 
requirements.  

Application examples 
Create a shift log which outputs e.g. any error events at the end of a shift.  
You can create a log which outputs alarms of a certain class or type. 
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3.12.2 Structure of reports 

Structure of a report 
The reports in RF-MANAGER all have the same basic structure. They are subdivided into 
different sections as shown in the figure below.  

 
Figure 3-21 Report 

The individual sections are used to output different data and can contain general objects and 
specific report objects. 
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● Report header 
The report header serves as the cover sheet for a report. The report header is used to 
output the project title and general information on the project. The report header is output 
without page header and without page footer. The report header is output once at the 
start of a report. 

● Report footer 
The report footer is used as the final page of a report. The report footer is used to output 
a summary of the report or other information which is required at the report end. The 
report footer is output without page header and without page footer. The report footer is 
output once at the end of a report. 

● Page header 
The page header is output with every page of a report. The page header is used to output 
the date, time, title or other general information. 

● Page footer 
The page footer is output with every page of a report. The page footer is used to output 
the page numbers, the total number of pages or other general information. 

● Page 
The runtime data are output in the "Detail page" area. The objects for outputting the 
runtime data are inserted in the "Detail page" area. When you output the data, page 
breaks are added automatically depending on the amount of data. You can also insert 
several pages into a report in order to optically separate the configuration of various 
output objects. 

The creation of a report is described in the "Creating a report" chapter. 

See also 
Working with reports (Page 339) 
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3.12.3 Elements and Basic Settings 

3.12.3.1 "Reports" editor 

Introduction 
You can create and edit reports with the report editor.  

Open 
Select the "Reports" entry in the project view and open the pop-up menu. Select the "New 
report" command in the pop-up menu. A new report is created and opened in the workplace. 
In order to open an existing report, double-click in the object view on the desired report. The 
selected report is opened. 

Layout 

 
① Project view 
② Workplace 
③ Toolbox 
④ Properties dialog box 
⑤ Object view 
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Menu bar 
The menu bar contains all commands required for operating RF-MANAGER. Any available 
shortcut keys are indicated next to the menu commands. 

Toolbars 
The toolbars contain the buttons most often used. 
Select "View > Toolbars" to show or hide the specific toolbars. The  button of a toolbar is 
used to display or hide the individual buttons of this toolbar.  

Workplace 
You configure the reports in the workplace.  

Toolbox 
The toolbox gives you access to the objects required to configure a report. The objects are 
inserted into the report using the drag-and-drop function. 

Properties dialog box 
When an object is selected, you can edit the properties of the selected object in the 
properties dialog box. 
When no object is selected, you can edit the properties of the active area of a report in the 
properties dialog box. 

See also 
Using the toolbox view (Page 338) 
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3.12.3.2 Using the toolbox view 

Introduction 
The toolbox view contains a selection of objects which you can insert into your reports in the 
"Simple objects" and "Report objects" groups. 

Changing default properties 
Default properties are preset for the various object types in the toolbox view. When you 
insert an object from the toolbox view into a report, the object takes over these default 
properties.  
You can customize the default properties of an object type to suit the requirements of your 
project. When you change the default properties of an object type, the properties of objects 
which have already been inserted are retained. You should therefore adapt the default 
properties before you insert the objects. 
The default properties of the objects are coupled to the user names under which you are 
logged on in the operating system. 
In order to change the default properties, you open the pop-up menu of an object in the 
toolbox view. Select the command "Edit default properties." The "Properties" dialog box is 
displayed. Adapt the default properties of the object to the requirements of your project. 

Displaying the toolbox view 
With the "View ▶ Toolbox view" menu you can display or hide the toolbox view.  

See also 
"Reports" editor (Page 336) 
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3.12.4 Working with reports 

Introduction 
New logs have to be created in order to log runtime data. As an alternative, you can adapt 
existing logs to your requirements. Specify in the logs which data are to be logged in 
runtime. 
In the RF-MANAGER you can create any number of logs and control the output of the 
individual logs differently. 

See also 
Structure of reports (Page 334) 

3.12.4.1 Summary 

Introduction 
When creating a report, you specify the individual sections and contents. Configure the 
contents of the following sections: 
● Report header 
● Page header 
● Page 
● Page footer 
● Report footer 

Configuration overview 
Objects from the toolbox view are available for designing a report and configuring the data 
for the output. Some objects have a limited functional scope when used in a report compared 
to similar objects of the screen editor. An I/O field can, for example, only be used as an 
output field. 
When a report is created in the report editor, it is displayed as wysiwyg. The dynamic object 
for outputting the data, for example "Print alarm", is an exception. The configured height of 
this object is irrelevant to the output format since the size of the dynamic object depends of 
the existing amount of data. Page breaks are inserted consecutively on the pages depending 
on the amount of data. You can only insert one object into each page of a report. Objects 
which are positioned on the same page below this dynamic object are not output. The "Print 
alarm" object is inserted automatically with the width configured for the report. The width of 
the output follows the configured width of the report. 
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A new report always only contains one page. This page represents a page for the output. If 
required, you can insert further pages into the report. To do so, move the cursor onto the title 
bar of an existing page and open the pop-up menu with the right mouse button. The 
commands "Insert page before" and "Insert page after" are used to insert a new page before 
or after the existing page. The pages have a consecutive number assigned to them. A 
maximum of 10 pages is permitted per report. If you create more than 10 pages, the 
consecutive numbers of the superfluous pages are placed in pointed brackets (for example: 
Page <11>). The superfluous pages are not taken into consideration for the output. The 
"Delete page" command in the pop-up menu of a page is used to delete the selected page. 
 

 
Figure 3-22 Pop-up menu of a page 

 
The sequence of the created pages can be changed subsequently. To do so, move the 
cursor onto the desired page and open the pop-up menu with right mouse button. Select the 
corresponding command "One page up" or "One page down" in the pop-up menu. The page 
is moved correspondingly. The consecutive numbering of the pages is retained. If, for 
example, Page 4 is moved "One page up" by means of the corresponding command, Pages 
3 and 4 are swapped. 
The individual report sections can be closed in order to obtain a better overview in the 
workplace. In order to minimize or maximize, click on the node before the section 
designation. 
 

 
 
You can also display or hide all the areas simultaneously. To do so, move the cursor onto 
the title bar of a report area and open the pop-up menu with the right mouse button. Select 
the corresponding command "Display all" or "Hide all" in the pop-up menu. 
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See also 
Working with reports (Page 339) 
Adapting the report properties (Page 341) 
Use of report objects (Page 344) 

3.12.4.2 Adapting the report properties 

Introduction 
You edit the output options and the format options for the report in the report properties. The 
following property groups are available: 
● General 
● Properties/Display 

Requirements 
● The report whose properties are to be changed must be open. 
● The properties dialog box has to be open. 

Editing the report properties 
Move the mouse pointer to the report to be edited in the project view or to the title of a report 
area, e.g. to the title line of the "Header". Open the pop-up menu with the right button and 
select the command "Document properties." The report properties are displayed in the 
properties dialog box. 
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Activate the "General" properties group in the properties dialog box. 
Activate or de-activate the output of the report header and report footer in the "Report" area. 
Activate or de-activate the output of the page header and page footer in the "Page" area. 
If the output of a report area is de-activated, this area is identified in the title bar by an "(X)." 
Activate the "Properties/Display" properties group in the properties dialog box. 

 
 
Select the page format for the output in the "Page" field. 
As an alternative, select the "User defined" format. You can then enter values for your own 
format in the "Width" and "Height" fields. 
Select the portrait or landscape format in the "Page orientation" field. 
Select the unit of measurement for setting the page size and page margins in the "Unit" field. 
Set the size of the page margins by using the fields in the "Page margins" area. The page 
margins set may not be smaller than the page margins set at the printer. 

See also 
Summary (Page 339) 
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3.12.4.3 Objects for report creation 

Introduction 
Objects can be either graphics elements for laying out your project report or dynamic 
elements for outputting data.  
The objects are made available in the "Simple objects" object group in the toolbox view. 
The special report objects are also available for creating reports. The special report objects 
are contained in the "Report objects" object group. 

Basic objects 
 
Icon Object Description 

 
Line The line is an open object. The line length and angle are defined by 

the height and width of the rectangle enclosing the object. The line 
ends can be represented as arrows or dots. 

 
Ellipse The ellipse is an enclosed object which can be filled with a color or 

pattern. You can customize the width and height of an ellipse in 
order to align it horizontally or vertically. 

 
Circle The circle is an enclosed object which can be filled with a color or 

pattern. The circle diameter can be adjusted freely. 

 
Rectangle The rectangle is an enclosed object which can be filled with a color 

or pattern. The height and width of a rectangle can be varied freely 
in order to allow a horizontal or vertical adjustment. The corners of a 
rounded rectangle can be rounded off as required. 

 
Text field The field for static text is an enclosed object which can be filled with 

a color or pattern. The static test is entered in a text field of any size. 
You can enter single or multiple line text for all configured 
languages. 

 
"I/O field" The I/O field can only be used as an output field in a report. With an 

"I/O field" you can output values with the following data formats: 
Binary, date, date-and-time, decimal, hexadecimal, string and time. 

 
"Date-time box" The date and time are output in a report with the "Date-time" field. 

You can output the system time or connect a RF-MANAGER 
variable through which the "Date/time" field is supplied with 
corresponding values. 

 
"Graphic I/O field" The graphical I/O field can only be used as an output field in a 

report. The field is used to select graphics from a graphics list. This 
allows you to display, for example, states of variables graphically. 
Example: 
Instead of the values 0 and 1, you can output one graphic each for a 
closed and an open valve. 
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Icon Object Description 

 
"Symbolic I/O field" The symbolic I/O field can only be used as an output field in a 

report. The field is used to select texts from a text list. This allows 
you to display, for example, states of variables in text form. 
Example: 
Instead of the values 0 and 1, you output "Motor OFF" and "Motor 
ON" for the state of a motor. 

 
"Graphic view" The graphics object offers the possibility of inserting graphics which 

were created with other programs into a report. You can insert 
graphics or images with the following formats: "*.emf", "*.wmf", 
"*.dib" and "*.bmp." You define the size and the graphics object 
properties. 

See also 
Use of report objects (Page 344) 
Summary (Page 339) 

3.12.4.4 Use of report objects 

Introduction 
Special objects are available for logs under the "Log objects" section in the toolbar. These 
objects are intended exclusively for use in reports.  

Overview of the objects 
 
Icon Object Short description 

 Page number Outputs the page number in a report. The object only has to be 
inserted once in a report, for example in the page footer. 

 Print alarm Outputs alarms in a report. 

See also 
Reporting alarms (Page 345) 
Summary (Page 339) 
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3.12.5 Reporting alarms 

Introduction 
Configure a report in RF-MANAGER with which you can output the alarms from the alarm 
buffer or an alarm log.  

Output data of an alarm report 
In order to report the alarms from the alarm buffer or an alarm log, insert the "Print alarm" 
object from the toolbox view into a report. Select the object in order to have the properties 
displayed in the properties dialog box. Configure the data selection for the report in the 
properties dialog box. 
The following data can be output in the report: 
● Current alarms from the alarm buffer 
● Alarms from an alarm log 
Specify the alarm classes which you want to output for the selected source. 
● RFID alarm classes 
● Custom alarm classes 
Specify the sequence of the alarms for the output. The following selections are possible: 
● Oldest alarm first 
● Most recent alarm first 
In order to output the alarms of a certain period, connect the "Display beginning" and 
"Display end" fields to variables. The variables can be supplied in runtime with the date and 
time for the first or the last alarm of the period. 

See also 
Working with reports (Page 339) 
Use of report objects (Page 344) 
Editing output parameters for an alarm log (Page 346) 
Outputting a report (Page 349) 
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3.12.5.1 Editing output parameters for an alarm log 

Introduction 
The output parameters for an alarm log are edited in the properties dialog box. The "Print 
alarm" object has to be inserted in a report in order to display the properties. The properties 
dialog box has to be open. 

Output parameters of "Print alarm" 
Select the "Print alarm" object in the workplace. The properties of the object are displayed in 
the properties dialog box. Select the data source and configure the selection and the layout 
of the data for the output in the "General" category.  

 
The following entries are available for the output of alarms: 
 
Attribute Function Requirements 
"Source for alarms" This is used to select the alarm source. 

You can select from the following options:
 Alarm events 
 Alarm log 

 

"Sorting" Is used to specify the sequence for the 
output. You can select from the following 
options: 
 Oldest alarm first 
 Most recent alarm first 

 

"Lines per entry" This specifies the number of lines 
available per alarm. The required number 
of lines depends on the number and width 
of the selected columns in for the output 
as well as the font used and the paper 
format of the printer. 

 

"Page header visible" Used to specify whether the table is to be 
output with column headers. 

 

"Alarm log" Is used to select the alarm log for the 
output. 

An alarm log has to be selected 
as the alarm source in the 
"Source for alarms." 
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Attribute Function Requirements 
"Alarm classes" Is used to select the alarm classes for the 

output. You can select from the following 
options: 
 RFID alarm classes 
 Custom alarm classes 
 System alarms 

 

"Display beginning" Used to select the first alarm for 
outputting the alarms of a specific period. 
Connect the field via the selection list to a 
variable. Supply the variable in runtime 
with a start value, for example via an 
input field. 

The variable must be of the type 
"Date and time." 

"Display end" Used to select the last alarm for 
outputting the alarms of a specific period. 
Connect the field via the selection list to a 
variable. Supply the variable in runtime 
with an end value, for example via an 
input field. 

The variable must be of the type 
"Date and time." 

 
Select the "Appearance" subcategory in the "Properties" category. Configure the foreground 
color, the background color, the style and the font settings. 

 
 
Select the "Layout" subcategory in the "Properties" category. Configure the position and size 
of the "Print alarm" object. Select the columns for the output in the report in the "Visible 
elements" area. 
The following columns can be output: 
● "Alarm number" 
● "Time" 
● "Alarm status" 
● "Alarm text" 
● "Date" 
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● "Alarm class" 
● "Device" 

 
 

 
 

Note 
The height of the "Print alarm" object configured in the report is irrelevant to the output. 
Since a large amount of data can occur during the report output, the "Print alarm" object 
is extended dynamically so that all the data arising can be output. If the page length is 
exceeded, an automatic page break is carried out. 

 

See also 
Reporting alarms (Page 345) 
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3.12.6 Outputting a report 

Introduction 
RF-MANAGER offers the following options for outputting a report: 
Time-controlled output, for example: 
● Non-recurring, time-controlled output 
● Output repeated at intervals 
Event-controlled output, for example: 
● Through a change in the variable value 
● Through activating a configured button in a screen 
● Overflow of a log 
● Using a script 

Configuration of the output 
Time-controlled output is configured through the scheduler. The report output can 
furthermore be controlled by system events which are made available by the scheduler.  
Event-controlled output of an object is configured directly at a variable, a button in the 
screen, or in a log. 

 

 Note 
The logs are output on the standard printer. 

 

See also 
Working with reports (Page 339) 
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3.13 User administration 

3.13.1 Field of application of the user administration 

Principle 
The access security system controls user access to data and functions in runtime to prevent 
unauthorized operations. Safety-relevant operations are already limited to specified user 
groups when a project is being created. For this purpose, users and user groups are set up 
and have characteristic access rights, the authorizations, assigned to them. Required 
operation authorizations are configured for objects. For example, operators only have access 
to specific function keys. Commissioning engineers, on the other hand, have unlimited 
access during runtime.  

Definition 
Users, user groups and authorizations are administered centrally in the user administration. 
The user administration controls access to data and functions during runtime. For this 
purpose, users and user groups are created, administered and transferred to the runtime 
system in the engineering system. In Runtime you manage the users and passwords by 
using the "User view". 

Application example 
You create and configure an access protection in order to protect operating elements, such 
as input fields and function keys, against unauthorized operation. Only specified persons or 
operator groups can change parameters and settings and call functions.  

 

CAUTION  
Access protection does not protect against incorrect operations. You are responsible for 
ensuring that only correspondingly trained and authorized personnel design, commission, 
operate and maintain, etc. plants and machines.  
Access protection is not suitable for defining work routines and monitoring their 
observance.  

 

See also 
"Users" user administration (Page 352) 
"Groups" user administration (Page 354) 
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3.13.2 Structure of the user administration 
Authorizations are not assigned directly to users in the user administration, but rather to user 
groups. A user is then, for example, assigned to the "Operators" user group and receives its 
authorizations. Authorizations do not have to be assigned individually to each user, only to 
the user group. 
In a different environment, other users occur. The authorizations and user groups of the 
project, however, remain unchanged. Only users are re-assigned to the user groups, for 
example "Operators."  
The user administration separates the administration of the users from the configuration of 
the authorizations. This ensures flexibility at the access protection. 

See also 
"Users" user administration (Page 352) 
"Groups" user administration (Page 354) 
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3.13.3 Elements and Basic Settings 

3.13.3.1 "Users" user administration 

Introduction 
In user administration you administer users and user groups in order to control access to 
data and functions in runtime. The user administration is divided into the administration of 
the users and the administration of the user groups. This section describes the 
administration of the users.  

Open 
You open the administration of the users in the project window by double-clicking on "Users."  

Layout 

 
① Workplace 
② Properties dialog box 
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Workplace 
The "Users" workplace shows the existing users and the user groups to which they are 
assigned. 

 

 Note 
A user can only be assigned to one user group. 

 

Properties dialog box 
When a user has been selected, edit the password and the time after which the user is 
logged off automatically in the "General" group. 

See also 
"User" workplace (Page 355) 
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3.13.3.2 "Groups" user administration 

Introduction 
In user administration you administer users and user groups in order to control access to 
data and functions in runtime. The user administration is divided into the administration of 
the users and the administration of the user groups. This section described the 
administration of the user groups.  

Open 
You open the administration of the user groups in the project window by double-clicking on 
"Groups." 

Layout 

 
① Workplace 
② Properties dialog box 
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Workplace 
The "Groups" workplace shows the existing user groups and their authorizations. 

Properties dialog box 
When a user group or an authorization is selected, you can edit the designation and the 
comment in the "General" group. 

See also 
"User groups" workplace (Page 356) 

3.13.3.3 "User" workplace 

Introduction 
The "Users" workplace lists the users and user groups in table form. You administrate the 
users and assign them to a user group.  

Principle 
The workplace consists of the "Users" and "Groups of the user" tables. 

 
The "Users" table shows the existing users. When you select a user in this table, the 
"Groups of the user" table displays the user group to which the user is assigned. 
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3.13.3.4 "User groups" workplace 

Introduction 
The "Groups" workplace shows a table of the user groups and their authorizations. You 
administer the user groups and assign authorizations to them.  

Principle 
The workplace consists of the "Groups" and "Group Authorizations" tables. 
 

 
The "Groups" table shows the existing user groups. When you select a user group in this 
table, the "Group Authorizations" table shows the authorizations which were assigned to the 
user group. 
The number of the user group and of the authorization is assigned by the user 
administration. The designations and descriptions are assigned by you. 
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3.13.4 Working with the user administration 

3.13.4.1 Users in Runtime 

Principle 
In the engineering system you create users and user groups and allocate authorizations to 
them. You configure objects with authorizations. After starting the Runtime system, all 
objects which were configured with an authorization are protected against unauthorized 
access in runtime.  

User view 
When you configure a user view in the engineering system, you can administer users in the 
user view following starting of the Runtime system.  

 

CAUTION  
Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the engineering system. When the users and user groups are transferred from 
the engineering system to the runtime system, all the changes in the user view are 
overwritten after a user prompt and based on the transfer settings. 

 

Exporting and importing user data 
The users and passwords existing in a runtime system are exported by means of a system 
function and imported to a different runtime system. This ensures that the user 
administrations of the different runtime systems have the same status.  

3.13.4.2 Access security 

Introduction 
You configure an authorization at an object in order to protect it against access. All logged-
on users who have this authorization can access the object. When a user does not have 
authorization to operate an object, the logon dialog is displayed automatically. 

 

 Note 
Several system functions are available under "User administration" so that user, password 
and user group can be edited. 
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3.14 System functions and runtime scripting 

3.14.1 Basic principles 

3.14.1.1 Fundamentals of system functions and runtime scripting 

Introduction 
RF-MANAGER provides predefined system functions for common configuration task. You 
can use them to perform many tasks in Runtime and need no programming skills to do so.  
You can use Runtime scripting to solve more complex problems. Runtime scripting has a 
programming interface which can be used to access some of the project data in runtime. The 
use of runtime scripting is aimed at project planners with knowledge of Visual Basic (VB) and 
Visual Basic Script (VBS).  

Use of system functions 
System functions provide support if you wish to assign a function to an operating element: 
● Writing/reading of tags 
● Locking/destroying tags 
● Setting the output port of a reader 
● Set a bit in the PLC 
● Value changes of a variable 
● Starting logging 
System functions can be configured in function lists and scripts. 

Use of runtime scripting 
VBScript is supported as a programming language. The use of runtime scripting allows 
flexibility in the realization of configurations. Create scripts with runtime scripting when extra 
functionality in runtime is needed, e.g.:  
● Conversion of values 

You use scripts to convert values between different measurement units, e.g. cm to inch. 
● Automation of production sequences 

A script can control a production sequence, for example, by transferring RFID data to a 
PLC. The PLC then makes a decision about the subsequent steps on the basis of the 
RFID data. 
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Scripts 
You can save your own VB script code in a script. You use the script just like a system 
function in the project. You have access to the variables of a project in the script. In addition, 
you can use all standard VBS functions in the script. You can call other scripts and system 
functions in the script.  

Execution of system functions and scripts 
System functions and scripts are executed in runtime after the onset of a configured event 
(e.g. a mouse click on a button).  
During configuration make sure that not too many scripts are activated at the same time. 
Furthermore, generally avoid running the system at 100 % load for longer periods. 
Scripts are processed at lower priority so as not to interfere with operation or the 
representation of values. If system utilization is extreme, the scripts to be executed are 
therefore first only premarked for execution. The maximum size of the premarked list 
depends on the runtime system. 
If more scripts than can be premarked are activated at one time, during a screen change for 
example, excess calls are discarded and a system alarm displayed.  

Recursion level 
The recursion level in scripts is limited by the stack size of the runtime system. In Runtime, 
an unrestricted number of recursions leads to a system error message. Therefore, please 
limit the number of recursions in a script.  
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3.14.1.2 System functions 

Introduction 
System functions are pre-defined functions you can use to implement many tasks in runtime 
even without having any programming knowledge, e.g.:  
● Calculations, for instance the increasing of a variable value to a specific or variable 

amount. 
● Logging functions, e.g. starting an alarm log 
● Settings, e.g. setting an output port in the reader. 
● Alarms, for instance after change of user. 

Purpose 
You use system functions in a function list or in a script. You cannot change system 
functions, since system functions are pre-defined functions.  
When configuring a function list, select the system functions from a selection list that is 
sorted by categories:  

 
When you want to use a system function in the script, you select it from a selection list. You 
can call up the selection list in the script with <Ctrl+Space>.  



 RF-MANAGER Engineering System 
 3.14 System functions and runtime scripting 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 361 

Language dependency 
The names of the system functions are dependent on the set project language. The 
functionality can then be recognized immediately by the project planner.  
Exception: When calling up system functions in a script, please use the English name for the 
system function. You can find the English name of the system function in the system function 
reference.  

3.14.1.3 Use of system functions 

Introduction 
A function list is processed in runtime when the configured event occurs. The operator 
triggers an event, for instance by pressing a function key on the runtime system. An event 
can also be triggered by the system, for instance if a process value falls below a limit value.  

Applications 
You can configure system functions on all the objects that are able to react to an event. You 
can use system functions directly in function lists and scripts and thereby control the course.  
● Function List 

System functions are processed sequentially in a function list, that is, from the first to the 
last system function. In order to avoid waiting times, system functions with a longer 
running time (for instance file operations) are processed simultaneously. For instance, a 
subsequent system function will already be performed even though the previous system 
function has not yet been completed.  

● Script 
In a script, you use system functions in connection with orders and requirements in the 
code. This way, you execute a script depending on a specific system state. In addition, 
return values of system functions can be evaluated, for example. Depending on the return 
value, test functions are then carried out, for example, which in turn affect the course of 
the script. 
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3.14.1.4 Scripts 

Introduction 
You program VB script codes in a script. You use finished scripts in the project just like a 
system function. When creating a script, you determine its type and define transfer 
parameters. Scripts of the type "Function" have a return value. Scripts of the type "Sub" are 
referred to as procedures and have no return value.  

Properties of scripts 
You can call up other scripts and system functions in a script. When calling up a system 
function, please use the English name of the system function. You can use the full scale of 
language from Microsoft VBScript in scripts. Functions and methods for user interaction are 
excluded, for instance "MsgBox". 

Organization of scripts 
Scripts are stored in the project database. The available scripts are listed in the project view 
under scripts. 
If you want to use a script in a function list, you can find the scripts in the selection list under 
user scripts.  
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3.14.1.5 Use of scripts 

Principle 
Scripts provide more flexibility by using control elements of a programming language. 
Using scripts in runtime, you implement individual solutions in a project, for instance:  
● Configuring an advanced functions list 

You use a script just like a function list by calling up system functions and other scripts in 
the script.  
You can execute system functions and scripts in the script dependent on conditions, or 
have them repeated. You then add the script to a functions list.  

● Programming new functions 
Scripts are available in the entire project. You use scripts just as you would system 
functions. You can define delivery parameters and return values for these scripts. You 
use scripts, e.g. to convert values.  

See also 
Fundamentals of system functions and runtime scripting (Page 358) 
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3.14.2 Working with function lists 

3.14.2.1 Basic principles of the functions list 

Introduction 
When the configured event occurs, several system functions and scripts are performed with 
the function list.  

Principle 
The function list is configured for an event of an object, e.g. a screen object or a variable. 
The events which are available depend on the selected object. 

 
Events occur only when the project is in runtime. Events include: 
● Value changes of a variable 
● Status changes of alarms 
● Pressing of a button 
You can configure a function list precisely on every event. 
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See also 
System functions (Page 360) 
Fundamentals of system functions and runtime scripting (Page 358) 

3.14.2.2 Properties of a function list 

Status information 
During configuration the project data is tested in the background. A status information 
returns in each function list the status of the respective system functions and scripts.  
The status information has the following meaning: 
● Orange: Function list is not performed in runtime because at least one system function or 

a script has not been supplied completely with parameters. 

Completion of system functions and scripts 
System functions and scripts in a function list are processed in runtime sequentially from top 
to bottom. In order to avoid waiting times, system functions with a longer running time (for 
instance file operations) are processed simultaneously. For instance, a subsequent system 
function will already be performed even though the previous system function has not yet 
been completed. 
To avoid programming sequential and conditional procedures, use a script with loops, 
conditional statements and cancellation requirements.  
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3.14.3 Elements and Basic Settings 

3.14.3.1 Scripts 

Introduction 
Create and edit scripts in the script editor.  

Open 
The script editor opens automatically when a new script is created or an existing script is 
opened. 
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Layout 

 
① Project View 
② Workplace 
③ Script wizard (toolbox view) 
④ Properties dialog box 

Menu bar 
The menu bar contains all commands required for operating RF-MANAGER. Any available 
shortcut keys are indicated next to the menu commands.  

"Scripts" toolbar 
The commands for synchronizing objects and variables as well as for checking script syntax 
are located in the "Script" toolbar.  

"Advanced Edit" toolbar 
In the symbol bar "Advanced Edit", you will find commands for the following actions: 
● Working with bookmarks 
● Indenting and reverse-indenting of code 
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● Commenting code 
● Jumping to a specific code line 

"IntelliSense" toolbar 
The commands for displaying selection lists, e.g. all available system functions or VBS 
constants, are found in the "IntelliSense" toolbar.  

Workplace 
Create and edit scripts in the work area. The creation of scripts is supported by syntax 
emphasis and IntelliSense.  

Properties dialog box  
Configure the script in the properties dialog box. You determine whether the script is a 
procedure or a function. Furthermore you can declare parameters for the script. 

"Script Wizard" 
In the "Script Wizard", system functions and scripts are set up with assigned parameters just 
as in a function list. The filed system functions and scripts are also transferred to the active 
script from the "Script Wizard." In this way, you only need to perform the parameter 
assignment once.  
If system functions or scripts have already been configured on an event, these are 
transferred to the "Script Wizard" using copy and paste. Only system functions which are 
allowed in a script may be filed in the "Script Wizard." When you use copy and paste to 
transfer system functions that you cannot use in a script, these system functions will be 
marked. 

See also 
Properties of the "Script" editor (Page 369) 
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3.14.3.2 Properties of the "Script" editor 

Introduction 
The script editor supports you during programming with functionalities such as IntelliSense 
and emphasized syntax. In addition, you can, for example, create references to variables 
with the drag-and-drop function.  

IntelliSense 
When you access objects or methods, you are supported by IntelliSense:  

 
The methods and properties which the given object possesses can be selected from the 
selection list.  
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Syntax emphasis 
In the script editor, keywords are emphasized by different colors. Objects which the script 
editor recognizes are displayed in bold. Unknown words are underlined with a red wavy line:  

 
The table shows the pre-set colors for the most important keywords. 
 
Color Meaning Example 
Blue Keyword (VBS) Dim, If, Then 
Cyan Script FahrenheitToCelsius 
Brown System function IncreaseValue 
Red Variable  Tag_1 
Green Comment 'This is a comment' 

Synchronization of objects 
When opening the script, instances of objects (e.g. variables) are automatically synchronized 
with the configuration data. If a variable has been renamed in the "Variables" editor, for 
example, this change also affects the script. If the affected script is opened during 
modification, the renamed object will be underlined with a blue wavy line. You perform the 
synchronization manually in the script editor.  
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Object list 
Using the key sequence <Alt+Right>, you call up the object list in which all available objects 
are displayed depending on the context. The object list can be called up during the 
assignment of parameters, for example, or when using listings.  
Example: You want to reference an existing process screen by means of the screen list. 
Enter "ActivateScreen" in the Scripts editor and then call up the object list with <Alt+Right>. 
All existing process screens in the project are listed for you in the object list: 
Select the desired process screen and take on the selection with <Return>.  

Drag-and-drop 
If a variable is required in the script, it can be pulled from the object window.  
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Help functions 
During programming you will be shown automatically short descriptions of the necessary 
parameters for the methods and system functions. In addition, the following help functions 
are available in the script editor:  
● Tooltip 

Unknown or incorrectly written keywords will be underlined with a wavy line. When you 
move the mouse over a keyword, Tooltip appears: 

 
For known keywords, Tooltip shows the type of keyword.  

● ParameterInfo 
The ParameterInfo offers information concerning the syntax and the parameters of a 
system function or a VBS standard function. 

● Context sensitive help 
The context sensitive help offers information concerning system functions, VBScript 
language elements, objects, etc. 
If information about an object, a method or a property is needed, move the mouse pointer 
over the corresponding keyword and press <F1>. This allows you to reach the 
corresponding reference description in the online help. 

See also 
Scripts (Page 366) 
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3.14.4 Creating scripts 

3.14.4.1 Access to variables 

Introduction 
In the script you have access to external and internal variables which you set up in the 
project. The value of a variable can be read or changed in runtime.  
Furthermore, you can set up local variables as a counter or as buffer storage in the script.  
The script fetches the value of the external variable from Runtime memory. At the start of 
Runtime, the actual value will be read from the reader or PLC and written to Runtime 
memory. The variable value will then be updated with the set cycle time. The script first 
accesses variable values read from the reader or PLC at the previous scan cycle checkpoint. 

Project variables 
If the variable name in the project corresponds to the VBS name conventions, the variable 
can be used directly in the script:  
 
 
'VBS_Example_03 
If BeltDriveOilTemperature > 100 Then [instruction] 

If the variable name in the project does not correspond to the VBS name conventions, then 
the variable must be referenced by means of the "Smart tags" list. In the following example, 
the variable name contains the & sign, which is not allowed according to VBS name 
conventions:  
 
 
'VBS_Example_04 
SmartTags("Test&Trial")= 2005 

The VBS name conventions are found in the help for VBS in the information system.  

Local variables 
You define local variables in the script using the Dim statement. Local variables can be used 
only within the script. Therefore, they do not appear in the "Variables" editor.  
In the script, you use a local variable, for example, as counter in a For statement. 
 
 
'VBS_Example_05 
Dim intCount 
For intCount = 1 To 10[Instruction]Next 
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 Note 
You have to use a local variable if you need a variable for a "For statement". Project 
variables are not allowed within a "For statement".  

 

Access to variables in a script 
If a variable is used whose name was first assembled in the script at runtime, this variable 
should be configured with the "Cyclic continuous" acquisition mode.  
If you configure the variables with the "Cyclic on use" acquisition mode, you have to ensure 
that the script is only called in a screen where the variable is also used in another place, in 
an I/O field for example.  
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3.14.4.2 Call up of scripts and system functions in the scripts 

Principle 
System functions and other scripts can be called up in a script.  
Call up a system function or a script without return value ("Sub") as follows: 
<Function name> [Parameter1], [Parameter2], [...] 
A system function or a script with return value ("Function") is called up by means of 
assignment to an expression: 
<Expression> = <Function name> ([Parameter1, Parameter2,... [Parameter N]) 
If you do not want to evaluate the return value, use the call up as you would for a system 
function or a script without return value.  

Particularities when calling up system functions 
You can insert system functions and scripts into the script from the "Script Wizard." The 
system functions are displayed in the currently configured language in the "Script Wizard." 
When calling up a system function in the script, always use the English name of the system 
function:  
SetValue Tag1, 64 
You can find the English name of the system function in the system function reference under 
"Syntax." The set project language is not taken into consideration. 
The following rules apply to the parameter delivery for system functions: 
● Constants. 

If you use a constant as a parameter, then the parameter type must correspond to one of 
the three data types: Integer, double or string. The available constants are shown in a 
selection list when assigning parameters. The usual VBS conventions apply to constants.  

● Variables 
Independent of the spelling, variables are always delivered as "Call by reference." When 
the variable to be delivered corresponds to the VBS name conventions, the variable 
name can be delivered without the keyword SmartTags: 
SetValue Tag1, 64 
or 
SetValue SmartTags("Tag1"), 64 

● References to objects, e.g. process screens and logs 
An object reference is delivered as parameter in quotation marks: 
ActivateScreen "MainScreen", 0 

Particularities when calling up scripts 
When calling up a script, parameters are delivered as "Call by Reference." When you deliver 
a variable as a parameter, for example, the value assignments in the script have an 
immediate effect on the value of the variable.  
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3.14.4.3 Synchronization of tags and objects 

Introduction 
If you change an object name in the RF-MANAGER, the change affects the entire project. 
Changes of this type can be marked in the script and can then be "synchronized".  

Application example 
In the variable editor you defined the variable "Oil Temperature" which you want to use in a 
script. During the configuration rename this variable "OilTemperatureMotor1" in the variable 
editor.  
● Script was open during the renaming:  

The now invalid variable name is underlined by a blue wavy line in the script. When you 
move the mouse pointer over the variable name, Tooltip appears. When you click on the 
button "Synchronize", the variable is renamed in the script: 

 
● Script was closed during the renaming  

When the script is reopened, the variable is automatically synchronized. 
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3.14.5 Debugging 

3.14.5.1 Debugging Scripts 

Introduction 
Debugging allows you to test your scripts in runtime for logical programming errors. For 
example, you can test whether the proper values were delivered to the variables, and 
whether cancellation terms are realized correctly.  
To debug your scripts use exclusively the "Microsoft Script Debugger" or the "Microsoft 
Script Editor" supplied with Microsoft Office XP.  
Constraints 
The following restrictions apply for the SIMATIC Panel PC 420/427B with Windows XPe: 
● The "Microsoft Script Debugger" and the "Microsoft Script Editor" that is supplied with 

Microsoft Office XP are not authorized and may not be installed. 
Use a standard PC to debug your scripts. Further information on debugging can be found 
in the online help under "System functions and Runtime Scripting > Debugging". 

● No logging to the "System" database 
If you want to configure logs on the SIMATIC Microbox 420/427B, you may not use the 
"Database / System" setting, because the SQL server that is required cannot be run 
together with the activated Enhanced Write Filter (EWF). 

Error types 
The following error types are distinguished when debugging:  
● Runtime error 

A runtime error occurs when you try to perform an invalid or incorrect instruction, e.g. 
when a variable is not defined.  
You use the instruction "On Error Resume Next" in the script to intercept runtime errors. 
With this setting, the script executes the next statement when a runtime error is detected. 
You can check the error code with the error object in the next line. In order to stop the 
processing of runtime errors in the script, use the instruction "On Error Goto 0". Additional 
information about error processing is found in the Microsoft VBS help in the information 
system.  

● Logical error 
A logical error occurs when the event you are expecting does not take place, e.g. 
because a condition was checked incorrectly. In order to resolve logical errors, go 
through the script step by step in order to identify the part of the script which does not 
function. 
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3.14.5.2 Integrating the debugger 

Installing a Script Debugger for the RF-MANAGER 
A script debugger must be installed in order to search for errors in scripts with the 
RF-MANAGER. 
The following script debuggers have been tested and released: 
● Microsoft Script Editor by Office XP 
● Microsoft Script Debugger 
An installed script debugger is either started automatically when a runtime occurs in a script 
or manually with the command "Start runtime system with script debugger". 

Microsoft Script Editor 
The Microsoft Office XP component "Microsoft Script Editor" contains such a script 
debugger. If the default settings were used to setup Microsoft Office, the "Microsoft Script 
Editor" component was set for ("Installed on First Use"). If you wish to explicitly install this 
component, you must specify it in the Microsoft Office setup. Click on "Web Debugging" in 
the component selection window and select the option "Run from My Computer". 
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If a project is activated in RF-MANAGER with the command "Start runtime system with script 
debugger", a dialog with a list of available script debuggers appears when the first script is 
run. 
Other installed script debuggers such as "Microsoft Visual Interdev" or "Microsoft Visual 
Studio .NET" may appear in the list. Select "Microsoft Script Editor" and confirm your 
selection by clicking "Yes". 

 
Activate the "Script" program object in the "Step Into Remote Procedure Call" dialog and 
confirm your selection with "OK". 
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The "Microsoft Script Editor" is started. Execution is stopped at the first line of the first script. 
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Microsoft Script Debugger 
If no script debugger is available, you can download the "Microsoft Script Debugger" 
(scd10en.exe) for free from Microsoft (www.microsoft.com). It will be started automatically by 
the RF-MANAGER once it is installed. 

 
 

 Note 
The "Microsoft Script Debugger" is not supported when another script debugger system is 
available on your computer! 
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Script Debugger Does Not Start When Runtime Starts 
If you have installed a script debugger, and the "Start Runtime with Script Debugger" 
command does not run it, make the following settings in the Windows registry to set 
Microsoft Script Debugger as default Just-In-Time (JIT) Debugger: 
● "HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}] 

(Default)="ScriptDebugSvc Class" 
"AppID"="{A87F84D0-7A74-11D0-B216-080000185165}" 

● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-
00805F2CD064}\LocalServer32] 
(Default)="c:\\Program Files\\Microsoft Script Debugger\\msscrdbg.exe" 

● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}\ProgID] 
(Default)="ScriptDebugSvc.ScriptDebugSvc.1" 

● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-
8F2000805F2CD064}\VersionIndependentProgID] 
(Default)="ScriptDebugSvc.ScriptDebugSvc" 

The "LocalServer32" file path must point to the installation folder of Microsoft Script 
Debugger. You must edit the path name accordingly if Microsoft Script Debugger is installed 
in a different folder.  
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3.14.6 Synchronization of functions in the runtime system 

3.14.6.1 Execution of the function list in runtime 

Principle 
In runtime a function list is completed from top to bottom. A distinction is made between 
synchronous completion and asynchronous completion, so that no waiting periods ensue 
during completion. The distinction is made by the system by evaluating the different runtimes 
of the system functions. Scripts are always processed synchronously independent of the 
runtime. If a system function returns an error status, the completion of the function list is 
cancelled.  

Synchronous completion 
During synchronous completion, the system functions in a function list are performed one 
after another. The previous system function must be finished before the next system function 
can be performed.  

Asynchronous completion 
System functions, which perform file operations such as storing and reading, have a longer 
runtime than system functions which, for example, set a variable value.  
Therefore, system functions with longer runtimes are performed asynchronously. While a 
system function such as CopyLog writes to a storage medium, the next system function is 
already being performed. Due to the parallel completion of system functions, waiting periods 
at the runtime system are avoided.  

3.14.6.2 Execution of scripts in runtime 

Principle 
Only one script at a time can be performed in runtime. If several scripts are waiting to be 
edited, the scripts are lined up in a queue and completed one after another.  

 

 Note 
A loop in a script therefore blocks the execution of other scripts in the queue even if the 
scripts are triggered asynchronously. 
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The RF-MANAGER supports a maximum nesting depth of eight scripts. Please note that the 
nesting depth is not checked.  

 

 Note 
If a script is configured for the "Runtime-Stopp" event, only those functions may be used in 
the script which are specified as configurable objects in the reference of the "Runtime-Stopp" 
system function.  
Ensure that the ending of the runtime is not interfered with by the execution of the script.  

 

3.15 Configuring multi-lingual projects 

3.15.1 Working with multiple languages 

Multi-lingual configuration in the RF-MANAGER 
You can configure your projects in multiple languages using the RF-MANAGER. There are 
various reasons for creating a project in multiple languages: 
● You would like to provide multiple languages to the various operators in a plant. The 

project is created in multiple languages because the service personnel do not speak the 
same language as the operators. Example: A Runtime system is used in Germany, but 
the service personnel understand only English. 

Translating project texts 
With the RF-MANAGER, you can directly enter project texts in several languages in various 
editors, for example in the "Screens" editor or the "Project texts" editor. In addition, the 
RF-MANAGER provides options for exporting and importing your configuration for translation 
purposes. This is particularly advantageous if you configure projects containing a large 
amount of text and want to have it translated. 

Language management and translation in the RF-MANAGER 
The following areas of the project view are used to manage languages and translate texts in 
the RF-MANAGER.  
 
Area Short description 
Project languages Management of project languages, editing language, and reference 

language. 
Languages and fonts Management of runtime languages and fonts used in the Runtime 

system. 
Project texts Central management of configured texts in all project languages. 
Graphic browser Management of graphics and their language-dependent variants. 
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3.15.2 Language terms in RF-MANAGER 

Principle of languages in the RF-MANAGER 
Multi-language capability is implemented on various language levels in the RF-MANAGER. 

User interface language and project languages 
Two language levels are differentiated in the RF-MANAGER: 
● User interface language 

During configuration, text is displayed in the RF-MANAGER menus and dialog boxes in 
the user interface language. You select the user interface language to be used when you 
install the RF-MANAGER. You can change the user interface language with the menu 
command "Options > Settings." 

● Project languages 
Project languages are used to create a project in multiple languages.  

The two language levels are completely independent of one another. For example, you can 
create English projects at any time using a German user interface and vice versa. 

Project languages 
The following project languages have been released for the RF-MANAGER: 
● German 
● English 
You can generally also configure in any language available in Windows. However, 
restrictions may apply when some languages are used for configuration, such as: 
● The Runtime system does not support languages that are written right-to-left, such as 

Hebrew or Arabic. 
● Language-specific fonts are not available. 
● Non-editable texts stored in the RF-MANAGER are displayed in English. 
The following languages are differentiated within the project languages. 
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● Reference language 
The reference language is the language that you use to configure the project initially. 
During configuration, you select one of the project languages as the reference language. 
You use the reference language as a template for translations. All of the texts for the 
project are first created in the reference language and then translated. While you are 
translating the texts, you can have them displayed simultaneously in the reference 
language. 

● Editing language 
You create the translations of the texts in the editing language.  
Once you have created your project in the reference language, you can translate the 
texts into the remaining project languages. For this purpose, you select one of the project 
languages as the editing language and edit the texts for this language. You can change 
the editing language at any time. 

 

 
 

Note 
When switching the project languages, the assignment to the keys on the keyboard also 
changes. In the case of some languages (e.g. Spanish), switching the keyboard 
assignment is not possible due to the operating system. In this case, the keyboard 
assignment is switched to English.  

 

● Runtime languages 
The runtime languages are those project languages made available to the runtime 
system. 
You must provide appropriate operator control elements so that the operator can switch 
between languages during runtime. 
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3.15.3 Language Settings 

3.15.3.1 Settings for languages in the operating system 

Introduction 
The operating system settings on the configuration PC influence the language management 
of the RF-MANAGER in the following areas:  
● Selection of project languages 
● Regional format of dates, times, currency, and numbers 
● Displaying ASCII characters 

Language settings in the Operating System 
A language is not available as a project language unless it is installed in the operating 
system.  
● Settings in Windows XP: 

You can call the "Regional and Language Options" dialog using the control panel icon of 
the same name in "Start > Settings > Control Panel > Date, Time, Language, and 
Regional Options." Afterwards, you can install your choice of languages on the 
"Languages" tab.  

The Input Method Editor (IME) is available in Windows for configuring Asian texts. Without 
this editor, you can display Asian text but not edit it. For more information on the Input 
Method Editor, refer to the documentation for Windows. 

Regional format of dates, times, currency, and numbers 
The RF-MANAGER specifies a fixed date and time format in the Date - Time field for the 
selected project language and runtime language. 
In order for dates, times, and numbers to be presented correctly in the selected editing 
language, this language must be set in the Regional Options on the Control Panel.  

Displaying ASCII characters 
With text output fields, the display of ASCII characters as of 128 depends on the set 
language and the operating system being used. 
If the same special characters are to be displayed on different computers, then the 
computers must use the same operating system and country settings. 



RF-MANAGER Engineering System  
3.15 Configuring multi-lingual projects 

 SIMATIC RF-MANAGER 2008 
388 Operating Manual, 06/2010, A5E01070042-03 

3.15.3.2 Operating system settings for Asian languages 

Settings on Western operating systems 
If you want to enter Asian characters, you must activate the support for this language in the 
operating system. To do this, open the Control Panel and select "Regional and Language 
Options". On the "Languages" tab, activate the check box "Install files for East Asian 
languages". Then click on "Details" under "Text Services and Input Languages". The dialog 
"Text Services and Input Languages" is opened. On the "Settings" tab add the required 
default input language under the "Installed Services".  
For entering Asian characters on Western operating systems, the "Input Method Editor" must 
also be installed. To install, under Windows XP in the Control Panel open "Regional and 
Language Options" > Languages > Details". In the "Text Services and Input Languages" add 
the necessary default input language under "Installed Services". 
To enter Asian characters when configuring, switch to the Asian entry method in the "Input 
Method Editor". 

Settings on Asian operating systems (not yet released) 
If you are configuring on an Asian operating system, to enter ASCII characters, e.g. for 
object names, you must switch to the English default input language. As the English default 
input language is included in the basic installation of the operating system, you do not need 
to install an additional input locale.  
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3.15.3.3 "Project Languages" editor 

Introduction 
You select the languages for creating your project in the "Project Languages" Editor: 
● The project languages for creating your project 
● The reference language in which you configure the project initially. 
● The editing language in which you translate the text. 

Open 
To open the "Project Languages" editor, double-click "Project Languages" in the "Language 
Settings" group in the "Project view."  

Layout 

 

Project languages 
Here you enable the project languages for creating your project.  

Reference language 
Here you select the reference language from the project languages. The languages 
displayed are limited to those that you enabled in the list of available languages.  

Editing language 
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Here you select the editing language from the project languages. The languages displayed 
are limited to those that you enabled as project languages in the list of available languages.  

3.15.4 Creating a project in multiple languages 

Translation methods 
You first create a project for one language only and then test it.  
Afterwards, you configure all other languages required. The following options are available: 
● Direct translation of project texts in the editors used to create the individual objects. 
● Central translation of project texts in the "Project texts" editor. 
● Export of project texts, translation in another program, and import of translated texts to 

the RF-MANAGER. 

Recommended workflow 
1. Set a language you are familiar with as the reference language in the "Project languages" 

editor. 
At the start of configuration, the reference language should correspond to the editing 
language.  

2. Create the project in this language. The reference language text is used as the source 
language for translation. 

3. In the "Project languages" editor, set one of the other project languages as the editing 
language. 

4. Translate all project texts into this language. You can perform the translation either 
directly in the individual editors or in the centralized "Project texts" editor where all project 
texts and their points of use are displayed. 
As an alternative,, you can export the texts to a *.csv file, have them translated, and then 
import the translated texts back into your project. 

5. If necessary, adapt the graphics in the project to reflect the editing language or country-
specific factors. 

6. Repeat steps 3 to 5 for all other project languages. 

Result 
The project is now available in more than one language and the language can be changed in 
Runtime. 

See also 
Translating project texts in the editor (Page 392) 
"Project texts" editor (Page 393) 
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3.15.4.1 Specific features of Asian and Eastern languages in the Engineering System 

Introduction 
When configuring for Asian languages or in an Asian language some specific features 
should be observed. These specific features must also be observed for other languages that 
have complex characters.  

Basic principles of configuration 
In order to ensure the full functionality of a project, when configuring in RF-MANAGER some 
elements should include no complex characters. The restrictions apply for the following 
elements:  
● Object names 
● Alarm texts 
The object names in RF-MANAGER are unique names and therefore are not translated 
when switching between languages. As the object names are used and processed 
functionally, they are subject to some restrictions. The object names may not include any 
special characters, umlauts or complex characters. Affected object names are, for example, 
project names, variable names, screen names etc. 
If you want to log alarms with alarm texts, then you may not use Asian Runtime language. 
When using an Asian Runtime language you cannot log alarm text, even if the alarm text 
itself is written, for example, in English. The restriction applies merely to logging, it is still 
possible to view and output in Runtime. Russian and other 1 Byte languages are not affected 
by this restriction. 

User administration 
No Asian or other complex characters may be used for user names and passwords. 

Project documentation 
You can optimize the appearance of the printout by selecting the respective Asian or Eastern 
font from the Configuration Dialog for the project documentation. 
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3.15.4.2 Translating project texts in the editor 

Introduction 
As a general rule, if you are creating a project for multiple languages, all texts are configured 
initially in a language you are familiar with. You use this language as the reference language 
for translation. 
Define the project languages in the "Project languages" editor. Select the reference 
language and the respective editing language to which it should be translated, from the 
project languages. 

Editors with language-dependent objects 
The following editors contain language-dependent objects:  
● Screens 
● Reports 
● RFID base alarms 
● RFID edge alarms 
● RFID status alarms 
● RFID device alarms 
● System alarms 
● Text lists 
● Graphics lists 

Switching the editing language in the RF-MANAGER editors 
You can switch the editing language by means of the "Language Settings" toolbar. The 
editing language applies to all editors.  

Reference texts 
As a general rule, if you are creating a project for multiple languages, all texts are configured 
initially in a language known to you. This language then serves as the reference language.  
If you then switch the editing language to enter texts in another language, all of the text fields 
are empty. 
The RF-MANAGER offers a convenient reference text function so that you have a template 
for translation. You can display the reference text window containing texts in the reference 
language in dialogs and editors. 
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3.15.4.3 "Project texts" editor 

"Project texts" editor 
You have access to all texts of a project in the "Project texts" editor.  
Examples: 
● Texts in screens 
● Alarms 
● Comments 
● Help texts 
● Central text display 

Opening the "Project texts" editor 
To open the "Project texts" editor, double-click "Project texts" in the "Language Settings" 
group in the project view.  
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Structure of the "Project texts" editor 

 
① Project View ④ Project languages 
② Reference language ⑤ Object view 
③ Used by ...   

Elements in the "Project texts" editor 
In the "Project texts" editor, a single column is created for each project language you have 
set. The text of a configured object is represented in all languages in a single row in the 
table. The rows are divided into the following columns. 
● Reference language column 

The first column displays the texts in the reference language. 
● Reference column 

The "Referenced by" column indicates the editor where the texts originated. 
● Project languages 

The remaining columns display the texts in the other project languages provided the texts 
have already been translated. 
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Translation methods 
You can translate the configured texts as follows: 
● Internal translation of texts directly in the "Project texts" editor. 

This method is recommended for texts with little to be translated. 
● External translation of texts using the export and import function. 

This method is recommended for large amounts of text to be translated or when there are 
many project languages. 

The "Project texts" editor is linked to the other editors. Texts introduced here are 
automatically available in other editors as appropriate. You can also jump directly from the 
"Project texts" editor to the point of use of the object to be translated. 

3.15.5 Use of language-dependent graphics 

Language-dependent screen versions 
You use the "Graphics" editor to import graphics into your project and manage their 
language-dependent versions. The graphics can then be linked to the screens of the project 
in the "Screens" editor. If you create a project in multiple languages, different graphics may 
be required for the various project languages due to the following: 
● The graphics contain text. 
● Cultural factors play a role in the graphics. 
In both cases, you must produce language-dependent versions of the graphics. 

Basic procedure 
1. First, configure all screens for one language in the "Screens" editor. 
2. Create a version of the graphics for each project language in a graphics program. 
3. In the "Graphics browser" editor, you can import the language-dependent graphics into 

the project. 

Result 
The version of each graphic for the current editing language setting is displayed in the 
"Screens" editor. The version of each graphic for the current runtime language setting is 
displayed during runtime. 

See also 
"Graphics" editor (Page 396) 
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3.15.5.1 "Graphics" editor 

Introduction 
You manage the configured graphic objects in multiple language versions in the "Graphics" 
editor.  

Opening the "Graphics" editor 
To open the "Graphics" editor, double-click the "Graphics" editor entry in the "Language 
Settings" group in the project view.  

Structure of the "Graphics" editor 

 

Workplace 
Here all of the configured graphic objects are displayed in a table. A separate table column is 
created for each project language, which contains the versions of the graphics for that 
language. 
In addition, you can specify a default graphic for each graphic to be displayed whenever a 
language-specific graphic for a project language does not exist. 

Preview 
Here you can preview the graphic displays on various runtime systems.  
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See also 
Use of language-dependent graphics (Page 395) 

3.15.6 Languages in Runtime 

Using multiple runtime languages 
You can decide which project languages are to be used as runtime languages in runtime. To 
enable the operator to switch between languages during runtime, you must configure a 
corresponding operator control element.  
When runtime starts, the project is displayed according to the most recent language setting. 
When runtime starts the first time, the language with the lowest number in the "Order for 
language setting" is displayed. 

Setting runtime languages during configuration 
In the "Languages and Fonts" editor you can specify:  
● The project languages to be available as runtime languages 
● The order in which the languages are to be switched 

3.15.6.1 Configuring language switching 

Introduction 
If multiple Runtime languages are to be available on the runtime system, you must configure 
language switching. This is necessary to enable the operator to switch between the various 
Runtime languages.  

Methods for language switching 
You can configure the following methods for language switching: 
● Direct language selection 

Each language is set by means of a separate button. In this case, you create a button for 
each Runtime language. 

● Change language 
The operator toggles the languages by means of a single button. 

Regardless of the method used, the button names must be translated into each of the 
languages used. You can also configure an output field that displays the current language 
setting. 
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3.16 Project documentation 

3.16.1 Basic principles 

Introduction 
Project documentation serves to print the configuration data of a RF-MANAGER project, e.g. 
a table containing the variables used and their parameters.  

Purpose 
You can output configuration data in a project report. You can output project reports for:  
● A complete RF-MANAGER project 
● A component of RF-MANAGER 
● A single or multiple objects 
Data is selected for output in accordance with the selected objects or components. The 
composition of the data is dependent on the selected output format "Compact" or "Complete" 
and is created by the system when the project report is generated.  
If you output the configuration data of several or all the components of RF-MANAGER, a 
separate chapter is output for each component. A separate chapter is output for each RF-
MANAGER screen in view of the possible data quantity. 
You can open the project report in a preview before you start the output. The preview allows 
you to verify the project report. 

Output media 
Project reports can be output to:  
● A printer 
● A file 
● The screen 
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3.16.1.1 Structure of a layout 

Introduction 
A layout for the project documentation consists of a cover sheet and a formal contents sheet 
which is filled dynamically with the configuration data. If the data for output fills more than 
one page, the system will automatically insert page breaks. Layouts are divided into various 
areas. The page area displays the entire layout surface. The margins can be specified for 
this area. The printable area consists of the header, footer and the page body.  

 
The header and footers are output on every page of a project report. The header and footer 
are not output on the cover sheet. 

Layout of the cover sheet 
General information about the project can be output on the cover sheet. The cover sheet 
contains predefined fields in which you can enter the corresponding information by means of 
a dialog box. The following information can be output on the cover sheet:  
● Project name 
● Company name 
● Department name 
● Author name 
● Company logo 
● Project logo 
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Layout of the contents pages 
The configuration data are output on the contents pages. The following elements are output 
in a project report:  
 
Line Contents 
Title Designation for the selected components for the project report 
Label Designation of the objects, the attributes and the output RF-MANAGER 

screens.  
Field Output configured attribute values of objects. 

The lines listed in the table are repeated for all the objects contained in the project report. 
Two formats are available for this output. 
In "Compact" format the data are output in a five-column table. In "Compact" format the five 
most important attributes of an object are output. The five attributes to be output are preset 
in the system. The selection of these attributes cannot be modified. 
In "Complete" format the data are output in two columns. In "Complete" format all the 
attributes of an object are output in the report. 
The output format is selected in the "Print documentation" dialog box. Select the "Compact" 
or "Complete" format on the "Content" tab in the "Documentation of the properties" area. 
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3.16.2 Working with layouts 

Introduction 
The "Print documentation" dialog box is used to edit the layouts. Using this dialog, you can 
create new layouts and duplicate and delete existing layouts.  

Overview 
The RF-MANAGER provides a sample layout as the basis for a project report. The ready-
made layout with its settings is always used if you use the  command button to create a 
new layout. RF-MANAGER generates the "standard layout" from the ready-made layout. The 
layout is used for the output of project reports using the "Print Selection" function.  
The layouts for the project reports are saved centrally in RF-MANAGER and are therefore 
available to all users in any project. Configure the common properties of a layout for an RF-
MANAGER project, e.g. author, company name, project name, header, footer, display used 
and the settings for the output. Duplicate this template several times and specify different 
configuration data for the output in each of these templates. For example, create a separate 
project report for each RF-MANAGER component. 
A predefined style is provided for designing the project reports. You can change the style as 
required. The style is not saved with the individual layouts. A change in the style therefore 
affects all the existing layouts. 

Commands for layout editing 
The following commands are available in the "Print project documentation" dialog box to edit 
the layouts. 
 
Button Context-sensitive menu command Hotkeys 

 
New <CTRL+SHIFT+N> 

 
Duplicating <CTRL+SHIFT+D> 

 
Delete <Del> 

 Rename F2 

 
Printing <CTRL+SHIFT+P> 

 
Preview <CTRL+SHIFT+V> 

 
Export <CTRL+SHIFT+E> 
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3.16.2.1 Editing a layout for the project documentation 

Introduction 
A layout is opened by using the "Print documentation" dialog box. The "Print documentation" 
dialog box is accessed via:  
● The "Project > Print project documentation..." menu command 

● The  command button in the "Print" toolbar. 
Open the properties of the layout to be edited by using the mouse to select the layout. 

Editing possibilities 
The properties of the selected layout are displayed in the "Print project documentation" 
dialog box.  

 
The following table shows the available categories and the editing possibilities. 
 
Tab Editing possibilities 
"Content" Is used to select the data for the output. 
"Cover page 
header/footer" 

Is used to enter the contents for the cover sheet, header and footer. 

"Cover page 
styles" 

Is used to configure the style. 

"Page setup" Is used to configure the paper format, the page orientation, the page margins 
and the height of the header and footer. 
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3.16.3 Creating a project report 

3.16.3.1 Selecting the data for a project report 

Introduction 
The selection of the data depends on the selected output format in the layout used. Five 
attributes each specified by the system are output in the project report for each object in the 
"Compact" output format. All the attributes of all the configured objects of an RF-MANAGER 
component are output in the "Complete" output format. 

Overview 
Select the RF-MANAGER components for the output on the "Content" tab in the "Print 
documentation" dialog box. Select the output format "Compact" or "Complete" in the 
"Documentation of the properties" area. In the RF-MANAGER components "Screens" and 
"Reports" you can limit the output of the data. The following options are available:  
● "Only graphics" 
● "Only properties" 
● "Graphics and properties" 
Further selection options in the "Screens" area": 
● "Graphics with overview", outputs the screens with the permanent window. 
● "Show tab order" outputs the screens with the tab order. 

3.16.3.2 Outputting of data of selected objects 

Introduction 
RF-MANAGER offers you the possibility to output the configuration data of individual objects. 
The output can also be carried out for several selected objects. 

Overview 
Select the objects for the data output in the project view or in the objects view.  
The output of the configuration data of a selected object is always performed with the 
"standard layout". The desired output options have to be set in this layout. Selection of 
another layout is valid for the documentation of individual object data. 
The configuration data of the selected objects are opened in the preview. Outputting to a 
printer can be started from the preview. The  button can be used to copy the data to the 
clipboard for further use.  
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3.16.3.3 Selecting the objects for project documentation 

Introduction 
RF-MANAGER offers various options for outputting the configuration data of individual or 
multiple objects of an RF-MANAGER component. Start the output using the:  
● The main menu 
● The toolbar 
● The shortcut menu of selected objects 

Selecting the objects 
Activate the object view and select the desired RF-MANAGER component in the project view 
using the menu command "View > Objects" . The existing objects of the RF-MANAGER 
component are displayed in the objects view. Use the mouse to select one or more objects 
whose data you want to output in the object view.  
You can also open the node of a RF-MANAGER component in the project view. The existing 
objects of the RF-MANAGER component are displayed. Select one or more objects using 
the mouse. 

Outputting the data 
RF-MANAGER provides several options for the output of data. After the object selection you 
start the output via:  

● The  button. 
● The "Print selection" command in the shortcut menu of the selection. 
● The "Project > Print Selection" command in the menu bar 
The configuration data are inserted into the "standard layout" and opened in the preview 
window.  



 RF-MANAGER Engineering System 
 3.17 Planning jobs 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 405 

3.17 Planning jobs 

3.17.1 Field of application of the scheduler 

Definition 
In the scheduler, you link system functions or scripts to an event. For example, you link the 
SendEMail system function to the "Runtime stop" event so that an e-mail is always sent to a 
particular recipient at the end of operation.  
A task therefore exists: When the event occurs, the linked function is called. An e-mail is 
sent when Runtime ends. 

Application example 
The scheduler is used to execute event-controlled jobs automatically. For example, you use 
a job to automate the following:  
● Regular swap out of log data 
● Printout of an alarm report when an alarm buffer overflow occurs 
● Printout of a report at shift end 

See also 
Scheduler (Page 408) 
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3.17.2 Working with jobs and events 

Introduction 
A job consists of a triggering event and a "function list".  

 

Definition 
The scheduler differentiates between time-based events and system events. A time-based 
event occurs at a particular time, for example, "Starting daily at 12:00". Examples of system 
events are "Runtime stop" and "Change user".  
The event occurs either cyclically, for example "Starting daily at 12:00", or acyclically, for 
example "Change user". 
The function list contains a system function or a script in each line.  

Job sequence 
When the event occurs, the scheduler starts the jobs associated with the event. The jobs are 
executed consecutively. A job is executed by executing the function list line-by-line.  
In the case of a system event, only one job per runtime system can be configured and 
executed.  

 

 Note 
If many jobs are executed within short intervals, time delays can occur. In the case of a 
cyclic event, make sure that all of the jobs are executed before the next event occurs. 
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Timer for time-based events 
To make dynamic changes to the configured start time during runtime for daily, annual or 
one-off events, select an internal variable as a timer. The value of the variable determines 
the start time for the job during runtime.  

 

NOTICE  
The variable must be of the "DateTime" type.  

 

See also 
Scheduler (Page 408) 
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3.17.3 elements 

3.17.3.1 Scheduler 

Introduction 
In the scheduler, you plan a job by configuring a function list for an event.  

Open 
Double-click on "Scheduler" to open it in the project view. 

Layout 

 

Workplace 
The workplace shows the planned jobs. 

See also 
Workplace of the "Scheduler" editor (Page 409) 
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3.17.3.2 Workplace of the "Scheduler" editor 

Introduction 
The workplace shows the planned jobs, which consist of the triggering event and the function 
list.  

Layout 
The workplace consists of the table of jobs, the properties, and the function list. 

 
The table of jobs shows the job, the triggering event, and additional information. You assign 
the label and a comment and select the event. The scheduler compiles a description of the 
job. 
The properties also show the job along with the triggering event. The time-based event is 
specified in the properties.  
In the function list you configure the functions or scripts to be executed in the job. 

 

 Note 
The compiled description provides a written summary of the job including the timing for the 
job. You can obtain more detailed information using the tooltip function. by moving the 
mouse pointer over the selected element in the user interface. 
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3.18 Transfer 

3.18.1 Fundamentals 

3.18.1.1 Requirements for transfer 
A transfer operation refers to the transfer of a compiled project file to the runtime system 
where the project is to run.  

Requirement 
After you have completed a configuration process, check the consistency of the project by 
using the menu "Project > Compiler > Check Consistency". After completing the consistency 
check, the system generates two compiled project files. This project files have the same 
name assigned to it as the project, however with the extensions "*.rfidx" and "*.xml". These 
compiled project files must be transferred to the runtime system. 

 

 Note 
Engineering System and Runtime System on the same PC 
If the Engineering System and Runtime System are on the same PC, a transfer is not 
necessary. The project files can be stored locally in any directory. 

 

The runtime systems must be connected to the configuration computer to transfer the project 
files. Mobile data storage units can also be used to transfer the files. 
Compile the project again if the *.pwx is not found and you receive an error message while 
transferring the data.  

Basic procedure 
1. Enter the transfer settings for the individual runtime systems in your RF-MANAGER 

project. 
2. Enter the transfer mode on the runtime system to which the project is to be transferred in 

"RF-MANAGER 2008 Runtime Loader". The alternative options are as follows: 
– Using the "RF-MANAGER 2008 Runtime Loader" 
– By executing the system function "SetDeviceMode" with the option "Transfer" 

3. Transfer the compiled project files from the configuration computer to the runtime 
systems. The project files are transferred to all runtime systems for which the respective 
check box is selected in the transfer settings. 
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Transfer mode  
The runtime system must be in "transfer mode" for the transfer operation. If a project is not 
yet available on the PC, you must enable the transfer mode in the "RF-
MANAGER 2008 Runtime Loader" manually before the first transfer operation.  
This is however not necessary if you selected the "File" option in the "Transfer settings" 
and/or your engineering system and your runtime system are located on the same PC. 

Automatic restart of RFID processing 
When you make extensive changes to your configuration in the engineering system, stop 
RFID processing before you copy the changes. Use the system function 
"StopRfidProcessing" for this purpose or select "Stop RFID processing" in the Start Center. 
This shortens the subsequent starting phase considerably. It is generally recommended that 
RFID processing should be restarted after several project modifications. 
Before any productive data has been supplied from the plant, the following possibility for 
transferring modified configuration data is available as an alternative: Check the box 
"Automatic restarting of RFID processing when runtime starts" under "Device settings > 
RFID/network settings".  

 
When this box is disabled, only those changes implemented since the last start will be 
transferred for any RFID processing in progress. This can result in inconsistencies in the 
configuration which can cause malfunctions in RFID processing. 

Data comparison with the runtime system 
You can use the menu item "Data comparison with the runtime system" to save changes in 
the Engineering System that you made to your project at runtime in the "Configuration" 
screen object. In this procedure, the changes are saved in an "xml.sync" file and copied into 
the project in the Engineering System.  
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Otherwise the changes in the runtime system will be overwritten by the transfer. 

See also 
Transfer settings (Page 412) 
Transfer project (Page 416) 

3.18.1.2 Menu commands and toolbar buttons for the transfer operation 

Menu commands 
Menu commands for the transfer operation are located on the "Project > Transfer" menu. 
The following menu commands are available:  
 
Command Function 
Transfer settings Settings for transferring a compiled project file to 

the runtime systems. Only active if a project is 
selected.  

Toolbar 
A toolbar containing the following icons is provided in RF-MANAGER for transfer purposes. 
 
Icon  

 Opens the transfer settings dialog 

3.18.1.3 Transfer settings 

Introduction 
You can enter transfer settings individually for each runtime system of your project. The 
transfer settings include communication settings and selection of the runtime system for the 
transfer operation.  

Selecting the runtime system for the transfer operation 
When a transfer operation is performed, the compiled project file is transferred to all runtime 
systems of the project for which the respective check box is selected in the transfer settings 
on the configuration computer.  
The relevant check box must be selected in the transfer settings on the configuration 
computer even if you use the context menu of the runtime system to start the transfer 
operation for this particular runtime system only. 
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Transfer modes 
You can specify the following transfer modes:  
● Ethernet network connection 

The configuration computer and runtime system are located in a network or are 
connected point-to-point. The transfer operation between the configuration computer and 
the HMI device takes place by means of an Ethernet connection.  

● File 
The configuration computer and runtime system are identical or are connected in a 
network. The transfer operation is performed in a copy in Explorer.  

 

 
 

Note 
For file transfer, it is not necessary to manually activate transfer mode in the 
"SIMATIC RF-MANAGER 2008 Runtime Loader" . 

 

The transfer mode setting for a runtime system is also applied if the runtime system is 
selected in the Project View and one of the commands on the "Project > Transfer" menu is 
selected. 

Runtime system on another computer 
If your runtime system is not located on your configuration computer, you must prepare your 
runtime system for transfer.  
1. Call up the "SIMATIC RF--MANAGER 2008 Runtime Loader" for this purpose on your 

target system. 
2. Select "Settings". 
3. Check the "Activate" checkbox as shown in the screenshot below. 

 
Figure 3-23 Runtime loader: Transfer settings 

If necessary, you can also check the "Remote control" check box. 
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4. Click the "OK" button to confirm the settings. 
5. Then select the "Transfer" option. 

The runtime system of the target computer now expects the compiled project files. 

Remote control 
If a project is running on the runtime system at runtime, transfer can be initiated via remote 
control for the test and startup phases.  
To do this, the "Remote control" option must be set in the transfer settings of the runtime 
loader in the runtime system (see screenshot above). 
During transfer via remote control, the running project is closed and the runtime system 
automatically switches to Transfer mode. If dialogs are still open on the runtime system, it is 
not possible to terminate the running project automatically. Close the dialog or cancel the 
transfer operation on the configuration computer.  
Following a successful transfer, the newly transferred project file is automatically started.  

 

 Note 
If you do not want to permanently enable the "Remote control" option on your target system, 
for example, because you want to prevent project files from being automatically transferred, 
you can also set the system function "SetDeviceMode" with the "Transfer" option on the 
target system.  
Any project that is running at runtime would in this case be terminated once on transfer 

 

Overwriting the password list  
When the compiled project file is transferred, the password list present on the runtime 
system is overwritten by the corresponding configuration data. Consequently, the option 
exists to create passwords as part of the project, which are then available on each runtime 
system where the project has been transferred.  
To prevent overwriting existing passwords, clear the respective check box. Another option 
for retaining the existing password list is to first make a backup copy of the list on the runtime 
system. Once the transfer operation has been performed, the password list can then be 
restored from the backup.  

See also 
Defining transfer settings (Page 415) 
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3.18.2 Transferring a project 

3.18.2.1 Defining transfer settings 

Introduction 
You can specify transfer settings individually for each runtime system of your project. The 
transfer settings include communication settings and the selection of the runtime system for 
the transfer operation.  

Requirements 
An RF-MANAGER project is open. 

Procedure 
1. Click the  icon in the "Transfer" toolbar. 

The "Select devices for transfer..." dialog is displayed. 
2. On the left, select the runtime system for which transfer settings are to be made. 
3. Select each check box in front of the runtime system to which the compiled project files 

are to be transferred during the transfer operation. 
4. Set the mode. 
5. Set the parameters for the selected transfer mode: 

– Ethernet: Computer name or IP address 
– Adapt file: Destination directory 

6. Select the appropriate check box if you want the password list that is present on the 
runtime system to be overwritten and thus reinitialized during the transfer operation. 

Result 
When a transfer operation is performed, the compiled project files are transferred to all 
runtime systems for which the check box is selected in the "Select devices for transfer..." 
dialog. The transfer mode set for each device is used for the transfer. The transfer takes 
place to the extent set. 
When transferring over Ethernet, the "Remote control" option must be enabled in the runtime 
loader or you must execute the system function "SetDeviceMode" with the "Transfer" option.  

See also 
Transfer project (Page 416) 
Transfer settings (Page 412) 
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3.18.2.2 Transfer project 

Introduction 
After successful compilation, transfer the compiled project files to the runtime systems on 
which the project is to run. This process is a transfer.  

 

 Note 
If you initiate a transfer operation for a project that has not yet been compiled in its current 
version, the project is automatically compiled prior to the transfer. 

 

The runtime systems must be connected to the configuration computer to transfer the project 
data. 

Requirements 
● The configuration has been completed. 
● The runtime systems to which the project data are to be transferred are connected to the 

configuration computer. 
● The transfer settings in the runtime loader for the runtime systems concerned are correct. 
● The checkbox has been activated for at least one runtime system in the "Select device for 

transfer..." dialog. 

Procedure 
1. Use the same transfer mode setting on the runtime system as is used in the transfer 

settings of the RF-MANGER for the respective runtime system. 
– The transfer mode is set in the loader menu when the runtime system starts up: Either 

the "Remote control" option is activated or the system is explicitly switched to transfer 
mode. 

The memory location for the project file is preset and can be overwritten.  
2. If transfer to several runtime systems should be performed simultaneously, click the  

button in the "Transfer" toolbar. The "Select device for transfer ..." dialog opens. 
Activate the checkbox of all runtime systems to which a transfer is required and click the 
"Transfer" button. 
If you want to transfer the project to only one runtime system, select the "Transfer" 
command in the shortcut menu for the runtime system. The checkbox must also be 
selected for this runtime system in the transfer settings; otherwise the transfer operation 
will not be carried out. 
If you have not yet compiled the project file, it is compiled automatically before the 
transfer operation. 

Result 
The project files are transferred.  



 RF-MANAGER Engineering System 
 3.18 Transfer 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 417 

Once the transfer operation is successfully concluded, the "*.rfidx" and "*.xml" files are 
located in the specified directory on the respective runtime system. Any existing project is 
overwritten.  
As soon as the transfer is finished, the runtime starts on the respective runtime system with 
the corresponding project file and displays the start screen. 
If an error occurred during the transfer operation, the corresponding messages appear under 
"Transfer" in the Output Window.  

Remote control 
If a project is running in runtime on the runtime system, transfer can be initiated via remote 
control for the test and startup phases.  
To do this, the "Remote control" option must be set in the transfer settings of the runtime 
loader in the runtime system.  
During transfer via remote control, the running project is closed and the runtime system 
automatically switches to transfer mode. If dialogs are still open on the runtime system, it is 
not possible to terminate the running project automatically. Close the dialog or cancel the 
transfer operation on the configuration computer.  
Following a successful transfer, the newly transferred project file is automatically started.  

See also 
Defining transfer settings (Page 415) 
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RF-MANAGER Runtime 4
4.1 Fundamentals 

4.1.1 Introduction to the RF-MANAGER Runtime 

Introduction 
RF-MANAGER Runtime is user-friendly software for RFID processing and visulaization of 
the projects you have created with the RF-MANAGER programming software.  
The RF-MANAGER is designed for processing, visualization and operation of RFID systems. 
The Runtime software has a window-based pixel-graphics user interface. With its quick 
response times, it supports reliable system operation. 

Licensing 
When you install the runtime software "RF-MANAGER Runtime", you need a license for 
unrestricted use. RF-MANAGER Runtime runs in a non-licensed mode if the licensing is 
missing.  

Components of the RF-MANAGER 
The configuration software RF-MANAGER Engineering System is used to create your 
project data on on the configuration computer under Windows. 
You use the RF-MANAGER Runtime software to execute your configuration under Windows. 
You can also use RF-MANAGER Runtime on your configuration computer for testing and 
simulating the generated project file.  

Virus scanner in runtime 
An active virus scanner will increase system load, and may lead to disturbances in Runtime.  
Always disable the virus scanner when you install an application. An active virus scanner 
may also cause operational disruptions of hardware expansions. When running RF-
MANAGER, the tool may also block the process interfaces of your modules or block the 
readers. This fact disqualifies in particular dynamic virus protection via gatekeeper 
mechanisms.  
Always run virus tests in offline mode, and then restart the computer before you activate 
Runtime. 
Any automatic update of virus scanners initiated on the network may cause unnecessary 
load on the system. Always run virus scanner updates in offline mode, and then restart the 
computer before you activate Runtime. 
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4.1.2 Functional scope of RF-MANAGER Runtime 

Functional scope 
Functionality of RF-MANAGER Runtime:  
 
● Parameterizing an RFID device: Stationary and mobile readers 
● Commissioning, optimizing and maintaining the RFID system with Windows-compatible 

user interface 
● Collect, filter, display and write RFID data 
● Read and control reader inputs/outputs 
● Interfacing to enterprise systems (ALE) for RFID data and alarms 
● Large selection of standard I/O fields, vector graphics and buttons 
● Integral alarm system 
● Dynamic positioning of objects 
● Logging of alarms 
● Visual Basic Script for user functions 
● Standard coupling with SIMATIC S7 
● Input protection by means of user groups, passwords and log-off times 
● Simulator for testing RFID projects 
● Supplying RFID data to the PLC 

4.1.3 System requirements 

System requirements 
 
 RF-MANAGER Engineering System RF-MANAGER Runtime 
Supported devices  Standard PC  Standard PC / SIMATIC Microbox PC 420 / 

SIMATIC Microbox PC 427B 
Operating system Windows XP Professional SP3 or higher 

 
Windows XP Professional SP3 or higher 
(standard PC) 
Windows XP Embedded SP3 or higher  
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 

CPU Pentium IV or later  
with 1.6 GHz processor 
 

Pentium III or later  
with 933 MHz processor 
(standard PC) 
Pentium III with at least 933 MHz processor  
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 
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 RF-MANAGER Engineering System RF-MANAGER Runtime 
Graphic Resolution of at least 1024x768 / 1280x1024 

recommended 
at least 256 colors 

Resolution of at least 640x480  
 
at least 256 colors 

RAM At least 1.0 GB / 2.0 GB recommended At least 512 MB / 1024 MB recommended 
At least 1.5 GB At least 256 MB  

excluding archives 
(standard PC) 
CompactFlash card with at least 512 MB 
(SIMATIC Microbox PC 420/ 
 SIMATIC Microbox PC 427B) 

Free memory space / 
hard disk 

In addition to the space needed by RF-MANAGER, Windows also requires space on the hard 
disk, e.g. for the swap file. For additional information, refer to your Windows documentation. 

Additional hardware CD-ROM drive (for installing the software) 
USB port for installing the licenses 

Reader for document 
display 

Adobe Acrobat Reader 5.02 

Internet browser Microsoft Internet Explorer V6.0 SP1 / SP2 
Multiple screens The operating system function used to visualize the screen content on several monitors (Control 

Panel > Display > Settings) is not released with RF-MANAGER. 
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4.2 Commissioning the runtime system 

4.2.1 Installation of RF-MANAGER Runtime 

Supported devices 
RF-MANAGER Runtime will run on the following Windows-based systems:  
● Standard PC 
● SIMATIC Microbox PC 420 
● SIMATIC Microbox PC 427B 

Installation on the PC  
You must install RF-MANAGER Runtime on your system if it has not already been installed.  
The runtime software RF-MANAGER Runtime is located on the CD "SIMATIC RF-
MANAGER". A license (license key) is required to run the Runtime software. 

 

NOTICE  
RF-MANAGER Runtime runs in demo mode only if you do not have a license. In demo 
mode, you are prompted to acknowledge specific messages at regular intervals.  

 

1. Install the runtime software from the CD. 
If the autorun function is enabled for your CD-ROM drive, the CD browser is run 
automatically when the CD is inserted. Otherwise, run the setup by selecting 
"RF-MANAGER\Runtime\setup.exe" from the CD.  

2. Select the user interface language of the Setup program under "Language." 
3. Select "Installation", then run the "RF-MANAGER Runtime" setup. 
4. Follow the setup instructions on the screen. 
5. Install the license when you are prompted to do so. 
6. Then install the currently available ServicePack (see "Installation instructions" manual) 

 

 
 

Note 
If, when installing the Runtime software, you do not have a license, you can install this 
later using the Automation License Manager. The Automation License Manager is 
automatically included in the RF-MANAGER setup. 
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4.2.2 Installation on Microbox PC 
 

NOTICE  
SIMATIC Microbox PC 420/427B 
The SIMATIC Microbox PC 420 and the SIMATIC Microbox PC 427B are only suitable for 
operation of the runtime system. The engineering system cannot be operated on the 
device. 

 

Enhanced Write Filter (EWF) 
Windows XP embedded includes a write filter, also called Enhanced Write Filter (EWF). 
Enhanced Write Filter (EWF) can be used to write-protect the system partition, for example 
in order to increase the lifetime of the CF card. For additional information, refer to the 
operating instructions. 

Installation of the runtime system on a Windows XPe system 
 

NOTICE  
Installation Requirements 
Please note that the keyboard must be plugged in during installation. 

 

1. In the Windows Start menu, select "Start -> Control Panel". Enter "cmd" and click the 
"OK" button. 
The input box opens.  

2. Enter "ewfmgr c: -commitanddisable" in the box. The write protection for C: is switched off 
and the modified data is accepted. 

3. Reboot the system in order to accept the changes. 
4. Install the runtime system. (see Section ) 
5. In the Windows Start menu, select "Start -> Control Panel". Enter "cmd" and click the 

"OK" button. 
6. Enter "ewfmgr c: -enable" in the box. The write protection for C: is switched on. 
7. Reboot the system in order to accept the changes. 
8. Install the RF-MANAGER Service Pack (see chapter ). 
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4.2.3 Installation Service Pack 

Requirement 
SIMATIC RF-MANAGER 2008 must be installed. 

Procedure 
1. Start the file "SIMATIC_RF-MANAGER_2008_SP3.exe" by double-clicking the file name. 
2. Follow the on-screen instructions. 

Result 
RF-MANAGER 2008 Service Pack is now installed on your computer. 
In the installation folder, usually "C:\Program Files\ Siemens\SIMATIC RF-MANAGER\RF-
MANAGER 2008 Support", five additional folders have been created by launching the 
Service Pack: 
● ALEDatabridgeClient 

ALEDataBridgeClient is already fully installed following installation of the Service Pack, 
and it can be started via "SIMATIC > RF-
MANAGER 2008 Runtime > AleDataBridgeClient". This demo application is based on the 
ALE+ Client API Library and uses the ALE interface to make files available in .csv (text), 
.sql (database), and .xml (structured text) formats.  
The documentation for the ALEDataBridgeClient can be found in the folder, along with 
the source files. 

● ALE+Client Demo 
The ALE+Client Demo is already fully installed following installation of the Service Pack, 
and it can be started via "SIMATIC > RF-MANAGER 2008 Runtime > ALE+Client Demo". 
This demo application is based on the ALE+ Client API Library and uses the ALE 
interface to provide an overview of the functional scope of the interface. All supported 
commands can be run, and reports for files and messages can be displayed. 
Along with the source files, the folder contains comprehensive documentation on the use 
of the ALE+ interface and the ALE+Client Demo. 

● RF610M 
The "RF610M" folder contains components to be installed on the respective devices if 
RF610M units are used with RF-MANAGER, as well as the installation documentation. 

● RF310M 
The "RF310M" folder contains components to be installed on the respective devices if 
RF310M units are used with RF-MANAGER, as well as the installation documentation.  
Prerequisites: RF310M from the 2nd generation (G2) of the PSION basic device with the 
MLFB 6GT2803-0AB00 

● Project samples 
The "Project samples" folder contains numerous example configurations for the new 
devices. The mode of operation of the readers and their integration into the RF-
MANAGER can be followed in the projects. 
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4.2.4 Electrical installation 

Connecting the PC to the controller 
The PC is connected to the PLC via a communications processor. Please refer to the 
hardware description from the manufacturer for the proper electrical installation of your PC. 
The table below shows the use of the interfaces: 

 
PLC  PC interface 
SIMATIC S7 via PPI  via CP 

– CP 5511 
– CP 5512 
– CP 5611 
– CP 5613 
– CP 5614 

 via PC/PPI adapter  1) 

SIMATIC S7 via MPI  via CP 
– CP 5511 
– CP 5512 
– CP 5611 
– CP 5613 
– CP 5614 

 via PC/MPI adapter  2) 
 via PC adapter USB 2) 
 via Teleservice V5.1 

SIMATIC S7 via PROFIBUS DP 3)  via CP 
– CP 5511 
– CP 5512 
– CP 5611 
– CP 5613 
– CP 5614 

SIMATIC S7 via Ethernet (TCP/IP)  Via CP: 
– CP 1512 
– CP 1612 
– CP 1613 

 

1) Point-to-point connection with S7-200 only, no configuration transfer 
2) Point-to-point connection with S7-300 or S7-400 only 
3) RF-MANAGER Runtime is an active node 
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4.2.5 Interfacing to the PLC 

Interfacing to the PLC 
Connect the runtime system to the PLC to test your project in combination with the PLC. 

Set PG/PC interface 

Communication with PROFIBUS DP 
1. Open the dialog "Set PG/PC interface" in the Windows Start menu under "Settings > 

Control Panel. 
2. Click the "Properties" button. 

Under "Network parameters", "DP" is selected as the profile. 
3. Select "Universal (DP/FMS)" and confirm with "OK". 
4. Click the "Properties" button again. 
5. Select "DP" again under "Profile" and confirm with "OK". 

MPI communication 
1. Open the dialog "Set PG/PC interface" in the Windows Start menu under "Settings > 

Control Panel. 
2. Click the "Properties" button and set the parameters for the runtime system on the "MPI 

network" tab sheet such that this is the only master on the bus. 
If you operate more than one runtime system over MPI, only one runtime system is 
permitted to be operated as a master on the bus. Check the network settings for the 
connected runtime systems. 

 

 
 

Note 
You will find detailed information regarding communication between the PLC and the 
runtime system in the section "Communication" in the Information System.  
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4.2.6 Settings of the Runtime software 
You must set the following parameters for the runtime software in the RF-MANAGER 
configuration software:  
● Display for runtime system  

In RF-MANAGER, you configure the Runtime layout of the generated project: Select 
whether to start the project in full-screen mode, or in a window smaller than the screen 
size. In full-screen mode, the project is zoomed to the full screen. There will be no 
window and operator control elements for this view. 

 

 
 

Note 
If the runtime system does not match the configured size (in pixels), the project appears 
only on a part of the screen when opened in full-screen mode. 

 

To start the system in full-screen mode, open the "Device settings" dialog box in the 
project view in RF-MANAGER. Under "Runtime Settings", set the "Full-screen mode" 
check box. You can hide the taskbar under WIndows as required. To hide the taskbar, 
select "Start > Settings > Taskbar", then clear the "Always on Top" and "Auto hide" check 
boxes on the "Taskbar properties" dialog box. 

● Dialog fonts  
The dialog text will be shown in the standard font. You define the standard font in the 
"Languages and fonts" editor. 

● Disabling program switching  
In order to prevent the operator from calling other applications in Runtime, you may lock 
program switching. To do so, open the "Device settings" dialog box in the project view, 
then set the "Disable program switching" and "Full-screen mode" check boxes. Also hide 
the taskbar under Windows as described earlier.  

 

 
 

Note 
If you decide to lock program switching, you should always configure a function key or 
button for calling the "StopRuntime" system function. Otherwise, it will not be possible to 
exit RF-MANAGER Runtime or Windows. 
When program switching is disabled, the <Ctrl+Alt+Del> keystroke function is also 
disabled.  

 

● Screen saver 
A screensaver is no longer required for most modern screens and can even damage 
them. These monitors switch to hibernate mode as soon as the video signal has not 
changed for a specified time. A conventional screensaver would prevent this and thus 
reduce the service life of your monitor.  

 

 
 

Note 
In case you do want to use a screensaver, please note that RF-MANAGER Runtime is 
only released for operation with the standard Windows screensavers. 

 

● Setting the time zone 
Make sure that the correct time zone is set on the PC on which the runtime software is 
installed. To set the time zone in Windows, select Start > Settings > Control Panel > 
Date/Time. 
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● SMTP server setup 
You can configure an SMTP server project-specifically for sending E-mail in ES under 
"Device settings > Device settings". This SMTP server will then apply to all runtime 
systems to which the project is transferred.  
If you want to change the SMTP server on a runtime system individually, you can do this 
in the Windows control panel under "RF-MANAGER Internet settings". 

● Using ports 
You will need the port addresses for configuring communication over Ethernet. 
The table below shows the ports used in RF-MANAGER. 

 
 Port address 

TCP/IP 
Port address 
UDP 

SendEmail 25  
Transfer (via Ethernet; PC Loader; PC) 2308 

alternative 50523 
 

Logging (via Ethernet) CSV file 139, 445 137, 138 
Logging (via Ethernet) database   
RF-MANAGER  4684  
RF-MANAGER  Configurable  
Reader discovery  30718 

 
 

 Note 
When the RF-MANAGER runtime project is generated, additional ports that are used by RF-
MANAGER internally are displayed in the output window. 
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4.2.7 Testing a project 

4.2.7.1 Prerequisites for operating a project with a reader 
If you want to operate a project with a reader, the following requirements must be fulfilled: 
● At least one reader is connected to the PC. 
● The reader must have communications capability. 

Connecting and parameterizing readers 
Depending on the reader model, there are different connection and commissioning methods 
for the reader: 
● Stationary readers (Page 90): 

– RF670R 
– RF660R 
– RF620R/RF630R, RF310R, RF340R, RF350R, RF380R 

● Mobile readers (Page 108): 
– RF310M 
– RF610M 

Connecting and parameterizing stationary readers 

Use of DHCP (Dynamic Host Configuration Protocol) 

Introduction 
A DHCP server ensures that IP addresses are automatically assigned to DHCP-capable 
network clients in a network segment. The DHCP server uses the MAC address of the 
network client for this purpose. The IP addresses are assigned due to permanent 
assignment of a MAC address to an IP address. The readers of the RF600 family with 
Ethernet connection are DHCP-capable. 
Mechanisms that extend beyond this, such as dynamic assignment of IP addresses or 
Domain Name Service (DNS), are not supported. 

Requirements for activating DHCP 
A DHCP server must be present in the network segment. 
An up-to-date list of permanent assignments between MAC addresses and IP addresses 
must be stored in the DHCP server. This list must be maintained by your responsible IT staff 
member. 
You will find the MAC addresses of readers: 
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● on the enclosure next to the RJ45 socket 
 

NOTICE  
 

Ensure that the DHCP server is running and the reader is entered in the list. Otherwise 
RF-MANAGER Basic will be unable to establish a connection to the reader following 
activation. 
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RF670R 

Connecting stationary readers to the parameterization computer 
You have the following options for connecting a reader of the RF600 series to your 
parameterization computer via Ethernet:  
● Ethernet connection (10/100 Mbit/s) via RJ45 cable, either over an Ethernet network 

(connection via hubs or switches) or as a point-to-point link using a crosslink cable 
directly between a PC and a reader. 

 
Figure 4-1 Overview of configuration of the RF670R reader 

Connecting the stationary reader to the parameterization computer over Ethernet  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the Ethernet interface of the reader to the hub/switch to which your parameterization 

computer is also connected over an RJ45 cable. It is strongly advised that you use the accessory 
cables approved by Siemens for each reader. 
When using RJ45 cables from other manufacturers, there is a risk that the cable will be difficult to 
remove from the socket of the reader.  
For PnP connections, a crosslink cable must be used if the network card in the PC does not 
support autocrossover. 

3 Connect the reader to the power supply. 
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Providing the reader with communications capability  

 
1. Select "Project > Reader configuration > Reader communication settings". 
2. If the reader has not been pre-parameterized, use the "Start Discovery" button to activate 

the automatic reader search function in the application. 
All readers connected via Ethernet will be shown in the list. 
Note that the network card you have used to connect the reader is selected under the 
network address. 

3. Select the desired reader. 
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4. Click the button "Use Reader Address" to adopt the IP address in the "IP Settings". 
5. In the "IP Settings" menu, you can now set new Ethernet parameters for the reader. 

These include: 
– The IP address, 
– The subnet mask 
– The IP address of the gateway 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
 

Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 

 

NOTICE  
 

Avoid simultaneous Ethernet access to readers 
The applications RF-Manager Basic and RF-Manager 2008 cannot simultaneously 
access the same reader of the RF600 family via Ethernet. 
Only start applications that are currently required.  
Make sure that all RF-Manager Basic 2010 components are deactivated. 
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Providing the reader with communications capability using the RF-MANAGER Basic 
As an alternative to using the RF-MANAGER Engineering System, you can use the "RF-
MANAGER Basic 2010" software, which is included in the scope of supply of the reader, to 
provide the reader with communications capability: 
1. In the "Reader" menu, select the command "Set Reader IP Address". 
2. If the reader has not been pre-parameterized, use the Start Discovery button to activate 

the automatic reader search function in the application. 
All readers connected via Ethernet will be shown in the list. 
Note that the network card you have used to connect the reader is selected under the 
network address. 

3. Select the desired reader. 
4. Click the button "Use Reader Address" to adopt the IP address in the "IP Settings". 
5. In the "IP Settings" menu, you can now set new Ethernet parameters for the reader. 

These include: 
– The IP address, 
– The subnet mask 
– The IP address of the gateway 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
 

Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 

 

NOTICE  
 

Avoid simultaneous Ethernet access to readers 
The applications RF-Manager Basic and RF-Manager 2008 cannot simultaneously 
access the same reader of the RF600 family via Ethernet. 
Only start applications that are currently required.  
Make sure that all RF-Manager 2008 Runtime components are deactivated. 

 

 
 

Note 
For more information on DHCP 
See Chapter Enabling DHCP (Page 95) 
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Enabling DHCP 
The RF670R reader can be switched over to DHCP mode using the "Communication 
settings" menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader that should be switched over to DHCP mode to the parameterization 

computer via the Ethernet interface. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to activate it. 
The DHCP mode is activated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 
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Disabling DHCP 
The DHCP mode can be disabled for the RF670R reader via the Communication settings 
menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader for which DHCP mode should be disabled to the parameterization 

computer via the Ethernet interface. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to deactivate it. 
The DHCP mode is deactivated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the Ethernet connection between the reader and the parameterization 
computer again. 
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Restoring default settings on a DHCP reader 
 

 Note 
Please note that this functionality is currently only available for the SIMATIC RF670R reader.

 

If DHCP is activated on a reader but no DHCP server is available, no connection can be 
made to that reader because it does not have an IP address.  

Procedure 

 
To assign the reader a new unambiguous IP address, proceed as follows: 
1. Disconnect the affected reader from the network and connect it point-to-point with the 

configuration computer. 
2. Select "Project > Reader configuration > Communication settings". 
3. Click the "Reset DHCP Readers" button. 

The reader is reset to the default IP address and DHCP is deactivated.  
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4. Assign a new unique IP address to the reader. 
5. Disconnect the reader from the parameterization computer and reconnect it to the 

network. 
 

NOTICE  
 

Several readers with identical IP address 
It is recommended that the affected reader is disconnected from the network and 
connected point-to-point with the configuration computer. 
If the reader remains in the network, all DHCP readers in the network are restored to 
their default settings and thus have identical IP addresses, because the "Reset DHCP 
Readers" button works on all DHCP readers in the network simultaneously. 
You must then disconnect all DHCP readers from the network, connect each point-to-
point with the configuration computer, and successively assign each DHCP reader an 
unambiguous new IP address. 

 

Result 
The reader has an unambiguous IP address and can be addressed via the network, e.g. to 
make settings. 
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RF660R 

Connecting stationary readers to the parameterization computer 
You have two alternatives for connecting a reader of the RF660 series to your 
parameterization computer:  
● Serial connection through RS232 cable. 
● Ethernet connection (10/100 Mbit/s) via RJ45 cable, either over an Ethernet network 

(connection via hubs or switches) or as a point-to-point link using a crosslink cable 
directly between a PC and a reader. 

 
Figure 4-2 Connection options from reader to parameterization computer 

 
 

 Note 
Setting-up an Ethernet connection 
If you want to connect and parameterize a stationary reader of the RF660 family over 
Ethernet, initial contact must be made over a serial connection, i.e.: a serial connection over 
an RS232 cable must be available. 

 

Connecting the stationary reader to the parameterization computer over a serial interface  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial interface of the reader to a spare COM port of your parameterization 

computer using the RS232 cable (Order No. 6GT 2891-0GH50 or 6GT 2891-0GN10). 
3 Connect the reader to the power supply. 
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Connecting the stationary reader to the parameterization computer over Ethernet  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the Ethernet interface of the reader to the hub/switch to which your parameterization 

computer is also connected over an RJ45 cable. It is urgently recommended that the connecting 
cable (Order No. 6GT 2891-0HN10 or 6GT 2891-0HN20) is used when connecting via a 
hub/switch. 
When using RJ45 cables from other manufacturers, there is a risk that the cable will be difficult to 
remove from the socket of the reader.  
For point-to-point links, a crosslink cable must be used. 

3 Connect the reader to the power supply. 

Providing the stationary reader with communications capability 
There are two possibilities for providing the reader with communications capability: 
● Using the RF-MANAGER Engineering System 
● Using the configuration software included in the scope of supply of the reader. 
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Providing the reader with communications capability using the RF-MANAGER Engineering System  

 
1. Select "Project > Reader configuration > Reader communication settings". 
2. In the "Reader communication settings" menu, you can 

– specify the reader's IP address and port number under "Ethernet" if the reader has 
already been pre-parameterized. 
If the reader has not been pre-parameterized, use the "Start Discovery" button to 
activate the automatic reader search function in the application.  

– Specify the required COM interface for initial contact between the parameterization 
computer and RF660R reader under "Serial port". 

3. In the "IP Settings" menu, you can set new Ethernet parameters for the reader. These 
include: 
– The IP address, 
– The IP address of the gateway 
– The subnet mask 
– and the port number 
Click the "Set Reader IP Address" button to transfer the new settings to the reader. 
Alternatively, DHCP can also be set.  

 

NOTICE  
Deactivate firewall 
If you want to parameterize a reader of the RF600 family over Ethernet, deactivate your 
firewall before communication starts between the parameterization computer and the 
reader. Otherwise, it may not be possible to connect. 
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NOTICE  
Avoid simultaneous Ethernet access to RF660R readers 
The SIMATIC RF660R Configuration Software and the RF-MANAGER cannot 
simultaneously access the same reader of the RF660 family via Ethernet. If you require 
simultaneous access, connect the reader and the SIMATIC RF660R Configuration 
Software over the serial interface. 

 

 

Establishing the communication capability of the RF660R reader using the SIMATIC RF660R 
Configuration Software  

As an alternative to using the RF-MANAGER Engineering System, you can use the SIMATIC 
RF660R Configuration Software that is included in the scope of supply of the reader to 
provide the reader with communications capability: 
● The radio profile applicable to your country has been set up. 

("Welcome" screen) 
● A permanent IP address has been assigned to the reader or DHCP has been activated. 

Note when using DHCP that a specific pre-installed infrastructure is required.  
("Ethernet and notify channel settings" menu) 

● Alarm channel configuration is set to "None". 
("Ethernet and notify channel settings" menu) 

● Read trigger mode is set to "On application request". 
Specification of a value / change in the default value for the "Minimum trigger duration" is 
not necessary.  
("Trigger settings" menu) 

● The reader is in "Stand-alone" mode. 
("Reader mode settings" menu) 

 

 
 

Note 
For more information on DHCP 
See Chapter Enabling DHCP (Page 103) 
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Enabling DHCP 
The RF660R reader can be switched over to DHCP mode using the "Communication 
settings" menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader that should be switched over to DHCP mode to the parameterization 

computer. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to activate it. 
The DHCP mode is activated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the connection between the reader and the parameterization computer again. 
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Disabling DHCP 
The DHCP mode can be disabled for the RF660R reader via the Communication settings 
menu item in RF-MANAGER. 

Procedure 

 
1. Connect the reader for which the DHCP mode is to be deactivated to the 

parameterization computer. 
2. Select "Project > Reader configuration > Reader communication settings" and click the 

option "DHCP" to deactivate it. 
The DHCP mode is deactivated for the selected reader. 

3. Click the "Set Reader IP Address" button. 
The new settings are transferred to the reader. 

4. Disconnect the connection between the reader and the parameterization computer again. 
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RF620R/RF630R, RF310R, RF340R, RF350R, RF380R 

Connecting the stationary reader to the parameterization computer over a serial interface 
You have two alternatives for connecting a reader to your parameterization computer:  
 
Reader Connection option 
RF620R/RF630R 
RF310R, RF340R, RF350R,  

 Serial connection via RS232/RS422 interface 
converter 

RF380R  Serial connection through RS232 cable 

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

Converter 
RS232 > 
RS422

* Readers are connected via one COM port each on PC

SIMATIC 
RF-MANAGER

COM1 - COMx *

 
Figure 4-3 Reader to parameterization computer connection options 

 

Connecting the stationary reader to the parameterization computer via RS232/RS422 interface 
converters  

 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial COM interface of the reader to an RS232/RS422 interface converter. Then 

connect the interface converter to your PC via an RS232 cable. 
A list of which interface converters have been tested by Siemens along with their pin assignment 
can be found in the RF600 System Manual, chapter "Integration into networks".  

3 Connect the reader to the power supply. 
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Connecting the stationary reader to the parameterization computer over a serial interface  
 
Procedure  
1 Disconnect the reader from the power supply. 
2 Connect the serial interface of the reader to a spare COM port of your parameterization 

computer using the RS232 cable (Order No. 6GT 2891-0GH50 or 6GT 2891-0GN10). 
3 Connect the reader to the power supply. 
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Providing the reader with communications capability 

Providing the reader with communications capability  

 
1. Enter the ComPort and baud rate in the dialog box "RFID-

Gerät>Eigenschaften>Eigenschaften". 
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Connecting and parameterizing mobile readers (RF310M/RF610M) 

Preconditions for parameterization of the WLAN connection 
● The mobile reader must be ready for operation (the battery is charged). 
● The mobile reader must contain a WLAN card. 
● A WLAN connection must exist between the reader and the network of the PC, e.g. via an 

access point. 
● Information regarding the WLAN settings must be available. 
● The operating mode of the mobile reader must be set to "Supervisor". 

 

Overview of procedure 
1. Make settings in the Engineering System. 
2. Parameterize the WLAN card in the mobile reader. 
3. Assign the IP address if a DHCP server is not used. 
4. Start the application on the mobile reader. 
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Settings in the Engineering System 
1. Enter IP address of the reader 

Enter the assigned IP address in the device settings of the mobile reader ("RFID devices 
> RFID device_X"). 

2. Enter the network address of the PC 
Enter the network address of the PC in the network settings ("Device settings > RFID / 
network settings"). 

 

 Note 
An automatic reader search is not possible in the Engineering System 
The automatic reader search via "Project > Reader configuration > Communication settings" 
does not function in the case of mobile readers. 

 

Parameterize the WLAN card in the mobile reader 
Two examples are given below for the procedure that you can follow for configuring the 
WLAN card of a mobile reader. The examples pertain to the SIMATIC RF610M mobile 
reader, but are also applicable to the SIMATIC RF310M mobile reader. 
Consult your network administrator to ensure that the WLAN connection is set up correctly. 
You will find detailed information on configuring the WLAN in the operating instructions for 
the PSION WORKABOUT PRO.  
Please note that "WPA 2" encryption is only possible in Example 2. 

Example 1 
With this procedure, the active radio network is automatically displayed and "WPA 2" 
encryption is not possible.  
1. Set the operating mode to "Supervisor" in SIMATIC RF610M. 
2. In SIMATIC RF610M, select "Start > Programs > Summit > SCU" 
3. Under "Active Config", select "Third party". 
4. To activate these changes, set the device to "Power down" mode by pressing the <FN> 

key followed by the <ENTER> key. Then restart the device by pressing the <ENTER> 
key. 

5. Select the required active radio network in the dialog that subsequently appears. 
6. Click the "Connect" button and enter the respective encryption code under 

"Authentication" and "Network key". 
7. Click on the "OK" button. 



RF-MANAGER Runtime  
4.2 Commissioning the runtime system 

 SIMATIC RF-MANAGER 2008 
450 Operating Manual, 06/2010, A5E01070042-03 

Example 2 
1. In the mobile reader, select "Start > Programs > Summit > SCU" 
2. Click on the "Config" tab. 
3. Select the "New" button to create a new profile setting 
4. Enter a name for the profile setting. 
5. At least make the following settings: 

– SSID (name of the radio network), e.g. "RF610M" 
– Auth Type (security level): e.g. "Shared" 

6. Select the encryption required under "Encryption": e.g. "WPA 2". 
7. Then click the button "WEP/PSK Keys". Enter the encryption code and confirm with "OK". 
8. Click the "Commit" button to confirm the settings. 
9. In the "Main" tab, under "Active config", select the profile that should be active. 

 

 Note 
Other encryption possibilities 
You can also use other encryption methods, depending on the access point. "WEP" 
encryption is no longer regarded as secure; you should not use this. 

 

 

Enter the IP address in the mobile reader 
If a DHCP server is not present in the network, you must enter the IP address in the mobile 
reader:  
1. Double-click the WLAN icon in the taskbar for this purpose. 
2. Click the "Configure" button and select "Specify an IP address". Enter the IP address. 
You can also enter the IP address in the following manner: "Start > Settings > Control 
Panel > Network and Dial-up Connections" and select the appropriate connection. 



 RF-MANAGER Runtime 
 4.2 Commissioning the runtime system 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 451 

Notes on working with RF-MANAGER and a mobile reader 

Display in the task bar 
After establishing the connection between the mobile reader and RF-MANAGER, note the 
symbol  in the task bar.  
It provides the following information about the radio connection: 
 
Green
:  

A radio connection exists 

Red: A radio connection does not exist 

Working with RF-MANAGER and the mobile reader 
To start working with the mobile reader, activate the "RF-MANAGER" application by double-
clicking the desktop icon for the mobile reader. 

 

 Note 
Display the MAC and IP address 
Double-click the icon in the taskbar. The MAC address and IP address are displayed in the 
"Wireless Statistics" and "IP Information" tab sheets. 

 

Use of DHCP (Dynamic Host Configuration Protocol) 

Introduction 
A DHCP server ensures that IP addresses are automatically assigned to DHCP-capable 
network clients in a network segment. The DHCP server uses the MAC address of the 
network client for this purpose. The IP addresses are assigned due to permanent 
assignment of a MAC address to an IP address. The readers of the RF600 family with 
Ethernet connection are DHCP-capable. 
Mechanisms that extend beyond this, such as dynamic assignment of IP addresses or 
Domain Name Service (DNS), are not supported in RF-MANAGER. 
RF-MANAGER always uses fixed IP addresses internally. If a reader is replaced and 
receives the IP address of a reader that is already known, the new reader will be 
reparameterized when the connection is established. The new reader will then function 
without any further modification to the project configuration. 
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Requirements for activating DHCP 
A DHCP server must be present in the network segment. 
An up-to-date list of permanent assignments between MAC addresses and IP addresses 
must be stored in the DHCP server. This list must be maintained by your responsible IT staff 
member.  
You will find the MAC addresses of readers: 
● In the case of mobile readers, in the "Wireless statistics" tab 

Double-click the WLAN icon in the taskbar and access the "Wireless statistics" tab.  
 

NOTICE  
 

Ensure that the DHCP server is running and the readers are entered in the list. 
Otherwise RF-MANAGER will be unable to establish a connection to a reader following 
activation. 

 

● DHCP can be used with the mobile reader if a WLAN card is inserted and the card is 
parameterized (seeParameterize the WLAN card in the mobile reader (Page 109)). 

Enabling DHCP 
The mobile reader is switched to DHCP mode using the integral device menu. Proceed as 
follows: 
1. Double-click the WLAN icon in the taskbar. 

Select "IP Information > Configure" to access the tab sheet for enabling DHCP mode. 
2. Activate the button "Obtain an IP address via DHCP" here. 

 
Alternatively, you can call up the tab sheet for enabling DHCP mode via "Start > Settings > 
Control Panel > Network and Dial-up Connections > Selection of the appropriate 
connection > IP Information > Configure". 
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Disabling DHCP 
If you want to disable DHCP mode for a mobile reader, proceed as follows: 
1. Double-click the  icon in the taskbar. 

Select "IP Information > Configure" to access the tab sheet for disabling DHCP mode. 
2. Deactivate the button "Obtain an IP address via DHCP" here. 

 

Benefits of replacing a reader with DHCP 
DHCP mode allows a reader to be replaced without the need for modifying the configuration 
in the project. The IT staff member only has to change the NAC address in the DHCP server.  

Mobile reader: SIMATIC RF310M and SIMATIC RF610M 
Enable DHCP mode on the mobile reader as described above under Mobile reader: 
SIMATIC RF310M, SIMATIC RF610M > Enabling DHCP. 
If the new reader is detected by RF-MANAGER and its configuration is not in accordance 
with the settings in the project, the reader will be automatically reparameterized. 
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4.2.7.2 Using the simulator 
The RF-MANAGER is supplied with a simulator which you can use to test the essential 
components of the RFID project.  
The simulator is a separate application.  
You can use the simulator to simulate operation of the readers used in your projects using 
pre-defined tag events in the runtime system. The tag events are created in a simulation 
table. Tag IDs can be defined simply and conveniently in this table. It is also possible to 
trigger several tag IDs simultaneously. 
You can also simulate reader inputs on the runtime system. The I/O events are also created 
in a simulation table. You can easily define the reader inputs and their conditions in this 
table. 
Simulated reader inputs can also be used to trigger tag events. 

Simulation of tags 
During simulation, you can use a simulation table to create any number of tag jobs with 
predefined tag events for the readers configured in the Engineering System. These jobs are 
independent of each other and can execute once, cyclically or triggered by reader inputs. 

 
The created jobs can be set to active or inactive. You can also copy the jobs and delete 
individual jobs. 

Simulation of reader inputs 
Using the simulation table I/O jobs, you can simulate reader inputs with predefined time 
events on the runtime system.  
For detailed information please see the simulator help system. 
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Handling instructions 
The following steps show the basic procedures for simulating a project.  
1. Start by creating a project as it is going to be run later with an interconnected controller. 
2. Save and compile the project. 
3. Launch the simulator directly from the running configuration software. Select "Compiler" > 

start Runtime with simulator" from the "Project" menu.  
When you simulate the project for the first time, the simulator is started with new, empty 
simulation tables; only the previously configured readers are shown. You can then create 
the required jobs for each reader and parameterize them using "Edit > Insert".  
If you have already created a simulation table for your project, it will then be opened 
automatically. The simulation table "*.rfidsim" contains all the settings that you made for 
the simulation. These settings can be changed. 

4. You can save all settings made in this table for project simulation to a file. To do so, 
select "File > Save" in the Simulator, then type in a file name ("*.rfidsim".) You can now 
always retrieve these settings in order to simulate your project again.  

5. When you click the Start button, simulation will be started in the runtime system. 
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4.2.7.3 Basic functional test of the RF670R using the SIMATIC RF-MANAGER Basic 

Requirements  
If problems occur when using the RF670R reader, you can check the general functionality as 
follows: 
● The antenna configuration must be as shown in the figure below. 
● The reader is connected to the SIMATIC RF-MANAGER Basic. 
● RF-Manager 2008 and RF-Manager 2008 Runtime must not have been started. 

Procedure 
To check whether the reader can read a tag, proceed as follows: 
1. Open the RF-MANAGER Basic. 
2. Select the IP address of the reader to be checked (see ). 
3. Hold a tag on an electromagnetically neutral base in the middle in front of the antennas. 

 

NOTICE  
 

As a base use wood or plastic, for example, but definitely do not use any metallic or 
field-influencing materials. 

 

4. In the menu "View", select the "Diagnosis View" command or click the  icon. 
The "Diagnosis View" dialog box is opened. 

5. Click "Start". 
 

 
Figure 4-4 Configuration to test the RF670R 
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Result 
If the tag in the field can be read by the reader, it will appear in the list in the "Diagnosis 
View" dialog. In addition, the orange LED of the RF670R indicates that a tag recognized by 
the reader is presently located in the field. 
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4.2.7.4 Basic functional test of the RF660R using the SIMATIC RF660R Configuration 
Software 

Requirements  
If problems occur when using the RF660R reader, you can check the general functionality as 
follows: 
● The antenna configuration must be as shown in the figure below. 
● Alternative configuration: 

The antennas are installed above one another. Mounting height of the first antenna 1 m 
above the ground, the second antenna 2 m above the ground (bottom edge of antenna in 
each case) 

● Reader must be in the "Autonomous" operating mode. 
● The reader must be connected to the RF660R Configuration Software. 

Procedure 
Hold a tag on an electromagnetically neutral base in the middle in front of the antennas. 

 

NOTICE  
As a base use wood or plastic, for example, but definitely do not use any metallic or field-
influencing materials. 

 

 
Figure 4-5 Configuration to test the RF660R 
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Result 
The "Tag Detect" LED of the RF660R starts to light up yellow. 

Event monitor 
To view the tag ID, ID type, protocol and time stamp of the transmitted tag, click the "Event 
monitor" button in the RF660R Configuration Software.  

 
Figure 4-6 Event monitor button 

The following window is displayed: 

 
Figure 4-7 Tag event monitor 



RF-MANAGER Runtime  
4.2 Commissioning the runtime system 

 SIMATIC RF-MANAGER 2008 
460 Operating Manual, 06/2010, A5E01070042-03 

4.2.8 Starting the project 

Introduction 
You can start the project after it has been transferred.  

Project start modes  
Options for starting an RF-MANAGER project on a Runtime PC: 
● Running it from the Explorer 

You can run the project by double-clicking the file name of your project with the extension 
".rfid" in Windows Explorer.  

● Starting together with Runtime 
Enter the project file in "RfmHmiRT.ini" in order to run it with the start of Runtime by 
means of the Windows Start menu. 

● Run from the command line 
You can start your project using "Run" in the Windows start menu by entering the 
following command line, for example: 
"c:\Programme\Siemens\SIMATIC RF-MANAGER\SIMATIC RF-MANAGER 2008 
Runtime\RfmHmiRT.exe" c:\project\myproject.rfidx 
and then pressing <Enter>. 

● Autostart 
– If your project is linked to the Autostart directory of the Windows start menu, it will be 

automatically upon system startup. 
– It is also possible to define the autostart settings in the "Settings" dialog box of the 

Runtime loader. 
 

 
 

Note 
You can start the loader with the Windows Start menu command "SIMATIC\SIMATIC 
RF-MANAGER Runtime\SIMATIC RF-MANAGER Runtime Loader". 
RF-MANAGER Runtime comprises two parts: 
 Runtime for monitoring 
 Runtime for RFID processing. 

 

When it is activated, both parts are started using the current configuration data. 
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4.2.9 Data comparison with the runtime system 

Introduction 
You can use the option "Data comparison with the runtime system" to save changes in the 
Engineering System that you made to your project at runtime in the "Configuration" view. In 
this procedure, the changes are saved in an xml.sync file and copied into the project in the 
Engineering System.  

General procedure 
1. Save your project modifications in the Configuration View in runtime. 
2. In the Engineering System, select the option "Project > Data comparison with the runtime 

system". 
3. Select the corresponding runtime system. If only one runtime system is available, this will 

be selected automatically.  
When the runtime system with the project to be compared is located on a PC other than 
the engineering system, select the option "Use transfer settings". 

4. Then click on "Compare data". 
The progress of data comparison is indicated in the output window. Any warnings or error 
messages will also be displayed here. When the procedure is completed, the message "Data 
comparison completed" is displayed in the output window. 

 

 Note 
Check the option "Use transfer settings" 
To avoid mistakes, you should check whether the option "Use transfer settings" is enabled or 
not before every synchronization procedure. 

 

Using the object option 
You can use the option "Create new objects" to refine the data comparison and adapt it to 
your specific requirements. In this case, comparison of each change to a multiply referenced 
object in the runtime system will result in the creation of new objects.  
Application example 
In RF-MANAGER, you configure a data selector and use it in five notification channels on 
five readers. This means that: You create an object with five references. 
At runtime, you change the parameterization of the data selector for four of the five 
notification channels. If you selected the option "Create a new object" for data comparison, 
four new objects (in this case data selectors) are created and saved back to the project.  
If you did not select the option "Create new object", no new objects will be created and the 
properties of the first imported data selector will be saved back to the project. The data 
selector will still represent an object with five references. 
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Displaying the data comparison report 
You can display the data comparison report in XML format for each runtime system. Detailed 
information on the last synchronization procedure is saved in this file.  
To display the report, select the option "Project > Data comparison with the runtime system". 
Select the appropriate runtime system and then click "Data comparison report".  

Displaying the progress of data comparison  
You can display the progress of data comparison in TXT format for each runtime system. 
Information on all previous comparison procedures is saved in this file.  
To display the progress, select the option "Project > Data comparison with the runtime 
system". Select the appropriate runtime system and then click "Progress of data 
comparison".  

See also 
Configuration (Page 500) 
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4.2.10 Backup configuration data 
Several years of operation in a rugged industrial environment may damage the hard disk 
drive of your runtime system. To ensure that you can retrieve all programs and settings to 
the new hard disk, create a backup copy of your hard disk configuration data. For detailed 
instructions for creating a backup, please see the documentation of the backup software that 
you have chosen.  

4.2.11 Stop runtime 

Introduction 
You specify the operations for terminating Runtime in the configuration.  

Procedure 
● When Runtime is running in window mode, you can close it simply by clicking "Close". 

Alternatively, you can also exit the runtime system via the Start Center in the quick start 
bar. 

● When Runtime is running in full-screen mode, you can close it by means of the program 
switching function and the Task Manager. 

● When Runtime is running in full-screen mode and program switching is disabled for the 
project, the closing sequence of Runtime must be configured separately. Actuate the 
relevant button to close Runtime. 

 

 
 

Note 
RF-MANAGER Runtime comprises two parts: 
 Runtime for monitoring 
 Runtime for RFID processing. 
When Runtime is terminated, only the part "Runtime for monitoring" is ended. The part 
"Runtime for RFID processing" continues to run and can be terminated using the system 
function "StopRfidProcessing". Alternatively, you can also exit the runtime system via the 
Start Center in the quick start bar. 

 

 
 

Note 
Please note that it can take some time to exit RF-MANAGER runtime. 
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4.3 Functionality in Runtime 

4.3.1 Screen objects in Runtime 

Overview 
The runtime system of RF-MANAGER  offers the following objects for operation and display:  
● Button 
● I/O field 
● Graphic I/O field 
● Symbolic I/O field 
● Alarm indicator 
● Alarm view 
● Alarm window 
● Date/time field 
● User view 
● RFID views 
● Statistics view 
● Configuration 

4.3.2 Alarms in Runtime 

Alarms 
Alarms indicate events and states in the runtime system which have occurred in the plant or 
in the runtime system itself. 
An alarm may contain the following information:  
● Date 
● Time 
● Alarm text 
● Device 
● Status 
● Alarm class 
● Alarm number 
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Alarm classes 
Alarms are assigned to various alarm classes. 
● System 

System alarms indicate states or events which occur in the runtime system.  
System alarms provide information on occurrences such as operator errors or 
communication faults.  

● Predefined alarm classes 
Class of alarms that provide information about errors and other system alarms. 

● Custom alarm classes 
The properties of this alarm class must be defined in the configuration 

Alarm buffer  
Alarm events are saved to an internal, temporary buffer.  

Alarm logging  
When alarm logging is enabled, alarm events are output directly to the printer.  
You can set the logging function separately for each alarm. The system outputs "activated" 
and "deactivated" alarm events to the printer. 
The output of alarms of the "System" class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project. 

Alarm log 
Alarm events are stored in an alarm log, provided this alarm log is configured.  

Alarm view 
The alarm view shows selected alarms or events from the alarm buffer or alarm log. By 
means of configuration, the display can be filtered in such a way that only alarms that 
contain a specific character string will be shown. 

Alarm window 
If configured, an alarm window shows all pending alarms of a particular alarm class. The 
alarm window is displayed as soon as a new alarm occurs.  
You can configure the order in which the alarms are displayed. You can choose to display 
the alarms in ascending or descending order of their occurrence. The alarm window can also 
be set to indicate the exact location of the fault, including the date and time of the alarm 
event. By means of configuration, the display can be filtered in such a way that only alarms 
that contain a specific character string will be shown. 
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Alarm indicator 
The alarm indicator is a configured graphic symbol that is displayed on the screen when an 
alarm activates. The alarm indicator is configured in the screen's template and is thus a 
component of all screens in a project.  
The alarm indicator can have one of two states: 
● Flashing: At least one unacknowledged alarm is pending. 
● Static: The alarms are acknowledged but at least one of them is not yet deactivated. 
Function lists can be used to configure the responses of the runtime system. 
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4.3.3 Variables in the runtime system 

Definition 
Variables correspond to defined memory areas in the runtime system, to which values are 
written and/or from which values are read. This action can be initiated by the reader or PLC, 
or by the operator on the runtime system.  

4.3.4 Log files in the runtime system 

Overview 
Alarm events can be saved in logs.  
Examples of alarm events are the activated and deactivated events occurring with a fault 
alarm.  

Memory options 
Depending on the configuration, the logs are written to a file or stored in a database set up 
for this purpose.  
● Logging to a CSV file 

The project engineer must have specified a folder path for storing the CSV file containing 
your logged data. This references the storage location.  
CSV format table columns are separated by separators, the table rows are terminated by 
a line break character. This allows you to evaluate or edit your log data using an external 
text editor or spreadsheet program, for example.  

● Logging to a database 
By storing your log files in a database, you can utilize the full database functionality for 
further processing and analysis of the logged data.  
The following databases have been tested and released for RF-MANAGER:  
– MS Data Engine 97 and MS Data Engine 2000 
– MS Access 97 and MS Access 2000 
– MS SQL Server 7.0 and MS SQL Server 2000 

The following types of log are used in RF-MANAGER:  
● Circular log 
● Segmented circular log 
● Log with level-dependent system alarm 
● Log file with data volume-based system alarm 
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Alarm logs 
Alarms in the project indicate fault states and operating states of the plant. Alarms can be 
displayed in the screens on the runtime system. RF-MANAGER lets you log alarms and 
document operational states and error states of the plant.  
The following data are logged to the file: 
● Date and time of alarm 
● Alarm number 
● Alarm tags (up to 8) 
● Alarm status 
● Alarm text (optional) 
● Device (optional) 
All alarms are assigned to a specific alarm class. All alarm classes can be logged.  
Alarms can be logged either automatically, or by operator intervention.  
The contents of log files can be displayed in the runtime system if a corresponding alarm 
view has been configured.  

4.3.5 Reports in the runtime system 

Overview 
Reports are used to document plant processes. The log content and layout are specified in 
the project, as is the event triggering the printout of the report.  
For example, a report can be configured for output at the end of a shift, in order to document 
faults.  

Output 
Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or 
manually, e.g. by means of a function key.  

Printing reports 
Reports are output to the printer in graphic mode. The use of a serial printer is not 
recommended because of the accumulated data volume.  
For proper output, the printer must support the paper format and page layout of the report.  

 

 Note 
The value of a variable in the report is read and output at the moment of printing. A 
substantial time may elapse between printing out the first and the last page of a report 
consisting of several pages. The same variable can therefore be output on the last page with 
a different value to that on the first page.  
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4.3.6 System functions and scripts in Runtime 

Purpose 
System functions and scripts are used in Runtime for the following purposes:  
● To perform actions 
● To control the system 
● To utilize the properties of the runtime system 
● To make system settings online in the runtime system 
In RF-MANAGER, each system function and each script is linked to an object, such as a 
button, field or screen, and an event. As soon as the event occurs, the system function is 
triggered.  

System functions 
System functions are predefined functions that are used to implement many tasks in 
Runtime, such as:  
● Writing/reading tags 
● Calculations, e.g. increasing a variable value by a specific or variable amount 
● Logging functions, e.g. starting an alarm log 
● Settings, e.g. setting a bit in the reader. 
● Alarms, e.g after a different user logs on. 

Scripts 
Scripts may also be included in the project for specific applications which may require 
additional functions. For the creation of scripts, RF-MANAGER provides an interface to 
Microsoft Visual Basic Script (VBScript). This allows you to integrate additional functions, 
such as: 
● conversion of values, e.g. between different physical units (temperatures) 
● Evaluation of several reader I/Os 
The status can be checked based on the returned values, and appropriate measures can 
thus be initiated.  

Events 
The object and the selected function determine what events can be defined as triggers for 
executing a system function.  
For example, the events "Change Value", "Below Lower Limit" and "Above Upper Limit" are 
associated with the "Variable" object. The "Loaded" and "Cleared" events are associated 
with the "Screen" object.  
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4.3.7 Security in the runtime system 

Overview 
The configuration engineer can protect the operation of a project by implementing a security 
system. The security system is based on authorizations, user groups and users.  
The security system of the runtime system is based on authorizations, user groups and 
users.  
If operator control objects protected by a password are operated, the runtime system 
requests the entry of a password. A login screen is displayed in which you enter your user 
name and password. After logging on, you can operate the operator control objects for which 
you have the necessary authorizations. 

 
The login dialog can be set up by the configuration engineer via an individual operator 
control object.  
In the same way, the configuration engineer can set up an operator control object to log off. 
After logging off, objects assigned password protection can no longer be operated; to do so, 
log in again.  

User groups and authorizations 
Project-specific user groups are created by the configuration engineer. The "Administrators" 
group is included in all projects by default. User groups are assigned authorizations. The 
authorization required for an operation is specifically defined for each individual object and 
function in the project. 

Users  
Each user is assigned to exactly one user group. 
Users can be created as follows: 
● By the configuration engineer during configuration 
● By the administrator on the runtime system 
● By a user with "Administration" authorization to the user administration on the runtime 

system 
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Passwords 
Only registered users may log on to Runtime by entering their user name and password. The 
passwords can be assigned by the configuring engineer, by the "Admin" user (or by users 
who have "Administration" authorization), or by the user himself.  
The authorizations of a user after logging in depends on the user group to the user is 
assigned. 
After the project is transferred, only the administrator is authorized to create user accounts, 
make user group assignments, and change passwords. Any other users who are 
subsequently assigned to the "Administrator" group by the administrator may also carry out 
these tasks. 
The user data are encrypted and saved on the runtime system to protect it from loss due to 
power failure.  

 

 Note 
Depending on the transfer settings, changes to the user data are overwritten when the 
project is transferred again. 

 

Logoff times 
A logoff time is specified in the system for each user. If the time between any two user 
actions, e.g. entering a value or changing screens, exceeds this logoff time, the user is 
automatically logged off. The user must then log in again to continue to operate objects 
assigned password protection.  

User view 
Use the User View to display the users on the runtime system. 

 



RF-MANAGER Runtime  
4.3 Functionality in Runtime 

 SIMATIC RF-MANAGER 2008 
472 Operating Manual, 06/2010, A5E01070042-03 

Export and import 
The users, passwords, group assignments and logoff times established on the runtime 
system can be exported and then imported on a different runtime system. This prevents you 
having to enter all of the data again on another runtime system.  

 

NOTICE  
When importing, the currently valid user data is overwritten. The imported user data and 
passwords are valid immediately. 

 

4.3.8 Further operating options in Runtime 

Print functions 
Print functions available in online mode:  
● Hardcopy 

You can print the content of the currently displayed screen if you utilize the "Print screen" 
system function in your configuration.  

● Printing alarms 
Each alarm event that occurs (activated, deactivated) is also sent to a printer.  

● Printing reports 
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4.4 Operating a project in Runtime 

4.4.1 Basic principles 

Introduction 
Operation of a system is dependent on the way that the project was created. This chapter 
contains general information on the settings for the Runtime software and the operation of 
predefined screen objects.  
Screen objects provide general system functions. Screen objects may have been used and 
configured in screens of the project.  

Multi-key operation 
Multi-key operation may initiate unwanted actions: You must only operate one function key 
or button at a given time. 

Change language  
RF-MANAGER allows you to configure a multilingual project. Up to five of these project 
languages can be loaded simultaneously onto the runtime system.  
You can switch between the individual languages in Runtime, provided this function has 
been configured. When languages are switched, the language-dependent objects such as 
texts or formats are displayed in another language. Objects that may contain language-
relevant texts include:  
● Alarms 
● Screens 
● Text lists 
● Help texts 
● Date/time 
● Decimal symbol 
● Static texts 
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4.4.1.1 Operation using mouse and keyboard 

Operation with the keyboard 
The navigation options listed in the table can be used for keyboard operations in a screen.  
 
Navigation PC 
Next field right/left  <Shift+Right> / <Shift+Left> 
Next field up/down  <Shift+Down> / <Shift+Up> 
To the right/left in the field  <Right> / <Left> 

The other function keys on the PC are assigned as follows:  
 
Key Function 
<Enter> Applies a value (e.g. in unmarked input fields) or opens a 

selection list.  
If the I/O field is marked (highlighted in color), the runtime 
system will switch to the special editing mode. Now, only 
one character will be marked in the field.  
Use the cursor keys <Up>/<Down> to scroll through a 
character table.  
Use the <Right>/<Left> cursor keys to move the cursor to 
the next or previous input position.  
Press <Enter> or <Esc> to exit from the entry mode. The 
characters entered up to this point will be either applied or 
discarded.  

<Esc> Interrupts the input. 
<Tab> Selects the next available screen object in the configured 

tab sequence.  
<Shift+Tab> Selects the previously available screen object in the 

configured tab sequence.  
<F1> … <F12>,  
<Shift+F1> … <Shift+F12> 

Triggers a function, e.g. screen selection.  

 
 

CAUTION  
If you press a function key after a screen change, the associated function in the new screen 
may be triggered before the new screen is fully displayed. 

 

Controlling Windows with the keyboard 
You may also use the keyboard to control the operating system of your runtime system. See 
your Windows manual for detailed information. The most important key combinations are 
shown in the table below.  
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Navigation Runtime system 
Open start menu <Ctrl+Esc> 
Show the shortcut menu of the selected element <Shift+F10> 
Select all <Ctrl+A> 
Display properties of the selected element <Ctrl+Enter> 
Explorer:   
Change folder <F4> 
Change display areas <F6> 
Activate menu bar <F10> 
Dialogs:   
Go to next field <Tab> 
Back to previous field <Shift+Tab> 
Open next tab <Ctrl+Tab> 
Open previous tab <Ctrl+Shift+Tab> 

Operation with the mouse 
A lightning symbol attached to the mouse pointer indicates that the screen object, for 
example a button, may be operated with the mouse.  
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4.4.2 Operating graphic objects 

4.4.2.1 Button 

Purpose 
A button is a virtual key on the screen of the runtime system that can have one or more 
functions. 

 

Layout 
The layout of the button depends on the button type. 
● Button with text: The text shown on the button gives information regarding the status of 

the button. 
● Button with graphic: The graphic shown on the button gives information regarding the 

status of the button. 
● Invisible: The button is not visible in the runtime system. 

Operation 
Depending on the configuration, you can operate the button in the following ways: 
● Standard operation: Click on the button. 
● Event: An event is triggered when you operate the button, e.g. when you click it. The 

processing of a function list can be configured to the event. 

Operation behavior 
The operation may be followed with a optical feedback. However, note that the optical 
feedback only indicates a completed operation and not whether the configured functions 
were actually executed. 
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Operation with mouse and keyboard 

Operation with the mouse 
1. Click the button. 

Operation with the keyboard 
1. Press the <Tab> key until the button is selected. 
2. Press <Enter> or <Space Bar>. 

4.4.2.2 I/O field 

Purpose 
You enter numeric or alphanumeric values in an I/O field. For example, a numeric value 
could be the number "80" as a temperature reference, an alphanumeric value could be the 
text "Service" as a user name. 

 

Layout 
The layout of the I/O field depends on the configuration: 
● Numerical I/O field 

For input of numbers in decimal, hexadecimal or binary format.  
● Alphanumerical I/O field 

For input of character strings. 
● I/O field for date and time 

For input of calendar dates or time information. The format depends on the set 
configuration.  

● I/O field for password entry 
For concealed entry of a password. The entered character string is displayed with 
placeholders (*).  

Operation 
Depending on the configuration, you can operate the I/O field in the following ways: 
● Standard operation: Enter a value in the I/O field. 
● Event: An event is triggered when you operate the I/O field, e.g. when you activate it. The 

processing of a function list can be configured to the event. 
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Operation behavior 

Limit value test of numerical values 
Tags can be assigned limit values. The entered value is then only accepted if the value lies 
within the configured limits. 
If an entered value exceeds a configured limit value, e.g. "80" with a limit value "78", the 
entered value is rejected. If an alarm window is configured, then a system alarm is displayed 
automatically.  

Decimal places for numerical values 
If a numeric input field is configured with a specific number of decimal places, decimal places 
in excess of the limit are ignored. Empty decimal places are filled with "0" after the number is 
confirmed. 

Hidden input 
A "*" is displayed for every character during hidden input. The data format of the value 
entered cannot be recognized. 

Operation with mouse and keyboard 

Operation with the mouse 
1. Click in the I/O field with the mouse pointer. 
2. Type in the relevant value. 
3. Confirm your input with <Enter> or cancel it with <Esc>. 

Operation with the keyboard 
1. Press the <Tab> key until the I/O field is selected. 
2. Enter the value. 
3. Confirm your input with <Enter> or cancel it with <Esc>. 

Alternative operation with the keyboard 
1. Press the <Tab> key until the I/O field is selected. 
2. Press <Return>. The object changes to the specific editing mode. Now, only one 

character will be marked in the field. 
3. Use the <Up>/<Down> cursor keys to scroll through a character table. 
4. Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input 

position. 
5. Confirm your input with <Enter> or cancel it with <Esc>. 
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4.4.2.3 Graphic view 

Purpose 
The graphic view displays graphics.  

 

Layout 
The layout of the graphic is dependent on the configuration. The graphic view can, for 
example, be automatically adapted to the size of the graphic.  

Operation 
The graphic view is for display only and cannot be operated.  

4.4.2.4 Graphic I/O field 

Purpose 
A graphic I/O field can have the following functions in the runtime system: 
● Output of graphic list entries 
● Combined entry and output 

 



RF-MANAGER Runtime  
4.4 Operating a project in Runtime 

 SIMATIC RF-MANAGER 2008 
480 Operating Manual, 06/2010, A5E01070042-03 

Operation 
Depending on the configuration, you can operate the graphic I/O field in the following ways: 
● Standard operation: Select an entry from the graphic list. 
● Event: An event is triggered when you operate the graphic I/O field, e.g. when you 

activate it. The processing of a function list can be configured to the event. 

Operation behavior 
If the graphic I/O field displays a cactus image, you have not defined a graphic to be output 
for a specific value in your project. 
The contents of the graphic I/O field change color in the runtime system to show that it is 
now activated. 
The frame in 3D is only shown graphically in an output field. 

Operation with mouse and keyboard 

Operation with the mouse 
1. Click on the graphic I/O field. The drop-down list opens. 
2. Click on the scroll bar with the mouse pointer. Move the scroll bar in the desired direction 

while holding down the left mouse button. 
3. Select the desired entry. The selection list is closed and the entry is displayed. 

Operation with the keyboard 
1. Press the <Tab> key until the graphic I/O field is selected. 
2. Press <Enter>. The drop-down list opens. 
3. Select the desired entry from the selection list. Toggle between the next or previous entry 

by using the cursor keys <Left>, <Right>, <Up> and <Down>. 
4. Confirm your input with <Enter> or cancel it with <Tab> or <Esc>. 
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4.4.2.5 Symbolic I/O field 

Purpose 
A symbolic I/O field can have the following functions in the runtime system: 
● Output of text list entries 
● Combined entry and output 

 

Operation 
Depending on the configuration, you can operate the symbolic I/O field in the following ways: 
● Standard operation: Select an entry from the text list. 
● Event: An event is triggered when you operate the symbolic I/O field, e.g. when you 

activate it. The processing of a function list can be configured to the event. 

Operation behavior 
If the symbolic I/O field contains a blank text line in the selection list, an entry has not been 
defined in the project for a specific value. The contents of the symbolic I/O field change color 
in the runtime system to show that it is now activated. 

Operation with mouse and keyboard 

Operation with the mouse 
1. Left mouse click on the symbolic I/O field. The drop-down list opens. 
2. Click on the scroll bar with the mouse pointer. Move the scroll bar in the desired direction 

while holding down the left mouse button. 
3. Select the desired entry with the left mouse button. The selection list is closed and the 

entry is displayed. 

Operation with the keyboard 
1. Press the <Tab> key until the symbolic I/O field is selected. 
2. Press <Enter>. The drop-down list opens. 
3. Select the desired entry from the selection list. Toggle between the next or previous entry 

by using the cursor keys <Left>, <Right>, <Up> and <Down>. 
4. Confirm your input with <Enter> or cancel it with <Tab> or <Esc>. 



RF-MANAGER Runtime  
4.4 Operating a project in Runtime 

 SIMATIC RF-MANAGER 2008 
482 Operating Manual, 06/2010, A5E01070042-03 

4.4.2.6 Alarm indicator 

Description 

Purpose 
During runtime, the alarm indicator is displayed if alarms of the specified alarm class are 
pending or require acknowledgement. 

 

Layout 
The alarm indicator can have one of two states: 
● Flashing: At least one unacknowledged alarm is pending. 
● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 

number indicates the number of queued alarms. 

Operation 
The alarm indicator can only be operated using the mouse. Depending on the configuration, 
you can operate the alarm indicator in the following ways: 
● Standard operation: Activate the alarm indicator. 
● Event: The alarm window is shown or hidden by operating the alarm indicator, e.g. by 

clicking. The processing of a function list can be configured to the event. 

Operation behavior 
Depending on the configuration, when operating the alarm indicator an alarm window is 
opened. 

Operation with the mouse 

Operation with the mouse 
1. Click on the alarm indicator with the mouse pointer. Depending on the configuration, the 

alarm window is opened. 
2. Use the Close icon to close the Alarm window and be able to operate the screens. The 

alarm window can be opened again by clicking on the alarm indicator. 
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4.4.2.7 Alarm view 

Purpose 
Alarms are indicated in the alarm view or in the alarm window in the runtime system. The 
layout and operation of the alarm window correspond to that of the alarm view. 

Layout  
Depending on the configuration, in the alarm view different columns with information 
regarding an alarm or an alarm event are displayed. Establishes that only alarms that 
contain a specific character string will be displayed in the alarm text. 

Operation 
Depending on the configuration you can: 
● Change the column sequence 
● Change the order in which the alarms are displayed 
● Editing alarms 
● Acknowledge alarms 

Controls 
The buttons have the following functions:  
 
Button Function 

 
Displays an alarm operator note 

 
Editing alarms 

 Acknowledge alarms 
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Operation with mouse and keyboard 

Introduction 
Within an alarm view there is a tabulator sequence that enables the operating elements and 
the last selected alarm to be selected via the keys of the runtime system. 

Operation with the mouse 
1. Click on the alarm to be edited. 
2. Click on the operating element you wish to use. 

Operation with the keyboard 
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view. 
2. Click on the alarm to be edited. You can use the keys <Pos1>,<End>,<Up> and <Down> 

for this. 
3. Press the <Tab> key until the operating element you wish to use is selected. 
4. Press <Enter>. 

Alternative operation 
Depending on the configuration, you can also operate the alarm view via the function keys. 
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Example: Change the sequence of the columns 
1. Select the "Alarm view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Choose the column header e.g. the "Date" column header. 
4. While holding down the mouse button, drag the column header to the column header 

"Time". 

Example: Change the order of the columns 
1. Select the "Alarm view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Click on the column header. 
4. Click the same column header again to reverse the sort order. 

Example: Acknowledging an alarm 
1. Select the "Alarm view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Select the alarm to be acknowledged. 

4. Click on the  button. 

Example: Edit alarm 
1. Select the "Alarm view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Click on the alarm to be edited. 

4. Click on the  button. 

Operation behavior 
When you edit an unacknowledged alarm, it is acknowledged automatically. 
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4.4.2.8 Simple alarm view 

Description 

Purpose  
The simple alarm view shows selected alarms or alarm events from the alarm buffer or alarm 
log. The layout and operation of the simple alarm window correspond to that of the simple 
alarm view.  

 

Layout  
Depending on the configuration, in the alarm view different columns with information 
regarding an alarm or an alarm event are displayed. 

Operation 
Depending on the configuration you can: 
● Acknowledge alarms 
● Edit alarms 
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Controls 
The buttons have the following functions:  
 
Button Function 

 
Acknowledging an alarm 

 
Edit alarm 

 
Displays an alarm operator note 

 
Shows the full text of the selected alarm in a separate window, the alarm text window.
In the alarm text window, you can view alarm text that requires more space than is 
available in the Alarm view. Close the alarm text window with . 

 
Scrolls one alarm up 

 
Scrolls one page up in the alarm view 

 
Scrolls one page down in the alarm view 

 
Scrolls one alarm down 

 

Operation with mouse and keyboard 

Introduction 
Within the simple alarm view there is a tabulator sequence that enables the operating 
elements and the last selected alarm to be selected via the keys of the runtime system. 

Operation with the mouse 
1. Click on the alarm to be edited. 
2. Click on the operating element you wish to use. 

Operation with the keyboard 
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view. 
2. Click on the alarm to be edited. You can use the keys <Home>,<End>,<Up> and <Down> 

for this. 
3. Press the <Tab> key until the operating element you wish to use is selected. 
4. Press <Enter>. 
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Alternative operation 
Depending on the configuration, you can also operate the alarm view via the function keys. 

Example: Acknowledging an alarm 
1. Select the alarm to be acknowledged. 

2. Click on the  button. 

Example: Edit alarm 
1. Click on the alarm to be edited. 

2. Click on the  button. 

Example: Calling the infotext 
1. Click on the alarm to be edited. 

2. Click on the  command button. 
3. To close the window for displaying the operator note, press the  button or use the key 

combination <Alt+F4>. 

4.4.2.9 Date/time field 

Purpose 
A "Date / time box" may have the following runtime functions: 
● Output of the date and time 
● Combined input and output; here the operator can edit the output values so as to reset 

the date and time. 

 

Layout 
The layout in the date/time field depends on the language set in the runtime system.  
The date can be displayed in detail (e.g. Tuesday, 31 December 2003) or in short form 
(31.12.2003).  

Operation 
Depending on the configuration, you can operate the date/time field in the following ways: 
● Standard operation: Change date and time. 
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Operation behavior 
When the operator of the runtime system ignores the syntax when entering values, or enters 
illegal values, the system rejects these. Instead, the original values (plus the time that has 
elapsed in the meantime) will appear in the date/time field and a system alarm will be 
displayed on the runtime system. 

Operation with mouse and keyboard 

Operation with the mouse 
1. Click in the date/time field. 
2. Type in the relevant value. 
3. Confirm your input to the runtime system with <Return> or cancel it with <Esc>. 

Operation with the keyboard 
1. Press the <Tab> key until the date/time field is selected. 
2. Enter the value. 
3. Confirm your input with <Enter> or cancel it with <Esc>. 

Alternative operation with the keyboard 
1. Press the <Tab> key until the date/time field is selected. 
2. Press <Enter>. The object changes to the specific editing mode. Now, only one character 

will be marked in the field. 
3. Use the <Up>/<Down> cursor keys to scroll through a character table. 
4. Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input 

position. 
5. Confirm your input with <Enter> or cancel it with <Esc>. 
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4.4.2.10 User view 

Purpose 
The user view is used by the administrator to manage user accounts, group assignments 
and user passwords.  
Users can change their passwords and logoff times. 

 

Layout 
The user view contains four columns for the user, password, group and log-off time. The 
passwords are encrypted by means of asterisks.  
● All users on the runtime system are displayed in the User View to the administrator or to a 

user with administrator authorizations. 
● When user administration authorization is lacking, only the personal user entry is 

displayed. 

Operation 
Depending on the configuration you can:  
● Manage users, e.g. create, delete. 
● Change existing user data. 
● Export or import user data. 



 RF-MANAGER Runtime 
 4.4 Operating a project in Runtime 

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 491 

Change existing user data 
The following options are available for the range of changes that can be made: 
● The administrator or a user with user administration authorization can change the data for 

all users on the runtime system in the User View. 
– User name 
– Group assignment 
– Password 
– Logoff times 

● Users without user management permission can only change their own user data. 
– Password 
– Logoff time 

 

 Note 
Names or passwords entered in the user view may not contain any special characters, such 
as / " § $ % & ' ?. 

 

Export or import user data 
A user view contains all users, passwords, group assignments and logoff times set up in the 
runtime system. To eliminate the necessity of re-entering all data again on another runtime 
system, you can export the user data, and then import it to another runtime system. 
However, this is only possible if this function has been configured.  

 

 Note 
Do not export the password list immediately after changing it. Exit the "User View" object 
after making changes and wait until the changes have been written to a file before 
performing the export. 

 

NOTICE  
The currently valid passwords are overwritten during an import. The imported user data and 
passwords are valid immediately.  

 

Operation with mouse and keyboard 

Operation with the mouse  
1. Click on the user view with the mouse pointer. 
2. Click on the user to be edited. 
3. Edit the user data. 
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Operation with the keyboard  
1. Press the <Tab> key until the user view is selected. 
2. Click on the user to be edited. You can use the keys <Home>,<End>,<Up> and <Down> 

for this. 
3. Edit the user data 

Example: Creating Users 
1. Click on an empty line in the "User" column of the user view with the mouse pointer. 
2. Then enter the user name. Press <Enter>. 
3. Use <Right> to select the next field. 
4. Assign a password and a logoff time in the same way and then select the group. 

Example: Changing group assignments 
1. Click in the "Group" field with the mouse pointer. 
2. Select a group from the selection list. Or you can use the cursor keys 

<Home>,<End>,<Up> and <Down> for this. 
3. Confirm the entry with <Enter>. 

Example: Delete a user 
1. Click on the user view with the mouse pointer. 
2. Select the user you wish to delete. 
3. Select the "Delete" option in the context menu. 
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4.4.2.11 Simple user view 

Description 

Purpose  
If insufficient space is available for the user element or if a change to the user data instigated 
by a user must be implemented, the simple user view can be used to display users on the 
runtime system.  

 

Layout 
The layout depends on the user rights.  
● All users on the runtime system are displayed in the User View to the administrator or to a 

user with administrator authorizations. 
● When user administration authorization is lacking, only the personal user entry is 

displayed.  

Operation  
Depending on the configuration you can: 
● Manage users, e.g. create, delete. 
● Change existing user data. 
● Export or import user data. 

Operation with mouse and keyboard 

Operation with the mouse 
1. Click on the user name to be processed with the mouse pointer. 
2. Change the user data. Custom user data (name, password, group, logoff time) is entered 

sequentially in several dialogs. 
3. use the "OK" button to confirm the entries. 
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Operation with the keyboard 
1. Keep pressing the <Tab> key until the simple user view is selected. 
2. Click on the user to be edited. 
3. Confirm the selection by pressing the <Enter> key. You can change the user data in the 

following dialogs. 
4. use the "OK" button to confirm the entries. 
The following table shows the available key operations for entering custom user data in the 
dialogs: 
 
Key Function 
<Up>/<Down>: Selects the previous/next user 
<Tab> Selects the next element in the dialog 
<Enter> Opens the next dialog 
<Del> Deletes the selected user. 

Example: Changing user data 
1. Click on the user name to be processed with the mouse pointer. The following dialog 

opens: 

 
2. If necessary, change the user name and password. Click on the "OK" button. The 

following dialog opens: 

 
3. If necessary, change the user group and the logoff time. Click on the "OK" button. 
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Example: Delete a user 
1. Keep pressing the <Tab> key until the simple user view is selected. 
2. Select the user you wish to delete. 
3. Delete the user by pressing the <Del> key. 
4. Click "OK" to close the dialog box. 

4.4.2.12 RFID view 

Purpose  
You can use the "RFID view" screen object to display tag events or the tags that are 
currently present in the field at runtime depending on the project specifications. The content 
of the display is dependent on the display selector used. This is named in the screen object 
header. 
Parameterizing display selectors (Page 273)  

 
 

NOTICE  
Preventing loss of data 
To ensure that all tag events are recorded, you should open the "RFID view" screen before 
the read procedures are performed. 

 

Layout  
The tag events are presented in tabular form and contain the following information: 
 
Parameter Meaning 
ID ID of the read tag (the output format is specified in the project) 
Workplace Name of the workplace that received the tag data 
Reader Name of the reader that read the tag data 
Data source Name of the data source that read the tag 
Date Date of the read procedure 
Time Time of the read procedure 
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Parameter Meaning 
Event type Description of filtering status 
Counters Number of tags* 
RSSI RSSI value when acquiring a tag 
Antenna Name of the antenna at which the tag was read 

*Depending on the parameterization in the "General" group in RF-MANAGER, the "Counter" 
can have the following meaning: 
 
Parameter Meaning 
Tags in field 1) All the tags are displayed that are currently detected by the reader 

and that are in the "Observed" state. 
Tag events 1)  All those tags will be displayed whose status changes (e.g. from 

"Glimpsed" status to "Observed" status). 
Tag events (number) 1)  All tags are displayed whose status has changed. If the same status 

change occurs again for a tag, the event counter in the previous 
alarm is incremented and a new alarm is not displayed.  

1) Only one selection can be active at a time 

Operation  
You can: 
● Delete events 
● Change the column sequence 
● Change the respective column width 

Controls  
The buttons have the following functions: 
 
Button Function 

 
Delete all events 

Example: Change the sequence of the columns 
1. Select the "RFID view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Choose the column header e.g. the "Date" column header. 
4. While holding down the mouse button, drag the column header to the column header 

"Time". 
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Example: Change the order of the columns 
1. Select the "RFID view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Click on the column header. 
4. Click the same column header again to reverse the sort order. 

Example: Changing the column width 
1. Select the "RFID view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Move the mouse pointer to the line that separates two column headers. 
4. Keep pressing the left mouse button while you adjust the column width as required. 
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4.4.2.13 Statistics view 

Purpose  
You can use the "Statistics view" screen object to display the following at runtime: 
● Statistical information 
● Operational status of the components of your system (e.g. failed write attempts) 

 

Layout  
In the "Statistics view" screen object, the components of your system are visualized in the 
form of a tree structure in the left-hand window area. When individual components are 
selected, the associated parameters and their values appear in the right-hand window area.  
If you selected advanced mode under "General" when parameterizing the statistics display 
using the editor, the parameters will only be displayed in English. In user mode, the display 
is language specific. 
The status symbols in the tree structure have the following meaning: 
 
Icon Meaning 

 
The component and its subcomponents are ready for operation 

 
The component and its subcomponents are not ready for operation 

 
The status of the component cannot be determined 

 
The component and its subcomponents are not in a uniform state. 
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Operation  
You can: 
● Display statistical values 
● Reset statistical values 
● Display operational status of the components 
● Change the column sequence 
● Change the respective column width 

Controls  
The buttons have the following functions: 
 
Button Function 

 
Open up the tree structure 

 
Reset all statistical values of the complete system 

 
Reset a selected statistical value 

 
Refresh a display 

 
 

 Note 
Refresh a display 
The display can be updated in two different ways: 
 Using the button . 
 By parameterizing a polling cycle in the "Statistics view" editor under "General". 

 

Example: Changing the column width 
1. Select the "Statistics view" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Move the mouse pointer to the line that separates two column headers. 
4. Keep pressing the left mouse button while you adjust the column width as required. 
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4.4.2.14 Configuration 

Purpose  
In the Configuration screen object, you can make changes to the project configuration at 
runtime. The view is used to commission and optimize your RFID system. You can 
reparameterize individual components, e.g. the antenna power. You can also delete 
individual parameters or display the operational status of the components of your system. 

 

Layout  
In the "Configuration" screen object, the components of your system are visualized in the 
form of a tree structure in the left-hand window area. When individual components are 
selected, the associated parameters and their values appear in the right-hand window area. 
If you want to edit a value, click in the appropriate field and make the change. 
If you selected advanced mode under "General" when parameterizing the statistics display 
using the editor, the parameters will only be displayed in English. In user mode, the display 
is language specific. 
The status symbols in the tree structure have the following meaning: 
 
Icon Meaning 

 
The component and its subcomponents are ready for operation 

 
The component and its subcomponents are not ready for operation 

 
The status of the component cannot be determined 

 
The components and their subcomponents are not in a uniform state 

 
 

 Note 
Refresh a display 
A refresh period can be specified for the display by parameterizing a polling cycle in the 
editor of the Configuration view under "General". 
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Operation  
You can: 
● Edit the values of parameters 
● Delete parameters 
● Add parameters 
● Display operational status of the components 
● Change the column sequence 
● Change the respective column width 

Controls  
The buttons have the following functions: 
 
Button Function 

 
Delete parameters 

 
Add parameters 

 
Open up the tree structure 

 
Activate changes to the project. The changes are not saved and will be lost 
when the runtime system is rebooted. It is generally recommended that the 
changes be simply activated and then the new project configuration tested.  

 
Activate and save changes to the project. Following a successful test, the 
changes can be saved. Only saved changes can be synchronized with the 
Engineering System. To prevent loss of data, note that all changes 
implemented subsequent to the last archived status will be saved. 

 
Undoing changes to the project. If a new project configuration results in 
errors, you can undo the changes. To prevent loss of data, note that all 
changes implemented subsequent to the last archived status will be undone.

Data comparison with the runtime system  
When you make changes to your system at runtime in the "Configuration" screen object, 
save them and save the changes back to the Engineering System. Select the menu item 
"Project > Data comparison with the runtime system..." for this purpose. 
  
This is the only way to ensure that the changes that are implemented at runtime for the 
purposes of system optimization are not lost when the project is transferred again.  
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Example: Changing the column width 
1. Select the "Configuration" screen object using the mouse pointer. 
2. Select "Edit" from the shortcut menu. 

Then you can edit the screen object. 
3. Move the mouse pointer to the line that separates two column headers. 
4. Keep pressing the left mouse button while you adjust the column width as required. 
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Technical specifications 5
5.1 Released operating systems 

The RF-MANAGER has been approved for the following operating systems: 
● Microsoft Windows XP Professional SP2 or higher 
● Windows XP Embedded / SP2 ( for SIMATIC Microbox PC 420/427B) 

5.2 Released databases 
Logging with RF-MANAGER Runtime is released for the following databases: 
● MS SQL Server: MS SQL Server 2000 was tested 
● MS Access: MS Access 2000 and MS Access XP were tested 
● MS Data Engine: MS Data Engine 2000 and MS Data Engine XP were tested 
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5.3 System alarms 

Introduction 
System alarms provide information about internal states of the runtime system, reader and 
PLC. 
The overview below shows the causes of system alarms and how to eliminate the cause of 
error. 
Some of the system alarms described in this section are relevant to individual runtime 
systems based on their range of features.  

 

 Note 
New system alarms 
You will find the latest additions to the system alarms in the Readme file or in the Information 
System. 

 

 Note 
System alarms are only indicated if an alarm window was configured. System alarms are 
output in the language currently set on your runtime system. 

 

System alarm parameters 
System alarms may contain encrypted parameters which are relevant to troubleshooting 
because they provide a reference to the source code of the Runtime software. These 
parameters are output after the text "Error code:" 

Meaning of the system alarms 
 
Number Effect/cause Remedy 

10000 The print job could not be started or was canceled 
due to an unknown error. Faulty printer setup. Or: 
No permission is available for accessing the 
network printer. 
Power supply failure during data transfer. 

Check the printer settings, cable connections and the 
power supply. 
Set up the printer once again. Obtain a network printer 
authorization. 
If the error persists, contact the Hotline! 

10001 No printer is installed or a default printer has not 
been set up. 

Install a printer and/or select it as the default printer. 

10002 Overflow of the graphics buffer for printing. Up to 
two images are buffered. 

Allow sufficient intervals between successive print jobs. 

10003 Images can now be buffered again. —  
10004 Overflow of the buffer for printing lines in text mode 

(e.g. alarms). Up to 1000 lines are buffered. 
Allow sufficient intervals between successive print jobs. 

10005 Text lines can now be buffered again. — 
10006 The Windows printing system reports an error. 

Refer to the output text and the error ID to 
determine the possible causes. Nothing is printed 
or the print is faulty.  

Repeat the action if necessary.  
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Number Effect/cause Remedy 
20010 An error has occurred in the specified script line. 

Execution of the script was therefore aborted. Note 
the system alarm that may have occurred prior to 
this.  

Select the specified script line in the configuration. 
Ensure that the variables used are of the allowed types. 
Check system functions for the correct number and types 
of parameters. 

20011 An error has occurred in a script that was called by 
the specified script.  
Execution of the script was therefore aborted in the 
called script.  
Note the system alarm that may have occurred 
prior to this.  

In the configuration, select the script that has been called 
directly or indirectly by the specified script.  
Ensure that the variables used are of the allowed types.  
Check system functions for the correct number and types 
of parameters. 

20012 The configuration data is inconsistent. The script 
could therefore not be generated. 

Recompile the configuration. 

20013 The scripting component of RF-MANAGER 
Runtime is not correctly installed. Therefore, no 
scripts can be executed. 

Reinstall RF-MANAGER Runtime on your PC. 
Regenerate your project with "Project > Generator > 
Rebuild all" and transfer the project to the runtime 
system. 

20014 The system function returns a value that is not 
written in any return variable. 

Select the specified script in the configuration. 
Check if the script name has been assigned a value. 

20015 Too many successive scripts have been triggered 
in short intervals. When more than 20 scripts are 
queued for processing, any subsequent scripts are 
rejected. In this case, the script indicated in the 
alarm is not executed. 

Find what is triggering the scripts. Extend the times, e.g. 
the polling time of the variables which trigger the scripts.  

30010 The variable could not accept the function result, 
e.g. when it has exceeded the value range. 

Check the variable type of the system function parameter.

30011 A system function could not be executed because 
the function was assigned an invalid value or type 
in the parameter. 

Check the parameter value and variable type of the 
invalid parameter. If a variable is used as a parameter, 
check its value. 

40010 The system function could not be executed since 
the parameters could not be converted to a 
common variable type. 

Check the parameter types in the configuration. 

40011 The system function could not be executed since 
the parameters could not be converted to a 
common variable type. 

Check the parameter types in the configuration. 

50000 The runtime system is receiving data faster than it 
is capable of processing. Therefore, no further data 
is accepted until all current data have been 
processed. Data exchange then resumes. 

— 

50001 Data exchange has been resumed. — 
60000 This alarm is generated by the “ShowSystemAlarm” 

function. The text to be displayed is transferred to 
the function as a parameter.  

— 

60010 The file could not be copied in the direction defined 
because one of the two files is currently open or the 
source/target path is not available. 
It is possible that the Windows user has no access 
rights to one of the two files. 

Restart the system function or check the paths of the 
source/target files.  
Using Windows NT/2000/XP: The user executing RF-
MANAGER Runtime must be granted access rights for 
the files. 

60011 An attempt was made to copy a file to itself. 
It is possible that the Windows user has no access 
rights to one of the two files. 

Check the path of the source/target file. 
Using Windows NT/2000/XP with NTFS: The user 
executing RF-MANAGER Runtime must be granted 
access rights for the files. 
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Number Effect/cause Remedy 
70010 The application could not be started because it 

could not be found in the path specified or there is 
insufficient memory space. 

Check if the application exists in the specified path or 
close other applications. 

70011 The system time could not be modified. 
The error message only appears in combination 
with the area pointer "Date/time control". Possible 
cause: 
 The Windows user has no right to modify the 

system time. 
If the first parameter in the system alarm is 
displayed with the value 13, the second parameter 
indicates the byte containing the incorrect value. 

Check the time which is to be set. 
Using Windows NT/2000/XP: The user executing RF-
MANAGER Runtime must be granted the right to change 
the system time of the operating system. 

70012 An error occurred when executing the function 
"StopRuntime" with the option "Runtime and 
operating system". 
Windows and RF-MANAGER Runtime are not 
closed. 
One possible cause is that other programs cannot 
be closed. 

Close all programs currently running. 
Then close Windows. 

70013 The system time could not be modified because an 
invalid value was entered. Incorrect separators may 
have been used. 

Check the time which is to be set.  

70014 The system time could not be modified. Possible 
causes: 
 An invalid time was transferred. 
 The Windows user has no right to modify the 

system time. 
 Windows rejects the setting request. 

Check the time which is to be set. 
Using Windows NT/2000/XP: The user executing RF-
MANAGER Runtime must be granted the right to change 
the system time of the operating system. 

70015 The system time could not be read because 
Windows rejects the reading function.  

— 

70016 An attempt was made to select a screen by means 
of a system function. This is not possible because 
the screen number specified does not exist. 
Or: A screen could not be generated due to 
insufficient system memory. 
Or: The screen is blocked. 
Or: Screen call has not been executed correctly. 

Check the screen number in the function or job with the 
screen numbers configured. 
Assign the number to a screen if necessary. 
Check the information about the screen call and whether 
the screen is blocked for certain users. 

70018 Acknowledgment that the password list has been 
successfully imported.  

— 

70019 Acknowledgment that the password list has been 
successfully exported.  

— 

70020 Acknowledgment for activation of alarm reporting. — 
70021 Acknowledgment for deactivation of alarm 

reporting. 
— 

70022 Acknowledgment to starting the Import Password 
List action. 

— 

70023 Acknowledgment to starting the Export Password 
List action. 

— 
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Number Effect/cause Remedy 
70024 The value range of the variable has been exceeded 

in the system function. 
The calculation of the system function is not 
performed. 

Check the desired calculation and correct it if necessary.  

70025 The value range of the variable has been exceeded 
in the system function. 
The calculation of the system function is not 
performed. 

Check the desired calculation and correct it if necessary.  

70026 No other screens are stored in the internal screen 
memory. 
No other screens can be selected. 

— 

70030 The configured parameters of the system function 
are faulty.  
The connection to the new PLC has not been 
established. 

Compare the parameters configured for the system 
function with the parameters configured for the controllers 
and correct them as necessary. 

70031 The controller configured in the system function is 
not an S7 controller. 
The connection to the new controller was not 
established. 

Compare the S7 controller name parameter configured 
for the system function with the parameters configured for 
the controller and correct them as necessary. 

70032 The object configured with this number in the tab 
order is not available in the selected screen. 
The screen changes but the focus is set to the first 
object. 

Check the number of the tab order and correct it if 
necessary. 

70033 An e-mail cannot be sent because a TCP/IP 
connection to the SMTP server no longer exists. 
This system alarm is generated only at the first 
attempt. All subsequent unsuccessful attempts to 
send an e-mail will no longer generate a system 
alarm. The event is regenerated when an e-mail 
has been successfully sent in the meantime. 
The central e-mail component in RF-MANAGER 
Runtime attempts, in regular intervals (1 minute), to 
establish the connection to the SMTP server and to 
send the remaining e-mails. 

Check the network connection to the SMTP server and 
re-establish it if necessary. 

70034 Following a disruption, the TCP/IP connection to 
the SMTP server could be re-established. 
The queued e-mails are then sent. 

— 

70036 No SMTP server for sending e-mails is configured. 
An attempt to connect to an SMTP server has failed 
and it is not possible to send e-mails. 
RF-MANAGER Runtime generates the system 
alarm after the first attempt to send an e-mail. 

Configure an SMTP server: 
In RF-MANAGER Engineering System 
using "Device settings > Device settings" 
Or 
In Windows Control Panel  
over "RF-MANAGER Internet settings" 

70037 An e-mail cannot be sent for unknown reasons. 
The contents of the e-mail are lost. 

Check the e-mail parameters (recipient etc.). 

70038 The SMTP server has rejected sending or 
forwarding an e-mail because the domain of the 
recipient is unknown to the server or because the 
SMTP server requires authentication. 
The contents of the e-mail are lost. 

Check the domain of the recipient address or deactivate 
the authentication on the SMTP server if possible. SMTP 
authentication is currently not used in RF-MANAGER 
Runtime. 
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Number Effect/cause Remedy 
70039 The syntax of the e-mail address is incorrect or 

contains illegal characters. 
The contents of the e-mail are discarded. 

Check the e-mail address of the recipient. 

70040 The syntax of the e-mail address is incorrect or 
contains illegal characters. 

— 

70041 The import of the user management was aborted 
due to an error. 
Nothing was imported. 

Check your user management or transfer it again to the 
panel. 

80001 The log specified is filled to the size defined (in 
percent) and must be stored elsewhere.  

Store the file or table by executing a ‘move’ or ‘copy’ 
function. 

80002 A line is missing in the specified log. — 
80003 The copying process for logging was not 

successful. 
In this case, it is advisable to check any 
subsequent system alarms, too. 

— 

80006 Since logging is not possible, this causes a 
permanent loss of the functionality. 

In the case of databases, check if the corresponding data 
source exists and start up the system again. 

80009 A copying action has been completed successfully. — 
80010 Since the storage location was incorrectly entered 

in RF-MANAGER, this causes a permanent loss of 
the functionality. 

Configure the storage location for the respective log 
again and restart the system when the full functionality is 
required. 

80012 Log entries are stored in a buffer. If the values are 
read to the buffer faster than they can be physically 
written (using a hard disk, for example), 
overloading may occur and recording is then 
stopped. 

Log fewer values. 
Or: 
Increase the logging cycle. 

80013 The overload status no longer applies. Archiving 
resumes the recording of all values. 

— 

80014 The same action was triggered twice in quick 
succession. Since the process is already in 
operation, the action is only carried out once. 

— 

80015 This system alarm is used to report DOS or 
database errors to the user. 

— 

80016 The logs are separated by the system function 
"CloseAllLogs" and the incoming entries exceed the 
defined buffer size. 
All entries in the buffer are deleted.  

Reconnect the logs.  

80017 The number of incoming events cause a buffer 
overflow. his can be caused, for example, by 
several copying actions being activated at the same 
time. 
All copy jobs are deleted.  

Stop the copy action.  

80019 The connection between RF-MANAGER and all 
logs were closed, for example, after executing the 
system function "CloseAllLogs". 
Entries are written to the buffer and are then written 
to the logs when a connection is re-established. 
There is no connection to the storage location and 
the storage medium may be replaced, for example. 

— 
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Number Effect/cause Remedy 
80020 The maximum number of simultaneously copy 

operations has been exceeded. Copying is not 
executed.  

Wait until the current copying actions have been 
completed, then restart the last copy action.  

80021 An attempt was made to delete a log which is still 
busy with a copy action. Deletion has not been 
executed.  

Wait until the current copying actions have been 
completed, then restart the last action  

80022 An attempt was made to start a sequence log, 
which is not a sequence log, from a log using the 
system function "StartSequenceLog". No sequence 
log file is created.  

In the project, check 
 if the "StartSequenceLog" system function was 

properly configured 
 if the variable parameters are properly provided with 

data on the runtime system. 

80023 An attempt was made to copy a log to itself. 
The log is not copied.  

In the project, check 
 if the "CopyLog" system function was properly 

configured 
 if the variable parameters are properly provided with 

data on the runtime system. 

80024 The "CopyLog" system function does not allow 
copying when the target log already contains data 
("Mode" parameter). The log is not copied.  

Edit the "CopyLog" system function in the project if 
necessary. Before you initiate the system function, delete 
the destination log file.  

80025 You have canceled the copy operation. 
Data written up to this point are retained. The 
destination log file (if configured) is not deleted. 
The cancellation is reported by an error entry 
$RT_ERR$ at the end of the destination log.  

— 

80026 This alarm is output after all logs are initialized. 
Values are written to the logs from then on. Prior to 
this, no entries are written to the logs, irrespective 
of whether RF-MANAGER Runtime is active or not. 

— 

80028 The alarm returns a status report indicating that the 
logs are currently being initialized. No values are 
logged until the alarm 80026 is output. 

— 

80029 The number of logs specified in the alarm could not 
be initialized. The logs are initialized. 
 The faulty log files are not available for logging 
jobs.  

Evaluate the additional system alarms , related to this 
alarm which is also generated. 
Check the configuration, the ODBC (Open Database 
Connectivity) and the specified drive.  

80030 The structure of the existing log file does not match 
the expected structure. 
Logging is stopped for this log. 

Delete the existing log data manually, in advance. 

80031 The log in CSV format is corrupted. 
The log cannot be used. 

Delete the faulty file. 

80032 Logs can be assigned events. These are triggered 
as soon as the log is full. If RF-MANAGER Runtime 
is started and the log is already full, the event is not 
triggered. 
The log specified no longer logs data because it is 
full. 

Close RF-MANAGER Runtime, delete the log, then 
restart RF-MANAGER Runtime. 
Or: 
Configure a button which contains the same actions as 
the event and press it. 

80033 "System Defined" is set in the data log file as the 
data source name. This causes an error. No data is 
written to the database logs, whereas the logging to 
the CSV logs works. 

Install MSDE again. 
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Number Effect/cause Remedy 
80034 An error has occurred in the initialization of the 

logs. An attempt has been made to create the 
tables as a backup. This action was successful. A 
backup has been made of the tables of the 
corrupted log file and the cleared log was restarted.

No action is necessary. However, it is recommended to 
save the backup files or delete them in order to make the 
space available again. 

80035 An error has occurred in the initialization of the 
logs. An attempt has been made to create backups 
of the tables and this has failed. No logging or 
backup has been performed. 

It is recommended to save the backups or to delete them 
in order to release memory. 

80044 The export of a log was interrupted because 
Runtime was closed or due to a power failure. 
When Runtime restarted, it was detected that the 
export needed to be resumed. 

The export resumes automatically. 

80045 The export of a log was interrupted due to an error 
in the connection to the server or at the server 
itself. 

The export is repeated automatically. Check: 
 the connection to the server 
 if the server is running 
 if there is enough free space on the server. 

80046 The destination file could not be written while 
exporting the log. 

Check if there is enough space on the server and it you 
have permission to create the log file. 

80047 The log could not be read while exporting it. Check if the storage medium is correctly inserted. 
80049 The log could not be renamed while preparing to 

export it.  
The job can not be completed." 

Check if the storage medium is correctly inserted and if 
there is sufficient space on the medium. 

80050 The log which shall be exported is not closed. 
 The job can not be completed. 

Make sure the "CloseAllLogs" system function is called 
before using the "ExportLog" system function. Change 
the configuration as required. 

110000 The operating mode was changed. "Offline" mode 
is now set. 

— 

110001 The operating mode was changed. "Online" mode 
is now set. 

— 

110002 The operating mode was not changed. Check the connection to the readers. 
110003 The operating mode of the specified controller was 

changed by the system function 
"SetConnectionMode". 
The operating mode is now "offline". 

— 

110004 The operating mode of the specified controller has 
been changed by the system function 
"SetConnectionMode". 
The operating mode is now "online". 

— 

110005 An attempt was made to use the system function 
"SetConnectionMode" to switch the specified 
controller to "online" mode, although the entire 
system is in "offline" mode. This changeover is not 
allowed. The controller remains in "offline" mode. 

Switch the complete system to "online" mode, then 
execute the system function again. 

130000 The action was not executed. Close all other programs. 
Delete files no longer required from the hard disk. 

130001 The action was not executed. Delete files no longer required from the hard disk. 
130002 The action was not executed. Close all other programs. 

Delete files no longer required from the hard disk. 
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Number Effect/cause Remedy 
130003 No data medium found. The operation is canceled. Check, for example, if 

 the correct data medium is being accessed 
 the data medium is inserted 

130004 The data medium is write-protected. The operation 
is canceled. 

Check if access has been made to the correct data 
carrier. Remove the write protection.  

130005 The file is read only. The operation is canceled. Check if access has been made to the correct file. Edit 
the file attributes if necessary.  

130006 Access to file failed. The operation is canceled. Check, for example, if 
 the correct file is being accessed 
 the file exists 
 another action is preventing simultaneous access to 

the file 

130007 The network connection is interrupted. 
Data cannot be saved or read over the network 
connection. 

Check the network connection and eliminate the cause of 
error. 

130010 The maximum nesting depth can be exhausted 
when, for example, a value change in a script 
results in the call of another script and the second 
script in turn has a value change that results in the 
call of yet a further script etc.  
The configured functionality is not supported. 

Check the configuration. 

140000 An online connection to the controller is 
established. 

— 

140001 The online connection to the controller was shut 
down. 

— 

140003 No variable updating or writing is executed. Check the connection and if the controller is switched on.
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface". 
Restart the system. 

140004 No variable update or write operations are 
executed because the access point or the module 
configuration is faulty. 

Verify the connection and check if the controller is 
switched on. 
Check the access point or the module configuration (MPI, 
PPI, PROFIBUS) in the Control Panel with "Set PG/PC 
interface". 
Restart the system. 

140005 No variable updating or writing is executed because 
the runtime system address is incorrect (possibly 
too high). 

Use a different runtime system address. 
Verify the connection and check if the controller is 
switched on. 
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface". 
Restart the system. 

140006 No variable updating or writing is executed because 
the baud rate is incorrect. 

Select a different baud rate in RF-MANAGER (according 
to module, profile, communication peer, etc.). 
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Number Effect/cause Remedy 
140007 Variable updating and writing are not performed 

because the bus profile is faulty (see %1). 
The following parameters cannot be entered in the 
registration database: 
1: Tslot 
2: Tqui 
3: Tset 
4: MinTsdr 
5: MaxTsdr 
6: Trdy 
7: Tid1 
8: Tid2 
9: Gap factor 
10: Retry limit 

Check the user-defined bus profile. 
Check the connection and if the controller is switched on.
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface". 
Restart the system. 

140008 No variable updating or writing is executed because 
baud rate is incorrect. The following parameters 
cannot be entered in the registration database: 
0: General error 
1: Incorrect version 
2: The profile cannot be entered in the registration 
database. 
3: The subnet type cannot be entered in the 
registration database. 
4: The target rotation time cannot be entered in the 
registration database. 
5: Highest address (HSA) faulty. 

Check the connection and if the controller is switched on.
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface". 
Restart the system. 

140009 Variables are not updated or written because the 
module for S7 communication was not found. 

Reinstall the module in the Control Panel using "Set 
PG/PC interface". 

140010 No S7 communication partner found because the 
controller is shut down. 
DP/T: 
The option “PG/PC is the only master” is not set in 
the Control Panel under “Set PG/PC interface.” 

Switch the controller on. 
DP/T: 
If only one master is connected to the network, disable 
"PG/PC is the only master" in "Set PG/PC interface". 
If several masters are connected to the network, enable 
these. Do not change any settings, for this will cause bus 
errors. 

140011 No variable updating or writing is executed because 
communication is down. 

Check the connection and that the communication 
partner is switched on. 

140012 There is an initialization problem (e.g. when RF-
MANAGER Runtime was closed in Task Manager).
Or: 
Another application (e.g.STEP7) with different bus 
parameters is active and the driver cannot be 
started with the new bus parameters (transmission 
rate, for example). 

Restart the runtime system. 
Or: 
Run RF-MANAGER Runtime, then start your other 
applications. 

140013 The MPI cable is disconnected and, thus, there is 
no power supply. 

Check the connections. 

140014 The configured bus address is in already in use by 
another application. 

Edit the runtime system address in the controller 
configuration. 
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140015 Wrong transmission rate 

Or:  
Faulty bus parameters (e.g.HSA) 
Or: 
Runtime system address > HSA or: Wrong interrupt 
vector (interrupt does not arrive at the driver) 

Correct the relevant parameters. 

140016 The hardware does not support the configured 
interrupt. 

Change the interrupt number. 

140017 The set interrupt is in use by another driver. Change the interrupt number. 
180000 A component/OCX received configuration data with 

a version ID which is not supported. 
Install a newer component. 

180001 System overload because too many actions 
running in parallel. Not all the actions can be 
executed, some are rejected.  

Several remedies are available: 
 Increase the configured cycle times or basic clock. 
 Generate the alarms at a slower rate (polling). 
 Initiate scripts and functions at greater intervals. 
If the alarm appears more frequently: 
Restart the runtime system.  

190000 It is possible that the variable is not updated. — 
190001 The variable is updated after the cause of the last 

error state has been eliminated (return to normal 
operation). 

— 

190002 The variable is not updated because 
communication with the controller is down. 

Activate the communication using the system function 
"SetDeviceMode" or "SetConnectionMode". 

190004 The variable is not updated because the configured 
variable address does not exist. 

Check the configuration. 

190005 The variable is not updated because the configured 
controller type does not exist for this variable. 

Check the configuration. 

190006 The variable is not updated because it is not 
possible to map the controller type in the data type 
of the variable. 

Check the configuration. 

190007 The variable value is not modified because the 
connection to the controller is interrupted or the 
variable is offline. 

Set online mode or reconnect to the controller. 

190008 The threshold values configured for the variable 
have been violated, for example, by 
 a value entered 
 a system function 
 a script 

Observe the configured or current threshold values of the 
variable. 

190009 An attempt has been made to assign the variable a 
value which is outside the permitted range of 
values for this data type. 
For example, a value of 260 was entered for a byte 
variable or a value of -3 for an unsigned word 
variable. 

Observe the range of values for the data type of the 
variables. 
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190010 Too many values are written to the variable (for 

example, in a loop triggered by a script). 
Values are lost because only up to 100 actions are 
saved to the buffer. 

The following remedies are available: 
 Increase the time interval between multiple write 

actions. 
 Do not use an array variable longer than 6 words 

when you configure an acknowledgment on the 
runtime system using "Read acknowledgment 
variable". 

190011 Possible cause 1: 
The value entered could not be written to the 
configured controller variable because the high or 
low limit was exceeded. 
The system discards the entry and restores the 
original value. 
Possible cause 2: 
The connection to the controller was interrupted. 

Make sure that the value entered lies within the range of 
values of the control variables. 
Check the connection to the PLC. 

190012 It is not possible to convert a value from a source 
format to a target format, for example: 
An attempt is being made to assign a value to a 
counter that is outside the valid, PLC-specific value 
range. 
A variable of the type Integer should be assigned a 
value of the type String. 

Check the range of values or the data type of the 
variables. 

200000 Coordination is not executed because the address 
configured in the controller does not exist/is not set.

Change the address or set up the address in the 
controller. 

200001 Coordination is canceled because the write access 
to the address configured in the PLC is not 
possible. 

Change the address or set the address in the controller at 
an area which allows write access. 

200002 Coordination is not carried out at the moment 
because the address format of the area pointer 
does not match the internal storage format. 

Internal error 

200003 Coordination can be executed again because the 
last error state is eliminated (return to normal 
operation). 

— 

200004 The coordination may not be executed. — 
200005 No more data is read or written. Possible causes: 

 The cable is defective 
 The PLC does not respond, is defective, etc. 
 System overload 

Check that the cable is connected and that the PLC is 
OK. 
Restart the system if the system alarm persists. 

230000 The value entered could not be accepted. The 
system discards the entry and restores the previous 
value.  
Either  
 The value range has been exceeded 
 Illegal characters have been entered 
 The maximum permitted number of users has 

been exceeded 

Enter a practical value or delete any unneeded users. 

230002 The currently logged in user is not granted write 
access rights. The system therefore discards the 
input and restored the previous value. 

Log on as a user with appropriate rights. 
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230003 Changeover to the specified screen failed because 

the screen is not available/configured. The current 
screen remains selected. 

Configure the screen and check the screen selection 
function. 

230005 The value range of the variable has been exceeded 
in the I/O field. 
The original value of the variable is retained. 

Observe the range of values for the variable when 
entering a value. 

240000 RF-MANAGER Runtime is operating in demo 
mode. 
You have no authorization or your authorization is 
corrupted. 

Install the authorization. 

240001 RF-MANAGER Runtime is operating in demo 
mode. 
Too many variables are configured for the installed 
version. 

Load an adequate authorization / powerpack. 

240002 RF-MANAGER Runtime is operating with a time-
limited emergency authorization. 

Restore the full authorization. 

240003 Authorization failed. 
Without authorization, RF-MANAGER will run in 
demo mode. 

Restart RF-MANAGER Runtime or reinstall it. 

240004 Error while reading the emergency authorization. 
RF-MANAGER Runtime is operating in demo 
mode. 

Restart RF-MANAGER Runtime, install the authorization 
or repair the authorization (see Commissioning 
Instructions Software Protection). 

240005 The Automation License Manager has detected an 
internal system fault.  
Possible causes: 
 A corrupt file 
 A defective installation 
 No free space for the Automation License 

Manager etc. 

Reboot the runtime system. If this does not solve the 
problem, remove the Automation License Manager and 
install it again. 

260000 An unknown user or an unknown password has 
been entered in the system. 
The current user is logged off from the system. 

Log on to the system as a user with a valid password. 

260001 The logged in user does not have sufficient 
authorization to execute the protected functions on 
the system. 

Log on to the system as a user with sufficient 
authorization. 

260002 This alarm is triggered by the system function 
"TrackUserChange". 

— 

260003 The user has logged off from the system.  — 
260004 The user name entered into the user view already 

exists in the user administration. 
Select another user name because user names have to 
be unique in the user administration. 

260005 The entry is discarded.  Use a shorter user name.  
260006 The entry is discarded.  Use a shorter or longer password. 
260007 The login timeout value entered is outside the valid 

range of 0 to 60 minutes. 
The new value is discarded and the original value is 
retained. 

Enter a login timeout value between 0 and 60 minutes. 

260009 You have attempted to delete the user "Admin". 
This user is a fixed component of the user 
management and cannot be deleted. 

If you need to delete a user, because perhaps you have 
exceeded the maximum number permitted, delete 
another user. 
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260012 The passwords entered in the "Change Password" 

dialog and the confirmation field are not identical. 
The password has not been changed. User will be 
logged off. 

You have to log on to the system again. Then enter the 
identical password twice to be able to change the 
password. 

260013 The password entered in the "Change Password" 
dialog is invalid because it is already in use. 
The password has not been changed. User will be 
logged off. 

You have to log on to the system again. Then enter a 
new password that has not been used before. 

260014 User has unsuccessfully attempted to log on 3 
times in succession. 
The user has been locked out and assigned to 
group no. 0. 

You can log on to the system with your correct password. 
Only an administrator can change the assignment to a 
group. 

270001 There is a device-specific limit as to how many 
alarms may be queued for output (see the 
operating instructions). This limit has been 
exceeded. 
The view no longer contains all the alarms. 
However, all alarms are written to the alarm buffer. 

— 

270002 The view shows alarms of a log for which there is 
no data in the current project. 
Wildcards are output for the alarms.  

Delete older log data if necessary.  

310000 An attempt is being made to print too many reports 
in parallel. 
Only one log file can be output to the printer at a 
given time; the print job is therefore rejected. 

Wait until the previous active log was printed. 
Repeat the print job if necessary. 

310001 An error occurred on triggering the printer. The 
report is either not printed or printed with errors. 

Evaluate the additional system alarms related to this 
alarm. 
Repeat the print job if necessary. 

330022 Too many dialogs are open on the runtime system. Close the dialogs that are not required on the runtime 
system. 

330026 The password will expire after the number of days 
shown. 

Enter a new password. 

500000 The system function cannot be executed due to an 
error. The function code is displayed. 

Dependent on the function and error. Logging can be 
activated to locate the cause of the error. 

500001 The system function cannot be executed due to an 
error. The function code and the error code are 
displayed. 

Dependent on the function and error. Logging can be 
activated to locate the cause of the error. 

500002 The system function cannot be executed due to an 
error. The function code, error code and other 
additional information are displayed. 

Dependent on the function and error. Logging can be 
activated to locate the cause of the error. 

500010 The number of configured readers exceeds the 
maximum number of readers specified by the 
license key. 

Reduce the number of configured readers or purchase a 
license key with a larger maximum number of readers. 

500013 Access from an RFID data link to the RFID data of 
RFID processing has failed. The data is accessed 
following activation of the RFID data link (an RFID 
data link that has been newly created in the project 
is activated by default). 

The RFID data link automatically attempts to access the 
RFID data again. If access was possible, a message to 
indicate success will be output with the message number 
500014. If this message does not appear after some time, 
terminate the complete RF-MANAGER runtime system 
(including the RFID processing) and restart it. 
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500014 A previously failed access from an RFID data link to 

the RFID data of RFID processing was successfully 
executed. 

— 

500015 The configured buffer size for an RFID data link 
was exceeded. New RFID data for the RFID data 
link are rejected. 

Ensure that the RFID data link can write the received 
RFID data in the configured variables in time (check the 
coordination procedure). Every data record that can be 
written in the variable is removed from the buffer for the 
RFID data link. If necessary, increase the buffer size of 
the RFID data link in the engineering system ("Number of 
entries in buffer"). 

500016 This alarm indicates that an RFID data record 
received from an RFID data link was inconsistent 
and therefore could not be processed. 

A direct remedy is not available. If the alarm appears 
frequently, terminate the complete RF-MANAGER 
runtime system (including the RFID processing) and 
restart it. 

500019 An attempt is being made to connect to RFID 
processing. RFID processing is a stand-alone 
component of RF-MANAGER Runtime that is 
activated by the rest of RF-MANAGER Runtime 
and that communicates with it through TCP/IP. 

— 

500020 Connection to RFID processing was successful. — 
500021 The connection to RFID processing was 

interrupted. Possible causes: 
1) RFID processing has been terminated (e.g. by 
means of the system function StopRfidProcessing). 
2) RFID processing is no longer able to maintain 
the connection due to an error. 

1) Start RFID processing again (e.g. by means of the 
system function StartRfidProcessing). 
2) Logging can be activated to locate the cause of the 
error. Rectify by terminating RFID processing and starting 
it again. In severe cases, exit RF-MANAGER Runtime, if 
necessary change the communication timeouts in the INI 
files "RfmHmiRTRfid.ini" and "RfmRfidRT.ini" and then 
start Runtime again. 

500022 It was not possible to start RFID processing. 
Possible causes: 
1) The path to RFID processing specified in the INI 
file "RfmHmiRTRfid.ini" is no longer the 
installation/storage location of the executable file 
for RFID processing (RfmRfidRT.exe). 
2) The system is overloaded. 

1) Change the path for the executable file for RFID 
processing (RfmRfidRT.exe) in the INI file 
"RfmHmiRTRfid.ini" to the actual storage location. 
2) Terminate processes that are not required. 

500023 The RFID configuration data could not be loaded by 
the RFID processing function. Possible causes: 
1) The default port required for transferring the 
RFID configuration data is already reserved by 
another process. 
2) The RFID configuration data are not consistent 
and/or the RFID processing function has error 
status 

1) Edit the default port in the INI file "RfmHmiRTRfid.ini" 
2) Logging can be activated to locate the cause of the 
error. Rectify by terminating RF-MANAGER Runtime 
complete with RFID processing, edit the project in the 
Engineering System and generate it again, then start 
Runtime again. 

500024 The RFID configuration data is activated. The RFID 
configuration data is transferred to RFID 
processing. 

— 

500025 RFID processing is started. RFID processing is a 
stand-alone component of RF-MANAGER Runtime 
that is activated by the rest of RF-MANAGER 
Runtime and that communicates with it through 
TCP/IP. 

— 
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500029 Parameters that have been changed in the 

configuration view could not be activated, i.e. they 
could not be written in RFID processing. 

Logging can be activated to locate the cause of the error. 
Enter valid values for the relevant parameters and write 
them again 

500030 Changes to the RFID configuration that have been 
activated but not yet saved could not be undone. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again.  
NOTICE: All changes that have not yet been saved will 
be lost. 

500031 Changes to the RFID configuration that have been 
activated but not yet saved could not be saved. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again.  
NOTICE: All changes that have not been saved will be 
lost. 

500032 Statistical parameters for RFID processing 
displayed in the statistics view could not be reset to 
their default value. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again.  
NOTICE: All statistics parameters will be reset. 

500033 The attempt to reset the statistical values of an 
RFID reader by means of a statistics view has 
failed. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again. NOTICE: All statistics parameters will 
be reset. 

500034 An attempt was made to modify and activate 
parameters of an RFID reader by means of a 
configuration display. It was not possible to start 
configuration of the reader. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again. NOTICE: All previously activated 
changes that have not been saved will be lost. 

500035 An attempt was made to modify and activate 
parameters of an RFID reader by means of a 
configuration display. It was not possible to 
complete configuration of the reader. NOTICE: The 
reader configuration may be inconsistent. 

Try again. Logging can be activated to locate the cause 
of the error. In severe cases, terminate RFID processing 
and start it again. NOTICE: All previously activated 
changes that have not been saved will be lost. 

500036 Parameters that have been changed in the 
configuration view could not be activated, i.e. they 
could not be written in RFID processing. 

Logging can be activated to locate the cause of the error. 
Enter valid values for the relevant parameters and write 
them again. 

500038 A configuration view or statistics view was unable 
to read the RFID configuration data from RFID 
processing. 

Reload the page with the configuration view or statistics 
view. If this does not rectify the error, exit and restart 
RFID processing. 

500045 The RF-MANAGER runtime system is trying to 
generate a system alarm due to a system error 
reported by RFID processing.  
Creation of the system alarm has failed. 

The system alarm will be automatically transferred to the 
RF-MANAGER runtime system once more.  
If the system alarm cannot be generated this time, 
terminate the complete RF-MANAGER runtime system 
(including the RFID processing) and restart it. 

500046 Access by the RF-MANAGER runtime system to 
the RFID alarms stored in RFID processing has 
failed.  
They are normally accessed following successful 
build-up of the connection to RFID processing. 

The RF-MANAGER runtime system automatically tries to 
access the RFID alarms again. If access was possible, a 
message to indicate success will be output with the 
message number 500047.  
If this message does not appear after some time, 
terminate the complete RF-MANAGER runtime system 
(including the RFID processing) and restart it. 

500047 Previously failed access by the RF-MANAGER 
runtime system to the RFID alarms stored in RFID 
processing was successfully repeated. 

— 
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500048 An error occurred while an RFID alarm was being 

acknowledged. 
Acknowledge more than once. 
Ensure that RFID processing was started and the 
connection between RFID processing and RF-MANAGER 
runtime has been established.  
If acknowledgement is still not possible, terminate RFID 
processing and restart it. In severe cases, terminate the 
complete RF-MANAGER runtime system and start it 
again. 

500049 All system alarms that appear in RF-MANAGER 
Runtime are transferred via RFID processing to an 
enterprise system that is connected over an ALE 
connection. For this reason, system alarms from 
the rest of RF-MANAGER Runtime must be 
transferred to RFID processing. The alarms are 
stored in a buffer until they can be transferred to 
RFID processing. This alarm indicates overflow of 
the internal buffer. Newly arising system alarms are 
rejected and no longer transferred to RFID 
processing or the enterprise system. This can occur 
if RFID processing is inactive or if communication 
between RFID processing and the rest of RF-
MANAGER Runtime is faulty. 

Start RFID processing (e.g. by means of the system 
function StartRfidProcessing). If the error occurs with 
RFID processing active, terminate RFID processing and 
restart it. In severe cases, terminate the complete RF-
MANAGER runtime system and start it again. 

500050 The connection to a reader could not be 
established. 

Check the power supply of the RFID reader. 
Check the communication settings of the reader: Network 
mode (the reader can only be operated in Ethernet mode 
with RF-MANAGER), network address, port number. 
Check whether the reader is connected to the RF-
MANAGER workstation via the network. 
In severe cases, switch the power supply to the reader off 
and on again and/or terminate and restart RFID 
processing.  

500051 An RFID reader has been successfully configured. — 
500052 The connection to an RFID reader has been 

established. 
— 

500053 The connection to an RFID reader has been 
interrupted. This alarm typically occurs when the 
reader is reconfigured when RFID processing is 
active (changes to the device settings and 
restarting of the runtime system from the 
engineering system when "Restart RFID 
processing when RF-MANAGER Runtime starts 
up"). If this alarm arises during normal operation 
(not reconfiguration), there is a problem with the 
reader. 

In the case of reconfiguration, this is not an error 
message. Rather, the connection to the reader is 
disconnected, the internal settings for the device are 
adapted and the connection to the reader is established 
again.  
If the alarm occurs during normal operation (not 
reconfiguration), check the power supply and network 
connection of the RFID reader and establish it again. In 
severe cases, terminate RFID processing and start it 
again. 

500054 This is a so-called RFID logging alarm: When 
logging is active, the outputs of certain log levels 
are not only entered in the specified logging file and 
the console but they are also displayed as system 
alarms. The relevant log outputs are also supplied 
to the user interface where they are directly visible 
to the plant operator. 

— 
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500055 A reader generates a device-specific error. In the 

case of SIMATIC RF660R readers, the error 
numbers and error texts are identical to those that 
are documented in the additional information of the 
RF660R manual. This system alarm only occurs in 
individual cases. In general, device-specific errors 
of readers are not indicated by means of system 
alarms, but instead using RFID device alarms. 

This is dependent on the cause of error, i.e. the reported 
error number. Refer to error number from additional 
information in RF660R manual. 

500056 The RFID system function to be executed is 
unknown. 

Check and correct the syntax of the system function to be 
executed.  

500057 The parameters for a function are invalid or contain 
the wrong values or types. 

Check that the parameters for system functions are of the 
correct type (especially important in scripts). 

500058 1) Error messages that are directly triggered by the 
RF660 hardware. 
2) In the case of "WriteTagId", this error message 
will sometimes be generated even though the 
function was performed successfully. 

For 1) Refer to error number from additional information 
in RF660 manual. 
For 2) With "ReadFirstTagId" / "ReadNextTagId", check 
whether the tag still has the old ID or whether it has 
already received the new ID with "WriteTagId". 

500059 The connection to RFID processing was 
interrupted. Possible causes: 
1) RFID processing has been terminated (e.g. by 
means of the system function StopRfidProcessing). 
2) RFID processing is no longer able to maintain 
the connection due to an error. 

1) Start RFID processing again (e.g. by means of the 
system function "StartRfidProcessing"). 
For 2) Logging can be activated to locate the cause of the 
error. Rectify by terminating RFID processing and starting 
it again. In severe cases, exit RF-MANAGER Runtime, if 
necessary change the communication timeouts in the INI 
files "RfmHmiRTRfid.ini" and "RfmRfidRT.ini" and then 
start Runtime again. 

500060 The workplace transferred to a system function as 
a parameter is unknown. 

Check and correct the transferred workplace. 

500061 The workplace set in "SetRfidWorkplaceStatus" 
cannot currently perform status changeover. 

Try again. 

500062 The reader transferred to a system function as a 
parameter is unknown. 

Check and correct the transferred reader. 

500063 The reader set in "SetRfidDeviceStatus" cannot 
currently perform status changeover. 

Try again. 

500064 One or more tags were detected by a reader, but 
could not be read. 

Check and modify read settings (protocol, read cycles, 
timeouts).  
Remove tags from the field and place them back in the 
field. 
Replace defective tags with new ones. 

500065 The data source transferred to a system function as 
a parameter is unknown. 

Check and correct the transferred data source. 

500066 A command that was sent from RFID processing to 
the reader hardware is not supported by the reader. 
This system alarm does not occur during normal 
operation of the reader with RF-MANAGER. 

— 

500067 A command that was sent from the RFID runtime 
system to the RF660R reader hardware produced 
an error. 

Refer to error number from additional information in 
RF660R manual. 

500068 An invalid duration (value < 0) was set for a read 
command ("ReadFirstTagId"). 

Set duration to a sensible value (≥ 0). 
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500069 The workplace transferred as a parameter to a 

system function is invalid, i.e. it can not be used in 
the current project configuration with this function. 

Check and correct the transferred workplace. 

500070 A tag is not present in the field (for "WriteTagId"). Tags moving into the field. 
500071 Several tags exist in the field and a "WriteTagId" 

command was issued without a tag ID for 
identifying the tag that should be written. 

The parameter for the tag ID in the "WriteTagId" function 
must reference a valid tag that is present in the field. 

500072 The addressed tag is locked and the function can 
therefore not be executed. 

First unlock the tags using the lock functions. 

500073 The password transferred for accessing a tag is 
invalid (for "KillTag", "WriteTagId", 
"LockEpcGen2Tag" / "LockIsoTag"). 

Use the correct password. 

500074 The tag is read-only. This error occurs on writing. Use another tag. 
500075 A conversion file does not exist for the specified tag 

format. This error can only occur when new formats 
are used following delivery of RF-MANAGER. 

Contact the manufacturer to find out if an update of the 
conversion file will be supplied with the next hot 
fix/service pack. 

500076 A parameter value for the "TranslateEpc" function 
undershoots the permitted lower limit. 

Refer to limit value for parameter in the documentation 
and use the valid value. 

500077 A parameter value for the "TranslateEpc" function 
overshoots the permitted upper limit. 

Refer to limit value for parameter in the documentation 
and use the valid value. 

500078 A parameter value for the "TranslateEpc" function 
contains invalid characters. 

Refer to permitted value range for parameter in the 
documentation and use the valid value. 

500079 An invalid name was used for a parameter of the 
"TranslateEpc" function. 

Refer to permitted parameters in the documentation and 
use the valid value. 

500080 When values were converted by the "TranslateEpc" 
function, an overflow occurred in the permitted 
value ranges. 

Check that the tag ID used is valid. 

500081 Conversion of a tag ID failed. Check formats, parameters and parameter values. 
500082 A conversion rule could not be found for the tag ID. 

1) The tag ID does not comply with any existing 
format or the format has been entered incorrectly 
(too long, too short, too few characters/sections). 
2) The conversion file does not contain a section 
that concerns the format. 
Occurs in the case of the "TranslateEpc" function, 
but also when tags with invalid formats are read (for 
transfer over ALE). 

Normally only case 1) occurs. A tag ID started with a valid 
header, but the subsequent information was invalid. 
Correct the user format. 

500083 A tag ID can not be correctly interpreted by the 
RFID processing function. This can be a tag ID that 
has been read from a tag or a tag ID that has been 
transferred to the "TranslateEPC" system function 
as a parameter. 

Ensure that a correct tag ID is read or transferred. 

500084 Activation of the RFID configuration data has been 
performed and successfully completed. 

— 
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500085 Activation of the RFID configuration data has failed. Try again by starting the runtime system from the 

engineering system again. If it occurs repeatedly, in the 
engineering system under RFID/Network Settings, check 
the box "Automatic restarting of RFID processing when 
runtime starts" and start runtime again. With this 
measure, RFID processing that is already running will 
also be restarted when the runtime system restarts and it 
will be completely reconfigured (no delta configuration).  

500089 During configuration or reconfiguration of an RFID 
reader, an error has occurred. 

Start the runtime system again from the engineering 
system. If it occurs repeatedly, in the engineering system 
under RFID/Network Settings, check the box "Automatic 
restarting of RFID processing when runtime starts" and 
start runtime again. With this measure, RFID processing 
that is already running will also be restarted when the 
runtime system restarts and the reader will be completely 
reconfigured (no delta configuration). In particularly 
severe cases, switch the power supply to the reader off 
and on again. 

500090 RFID processing cannot be started due to an 
internal error. 

Start the runtime system again from the engineering 
system. 

500091 RFID processing has been successfully started. — 
500092 The alarms buffered in RFID processing (RFID 

alarms and system alarms) have exceeded the 
maximum permissible buffer size. A specific 
number of alarms has been rejected. This can 
occur when there is no enterprise system 
connected over an ALE connection that can accept 
the alarms. 

If an enterprise system is not connected over an ALE 
connection, this system alarm only provides information 
and does not constitute an error. To ensure that no 
alarms are lost, an enterprise system must always be 
connected. 

500093 RFID processing is terminated and shut down. — 
500100 The RFID data link set in "SetRfidDataLinkStatus" 

cannot currently perform status changeover. 
Try again. 

500110 The trigger transferred to a system function as a 
parameter is unknown. 

Check and correct the transferred trigger. 

500111 The tag could not be found in the field with the tag 
ID that was transferred as a parameter with a 
system function. 

Move the tag with the relevant tag ID into the field. 
Check and correct the transferred tag ID. 
Check and modify read settings (protocol, read cycles, 
timeouts). 

500112 The tag field transferred to a system function as a 
parameter is unknown. 

Check and correct the transferred tag field. 

500113 The system function "ReadNextTagId" was called 
for a workplace without a preceding 
"ReadFirstTagID". 

Use "ReadFirstTagID" with the required workplace. 
"ReadNextTagId" can then be called with this workplace. 
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Appendix A
A.1 Service & Support 

A.1.1 Technical Support 

Technical Support  
You can access technical support for all IA/DT projects via the following: 
● Phone: + 49 (0) 911 895 7222 
● Fax: + 49 (0) 911 895 7223 
● E-mail (mailto:support.automation@siemens.com) 
● Internet: Online support request form: (www.siemens.com/automation/support-request) 

A.1.2 Contact partner 

Contact partner 
If you have any further questions on the use of our products, please contact one of our 
representatives at your local Siemens office.  
The addresses are found on the following pages: 
● On the Internet (www.siemens.com/automation/partner) 
● In Catalog CA 01 
● In Catalog FS 10 specially for factory automation sensors 

mailto:support.automation@siemens.com�
http://www.siemens.com/automation/support-request�
http://www.siemens.com/automation/partner�
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A.1.3 Service & support for industrial automation and drive technologies 

Service & support for industrial automation and drive technologies 
You can find various services on the Support homepage 
(www.siemens.com/automation/service&support) of IA/DT on the Internet.  
There you will find the following information, for example: 
● Our newsletter containing up-to-date information on your products. 
● Relevant documentation for your application, which you can access via the search 

function in "Product Support". 
● A forum for global information exchange by users and specialists. 
● Your local contact for IA/DT on site. 
● Information about on-site service, repairs, and spare parts. Much more can be found 

under "Our service offer". 

A.1.4 RFID homepage 

RFID homepage 
For general information about our identification systems, visit RFID homepage 
(www.siemens.com/simatic-sensors/rf). 

A.1.5 Technical documentation on the Internet 

Technical documentation on the Internet 
A guide to the technical documentation for the various products and systems is available on 
the Internet:  
SIMATIC Guide manuals (www.siemens.com/simatic-tech-doku-portal) 

A.1.6 Online catalog and ordering system  

Online catalog and ordering system  
The online catalog and the online ordering system can also be found on the Industry Mall 
Homepage (http://www.siemens.com/industrymall). 

http://www.siemens.com/automation/service&support�
http://www.siemens.com/simatic-sensors/rf�
http://www.siemens.com/simatic-tech-doku-portal�
http://www.siemens.com/industrymall�
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A.1.7 Training 

Training center  
We offer appropriate courses to get you started. Please contact your local training center or 
the central training center in  
D-90327 Nuremberg. 
Phone: +49 (0) 180 523 56 11 
(€ 0.14 /min. from the German landline network, deviating mobile communications prices are 
possible) 
For information about courses, see the SITRAIN homepage (www.sitrain.com). 

 

http://www.sitrain.com/�
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Glossary 

Active field 
Area with minimum field strength containing the sensing range. Within this sensing range, 
data can be read from the tag or written to the tag. 

Active surface 
See active field 
See active field 

Active surface 
See active field 
See active field 

Active tag/transponder  
Active transponders are battery-operated, i.e. they obtain the energy required to save data 
on the microchip from a built-in battery. They are usually in an idle state and do not transmit 
data in order to increase the energy source's service life. The transmitter is only activated 
when it receives a special activation signal.  

ALE interface 
Application Level Events (ALE) specifies an interface over which RFID data can be 
requested from higher-level systems. The data volume is reduced via ALE connections and 
the quality of the data stream is improved at the same time. The ALE interface can be used 
by higher-level systems for both synchronous and asynchronous reading of RFID data. ALE 
clients therefore only have a logical view of workplaces, detailed knowledge of the RFID 
system or readers is no longer necessary. 
For an ALE connection, ALE groups can also be configured that specify how the data 
records that have been passed on should be grouped for the report to the ALE client. 

AM 
Amplitude modulation; data are present in the changes in carrier frequency amplitude. 

Amplitude modulation 
See AM 
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Antenna switching 
The change antenna function switches antennas over between transmitting (TX) and 
receiving (RX) in accordance with the rotation principle. In practice, the system transmits on 
one antenna at one time and receives on the other antennas.  

Antennas 
Antennas read/write RFID data from/to the tags. They pass the read data onto the data 
sources. 

AS 
See Automation system 

ASM 
Interface module, see communication modules 

Automation system (AS) 
A programmable logical controller (PLC) of the SIMATIC S7 system, comprising a central 
controller, a CPU and various I/O modules. 

Battery-free data storage unit 
Mobile data storage units which operate without batteries (see transponders). Power is 
supplied to the data storage unit across an electromagnetic alternating field. 

Baud 
Unit (digits per second). 

Baud rate 
The baud rate describes the data transmission's digit rate. 

Byte 
One byte represents a group of eight bits. 

CE guidelines 
See CE Label 

CE Label 
Communauté Européenne (product mark of the European Union) 
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Communication modules 
Communication modules are used to integrate the identification systems in SIMATIC or 
SINUMERIK systems, or to connect them to PROFIBUS, PROFINET, PC or any other 
system. Once supplied with the corresponding parameters and data, they handle data 
communication. They then make the corresponding results and data available. Suitable 
software blocks (FB/FC for SIMATIC; C libraries for PCs with Windows) ensure easy and 
fast integration in the application. 

Continuous Wave 
See CW 

CW 
Continuous Wave; data are present in the carrier frequency which is switched on and off. 

Data rate 
The rate at which data are exchanged between the tag and reader. Typical units are bits per 
second or bytes per second. 

Data sources 
Data sources are the basic components for reading RFID data. They encapsulate the 
antennas assigned to them and the data received by them for the subsequent function units. 
In general, one RFID device can also contain more than one data source. Various different 
data sources can be defined so that mutually independent tasks can be performed with the 
same reader.  

Data transfer rate 
Number of characters which can be transmitted from a tag to a reader within a defined time. 
Baud rates are also used to specify how fast a reader can read information. 

Data transmission rate 
Unit of measurement for the volume of data transmitted within a unit of time, e.g. bytes/s, 
see also Baud 

dB 
See Decibel  

dBm 
Dimensional unit for the transmitted power in the logarithmic relation to 1 mW (Milliwatt).  
0 dBm = 1 mW, +23 dBm = 200 mW, +30 dBm = 1 W 
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dBr 
dB(relative); a relative difference to a reference value 

Decibel (dB) 
Unit of measurement for the logarithmic relationship between two variables. 

Detuning 
UHF antennas are tuned to receive a particular electromagnetic wavelength from the reader. 
If the antenna is too close to metal or a metallic material, it can be detuned, making the 
performance deteriorate. 

DHCP 
Dynamic Host Configuration Protocol 

Distant field communication 
RFID antennas emit electromagnetic waves. If a tag is further than one full wavelength from 
the transmit antenna of the reader, this is known as a distant field. If it is within one complete 
wavelength, this is known as the near field. 
The wavelength in the UHF RFID system is approximately 33 cm. 
The distant field weakens according to the square of the distance to the antenna and the 
near field weakens according to the cube of the distance to the antenna. Passive RFID 
systems based on distant field communication (UHF and microwave systems) have a greater 
read range than systems based on near field communication (typically low-frequency and 
high-frequency systems). 

Dwell time 
The dwell time is the time during which the transponder dwells within the sensing range of a 
reader. The reader can exchange data with the transponder during this time. 

Dynamic mode 
In dynamic mode, the data carrier moves past the reader at a traversing rate which depends 
on the configuration. Various checking mechanisms ensure error-free data transfer even 
under extreme environmental conditions. 

EAN  
European article number. Standardized barcode used in Europe, Asia and South America. Is 
administered by EAN International. 

EBS 
Equipotential Bonding Strip 
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Effective Isotropic Radiated Power 
See EIRP 

Effective Radiated Power 
See ERP. 

EIRP 
Effective Isotropic Radiated Power; unit of measurement for the transmission power of 
antennas (referred to an isotropic radiator) mainly used in the USA. EIRP is specified in 
Watt, and is not equal to ERP. (0 dbi = –2.14 dBm) 

Electromagnetic compatibility (EMC) 
Electromagnetic compatibility is the ability of an electrical or electronic device to operate 
satisfactorily in an electromagnetic environment without affecting or interfering with the 
environment over and above certain limits. 

EMC 
See Electromagnetic compatibility 

EMC directive 
Guidelines for electromagnetic compatibility This guideline relates to any electrical or 
electronic equipment, plant or system containing electric or electronic components. 

EPC 
Electronic Product Code. Standardized number system for identifying articles with a data 
width of either 64, 96 or 256 bits. 

EPCglobal 
The non-profit organization EPCglobal Inc. develops standards for uniform use of RFID 
technology throughout the entire supply chain spanning different countries and sectors. 
Development of the EPC (Electronic Product Code) was an important step in the direction of 
RFID standardization. 

Equipotential bonding 
Potential differences between different parts of a plant can arise due to the different design 
of the plant components and different voltage levels. It is necessary to compensate for these 
differences by equipotential bonding. this is done by combining the equipotential bonding 
conductors of power components and non-power components on a centralized equalizing 
conductor (EBS = Equipotential Bonding Strip). 
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ERP 
Effective Radiated Power; unit of measurement for the power of antennas (referred to an 
ideal dipole) mainly used in Europe. ERP is specified in Watt, and is not equal to EIRP. 
(0dbm = + 2.14 dBi) 

ESD directive 
Directive for handling Electrostatic Sensitive Devices 

ETSI 
European Telecommunications Standard Institute 

European Article Numbering 
See EAN. 

eXtensible markup language 
See XML. 

FCC 
Federal Communications Commission (USA) 

FHSS 
Frequency Hopping Spread Spectrum; frequency hopping procedure. 

FM 
Frequency modulation; data are present in the changes in the frequency of the carrier 
frequency. 

Frequency hopping 
Frequency hopping technique Automatic search for free channels.  
In frequency hopping mode, data packets are transmitted between communication partners 
on continuously changing carrier frequencies. This makes it possible to react to interference 
from devices transmitting signals in the same frequency range (channel). If an attempt to 
send a data packet is unsuccessful, the packet can be transmitted again on a different 
carrier frequency. By default the RF600 uses this procedure (FCC) only in the USA and 
Canada. 

Frequency modulation 
See FM. 



 Glossary 
  

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 533 

Frequency Shift Keying 
See FSK 

FSK 
Modulation, Frequency Shift Keying; data are present in the changes between two 
frequencies. 

ICNIRP 
International Commission of Non Ionizing Radiological Protection 

ICRP 
International Commission of Radiological Protection 

Interface modules 
See communication modules 

Interrogator 
See readers 

ISO 
International Standard Organization 

ISO 18000 
Standard for data exchange of RFID systems between reader and transponder. There are 
various subdefinitions of this standard for the various approved frequency ranges for RFID. 
For example, the range 865 ... 868 MHz is described in ISO 18000-6.  

LAN 
Local Area Network 

LBT 
Listen Before Talk; the reader only transmits when the channel is free. 

Limit distance 
The limit distance is the maximum clear distance between reader antenna and transponder 
at which the transmission can still function under normal conditions. 
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Mass recording 
The capability of a reader to record several or many transponders quasi-simultaneously and 
to read the code. Contrary to the multi-tag capability, the reader is not able to specifically 
address individual tags. 

MDS 
Mobile data memory, see transponder 

MES 
Manufacturing Execution System 

Metal-free area 
Distance/area which must be maintained between the transponder and metal in order to 
prevent interference during data transfer between the transponder and reader. 

Mobile Data Memory (MDS) 
Mobile data memory, see transponder 

Modulation 
Modulation is a procedure with which one or more characteristics (e.g. phase, amplitude, 
frequency) of a carrier oscillation are modified according to the response of a modulating 
oscillation. 

MTBF 
Mean Time Between Failures of a device 

Multi-tag capability 
Multi-tag capability means that a reader can communicate simultaneously with different data 
carriers. Therefore the reader can specifically address a transponder with its UID (see also 
mass recording). 

Near field communication 
RFID antennas emit electromagnetic waves. If a tag is further than one full wavelength from 
the transmit antenna of the reader, this is known as a distant field. If it is within one complete 
wavelength, this is known as the near field. 
The wavelength in the UHF RFID system is approximately 33 cm. 
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The distant field weakens according to the square of the distance to the antenna and the 
near field weakens according to the cube of the distance to the antenna. Passive RFID 
systems based on near field communication (typically low-frequency and high-frequency 
systems) have a greater read range than systems based on distant field communication 
(typically UHF and microwave systems). 

Notification channels 
One or more data sources are assigned to notification channels as data suppliers. 
Notification channels are used for asynchronous read procedures. The notification channel 
passes on the RFID data to the data sources assigned to it in accordance with the 
configured triggering mechanism (notification channel trigger) and the data selector. 
Notification channels can reference more than one data source. The information from 
notification channels (if they have been created) is also requested in the synchronous read 
procedure. 

Passive tag/transponder  
A tag without its own power supply. Passive transponders obtain the energy required to 
supply the microchips from the radio waves they receive. 

PDM  
Pulse width modulation; data are present in the pulse width. 

Phase modulation 
See PM 

PLC 
Programmable Logic Controller, see PLC. 
Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 
Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  

PLC 
Programmable Logic Controller, see PLC. 
Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 
Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  
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PLC 
Programmable Logic Controller, see PLC. 
Programmable logic controller; electronic device used in automation engineering for open-
loop and closed-loop control tasks. The typical modules of a PLC are the CPU, power supply 
(PS) and various input/output modules (I/O). 
Programmable controller: The programmable logical controllers (PLC) of the SIMATIC 
system consist of a central controller, one or more CPUs, and various other modules (e.g. 
I/O modules).  

PM  
Phase modulation; data are present in the changes in carrier frequency phase. 

Programmable Logic Controller 
See PLC. 

Programmable logic controller  
See PLC 

Pulse width modulation 
See PDM 

Radio Frequency Identification 
See RFID. 

Read procedures 
There are two different techniques for reading the data sources: 
● Synchronous read procedure 

A synchronous read procedure is when an ALE client of the enterprise system logs onto 
the report of the ALE interface and receives the required data automatically. 

● Asynchronous read procedure 
An asynchronous read procedure is when an ALE client of the enterprise system logs 
onto the report of the ALE interface and receives the data automatically. This continues 
until the client logs off again. 

Read rate 
Number of tags which can be read within a defined time.  
The read rate can also be used for the maximum rate at which data can be read from a tag. 
The unit is bits per second or bytes per second. 
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Reader (also interrogator) 
Readers transfer data between the mobile data storage units (tags or transponders) and the 
higher-level systems. The data, including the energy required for processing and sending 
back, are transmitted to the transponder across an electromagnetic alternating field. This 
principle enables contact-free data transmission, ensures high industrial compatibility and 
works reliably in the presence of contamination or through non-metallic materials. 

Reader talks first 
A passive tag communicates in the read field of a reader with the reader. The reader sends 
energy to the tags which only reply when they are explicitly requested. The reader is able to 
find tags with a specific serial number commencing with either 1 or 0. 
If more than one tag responds, the reader can scan all tags commencing with 01 and 
subsequently with 010. This is referred to as "walking" on a binary tree, or "tree walking".  

Reading range 
The distance within which a reader can communicate with a tag. Active tags can cover a 
greater distance than passive tags because they use a battery to send signals. 

Report 
A combination of rules which manage communications systems. 

RFID  
Radio Frequency Identification; a method of identifying items using electromagnetic waves. 
The reader supplies energy to the tag and communicates with it. 

RFID device 
The RFID device is a function block in RF-MANAGER and represents a reader. The 
following components are active in this function block: Antennas, data sources and 
notification channels. 

RFID systems 
SIMATIC RF identification systems control and optimize material flow and production 
sequences. They identify reliably, quickly and economically, use non-contact data 
communication technology, and store data directly on the product. They are also resistant to 
contamination. 

RH circular 
Right hand circular polarization 
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RTNC 
Connector standard (Reverse TNC). Industrial coaxial connector with screw coupling, can be 
used for frequencies of up to 2 GHz. The mechanical design of the RTNC connector is not 
compatible with the TNC connector. 

RTTE 
Radio and Telecommunications Terminal Equipment 

SCM 
Supply Chain Management 

Secondary fields 
In addition to the main sensing range (antenna's main direction of transmission) there are 
secondary fields. These secondary fields are usually smaller than the main fields. The shape 
and characteristics of the secondary field depend on the metallic objects in the surroundings. 
Secondary fields should not be used in configuring. 

Selectors 
An RFID system that has been configured using RF-MANAGER recognizes different types of 
selectors. These are distinguished as follows: 
● Tag selectors 

Tag selectors are components of data sources. They determine which tag data areas 
should be read or routed on. They also define which tags should be supplied or filtered 
out on the basis of the contents of these data areas. In this case, a tag selector orientates 
itself on the tag ID or the freely parameterizable user data of the tag. 

● Data selectors 
Data selectors are components of notification channels. They further dilute the 
information stream and specify which information should be passed on.  
In general, data selectors can also supply additional information (reader fields). This 
includes, for example, the time of the read. 

● ALE selectors 
ALE selectors reduce the data volume in accordance with the requirements of higher-
level systems and pass on the information in the form of ALE reports. ALE selectors can 
only sort EPC data; filtering of the freely parameterizable user data is not possible. 

SELV 
Safety Extra Low Voltage 

Sensing range 
Area in which reliable data exchange between transponder and reader is possible due to a 
particular minimum field strength. 
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Smoothing 
Smoothing is a technique that is used to optimize the read quality. The RF-MANAGER 
marks the read event with a status description for the tag (e.g.: detected for the first time, 
reliably detected, lost) and adds these states to the read results. Time intervals are defined 
using this technique - for example, how long a tag detected for the first time has to be "seen" 
for it to be regarded as reliably detected. This allows tags to be excluded that have been 
unintentionally detected briefly in the boundary areas of the reader.  

SSB 
Single Sideband Modulation. SSB is similar to AM (amplitude modulation), however, only 
one sideband is sent instead of two sidebands. This saves 50% of the spectrum required in 
the HF channel without affecting the signal/data rate. For RFID applications, an HF carrier 
must also be sent to supply energy to the tag. Sending a carrier is many times not required 
for other SSB applications, since the HF carrier itself does not contain any data.  

Static mode 
In static mode the transponder is positioned at a fixed distance (maximum: limit distance) 
exactly above the reader.  

Tag 
See transponder 

Tag talks first 
A passive tag communicates in the read field of a reader with the reader. When a tag 
reaches the field of a reader, it immediately indicates its presence by reflecting a signal. 

TARI 
Abbreviation of Type A Reference Interval. Duration (period) for representation of a bit with 
content 0. 

TCP/IP 
Transmission Control Protocol/Internet Protocol 

Telegram cycles 
A passive tag communicates in the read field of a reader with the reader. When a tag 
reaches the field of a reader, it immediately indicates its presence by reflecting a signal.  
Transmission of a read or write command is implemented in three cycles. They are called 
"Telegram cycles". One or two bytes of user data can be transferred with each command. 
The acknowledgment or response transfer (status or read data) takes place in three further 
cycles. 
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Template 
The template is a configuration file (*.rf660r) which contains all of the country-specific 
parameters (such as radio and tag protocol settings) required for operating the reader. 

TNC 
Connector designation (Threaded Neill Concelman). 
Industrial coaxial connector with screw coupling, can be used for frequencies of up to 2 GHz.  

Transceiver (transmitter/receiver) 
Combination of transmitter and receiver. A unit which can both send and receive 
electromagnetic waves. 

Transmission distance 
Distance between communication module and transponder 

Transponder 
An invented word from transmitter and responder. Transponders are used on the product, 
the product carrier, the object, or its transport or packaging unit, and contain production and 
manufacturing data, i.e. all application-specific data. They follow the product through 
assembly lines, transfer and production lines and are used to control material flow. 
Because of their wireless design, transponders can be used, if necessary, at individual work 
locations or manufacturing stations, where their data can be read and updated.  

Tree walking 
See Reader talks first. 

Triggers 
Triggers represent activation mechanisms that can be used to control asynchronous read 
and filter procedures. These are distinguished as follows: 
● Read triggers 

Read triggers cause the data source to read the data from the tags that are located in the 
field of the antennas. A continuous trigger can, for example, be configured that will cause 
the antennas to read constantly. 

● Notification channel triggers 
Notification channel triggers cause the notification channel to transfer the data from the 
data source assigned to it. A continuous trigger can, for example, be configured that will 
cause data to be transferred constantly. 
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UHF  
Ultra-high frequency; frequency range from 300 MHz to 3 GHz. UHF RFID tags usually 
operate between 866 MHz and 960 MHz. This corresponds to a wave length of approx. 33 
cm. 

UID 
User IDentifier; the UID is an unambiguous number in the transponder, assigned by the 
manufacturer. The UID is unambiguous, and can usually also be used as a fixed code. The 
UID is used to specifically address a transponder 

Ultra High Frequency 
See UHF. 

User IDentifier 
See UID 

VESA 
Video Electronics Standards Association (authority that defines standards for the PC 
industry) 

Walking 
See Reader talks first. 

WLAN 
Wireless LAN 

Workplaces 
Workplaces are used as an abstraction of the hardware. The relevant data sources and 
notification channels are grouped here into workplaces using the RF-MANAGER. In practice, 
workplaces are combinations of readers. 

Write/read distance 
See transmission distance 

writer 
See readers 
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XML  
eXtensible markup language; XML is a language derived from SGML with which other 
languages (document types) can be described. In the meantime, XML has become a widely 
used method for distributing information over the Internet. Data exchange between reader 
and read station is carried out using XML commands. 
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"Variables" editor,  

* 
*.pwx, 126, 410 
*.rfidsim, 131, 455 

A 
Access 

Variable, 373 
Acknowledgement variable 

For RFID data link, 255 
Acquisition cycle 

Variable, 286, 290, 291 
Action 

in the Object View, 85 
Adapt data comparison 

Runtime system, 461 
Add 

ALE connection, 259 
ALE groups, 268 
ALE selector, 265 
Data selector, 275 
Display selector, 273 
RFID data link, 249 
RFID device (reader), 138 
Tag selector, 272 
Workplace, 245 

Aiming duration, 227 
Alarm 

Acknowledge, 485, 488 
Acknowledging, 305, 318 
Alarm class, 304 
Alarm indicator, 306 
Alarm settings, 312 
Alarm system tasks, 301 
Basic settings, 312 
Calling the infotext, 488 
Display for runtime system, 306 
Editing, 485, 488 
Editor, 313 
Elements, 311 
Evaluation and documentation, 308 
Events, 309 
Filtering a display, 307 
in Runtime, 464 
Logging, 308, 319, 320, 325, 345 
Optional properties, 311 
Output, 325 
Printing, 308 
Property, 311 
RFID alarm, 301, 302 
RFID base alarm, 302 
RFID device alarm, 302 
RFID edge alarm, 302 
RFID status alarm, 302 
System alarm, 301, 303 
System functions, 309 
Trigger, 311 

Alarm buffer 
in Runtime, 465 

Alarm class, 311, 320 
"Alarm classes" editor,  
Predefined, 304 
Settings, 304 
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Alarm classes 
in Runtime, 465 

Alarm indicator, 482 
Behavior, 482 
Layout, 482 
Operation, 482 
Operation with the mouse, 482 
Purpose, 482 

Alarm line, 306 
Alarm log, 320 

"Alarm logs" editor,  
Data, 320 
Display contents, 321 
Displaying alarms, 325 
in Runtime, 465 
Log behavior, 321 
Log types, 321 
Properties, 323 
Properties dialog box, 322 
Scope of alarm logging, 468 
Storage media, 321 
Structure of csv file format, 326 
Workplace, 322 

Alarm logging 
configuring, 346 

Alarm number, 311 
Alarm system 

Tasks, 301 
Alarm text, 311 
Alarm types 

RFID alarm, 302 
Alarm view, 302, 306, 321, 483 

Control, 483 
Filtering, 307 
Layout, 483 
Operation, 483 
Operation with the keyboard, 484 
Operation with the mouse, 484 
Purpose, 483 

Alarm window, 302, 306, 483 
Control, 483 
in Runtime, 465 
Layout, 483 
Operation, 483 
Purpose, 483 

ALE (Application Level Events), 20 
ALE client 

ALE interface, 24 
ALE connection 

Add, 259 
ALE report, 261 
Assign ALE groups, 261 

Assign ALE selectors, 261 
Assign path, 260 
Assign port, 260 
Assign RFID edge alarm, 264 
Assign RFID status alarm, 264 
Assign workplaces, 260 
Enable, 260 
Name, 260 
Report cycle options, 263 
Standard ALE connection, 260 
Start cycle, 263 
Stop cycle, 263 

ALE groups 
Add, 268 
Assign EPC type, 269 
EPC data field, 269 
Filter, 269 
Group by value, 269 
Name, 269 

ALE interface 
ALE client, 24 
ALE groups, 24 
ALE report, 24 
ALE selector, 24 
Asynchronous read procedure, 24 
RFID system, 24, 28, 33 
Synchronous read procedure, 24 

ALE report 
ALE connection, 261 
ALE interface, 24 

ALE selector 
Add, 265 
Assign EPC type, 266 
EPC data field, 267 
Filter, 267 
ISO 18000-6B tag, 265 
Name, 266 

All RFID devices 
Display parameters, 243 
Editing the overview table, 243 
Multiple selection in the overview table, 244 

Antenna 
RFID device (reader), 22, 27, 31 

Antenna configurations 
Antennas, 153, 185 

Antenna gain 
Antennas, 151, 182 

Antenna port 
Antennas, 151, 182, 206 

Antenna switching 
Antennas, 184 

Antennas 
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Antenna configurations, 153, 185 
Antenna gain, 151, 182 
Antenna port, 151, 182, 206 
Antenna switching, 184 
Assign RFID base alarms, 152, 183, 218, 235 
Assign RFID status alarms, 152, 183, 218, 235 
Cable attenuation, 182 
Cable loss, 151 
Description, 183, 206, 218, 235 
Enable, 182 
ETSI radio profile, 153, 184, 185 
ETSI_SRD radio profile, 184 
FCC radio profile, 153, 185 
Minimum spacings for antennas, 157, 189 
Name, 151, 182, 206 
Operating mode, 182 
Tag antenna alignment, 159, 191 
Transmit power, 151, 153, 182, 184 

Application 
Script, 363 
System function, 361 

Application example, 405 
Project Wizard, 114 

Application examples 
for logs, 333 

Area of application, 350, 405 
Planning jobs, 405 
User administration, 350 

Area pointer 
"PLC connections" editor,  

Asian languages 
Configuration, 391 

Asian operating system, 388 
Assign ALE groups 

ALE connection, 261 
Assign ALE selectors 

ALE connection, 261 
Assign antennas 

Data sources, 160, 192, 207 
Assign data selector 

Notification channels, 166, 196, 211, 224, 240 
RFID device (reader), 147, 177, 204, 216, 233 

Assign data sources 
Notification channels, 166, 196, 211, 224, 240 
Workplace, 247 

Assign EPC type 
ALE groups, 269 
ALE selector, 266 

Assign event filter 
Data selector, 276 

Assign notification channel 
Workplace, 246 

Assign path 
ALE connection, 260 

Assign port 
ALE connection, 260 

Assign read trigger 
Data sources, 163, 195, 210, 222, 239 

Assign reader filter 
Data selector, 276 

Assign reference point 
Display selector, 274 

Assign RFID base alarms 
Antennas, 152, 183, 218, 235 

Assign RFID device (reader) 
Workplace, 246, 247 

Assign RFID edge alarm 
ALE connection, 264 

Assign RFID status alarm 
ALE connection, 264 
Notification channels, 197, 212 
RFID device (reader), 147, 177, 204, 217, 234 

Assign RFID status alarms 
Antennas, 152, 183, 218, 235 

Assign tag selectors 
Data sources, 163, 195, 210, 222, 239 

Assign triggers 
Notification channels, 167, 197, 212, 225, 241 

Assign type 
Trigger, 169, 198, 213 
Triggers, 226, 242 

Assign type of reference point 
Display selector, 274 

Assign workplaces 
ALE connection, 260 

Asynchronous data access 
Assign notification channel, 246 
Assign RFID device (reader), 246 
Workplace, 246 

Authorization 
in Runtime, 470 

Automatic synchronization, 376 

B 
Backup configuration data 

Runtime system, 463 
Barcode scanner, 227 
Barcode type, 228 

ID character, 228 
Barcode unit, 227 

Aiming duration, 227 
Bi-directional redundancy, 227 
Linear security level, 227 



Index 
  

 SIMATIC RF-MANAGER 2008 
546 Operating Manual, 06/2010, A5E01070042-03 

Basic objects, 343 
Basic settings 

Alarm, 312 
Behavior 

Alarm indicator, 482 
Button, 476 
Date/time field, 489 
Graphic I/O field, 480 
I/O field, 478 
Symbolic I/O field, 481 

Bi-directional redundancy, 227 
Button, 476 

Behavior, 476 
Layout, 476 
Operation, 476 
Operation with the keyboard, 477 
Operation with the mouse, 477 
Purpose, 476 

C 
Cable attenuation 

Antennas, 182 
Cable loss 

Antennas, 151 
calling 

System function in the script, 375 
Calling 

Script in the script, 375 
Change 

Default properties, 338 
Change language, 397 
Changing, 72 
Channel IDs 

RFID device (reader), 172 
Channel switching interval 

RFID device (reader), 172 
Circle, 343 
Circular log, 321 
Combining, 61 

Window, 61 
Communication 

between PLC and variable, 286 
Between the reader and variable, 288 
Communication drivers, 329 
Communication partners, 328 
using area pointers, 328 
using variables, 328 

Communication drivers 
"PLC connections" editor,  
Communication, 329 

Configuration, 391 

Asian languages, 391 
Control, 501 
Data comparison, 501 
Layout, 500 
Operation, 501 
Purpose, 500 

configuring 
Solution-oriented concepts, 66 

Configuring 
Toolbar, 49 

Connecting 
RFID device (reader) to parameterization 
computer, 91, 99, 105, 431, 439, 445 

Connection 
Serial, 105, 106, 445, 446 

Consistency check 
project, 128 

Contact partner, 523 
Contact person 

RFID device (reader), 148, 178, 205, 217, 234 
Context Menu, 64 

calling, 64 
Control 

Alarm view, 483 
Alarm window, 483 
Configuration, 501 
Editor-specific, 58 
of a frame, 59 
of a toolbar, 59 
Placing editor-specific, 58 
RFID view, 496 
Simple alarm view, 487 
Simple alarm window, 487 
Statistics view, 499 

Courses, 525 
Cover sheet 

Layout, 399 
Cross-references, 86 

Edit via shortcut menu, 86 
Editor, 86 
Working with, 86 

D 
Data comparison 

Runtime system, 461 
Data selection 

For project report, 403 
Data selector 

Add, 275 
Assign event filter, 276 
Assign reader filter, 276 
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Name, 276 
Standard data selector, 276 

Data source 
Read trigger, 23, 27, 32 
RFID device (reader), 22, 27, 32 
Smoothing, 23 
Tag selector, 23, 27, 32 

Data sources 
Assign antennas, 160, 192, 207 
Assign read trigger, 163, 195, 210, 222, 239 
Assign tag selectors, 163, 195, 210, 222, 239 
Enable, 160, 192, 207, 219 
Glimpsed timeout, 161, 193, 208, 220, 237 
Lost timeout, 161, 193, 208, 220, 237 
Maximal read duty cycle, 193, 208, 220 
Name, 160, 192, 207 
Observed threshold, 161, 193, 208, 220, 237 
Observed timeout, 161, 193, 208, 220, 237 
Read cycles per trigger, 161, 193, 208, 220 
Read timeout, 161, 193, 208, 220 
Session, 160, 192 
Smoothing, 161, 193, 208, 220, 237 

Data type 
External variable, 286 

Databases, 503 
MS Access 2000, 503 
MS Access XP, 503 
MS Data Engine 2000, 503 
MS Data Engine XP, 503 
MS SQL Server 2000, 503 

Date/time field, 489 
Behavior, 489 
Layout, 488 
Operation, 488 
Operation with the keyboard, 489 
Operation with the mouse, 489 
Purpose, 488 

Debugger 
Error types, 377 

Default properties 
change, 338 

Delay time 
For RFID data link, 257 

Dense Interrogator Environment mode (DIE mode) 
RFID device (reader), 180 

Dense Interrogator mode 
RFID device (reader), 149, 172, 173, 179 

Description 
Antennas, 183, 206, 218, 235 

Disabling program switching 
Runtime system, 427 

Display selector 

Add, 273 
Assign reference point, 274 
Assign type of reference point, 274 
Name, 274 

Docking, 60 
Toolbar, 60 
Window, 60 

Documentation in RF-MANAGER, 87 
Drag and drop, 63 
Drag-and-drop, 371 
dynamic operation, 298 

E 
Edit 

Project, 78 
RFID device (reader), 138 

Editing 
Layout, 401, 402 
Report properties, 341 

Editing language, 386 
Editing possibilities 

Project report, 402 
Editor, 313 

"Alarm log",  
"Alarm management",  
"Cycles",  
"Device settings",  
"Graphic browser",  
"Graphics lists",  
"Project languages",  
"Project texts",  
"Reports",  
"Runtime user administration",  
"Scheduler",  
"Screens",  
"Text lists",  
"Variables",  
Closing, 72 
Cross-references, 86 
General operation, 313 
Graphical editor, 68, 79 
Open, 69 
Project documentation, 87 
Properties, 68 
Short description of the editors, 78 
Tabular editors, 68, 79, 313 
With language-dependent objects, 392 

Ellipse, 343 
Enable 

ALE connection, 260 
Antennas, 182 
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Data sources, 160, 192, 207, 219 
Notification channels, 166, 196, 211, 224, 240 
RFID data link, 252 

Engineering support, 45, 66 
Overview, 66 

Enterprise system, 21, 23, 24, 26, 27, 30, 32, 36 
EPC Class 1 Gen2 

RFID device (reader), 141, 173 
EPC Class1 Gen1 

RFID device (reader), 173 
EPC Class1 Gen2 

Tag communication scheme, 149, 179 
EPC data field 

ALE groups, 269 
ALE selector, 267 

Error 
Logical error, 377 
Runtime error, 377 

ETSI radio profile 
Antennas, 153, 184, 185 

ETSI_SRD radio profile 
Antennas, 184 

Event, 20 
Time-based event, 407 

Event monitor 
RFID device (reader), 135, 459 

execute 
Scripts in runtime, 384 

Exit 
Runtime system, 463 

Export, 357 
Exporting 

User data, 472 
External image file 

Creating a folder reference, 382 
External variable, 286 

F 
FCC radio profile 

Antennas, 153, 185 
Filter 

ALE groups, 269 
ALE selector, 267 
Tag selector, 272 

Filtering 
of the Alarm View, 307 

Frequency hopping 
RFID device (reader), 140, 172 

Function key, 292, 299 
Function List, 364 

Asynchronous completion, 383 

Completion, 365 
Completion in runtime, 383 
Script, 365 
Status information, 365 
Synchronous completion, 383 
System function, 365 

Functional scope 
Dependencies, 427 
RF-MANAGER Runtime, 420 

G 
Glimpsed timeout 

Data sources, 161, 193, 208, 220, 237 
Global assignment 

of a function key, 299 
Graphic 

with transparent background, 297 
Graphic browser 

use image, 297 
Graphic Collection editor, 396 
Graphic I/O field, 480 

Behavior, 480 
Operation, 480 
Operation with the keyboard, 480 
Operation with the mouse, 480 
Purpose, 479 

Graphic view, 343, 479 
Layout, 479 
Operation, 479 
Purpose, 479 

Graphics 
Structure of editor, 396 
use from the image browser, 297 

Group by value 
ALE groups, 269 

H 
Heartbeat interval 

RFID device (reader), 174 
Help, 73 

display, 73 
Help function, 372 
Hide, 62 

Window, 62 

I 
I/O field, 480 

Behavior, 480 
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Layout, 477 
Operation, 480 
Operation with the keyboard, 480 
Operation with the mouse, 480 
Purpose, 479 

Import, 357 
importing 

User data, 472 
Initial Q 

RFID device (reader), 141, 173, 215 
Installation 

on the PC, 422 
IntelliSense, 369 
Interface 

RJ-45, 99, 105, 439, 445 
RS232, 99, 105, 439, 445 
RS422, 105, 445 

Interface converter, 105, 445 
Internal variable, 373 
Introduction 

Project documentation, 398, 400 
IP address 

RFID device (reader), 139, 170 
ISO 18000-6 Type B 

RFID device (reader), 173 
Tag communication scheme, 179 

ISO 18000-6B tag 
ALE selector, 265 

L 
Language dependency 

System function, 375 
Language settings 

Toolbar, 392 
Language-dependent format, 387 
Languages 

In various editors, 392 
Layout 

Alarm indicator, 482 
Alarm view, 483 
Alarm window, 483 
Button, 476 
Configuration, 500 
Cover sheet, 399 
Date/time field, 488 
Editing, 401, 402 
Graphic view, 479 
I/O field, 477 
Project report, 399 
Property, 401 

Regional format of the date, time, currency, and 
numbers, 387 
Report, 334 
RFID view, 495 
Simple alarm view, 486 
Simple alarm window, 486 
Simple user view, 493 
Statistics view, 498 
User view, 490 

License key 
RF-MANAGER, 14 

Licensing 
General information, 419 

Line, 227 
Linear security level, 227 
Local assignment 

of a function key, 299 
Local variables, 373 
Log 

Application examples, 333 
in runtime, 467 
Memory options, 467 

Log database 
Direct access with ODBC, 327 

Log type, 321 
Circular log, 321 
Segmented circular log, 321 

Logging 
Alarms, 325 
Scope of alarm logging, 468 

Logging cycle 
Variables, 291 

Logical error, 377 
Logoff time 

Exporting/importing, 472 
in Runtime, 471 

Lost timeout 
Data sources, 161, 193, 208, 220, 237 

M 
MAC address, 111, 451 
Manual synchronization, 376 
Maximal read duty cycle 

Data sources, 193, 208, 220 
Menu, 64 

Command, 49 
Minimum distance between antennas 

RFID device (reader), 150, 180 
Minimum spacings for antennas 

Antennas, 157, 189 
Minimum trigger duration 
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RFID device (reader), 174 
Mouse functions, 64 
Multi-language user interface 

RF-MANAGER, 77 
Multilingual projects 

Project, 76 
Multi-user project 

Project, 75 

N 
Name 

ALE connection, 260 
ALE groups, 269 
ALE selector, 266 
Antennas, 151, 182, 206 
Data selector, 276 
Data sources, 160, 192, 207 
Notification channels, 166, 196, 211, 224, 240 
RFID device (reader), 170 
Tag selector, 272 
Trigger, 169, 198, 213 
Triggers, 226, 242 

Navigation arrow, 72 
Notification channel 

Data selector, 23, 27, 32 
Notification channel trigger, 23, 27, 32 
RFID device (reader), 23, 27, 32 

Notification channels 
Assign data selector, 166, 196, 211, 224, 240 
Assign data sources, 166, 196, 211, 224, 240 
Assign RFID status alarm, 197, 212 
Assign triggers, 167, 197, 212, 225, 241 
Enable, 166, 196, 211, 224, 240 
Name, 166, 196, 211, 224, 240 

O 
Object, 85 

RFID objects, 78 
Selecting for project report, 404 
Synchronize in the script, 376 

Object selection 
Outputting configuration data, 403 

Object view 
Properties, 57 
Working in the Object View, 85 

Object View 
Action in, 85 
Shortcut menu actions, 85 

Objects in Runtime 

Overview, 464 
Observed threshold 

Data sources, 161, 193, 208, 220, 237 
Observed timeout 

Data sources, 161, 193, 208, 220, 237 
Online help, 73 

display, 73 
Open, 69 

"Alarm classes" editor,  
"Alarm logs" editor,  
"PLC connections" editor,  
"RFID alarms" editor,  
"System alarms" editor,  
Editor, 69 

Operating 
Runtime using the keyboard, 474 
Runtime with mouse, 475 

Operating mode 
Antennas, 182 

Operating system 
Asian language settings, 388 
Settings on Western, 388 

Operating systems, 503 
Windows XP Embedded, 503 
Windows XP Professional, 503 

Operation, 482 
Alarm indicator, 482 
Alarm view, 483 
Alarm window, 483 
Button, 476 
Configuration, 501 
Date/time field, 488 
Graphic I/O field, 480 
Graphic view, 479 
Hotkeys, 65 
I/O field, 477 
RFID view, 496 
Simple alarm view, 486 
Simple alarm window, 486 
Simple user view, 493 
Statistics view, 499 
Symbolic I/O field, 481 
User view, 490 
with the mouse, 63 

Operation and display options 
Project Wizard, 114 

Operation with the keyboard 
Alarm view, 484 
Button, 477 
Date/time field, 489 
Graphic I/O field, 480 
I/O field, 478 



 Index 
  

SIMATIC RF-MANAGER 2008 
Operating Manual, 06/2010, A5E01070042-03 551 

Simple alarm view, 487 
Simple user view, 494 
Symbolic I/O field, 481 
User view, 492 

Operation with the mouse 
Alarm indicator, 482 
Alarm view, 484 
Button, 477 
Date/time field, 489 
Graphic I/O field, 480 
I/O field, 478 
Simple alarm view, 487 
Simple user view, 493 
Symbolic I/O field, 481 
User view, 491 

Optimizing tag reading accuracy 
RFID device (reader), 150, 181 

organizing 
Script, 362 

Output 
Project report, 404 

Output medium 
Project report, 398 

Output window 
Properties, 55 

Overview 
Report system, 333 

P 
Parameter delivery 

Script, 375 
System function, 375 

Password 
Exporting/importing, 472 
in Runtime, 471 

Pin assignments 
a function key, 299 

Planning jobs, 405 
Application example, 405 
Area of application, 405 
Workplace, 409 

Plausibility check 
project, 128 

PLC 
Linking variables, 286 

Poll cycle 
Variable, 289 
Workplace, 247 

Polygon, 343 
Polyline, 343 
Port 

Ethernet, 91, 99, 100, 431, 439, 440 
Serial, 99, 439 
Serial with interface converter, 105, 445 

Port number 
RFID device (reader), 170 

Predefined tag field 
Tag selector, 272 

Print 
Report, 468 
Selection, 403, 404 

Print alarm 
Configuring output parameters, 346 

Printing 
Alarms, 472 
Runtime, 472 
Screen, 472 

project 
Consistency check, 128 
Create new using the Project Wizard, 88, 114 
Create new via option 'Create empty project', 88 
Editing, 78 
Plausibility check, 128 
Project documentation, 87 
Resolve error, 129 
Synchronization of project changes, 127, 412 
Testing, 128 
Transfer, 416 
Working with, 67 

Project, 114 
Displaying in the Object View, 81 
Displaying in the Project View, 80 
Load, 67 
Multilingual projects, 76 
Multiple sessions, 74 
Multi-user project, 75 
New, 67 
Several projects, 67 
Single-user project, 75 
Starting, 460 
Working in the Object View, 82 

Project data, 68 
Updating, 68 

Project documentation 
Introduction, 398 
Project, 87 
Purpose, 398 

Project language, 78 
Editor, 389 

Project languages 
Editor, 389 

Project Languages editor, 389 
Project report, 402 
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Data selection, 403 
Editing possibilities, 402 
For individual objects, 403, 404 
Layout, 399 
Layout contents page, 400 
Output, 404 
Output medium, 398 
Outputting Compact, 400 
Outputting complete, 400 
Selecting objects, 404 

Project text 
Access to, 393 
Editor, 393 

Project Texts editor, 393 
Project variable, 373 
Project view, 50, 53 

Drag and drop actions, 84 
Shortcut menu actions, 83 
Working in the Project View, 83 
Working with, 51 

Project Wizard 
Application example, 114 
Creating / modifying a project, 125 
Enter project information, 124 
Operation and display options, 114 
Parameterize the connection between the RFID 
device and the Enterprise System, 118 
Several RFID devices, 116 
Single RFID device, 115 
Specify system screens, 122 
Specifying workplaces and assigned readers, 120 

Properties 
Alarm log, 323 

Properties dialog box, 322 
"Alarm classes" editor,  
"Alarm logs" editor,  
"System alarms" editor,  
Alarm log, 322 
Property, 54 
Variable, 282 

Property 
Alarm, 311 
Layout, 401 
Variable, 284 

Protocol version 
RFID device (reader), 175 

Purpose 
Alarm indicator, 482 
Alarm view, 483 
Alarm window, 483 
Button, 476 
Configuration, 500 

Date/time field, 488 
Graphic I/O field, 479 
Graphic view, 479 
I/O field, 477 
Of report objects, 344 
Project documentation, 398 
RFID view, 495 
Simple alarm view, 486 
Simple alarm window, 486 
Simple user view, 493 
Statistics view, 498 
Symbolic I/O field, 481 
User view, 490 

R 
Radio profile 

RFID device (reader), 139 
Read continuously 

Variable, 290 
Read cycles 

RFID device (reader), 173 
Read cycles per trigger 

Data sources, 161, 193, 208, 220 
Read mode 

RFID device (reader), 173, 215 
Read timeout 

Data sources, 161, 193, 208, 220 
Reader 

Linking variables, 288 
Reader location 

RFID device (reader), 148, 178, 205, 217, 234 
Reader role 

RFID device (reader), 148, 178, 205, 217, 234 
Reader status 

RFID device (reader), 147, 177, 204, 217, 234 
Rectangle, 343 
Recursion level, 359 
Reference language, 386 
Reference text function, 392 
Remote control 

Of the runtime system for transfer, 417 
Replacing, 87 

Character string, 87 
Object, 87 

Report 
in Runtime, 468 
Layout, 334 
Print, 468 

Report cycle options 
ALE connection, 263 

Report objects 
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Purpose, 344 
Report properties 

Editing, 341 
Report system, 333 

Overview, 333 
Resolve error 

project, 129 
RFID alarm, 302 

"RFID alarms" editor,  
Alarm types, 302 
Base alarm, 302 
Device alarm, 302 
Edge alarm, 302 
Status alarm, 302 
Trigger, 302 

RFID base alarm, 302 
RFID data link 

Add, 249 
Coordination with acknowledgement variable, 255 
Coordination with delay time, 257 
Enable, 252 
Function at runtime, 255, 257 
Without coordination procedure, 258 

RFID device 
Enabling alarms, 147, 177, 204, 217, 234 
Suppression interval, 147, 177, 204, 217, 234 

RFID device (reader) 
Add, 138 
Antenna, 22, 27, 31 
Assign data selector, 147, 177, 204, 216, 233 
Assign RFID status alarm, 147, 177, 204, 217, 234 
Channel IDs, 172 
Channel switching interval, 172 
Communication settings using SIMATIC RF660R 
Configuration Software, 102, 442 
Communications settings using the RF-MANAGER 
Engineering System, 92, 94, 101, 107, 432, 434, 
441, 447 
connecting through Ethernet port (RJ45 
interface), 91, 100, 431, 440 
connecting through serial port (RS232 
interface), 99, 106, 439, 446 
Connecting via interface converters, 105, 445 
Contact person, 148, 178, 205, 217, 234 
Data source, 22, 27, 32 
Dense Interrogator Environment mode (DIE 
mode), 180 
Dense Interrogator mode, 149, 172, 173, 179 
Edit, 138 
EPC Class 1 Gen1, 173 
EPC Class1 Gen2, 141, 173 
Event monitor, 135, 459 

Frequency hopping, 140, 172 
Heartbeat interval, 174 
Initial Q, 141, 173, 215 
IP address, 139, 170 
ISO 18000-6 Type B, 173 
Minimum distance between antennas, 150, 180 
Minimum trigger duration, 174 
Name, 170 
Notification channel, 23, 27, 32 
Optimizing tag reading accuracy, 150, 181 
Port number, 170 
Protocol version, 175 
Radio profile, 139 
Read cycles, 173 
Read mode, 173, 215 
Reader location, 148, 178, 205, 217, 234 
Reader role, 148, 178, 205, 217, 234 
Reader status, 147, 177, 204, 217, 234 
RFID system, 22, 27, 31 
Send only on even channels, 172 
Standard data selector, 147, 177, 204, 216, 233 
Switching interval, 170 
Switching mode, 170 
Tag communication scheme, 141, 173 
Test configuration, 132, 134, 456, 458 
Testing, 128 

RFID device alarm, 302 
RFID edge alarm, 264 
RFID functionalities 

Erasing tag, 40 
Locking tags, 40 
Read tag, 38 
Writing tags, 39 

RFID objects 
Object, 78 

RFID status alarm, 264 
RFID system 

ALE interface, 24, 28, 33 
Components, 21, 26, 30 
RFID device (reader), 22, 27, 31 
RF-MANAGER workstation, 21, 26, 30 
Workplace, 24, 28, 33 

RFID view, 496 
Control, 496 
Layout, 495 
Operation, 496 
Purpose, 495 

RF-MANAGER 
Engineering support, 66 
Engineering System (ES), 13 
Individual configuration, 74 
Levels of the automation/IT structure, 18 
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License key, 14 
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